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TaiRox CRM and Collections Quick Overview

Quick Overview

TaiRox CRM and Collections is a customer relationship and collections management solution that
integrates fully with Sage 300. It lets you easily monitor customer activity and get paid faster.

CRM and Collections lets you manage all customer contact, opportunities, orders and collections. You
can also purchase the TaiRox Collections module without CRM features to manage your receivables.

CRM and Collections provides these entities for managing customers and sales opportunities:
e Companies that you can automatically promote to Sage 300 Customers
Contacts that are fully integrated with Sage 300 M/T Contacts
Bulk emailing that leverages the features of common bulk email providers such as MailChimp
Opportunities that are linked to Sage 300 orders and quotes
Tasks that appear on the dashboard for overdue invoices and other collections or CRM activities
Communications that feed emailing services such as MailChimp or Swiftpage
Cases for collections, support, on-site appointments, and other activities

It includes the following features for managing customer accounts and collections efficiently:
e Calendar and Dashboard views that show opportunities, cases, tasks, disputed invoices,
tracked/overdue invoices, and promised payments by revisit date for the day, week, or month
o Event emails (ics files) that update users’ email calendars with new opportunities, cases, and
tasks to which they are assigned
e Overdue invoice features for scheduling and sending aging period-specific overdue payment
reminder emails and generating phone tasks for calling customer contacts
e Payment due alerts to send customer reminder emails for invoices before they are overdue
Programs to email A/R and O/E invoices, statements, and letters to multiple recipients per
company and store emails with attachments for easy retrieval
Functionality to resend existing O/E and A/R documents and statements to any contacts
Invoice tracking for attaching documents and notes to invoices and other A/R documents
Promised payments for tracking customer agreements for settling accounts
Customer Aging screen to give you a lightning-fast view and report of overdue customer accounts
Collections cases, disputed invoices and promised payments that are created directly from the
customer aging screen
e Reports to assess your collections performance and review the status of disputed invoices,
overdue invoices, and promised payments

All CRM and Collections entities and functions appear on the Sage 300 desktop.
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CRM and Collections includes setup options for customizing opportunities and cases, creating demo data
for any Sage 300 database, generating opportunities for multiple companies, and scheduling and sending
payment due alerts and overdue payment reminders to multiple contacts per company.
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Setting Up CRM and Collections

This guide provides instructions for setting up TaiRox CRM and Collections and TaiRox Collections — a
product that provides the complete Collections module without TaiRox CRM'’s sales features.

This guide uses the product name “CRM and Collections” throughout, and indicates where a feature is
available in TaiRox CRM and Collections but not available in the stand-alone TaiRox Collections module.

See the CRM and Collections Implementation Guide and data input Setup Forms.

System Requirements

e Sage 300 2018 or later

TaiRox CRM and Collections has been extensively tested on Sage 300 2018 and later platforms.
CRM and Collections for earlier versions of Sage 300 may be provided upon request.

o Activate Sage 300 M/T Contacts if it’s available with your version of Sage 300.

If you previously used TaiRox Productivity Tools to add contacts in Extended Customers,
make sure that you update TaiRox Productivity Tools contacts to Sage 300 M/T Contacts
before you continue.

e SQL Server 2012 or later

LanPaks and Multiuser Licensing

CRM and Collections does not have its own multiuser licensing system. The number of users is controlled
by Sage 300 LanPaks. If you need to increase the number of users concurrently accessing CRM and
Collections, you must increase the number of LanPaks.

Installing TaiRox CRM and Collections on the Server

Uninstall prior version of CRM and Collections before installing a new version

e |n Windows 10 or Windows 11, go to Settings > Apps and Features, click TaiRox CRM, and
choose the Uninstall button.

In Windows 7, go to Control Panel > All Control Panel ltems > Programs and Features, right-
click TaiRox CRM and Collections, and select Uninstall.
Install the new version of CRM and Collections

e Run Setup-2018-2024.msi to install TaiRox CRM and Collections.
e Click Next, Accept the license agreement, click Next, and click Next again to install.
e After installing, run RegAcc.exe on each workstation that runs Sage 300 from a server.

Activating CRM and Collections and Entering License Information

Activate CRM and Collections to add and update database tables

e Select Administrative Services > Data Activation.
e Choose the new version of CRM and Collections

from Applications for Activation, and click Next. e

L] C|IC|( ACt|Vate ] ] . ] \'J ?;;;Z;Z:L e

e Add CRM and Collections license information N T ‘

. . Company | TAIROX SOFTWARE INC

e Select TaiRox CRM and Collections > Setup > o — }
License Information. — T

e Enter the license number in the License field and cevien PO |

. Prchase Cose

click Save.
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Set Up Options, Opportunity Stages, Case Stages,
Communication Types, and Optional Fields
After installing and activating CRM and Collections, follow these steps to choose options and add the

opportunity stages, case stages, communication types, territories, optional fields, and emailed accounting
documents that you want to use for your company.

Activate Sage 300 M/T Contacts if available with your version of Sage 300

TaiRox contacts are fully integrated with Sage 300 M/T Contacts. TaiRox’s Contacts program lists all
contacts added in CRM and Collections or with the Sage 300 Multiple Contacts module. And A/R
integration ensures that you have the same contacts in TaiRox that you have in Sage 300 A/R.

Step 1: Set up CRM and Collections options
The Options screen provides default settings that are used throughout CRM and Collections. For
details on all options, see Options, in the Setup and Maintenance Screens chapter in this guide.
e Goto TaiRox CRM and Collections > Setup > Options
The Options screen has four tabs — Options, E-Mail, Calendar, and Document Folders.

Options  Email Calendar Document Folders ~ Customer PDFs

Email Archive Folder |F.-Sage-Sage!DD'-SharedDala'-Cumpany-.SAMLTD'-.TalF!u: CRM\Documents*Sent Emails ‘ Browse...

[[] Suspend A/R Integration
[ Suspend M/T Integration

Save Close

e The Email Archive Folder is the default location where emails created by CRM and Collections
are stored as EML files. The files are referenced in CRM and Collections as Communications.
(EML files store the complete email, including attachments.) You can override the default location
for statements, letters, invoices, overdue payment reminders, and payment due alerts.

If you do not specify an Email Archive Folder, EML files will be stored in the Sage 300 Shared
Data folder under COMPANY\Company ID\TaiRox CRM\Documents.

You can use UNC file paths to specify the folder (such as \\ComputerName\C$\SentEmails).

e The Suspend A/R Integration checkbox lets you disable automatic updates between Accounts
Receivable customer records and TaiRox CRM and Collections companies.

Leave this box unchecked to automatically synchronize customer and company records in
Accounts Receivable and CRM and Collections. See Options for more information on A/R / CRM
synchronization.

Note: Sync Companies is disabled if you select the Suspend A/R Integration checkbox in
Setup Options. Do not suspend A/R Integration while setting up CRM and Collections.

e The Suspend M/T Integration checkbox appears only if you are using the Sage Multiple
Contacts module. It lets you disable automatic updates between Sage 300 M/T Contacts records
and the Contacts program in TaiRox CRM and Collections.
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Note: Sync Contacts is disabled if you select the Suspend M/T Integration checkbox in
Setup Options. Do not suspend M/T Integration while setting up CRM and Collections.

In addition, Sync Companies will not compare contacts added to CRM and Collections
Companies and A/R Customers if you suspend M/T Integration.

Email Tab

Email Server Settings are used to send calendar events to users when you assign users and
revisit dates to tasks, send emails from the Send Documents program in the Companies window,
send invoices, statements and letters from the programs in the Send Documents folder, and send
overdue payment reminders and payment due alerts to customers.

These settings are also used for sending bulk emails if you do not subscribe to a bulk email
service. (Note that Send Bulk Email will not appear if you only have the Collections module.)

And you can override the default “From Email” address for most documents and when you resend
documents using the Send Documents button in the Company window.

If this field is left blank, programs will default to the user’'s email address in Sage 300.

See the following sections for more information on overriding the From Email address for specific
email programs:

o For A/R Statements and Letters and for A/R and O/E invoices use the Accounting Documents
Setup program to override the default From Email.

o For Overdue Payment Reminders and Payment Due Alerts, see the Overdue Payment
Reminders Setup program and Payment Due Alerts Setup program.

For more details on emailing documents, see Step 13: Add settings for emailing overdue
payment reminders, and payment due alerts to customers and Step 14: Add settings for emailing
invoices, statements, letters to customers.

Calendar Tab

Select the entities that you want to update users’ calendars when you change revisit dates and
user assignments. You can update users’ calendars for cases, opportunities, and tasks.

Note that “Opportunities” will not appear if you are running the Collections module without CRM.

CRM and Collections generates .ics files when employees add or change revisit dates and user
assignments for cases, opportunities, and tasks, and sends them to the “Email 1” address
entered in Sage 300 for the assigned — and unassigned -- user.

.ics files (iCalendar files) are plain text files containing the details for a calendar event or a
to-do item. Typically, they are sent as attachments to emails that you can save to a calendar,
such as the calendar in Outlook or the Google calendar.

Note: CRM and Collections does not send calendar files when tasks are generated by the
Overdue Payment Reminders program. However, it will send calendar reminders when you
change the revisit date or user for tasks generated by Overdue Payment Reminders.

To set up TaiRox CRM and Sage 300 to send calendar event files you must also:
o Add “Email 1” email addresses for users in Sage 300 > Administrative Services > Users.
TaiRox CRM and Collections sends calendar events to the Email 1 email address.

o Add your email server settings on the Email tab in CRM and Collections > Setup >
Options. Use the Send Test Email button to test the email server settings.

For more details on ics files and setting up users for receiving emails, see Appendix E: Updating
Calendars with .ics Event Files.
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Document Folders Tab

The Document Folders tab lets you organize sales and accounting documents according to your
company’s unique needs — and in any location accessible from the CRM and Collections server.

The root folders for opportunity, case, and tracked invoice documents can be located anywhere
on the network, so, for example, cases and tracked invoices could be located on an Accounting
server, and opportunities on a Sales server.

You should set up the document folder locations before you start using CRM and Collections.
See Options - Document Folders tab for more information.

Emails sent by Send Statements/Letters, Send A/R Invoices, Send O/E Invoices, and Overdue
Payment Reminders are stored in the Email Archive Folder specified on the Options tab (unless
you specify different folders on the Accounting Documents form in the Setup folder).

Customer PDFs Tab

Click the A/R and O/E Invoice and Credit Note Options buttons to choose the report and report
options to use for generating A/R and O/E invoices and credit/debit notes attached to emails sent
by the Overdue Payment Reminders program, Payment Due Alerts program, and Send Invoices
program.

o The A/R Invoice Options apply also to A/R Credit and Debit notes.
o The “V/M” invoice and credit note buttons appear if you use Technisoft's Service Manager
application for Sage 300.

Note: The reports and options specified here are shared by the Overdue Payment Reminders
program, Payment Due Alerts program, and the Send Invoices program, so the invoices
generated by all three programs will match.

Step 2: Add opportunity stages — if you have CRM and Collections

Opportunity stages are the key milestones of your sales process. For example, your process might

include the following steps: “Prospect,” “Qualified”, “Meeting”, and “Proposal.”

Opportunity Stages appear in a dropdown list on the CRM and Collections Opportunity screen.

If you are using the stand-alone Collections module, you will not see Opportunity Stages.

e Add opportunity stages to TaiRox CRM using TaiRox CRM and Collections > Setup >
Opportunity Stages.

Coce WoapEN  r Qo+

Description |Meet|ng |

Created On 2022-05-10 Created By IAOMIN
Modffied On 2022-05-10 Modified By IADMIN

Notes
Save Delete Close
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Notes:

e The Sort Order determines the order that opportunity stages will appear in the Finder for the
“Stage” field on the Opportunity screen. In this example, UNQUAL has sort order “1”, and so it
appears at the top of the list.

. File Key Settings Global Settings
o [ ®Q + tame [EISe & 9 g

Find By: ‘Shnw all records v‘ Find Now | | Set Crtenia

Opportunity  Onders Documents  Notes

Company Name  [The Paper Hangers
Crseson -

Auto Search

Modfied On Modfied By Description Modfied On Modified By
UNQUAL Unqualfied ADMIN 20201208 ADMIN
sron
o QUALIFIED Qualiied ADMIN 20201208 ADMIN
Certairty [0 c0 Mesting [ ADMIN 2020-12-08 ADMIN
y
o VECTING 7T [Meeing | | PROPOSAL Proposal ADMIN 20201208 ADMIN
- QUOTE Quote based on .. ADMIN 20201208 ADMIN
Assigned To KEITH L Status ORDER Order enteredin ... ADMIN 20201208 ADMIN w
e am ININNAIR ity e ae < >

e The following stages (shown in sort order) are created by default when you activate CRM:

UNQUAL (sort order 1)
QUALIFIED (sort order 2)
MEETING (sort order 3)
PROPOSAL  (sort order 4)

You can edit the default stages, add new ones, and change the sort order to match your
company’s sales process.

O O O O

Step 3: Add case stages for one or more types of cases
e Add case stages to TaiRox CRM using TaiRox CRM > Setup > Case Stages.

e You do not have to use case stages, but they let users quickly see the progress of each case.

CRM and Collections provides four different types of cases: collection, support, appointment, and
other. The case stages should include the main steps that your company might complete for each of
the collection, support, and customer service processes.

Each case stage that you define is identified by a code and a description. Stages also include notes
where you can document the procedures for each stage.

If you use only one type of case, such as collection cases, you might have codes like this:
“‘REMINDER,” “DEFAULTNOTE”, “DEMAND”, and “LEGAL.”

However, if you use more than one type of case — for example, cases for collection issues and for
support issues — you would probably define a full set of case stages for each type of case, using
codes like C1, C2, C3 for stages in the collections process and codes like S1, S2, S3 for support
stages — as in the following screen.

Code 14 P+

Description |Opening collection case with customer |

Created On 20220512 Created By ADMIN
Modified On 2022-08-12 Modfied By ADMIN

[ Inactive
S0t Order
Notes (Opening collection case
Save Delete Close
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Notes:

e The Sort Order determines the order that the case stages will appear in the Finder for the
“Stage” field on the Case screen. For example, “A1” has sort order “1” and will appear at the top
of the finder list.

2 |E1 Opening collection case with customer  2020-12-08 ADMIN
3c2 Case stil open 20201208 ADMIN
4 C3 Case resolved 2020-12-08 ADMIN
5 51 51 - lssue logged with support 2020-12-08 ADMIN
6 52 52 - Issue escalated to level 2 20201208 ADMIN
7 53 53 - Level 2 contact made 20201208 ADMIN
8 54 54 - Customer appointment 2020-12-08 ADMIN W
£ >

Step 4. Add communication types

Communication types appear on communications and show how you communicated with companies
and contacts — such as by phone, email, mail, fax, text, or meeting. Each time you document a
communication, you must also specify the communication type.

¢ Add communication types to CRM using TaiRox CRM > Setup > Communication Types.
e The following default communication types are created automatically when you activate CRM:

EMAIL
FAX
MAIL
PHONE
TEXT

Code 4 P Qo+

Description |E—Mai\ ‘
Crested On Crested By
— —_

[ inactive

O O O O O

Notes

Save Delete Close

Step 5: Add optional fields

You can add Sage 300 optional fields to companies, contacts, opportunities, users, documents,
communications, and cases. Optional fields in CRM are displayed in data grids — such as in the lists
of companies, contacts, and users — as well as on Optional Field tabs.
To use optional fields with CRM records:
e First, add optional fields to Sage 300 using Common Services > Optional Fields.

You can also add a set of values for a Finder list when you add the fields.
e Second, add optional fields to TaiRox CRM using TaiRox CRM > Setup > Optional Fields.

You can set the default value of an optional field by choosing Yes in the Value Set field and
selecting the value in the Default Value field from values that were added in Common Services.
Or you can enter a default value if no list of values were added.
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Location | Companies

Q, Optional Field Optional Field Description

PYMTMETHC File Key Settings Global Settings
SALESREP

ACCTCLASS wccounts Payable °{  Accounts Payable  No

COURIER
FRGHTMET!

Set up Contacts and Companies

Find By: | Show all records ~ ‘ Find Now Set Criteria

Auto Search

Text Value Description

Accounts Payable
Accounts Receiv_. Accounts Recei

Accumulated De...  Accumulated De
Administrative Ex... Administrative E... v

Save | Delete | | Close

Select Cancel

Notes:

If the list is empty, just click the “Optional Field” column heading and select the first optional field
from the list that appears.

If the list already contains optional fields, click the Insert key, and then click the Finder to select
the new optional field from the list.

Double-click the Value Set field to set a default value for the field.

Use the Finder in the Default Value field to select from values or enter a default value if no list of
values exists.

If you add an optional field to CRM that is already used for A/R customers, CRM will display the
following message. Click Yes to update Companies with the optional field values from A/R.

One or more of the new Company optional fields are also
Customer optional fields.

Do you want them to be set to the customer values?

Yes

1=
=]

CRM will continue to synchronize optional fields for companies unless you select the Suspend
A/R Integration checkbox in CRM and Collections Options.

Similarly, if you add an optional field to CRM that is already used for M/T Contacts, CRM and
Collections will update CRM contacts with the optional field values from Sage 300, and will
continue to synchronize optional fields for contacts unless you select the Suspend M/T Integration
checkbox in Setup Options.

Set up Contacts and Companies

If you have the Sage 300 Multiple Contacts module, make sure that M/T Contacts is activated, then
follow “Step 6” and “Step 7” to set up CRM contact and company records.

If you previously used TaiRox Productivity Tools to add contacts in Extended Customers, make
sure that you update TaiRox Productivity Tools contacts to Sage 300 M/T Contacts before you
continue.

After updating TaiRox Productivity Tools contacts, run Sync Contacts to check that all contacts
have been copied to TaiRox CRM and Collections.

If you do NOT have the Sage 300 Multiple Contacts module, go directly to “Step 7” to set up CRM
company records.
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Step 6: Sync TaiRox Contacts with Sage M/T Contacts (if you use the Sage
Multiple Contacts module)

If you have the Sage 300 Multiple Contacts module, activate the Sage 300 M/T Contacts module if
you have not already done it.

Use Periodic Processing > Sync Contacts to add the list of contacts maintained in Sage’s M/T
Contacts module to the list of contacts maintained by TaiRox CRM. After setting up CRM and
Collections, you can use Sync Contacts to ensure that both lists of contacts match.

The Sync Contacts icon will not appear in the Periodic Processing folder unless M/T Contacts
is activated.

Note: Make sure that “Suspend M/T Integration” is NOT selected in Setup Options.

The Sync Contacts program is disabled if you select the Suspend M/T Integration checkbox. Do
not suspend M/T Integration while setting up CRM and Collections.

Welcome to the Sync Contacts Wizard

This wizard wil help you identfy and resolve any dfferences between the contacts in TaiRax CRM and the contacts in Sage Multiple Contacts

Cortacts are uniquely identfied by their contact codes. F a contact in TaiRox CRM and a contact in Sage Muttiple Contacts have the same
contact code then they represert the same cortact

Previous

2

Notes:

e Proceed through the wizard to copy all Sage contacts to TaiRox CRM and all CRM contacts to
Sage M/T Contacts.

e See Sync CRM Contacts with M/T Contacts for details on using the program.

Step 7: Sync Companies with Sage A/R Customers and Customer Contacts

Use Periodic Processing > Sync Companies to add all active A/R customers to TaiRox CRM and
Collections as new company records. Sync Companies ensures that the list of companies maintained
by TaiRox matches the list of customers in Accounts Receivable.

Note regarding inactive customers: Sync Companies only considers active customers when
checking if a customer has a corresponding company in TaiRox CRM and Collections.

If you need to add an inactive customer to CRM and Collections:

e Open the inactive customer in the A/R Customers program.

e Make the inactive customer active, and save the change. CRM and Collections will automatically
sync the record.

e Make the customer record inactive again, and save the change.

Generally, you will want to add all of your current Sage 300 A/R customers to CRM and Collections.
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Note: Make sure that “Suspend A/R Integration” is NOT selected in Setup Options.

The Sync Companies program is disabled if you select the Suspend A/R Integration checkbox.
Do not suspend A/R Integration while setting up CRM and Collections.

Welcome to the Sync Companies Wizand.

This wizard will help you identify any A/R customers that
between the A/R customers and their corresp:

a company in TaiRox CRM, 25 wel as identfy and resalve any differences
iRax CRM.

“You should run the Sync Contacts Wizard before running this wizar

Previous

o
2

Notes:
e Proceed through the wizard to copy all Sage A/R customers to TaiRox CRM and Collections.
e See Sync CRM Companies with Sage 300 A/R Customers for details on using the program.

Step 8: Run “Import Prod. Tools Contacts” if you use TaiRox Productivity Tools
to add contacts to A/R Customers

The “Import Prod. Tools Contacts” icon will not appear in the CRM Setup folder if you use the
Multiple Contacts module with Sage 300.

The Import Prod. Tools Contacts program in the Setup folder lets you import contacts for A/R
customers that are maintained by the Extended Customers program in TaiRox Productivity Tools —
prior to the introduction of the Sage 300 Multiple Contacts module.

The TaiRox Productivity Tools User Guide provides instructions for updating contacts when you
activate the M/T Contacts module.

The following “Import Prod. Tools Contacts” screen shows settings for importing all active contacts
from TaiRox Extended Customers for all companies that are active. (These settings match the
behavior of Sync Contacts and Companies.)

Customer Range
Select Customers By From To
oo o] 2l |Q [z [¢
| {None) w ‘
| {None) ~ ‘
| {None) w ‘
| {None) w ‘
| {None) w ‘
| {None) w ‘
Additional Criteria
‘ Insert Only V| [ inciude Inactive Customers
[include Inactive Contacts
Process Log.. Close
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Notes:

Set up Territories, Users, and Security

e See Appendix F: Exporting and Importing Companies, Contact, and Notes for information on

importing data from other accounting systems or contact management programs.

Set up Territories, Users, and Security

Company, user, and territory considerations for setting up

Each company in CRM must be assigned to a territory.

e Companies that are imported from A/R are assigned the territory code from A/R. If the territory

code was blank in A/R, they are added to the Default (blank) group in CRM.

e Companies that are added in CRM are also assigned a territory code. You can choose a blank

(default) code, or choose an existing territory from a dropdown list.

e Opportunities and cases are linked to companies and, therefore, are linked indirectly to a territory.
Contacts that are linked to companies are also indirectly linked to the company’s territory.

CRM users see companies, opportunities, cases, tasks, and notes based on the territories to which they

belong.

¢ A CRM user can be granted the right to see all territories. CRM includes a switch that effectively

turns off all territory restrictions for a user.

e Alternatively, a CRM user can be granted rights to see any number of specific territories. There is

no hierarchy of territories.

For more information on CRM security, see Appendix G: CRM Security.

Step 9: Add descriptions to territory codes. You can also add new territory
codes if you need them for new prospects

ortores S
Search | | Search
OrderBy  [Code ~| %
1 Defautt Temitory 20191209 ADMIN
2 AK Maska 20191209 ADMIN 2
3 CA Califomia 20191209 ADMIN 2
I T nsas Jaown ]
5 MO MO 20191208  ADMIN 4
6 NJ NJ 20191208 ADMIN
70N ON 20191208 ADMIN
8 PA PA 20191208 ADMIN
§TX T® 20191209  ADMIN
10 VA VA 20191209 ADMIN
< >
Page of 1 Add Delete Change Log..
Close

e Double-click a row to display territory information and add a territory name.
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You can also add notes — for example, to say who is assigned the territory, or to provide phone
numbers and addresses.

e Click the Add button to add new territories to CRM.

Step 10: Add Sage 300 users to CRM and Collections

e First, add users to Sage 300 using Administrative Services > Users.

Note: You must add an email address to the Email 1 field in Sage 300 to send calendar events to
assigned users for cases, opportunities, and tasks.

e Second, add Sage 300 users to TaiRox CRM using TaiRox CRM > Setup > Users.

User ID User Name et Fider |
Users Tertaries
Search [ Search
Order By [ User ID ]2
D U [
4DQ User 1512
3 KE 1512
2W coasin [ ooty [
I e T
[inactive
User ID I 1Q + |
] Al Tenitories
/’ Motes
\ Change Log
Cancsl
< \ >
Page o o~ Dekete Change Log...
Close
Notes:

e Click the Add button on the Users screen.
e Enter the User ID or use the Finder to select the new CRM user.
Note: the user must be added to Sage 300 first.

o Select the “All Territories” checkbox if you want the user to see opportunities, cases, and notes
for all territories — not just territories to which they are assigned.

e Click the Add button on the User screen.
To assign users to territories:

You do not have to assign users to individual territories if they have access to All Territories.

e Click the Territories tab on the Users screen:

UserD  |KEITH User Name  |keith Rider

Users  Tenmitories

Search [ Search

Order By [ Code v| %

ID Code Name CrestedOn  Created By

Note that Collections users need access to all territories to run Overdue Payment Reminders and
view all disputed invoices, overdue invoices, tracked invoices, and promised payments.
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e Click the Link button at the bottom of the screen.
e Enter or select a territory code and click the Add button.

e Click the New button (4) on the Territory popup to add another territory.

Step 11: Add new CRM and Collections security groups to Sage 300

Create security groups for different sets of users to allow different access rights for groups of users.
See Appendix G: CRM and Collections Security.

e Select Administrative Services > Security Groups
e Choose “TaiRox CRM and Collections” as the application

Collections users require access to the Collections security authorization and should have user
access to all territories in order to run Overdue Payment Reminders and view all disputed invoices,
overdue invoices, tracked invoices, and promised payments.

Step 12: Add CRM and Collections users to security groups in Sage 300

After creating CRM and Collections security groups, add users in Sage 300 Administrative Services.
See Appendix G: CRM and Collections Security.

e Select Administrative Services > User Authorizations

Specify Email Settings for Customer Documents

CRM and Collections lets you email invoices, statements, letters, overdue payment reminders, and
payment due alerts to multiple recipients and create a communication record of each email for easy
lookup.

¢ You specify all email message details for the Send A/R statements/Letters, Send A/R Invoices,
and Send O/E Invoices programs using the Accounting Documents screen. These programs are
replacements for Sage 300 programs that save copies of statements, letters and invoices as
communications.

e You choose the email templates for overdue invoice reminders, payment due alerts and the Send
Invoices program using the Overdue Payment Reminders Setup, Payment Due Alerts Setup, and
Send Invoices Setup programs.

Step 13: Add settings for emailing overdue payment reminders, payment due
alerts, and invoices to customers

Note that CRM and Collections uses the “Preferred Language” setting in the Company window to send
emails and attached invoices to customers in English, French, or Spanish. See Appendix C: Editing Email
Templates for Payment Due Alerts, Overdue Payment Reminders, and Send Invoices for details.

Overdue Payment Reminders Setup
e Goto TaiRox CRM and Collections > Setup > Overdue Payment Reminders

The Overdue Payment Reminders screen has two tabs — Settings and Scheduling.

Settings tab

e Overdue Payment Reminder settings are used by the Overdue Payment Reminders program
to send reminder emails to customers and to create phone tasks for users making collection calls.
See Overdue Payment Reminders and Overdue Payment Reminders Setup for details.
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See Appendix C: Editing Email Templates for Payment Due Alerts, Overdue Payment Reminders,

and

Send Invoices for information on creating email templates.

Settings ~ Scheduling

Overdue Payment Reminder Stages

Email Subject
From Email
Reply-To Email
Ce

Bee

Email Archive
Folder
Organize By

Save

Days Overdue Label Color  Action Email Template
[ [ & [ | [] [sendErai | [tstesm <[ Preview
‘ 31| ‘ EDl ‘Z'P‘“‘ Due ‘ |:| ‘Send Email v| 2PastDue html ~ || Preview
61 30| [3-In Arears | [ [sendErai  ~] [BnAmearshini ~ ][ Preview
[ Ove] [ S [¢-Deinquert | [ [serdEmai ]| [4Deinquenthimi <[ Preview
Minimum days overdue before creating an Overdue Fayment Reminder Aitachments

Minimum number of days between Overdue Payment Reminders

Format Overdue Invaices v

Create a Communication When You Send an Email

Install Cunent Templates

Sample Company Limited - Payment Overdue

|F: Sage\Sage 300°\SharedData\Company \SAMLTD\TziRax CRM\Documents\Sent Emails ‘ Browse...

[ 5ave All Sent Emails in the Email Archive Folder by Year and Morth ~]

Close

Days Overdue: The default settings provide standard 30-60-90 aging buckets, but you can
change the number of days for each range.

CRM uses these aging buckets to assign overdue invoices to invoice stages when you click the
Update button on the Overdue Payment Reminders form.

Labels and Color: You can change the labels and colors used for each overdue invoice stage.

Labels appear on the Overdue Payment Reminders form.
Action: The program supports two actions:

o Send Email — to send payment reminders using the selected email template to company
contacts when a company’s oldest invoice reaches this overdue stage.

o Create Task — to create a collections task for calling up a customer when the company’s
oldest invoice reaches this overdue stage.

Email Template: Choose the default email message that you want to send to customers for
each overdue invoice stage. You can edit the default template files or add your own.

Note the following points regarding template locations:

o During installation, the program copies the email templates to the following program directory:

\<Sage300>\XQ61A\Templates\Overdue Payment Reminders

o When you first activate CRM and Collections for a new company, the program copies the
email templates to the following company directory

C:\Sage300SharedData\Company\<companyID>\TaiRox CRM\Templates\Overdue Payment Reminders

o The Setup program looks in the company directory for Overdue Payment Reminder
templates:

C:\Sage300SharedData\Company\<companyID>\TaiRox CRM\Templates\Overdue Payment Reminders

Preview: Click the Preview button to view the body of the selected payment reminder email
template.

Note: The Preview button will use the default program for the file type that’s set up in
Windows File Explorer. For example, the default program may be your internet browser.

TaiRox CRM and Collections for Sage 300 13 User Guide



Setting Up CRM and Collections Specify Email Settings for Customer Documents

Attachments: Click the Attachments button to add additional attachments to all of the overdue
payment reminder emails — such as your policy on overdue accounts.

You can use “drag and drop” to add attachments, or click the Add button on the Attachments
screen to search for attachments using Windows File Explorer.

Install Current Templates button: When you update CRM and Collections, you can get the
most recent templates installed by program updates by clicking the “Install Current Templates”
button. It will copy new templates from \XQ61A\Templates\Overdue Payment Reminders to the
company folder.

Minimum days overdue before creating an Overdue Payment Reminder lets you specify the
default minimum number of days that an invoice must be overdue before it will create an overdue
payment reminder record.

You can change this setting for individual companies in the Company window. (For example, you
may have customers whose payment is always late or who may have different payment terms.)

Minimum number of days between Overdue Payment Reminders ensures that you do not
spam customers with too many payment reminders. If you do not specify a minimum (e.g. 7 or 14
days), the program will create a new reminder for all overdue invoices each time you update the
overdue payment reminders list and process payment reminders. See Overdue Payment
Reminders for detalils.

Format: Select Overdue Invoices to only list overdue invoices, debit notes and interest charges
on overdue payment reminders, or select Account Summary to list all unpaid documents and
unapplied credits.

Email Subject: Specify the subject line that you want to appear on all overdue payment
reminder emails.

From Email: Specify the “From Email” address that you want to appear on all overdue payment
reminder emails.

Reply-To Email: You can also specify a different email address that will be used when recipients
reply to your overdue payment reminder emails.

Cc / Bcc: Add email addresses in the Cc and Bcc fields to send copies (or blind copies) to other
recipients in your company. To Cc or Bcc multiple recipients, separate the email addresses with
commas or semicolons.

Create a Communication When You Send an Email: Select the “Create a Communication”
checkbox to create a communication when overdue payment reminders are emailed to
customers.

Scheduling tab

The Scheduling tab provides the user information that will be in effect when running the Overdue
Payment Reminders program as a scheduled background task.

e Send Email settings: Apply to any selected customers that have a Send Email action.
Attach Copies of the Invoices: Select to include PDF copies of overdue invoices with emails.

Substitution Variables: Enter values for variables that appear in the email templates when
reminders are sent from a Windows scheduled task. (Note that the actual task user may be the
Sage 300 Admin user, but you may want emails to be from the Accounts Receivable manager.)

e Create Task settings: These settings apply to customers that have a Create Task action.

You can specify a user name in the Task options to assign tasks for this set of companies to a
single user.

Specify the number of days following run time that the call task should appear on the assigned
user’s dashboard.

e Exclude Customer settings: Use the checkboxes to choose which invoices to exclude from
emails or tasks.
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Payment Due Alerts Setup
e Goto TaiRox CRM and Collections > Setup > Payment Due Alerts

The Payment Due Alerts screen has two tabs — Settings and Scheduling.

Settings tab

e Payment Due Alerts settings are used by the Payment Due Alerts program to send reminder
emails to customers about upcoming invoice payments. See Payment Due Alerts and Payment
Due Alerts Setup for details.

Settings  Scheduling

Number of days before due date to send a Payment Due Alet

Minimum number of days between Payment Due Alerts
Email Template DueSoon html ~ Preview Attachments ..

Email Subject ‘Samp\e Company Limited - Payment Due Soon

From Email ‘serﬂ@samnd com

Reply-To Email ‘rep?y@sam?td com

Ce [cC@samhd.com

Bee ‘

Create a Communication When You Send an Emai

Email Archive

Folder |F "Sage\Sage300\SharedData \Company\SAMLTD\TaiRox CRM\Documents\Sent Emails | Browse...
Organize By | Save All Sent Emails in the Email Archive Folder by Year and Month vl

Save Close

Number of days before due date to send a Payment Due Alert lets you specify the number of
days before payments are due to send reminders. This number applies to the invoice that is
closest to being due.

You can change this setting for individual companies in the Company window. (For example, you
may customers whose payment is always late or that may have different payment terms.)

Minimum number of days between Payment Due Alerts ensures that you do not send
customers too many payment alerts. If you do not specify a minimum (e.g. 10 days), the program
will let you create a new alert each time you run Update and process payment due alerts. This
can result in spamming customers.

Note: The Minimum number of days between Payment Due Alerts must be less than the
Minimum number of days before the due date to send Payment Due Alerts. This ensures that
an alert will be sent for each invoice before it becomes due.

Email Template: Choose the default email message that you want to send to customers to
remind them of invoice payments. You can edit the default template files or add your own — and
you can override the default email message templates when you process payment due alerts.

Note the following points regarding template locations:
o During installation, the program copies the email templates to the following program directory:
\<Sage300>\XQ61A\Templates\Payment Due Alerts

o When you first activate CRM and Collections for a new company, the program copies the
email templates to the following company directory

C:\Sage300SharedData\Company\<companyID>\TaiRox CRM\Templates\Templates\Payment Due Alerts

o The Payment Due Alerts Setup program looks in the company directory for Payment Due
Alerts templates. Template files must be stored in the following folder to be selected by the
program.

C:\Sage300SharedData\Company\<companylD>\TaiRox CRM\Templates\Payment Due Alerts
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Preview: Click the Preview button to view the body of the selected payment due alert email
template.

Note: The Preview button will use the default program for the file type that’s set up in
Windows File Explorer. For example, the default program may be your internet browser.

Attachments: You can add additional attachments to all of the payment due alert emails — such
as your policy on overdue accounts.

You can use “drag and drop” to add attachments, or click the Add button on the Attachments
screen to search for attachments using Windows File Explorer.

Email Subject: Specify the subject line that you want to appear on all payment due alert emails.

From Email: Specify the “From Email” address that you want to appear on all payment due alert
emails.

Reply-To Email: You can also specify a different email address that will be used when recipients
reply to your payment due alerts.

Cc / Bcc: Add email addresses in the Cc and Bcc fields to send copies (or blind copies) to other
recipients in your company. To Cc or Bcc multiple recipients, separate the email addresses with
commas or semicolons.

Create a Communication When You Send an Email: Select the “Create a Communication”
checkbox to create a communication when payment due alerts are emailed to customers.
Scheduling tab

The Scheduling tab provides the user information that will be in effect when running the Payment
Due Alerts program as a scheduled background task.

e Send Email settings
Attach Copies of the Invoices: Select to include PDF copies of due invoices with emails.

Substitution Variables: Enter values for variables that appear in the email templates when
reminders are sent from a Windows scheduled task. (Note that the actual task user may be the
Sage 300 Admin user, but you may want emails to be from the Accounts Receivable manager.)

See Appendix C: Editing Email Templates for Payment Due Alerts, Overdue Payment Reminders,
and Send Invoices for information on creating email templates.

Send Invoices Setup
e Goto TaiRox CRM and Collections > Setup > Send Invoices

The Send Invoices Setup screen has two tabs — Settings and Scheduling.

Settings tab

e Send Invoices settings are used by the Send Invoices program to send emails to customers
with posted and unsent attached invoices. See Send Invoices and Send Invoices Setup for
details.
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Cc

Bec

Sa

Seftings  Scheduling

Email Template Sendlnvoice html ~ Preview Atachments...
Email Subject ‘Samp\e Company Ltd. - Invoice/Facture
From Email [Den@samtd com

\
\
Reply-To Emal  [AR@sanitd com |
\
|

Create a Communication When You Send an Email
Email Archive
Folder |F \Sage\Sage 300'SharedData"Company \SAMLTD\TaiRox CRM\Email Archve Folders | Browse...

Organize By | Save All Sent Emails in the Email Archive Folder by Year and Month "l

‘Dun@samkd com

ve Close

Email Template: Choose the default email message that you want to send to customers with
invoices. You can edit the default template files or add your own — and you can choose a different
email message template when you send invoices.

Note the following regarding template locations:
o During installation, the program copies the email templates to the following program directory:
\<Sage300>\XQ61A\Templates\Send Invoices

o When you first activate CRM and Collections for a new company, the program copies the
email templates to the following company directory

C:\Sage300SharedData\Company\<companylD>\TaiRox CRM\Templates\Templates\Send Invoices

o The Payment Due Alerts Setup program looks in the company directory for Payment Due
Alerts templates. Template files must be stored in the following folder to be selected by the
program.

C:\Sage300SharedData\Company\<companylD>\TaiRox CRM\Templates\Send Invoices

You can get the most recent templates installed by program updates by copying the new
templates from \XQ61A\Templates\Send Invoices to the company folder. Make sure that your
current templates have a different name from the templates installed by CRM and Collections.

Preview: Click the Preview button to view the body of the selected Send Invoices email
template.

Note: The Preview button will use the default program for the file type that's set up in
Windows File Explorer. For example, the default program may be your internet browser.

You can get the most recent templates installed by program updates by copying the new
templates from \XQ61A\Templates\Send Invoices to the company folder. Make sure that your
current templates have a different name from the templates installed by CRM and Collections.

Attachments: Click the Attachments button to add additional attachments to all of the invoice
emails — such as your policy on overdue accounts.

You can use “drag and drop” to add attachments, or click the Add button on the Attachments
screen to search for attachments using Windows File Explorer.

Email Subject: Specify the subject line that you want to appear on all invoice emails.
From Email: Specify the “From Email” address that you want to appear on all invoice emails.

Reply-To Email: You can also specify a different email address that will be used when recipients
reply to your invoice emails.

Cc / Bcc: Add email addresses in the Cc and Bcc fields to send copies (or blind copies) to other
recipients in your company. To Cc or Bcc multiple recipients, separate the email addresses with
commas or semicolons.

TaiRox CRM and Collections for Sage 300 17 User Guide



Setting Up CRM and Collections Specify Email Settings for Customer Documents

Create a Communication When You Send an Email: Select the “Create a Communication”
checkbox to create a communication when invoices are emailed to customers.

Scheduling tab

The Scheduling tab provides the user information that will be in effect when running Send
Invoices as a scheduled background task.

See the CRM and Collections Scheduler User Guide for information on setting up Windows
scheduled tasks for sending invoices.

Send Email settings

Substitution Variables: Enter values for variables that appear in the email templates when
invoices are sent from a Windows scheduled task. (Note that the actual task user may be the
Sage 300 Admin user, but you may want emails to be from the Accounts Receivable manager.)

See Appendix C: Editing Email Templates for Payment Due Alerts, Overdue Payment Reminders,
and Send Invoices for information on creating email templates.

Step 14: Add settings for emailing invoices, statements and letters to customers

Open TaiRox CRM and Collections > Setup > Accounting Documents to specify properties
for emails sent using Send Statements/Letters, Send A/R Invoices, and Send O/E Invoices.

Send Invoices, Overdue Payment Reminders, and Payment Due Alerts do not use this form
for email settings.

o You select email templates for Overdue Payment Reminders and Payment Due Alerts in the
Overdue Payment Reminders Setup, Payment Due Alerts Setup, and Send Invoices Setup
screens.

Notes:

Select the document type from the Name dropdown at the top of the screen.

Name A/R Statement
A/R Statement
Created On AJR Letter

Modified On

O/E Invoice

[inactive

The message details at the top of the screen let you specify a different reply-to email address,
Cc, Bcc, email subject and email message body for each type of accounting document. The
“From Email” will override the default From Email address specified on the Email tab in the

Options program.
Separate multiple Cc and Bcc recipients’ email addresses with commas or semicolons.

From Email

Cc

Bcc

\ |
Reply To Emal | |
\ |
\ |
[Documents Attached for SCISTOMER_NUMBER SCUSTOMER_NAME I3

Subject
Body Documents Atached

Atachment Limit | 0] (0for noimi)

The Attachment Limit is the maximum number for attachments for a single email. For example, if
you specify 1, the program will generate a separate email for each invoice that’s sent to the same
company email address or contact.

Enter “0” for no limit on the number of attachments.

Select “Create a Communication When You Send an Email” to store a copy of each email that
CRM creates as a communication. You can look up past emails by communication or recipient.
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Specify Email Settings for Customer Documents

e The Email Archive Folder field lets you specify a different archive folder for each type of
accounting document. If you do not specify a folder, CRM will use the Email Archive Folder
specified on the first tab in the Options form.

e Choose from the “Organize By” dropdown to save all communications in subfolders of the Email
Archive Folder you specified, organized by Year (ArchiveFolder\YYYY), Year and Month
(ArchiveFolden\YYYYMM) or Year, Month, and Day (ArchiveFolder\YYYYMMDD).

e Accounting documents use the server set up on the Email tab in CRM and Collections Options.

Nams [ A/R Statement v
Crested On Created By

Modified On Modiied By

[inactive

From Emai I ‘
Reply To Emal | |
Ce [ ‘
Bec [ ‘
Sublect [Documents Atached for SCUSTOMER_NUMBER SCUSTOMER_NAME =
Body Documents Atached =]

[ 9 @fornalimit)

Atachment Limit

Notes

[ Create a Communication When You Send an E-mail
E-mail Archive

Archive Folder |F \Sage'Sage 300\Shared Data'\Company \SAMLTD"TaiRox CRM\Documents

|| Browse...

Organize By [ Save Al Sent Emails inthe Email Archive Folder

Save

Close

Step 15: Specify the email recipients of accounting documents on the Contacts

tab for each company

The Contacts tab in the CRM and Collections Company window lets you:

e Add contacts to existing companies.

¢ Identify which contacts in each company will be emailed statements, letters, invoices, overdue
invoice payment reminders, and payment due alerts.

Mame  |ACME Pumbing

| Cotorer e 5 8

o] Gt oot Donmets o s Conurcrs

Search [

| [ Seerch | Adyanced.. |

Order By [ contact Code o] s

First Name
AndrewMuey @tairox.com
AnneYale@taioz.com
CharlesBiiar@airox.com
EdwardCavendish @tairox.com

Murey Andrew
Yale Ane

Biiar Charles
Cavendish Edward

RICHARDFLTOKWADD020 Richard

A/R Invoices

A/R Statements

O/E Invoices

X/Q Payment Reminders

If you already email statements, letters and invoices to customers from Sage 300, CRM and

Collections’ Send Documents features will continue to email statements, letters and invoices to
customers if their Delivery Method in A/R is set to Email or Contact’s Email.

In addition, all Collections programs that email documents create a communication for each emailed
invoice, statement, letter, or notice and attach it to the company record, so you can look up emailed

documents to confirm them later.
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However, to use all email features (such as sending different documents to different — and multiple
— recipients), you must:

e For each company, specify the email recipients for each document type on the Contacts tab in
the Company (or Companies) window.

Note — if you use M/T Contacts — that the documents shown on the Contacts tab in Sage 300 A/R
and on the contacts tab in CRM are not the same.

For example, the CRM list does not include O/E Order Confirmations. However, if you selected
contacts for Invoices in Sage 300 A/R, the contacts you selected there will appear in CRM.

You can specify any number of recipients from the list of CRM contacts for the company.

Hint: Right-click the column headings in the grid and choose “Hide Most Columns” to easily view
the contact names and the email forms (as shown above). You can reset the columns after
selecting email recipients, or choose the precise group of fields that you want to display — such as
the email address field or the Address 1 field.

ID Cortact Code ame it Name FrrRETI . Phone (Office)  Phone (Mobike)
13 BETHFRENCHO0013  French Beth e (7035551069 (703) 5551086 (703) 555-103¢
14 ELIZABETHKERSHAWOD. . Kershaw Bizabeth cro (3055551040 (055551010 (3055551083
12 JOENGLISHO0012 English Jo estore Jetautts (403)5551070  (403)55510685  (403)555-101

11 JOESLOANOOOT! Sioan Joe Hide Mozt Columans [ coo (250)555-1076  (250) 5551045 (250) 555-1043
10 JOSEPHVIPONDO0OI0  Vipond Joseph (647)555-1041  (647) 5551082  (647) 555103
Jose

9 JOSETRUDEALIDDO0S Trudeau (212) 555-1083 (212) 555-1067 (212) 555-107:

Note: If you do not set up recipients on the Contacts tab for each company, you cannot send
documents to multiple recipients — or different recipients — for each type of accounting document.

See Specify Email Addresses for Statements, Letters, Invoices, Overdue Payment Reminders, and
Payment Due Alerts for details.

Step 16: Set up bulk email accounts

The Bulk Email Accounts Setup program stores the connection information for your bulk email
provider’s website.

This information is required if you want to use the Send Bulk Email program with a bulk email service
provider such as MailChimp or SendGrid to send general announcements or sales and marketing
emails to customers.

Note: Send Bulk Email is a CRM and Collections feature. It is not included in the Collections
module without CRM.

Note:

e You can send bulk emails using the email server specified in Setup > Options if you do not
subscribe to a bulk emailing service.

e You do not need a bulk email provider to send invoices and other accounting documents from
CRM and Collections to customers.

Open TaiRox CRM and Collections > Marketing > Bulk Email Accounts to specify the connection
properties for your bulk email account. Note that the Marketing folder will not appear on the Desktop
unless you have CRM and Collections.
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o W AEORD ]y b Q4+
Description |SendGrid bulk mailing account |
— "y
Modiied On Modified By
[ inactive l:l
Provider [ SendGrd ~] Send Test Email
APl Key |---....-- ¥ e e |
API Ut [nttps:/api sendgrid.com 3 |
Notes Account for sendng bulk emails to customers]

Save Delete Close

Notes:

e Choose the provider from the Provider dropdown list. CRM and Collections currently supports
bulk emailing through MailChimp and SendGrid. More providers will be added in future.

e The API key is from your email provider. The Send Bulk Email program uses it to log in to the
provider's website when you are performing a bulk email run.

e You can enter any notes with the account record.

See Set Up Bulk Email Accounts and Appendix D: Sending Bulk Emails and Using Bulk Email Templates
for details.

Add New Companies, Contacts, and Opportunities

You are now ready to add new prospects and contacts to CRM, and to add and track new opportunities.

For help on performing these tasks, see the following sections in this guide.

e To add companies: Company — Add/Edit

e To add contacts: Contact — Add/Edit

e To add opportunities: Opportunity — Add/Edit

See Copying Opportunities, and also see Create Opportunities for information on generating
opportunities for multiple companies in a single process.

Note that Opportunities are not available with the stand-alone Collections module (without CRM).

e To add documents: Document — Add/Edit,

You can also drag and drop documents to company records, opportunities, cases, disputed
invoices, and tracked invoices.

Demonstrating TaiRox CRM and Collections
CRM and Collections has functions for creating and removing demonstration data. The data will be
created for the 12 months preceding the current Sage 300 session date.

e Activate CRM and Collections for the database where you want to create demo data.

e Use TaiRox CRM and Collections > Setup > Create Demo Data to create CRM Opportunities,
Contacts, Contact Groups, Cases, Notes, Documents, and Communications.
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Different opportunities will have Won, Lost, Closed and Deferred statuses. The opportunity dates
will be set relative to the session date (forward and backward).

Cases will have revisit dates as might be expected, and the resulting data will produce
reasonable Charts.

e Use TaiRox CRM and Collections > Setup > Remove CRM Data to delete this data.

Notes:

e Import Customers, Import Contacts and Sync Companies are part of the go-live and maintenance
processes and do not create demonstration data.

e The following programs will generate emails and communications in demo mode, but will NOT
actually send emails: Send Documents, Payment Due Alerts, and Overdue Payment Reminders.

Cases, opportunities and tasks will generate calendar events, but they will not send them either.

This means that you can demonstrate this functionality without setting up an email server.

A/R and M/T Integration are suspended in CRM and Collections Demo Data:

Note that A/R and M/T Integration are suspended when you create CRM and Collections Demo Data.
If you look in Setup Options, you will see that both “suspend integration” options are checked.

Suspend A/R Integration
[] Suspend M/T Integration

Suspend M/T Integration appears only if you are using Sage 300’s Multiple Contacts module.

Warning Messages when you select Sync Contacts or Sync Companies

If you select Sync Contacts or Sync Companies, then following messages will appear.

Message Message

Description: M/T integration has been suspended in TaiRox CRM Options Description: A/R integration has been suspended in TaiRox CRM Options
Sync Contacts cannot be performed. Sync Companies cannot be performed.
Source: 15:56:36 - Source: 15:57:18 -
B n

Note that A/R and M/T Integration are suspended for your protection!

Integration is suspended to ensure that CRM and Collections does NOT update the Sage 300
Multiple Contacts and Accounts Receivable data for your company’s database.

If you created Demo Data using SAMLTD or SAMINC — or with a copy of your company database —
and want to see the results of A/R and M/T Integration, you can turn on integration in Setup Options.

If you uncheck the “Suspend xx Integration” checkboxes, the program will display a message like this:

in Demao Mode unless you are certain ‘Sample Company

o The Suspend A/R Integration option should be checked when
Limited' is a test company.

Are you sure you want to turn off Suspend A/R Integration?
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Companies, Contacts, Cases, Tasks, Opportunities, and Communications Dashboard

Companies, Contacts, Cases, Tasks,
Opportunities, and Communications

o i B < ® ’

Dashboard Calendar Companies Opportunities* Contacts Contact Groups Send Bulk Email*
g = i
= E - =
Documents Communications Cases Tasks Motes Sales Reports Change Leg

* Opportunities are not available in the TaiRox Collections module (just in TaiRox CRM and Collections)
* Send Bulk Email isin the Marketing folder, which does not appear in the TaiRox Collections module

Dashboard

"What do | need to do today, this week, or this month?"

The Dashboard displays sales opportunities, cases, tasks, disputed invoices, tracked invoices, and
promised payments with a revisit date for the currently selected day, week, or month that are assigned to
you, to all users or to other users (depending on your user permissions), or that are unassigned.

Tasks also appear on the dashboard according to the Revisit Date until they are closed. The Due Date
does not affect when they appear on the dashboard.

¢ You will not see opportunities on the dashboard with the stand-alone Collections module.
e See Appendix G: CRM and Collections Security for details on user security access.

Double-click to display the details for a case, task, opportunity, disputed invoice, tracked invoice,
or promised payment.

Today 4 b iy 1312021 | | Coar OWesk @ Morth | Befresh
[ECompany Name Assigned To  Revisit On EVE Expected Close  Notes

Case - Needs Ready4o-Post training Bargain Mart - San Diego KEITH 2021-01-04 12:00:00 AM Training took p|
Case - Cannot run Day End Frame-Up WADE 2021-01-05 12:00:00 AM Cannot run Day
Opportunity - Winter Sale The House Doctars DON 201-0105 12:00:00 AM 201-0305 Grade A
Case - Database issue - sending log files J &Y Builders Ltd KEITH 2021-01-06 12:00:00 AM Received on J;
Opportunity - Winter Sale The Yoshida Gardens KEITH 2021-01-06 12:00:00 AM 2021-02-04 Grade C
Opportunity - Winter Sale Astral Construction Co Ltd KEITH 2021-01-06 12:00:00 AM 2021-0107 Grade C
Case - New activation code not working CanAm Industries KEITH 2021-01-06 10:00:00 AM Sent out new ¢
Disputed Invoice - INOOD0D00D00053 Coastal Blectric Company KEITH 2010107 12:00:00 AM Met with Coast
Task - Collection Call - The Yoshida Gardens The Yoshida Gardens DOM 20210107 12:00:00 AM 2021-01-08
Case - Training for Check Approval Mr. Ronald English WADE 2011-01-08 12:00:00 AM ‘Will happen on|
Case - Need to renew TPT license The Courtyard WADE 20210108 12:00:00 AM
Task - Draw up proposal for new office location Astral Construction Co Ltd WADE 2021-01-11 12:00:00 AM 20210114
Task - Review spring sale website pages KEITH 2021-01-12 12:00:00 AM 2021-01-14
Promasd Paymert -2 Ve Stephen ey [ooN ——o6zr0iets 1200004 |~ |-metweh el
Promised Payment - 1 Astral Construction Co Ltd. KEITH 2010119 12:00:00 AM - Discussed pay
Opportunity - Summer Sale Cash Transactions WADE 2021-01-20 12:00:00 AM 2021-03-04 Grade A
Task - Meeting with Bargain Mart Stores - renovation Bargain Mart Stores Inc. DON 2021-01-21 10:00:00 AM 2021-01-23
Opportunity - Winter Sale Web customer sales DOM 2021-01-25 12:00:00 AM 2021-02-19 Grade B
Task - CanAm requirements list expected next week -keepinmind  CanAm Industries WADE 2021-01-26 12:00:00 AM 2021-01-25
Task - Collection Call - The Yoshida Gardens The Yoshida Gardens WADE 2021-01-26 12:00:00 AM
< >

Page of 2 [ Close

Notes:

e The dashboard does not show cases, tasks, disputed invoices, tracked invoices or promised
payments that are closed or deleted, or opportunities that are won/lost or deleted.
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e Today: The session date is used by default on the Dashboard screen. If you change the date,
click the Today button to quickly return to the session date, retaining the day-week-month state.

e Navigation Arrows: Use arrows to the right of the Today button to navigate to the previous or
next day, week or month.

e Day, Week or Month: Choose to display items with a revisit date for the selected day, week or
month. The grid includes a Revisit On Date and a Revisit On Time for scheduling appointments.

e Me, All Users, Unassigned, or Other User: “Me” displays items assigned to the logged in user.
“All Users” shows all items the logged-in user is allowed to see, “Unassigned” shows
opportunities, cases, tasks, tracked invoices, and promised payments that are not assigned to
any users. You can also see items assigned to specific other users if you have permission to
view them.

o Refresh: This button reloads the data from the database (changing states does not do this).

e The dashboard selects and sorts cases, opportunities, tasks, disputed invoices, tracked invoices,
and promised payments by Revisit Date. Iltems without a Revisit Time display 12:00 AM.

o Users that are not assigned to “All Territories” will only see opportunities and cases that match
the company territories to which they have access.

Drill Down:

o Double-click a row to open the case, opportunity, task, tracked invoice, or promised payment.

4 b Januay 1312021

[EC Name Assigned To  Revisit On Revisit At Expected Close  Notes
Case - Needs Ready+o-Post training Bargain Mart - San Diego KEITH 20210104 12:00:00 AM Training took p)
Case -Cannot run Day End Frame-Up WADE 20210105 12:00:00 AM Cannot run Da:
Opportunity - Winter Sale The House Doctors DON 20210105 12:00:00 AM 20210305 Grade A
J & Y Builders Ltd KEITH 2021-01-06 12:00:00 AM

The Yoshida Gardens KEITH 20210106 12:00:00 AM

20210204

T [ EQ 4 Name |Databaseissue-sendig logfies

-Drd Case Documents Motes

Company Name [ & ¥ Buiders Lid

I Created On Created By [ADMIN
& Modfied On [2021-03-03 Modfied By IADMIN

Type | Support ~ |

e Click the Company Name column heading (as below) to open the Company details for the
selected row. The following screen shot shows the company information for the highlighted item —
J & L Builders Ltd.

4 b danuay 1312021

[BCompany Hame Assigned To Revisit On Revist At Evpected Close  Notes

Case - Needs Readyto-Post training Bargan Mart - San Dego 20210104 120000 AM
Case - Cannot run Day End rame-Up 20210105 120000 AM
Opportunty - [he House Nociors 20210105 12:00:00 AM 20210305
Case - Databs ending log files K

2021-01-06 12:00:00 AM 2021-02-04

o [ Q4 Hame [18VBuiders tg

Company Optional Fields Contacts Opportunities Documents Cases Notes Communications

Crected On ezl Costomer Number ENC)
Modfied On Modfied By Comency = ]

[ Inactive

Short Name ey 1 Casefs) Collections...
Street 1 [333 Ralston Way |= Disputed Invoice(s)

Overdue Invice(s)
Promised Payment(s)

Street 2 [uric 5 |
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Calendar
Like the Dashboard, the Calendar screen displays sales opportunities, tasks, cases, disputed invoices,
tracked invoices, and promised payments according to their revisit dates.

e Double-click a calendar entry to display the details for a case, task, opportunity, disputed invoice,
tracked invoice, or promised payment.

You will not see opportunities on the dashboard if you are using the stand-alone Collections module.
e Choose to see items for the currently selected day, week, or month.

e Choose items that are assigned to you, to another specific user, to all users, or that are
unassigned. See Appendix G: CRM and Collections Security for details on user security access.

Day Week Month v
< » March - April, 2022
TUESDAY WEDNESDAY THURSDAY FRIDAY SA/SU A
X March, 2022
Mar 28 29 30 31 Apr1 2
MO TUSWE TH R 54 SU [ poN: Opportunit.. [] ADMIN: Opportu... [| DON: Case 8 - Can... [| DOM:Case5-J Y ..
81 2 3 4 5 6
7 8 9 10 11 12 13
14 15 16 17 13 13 20 3
21 22 23 24 25 26 27 DEITH: L=l
28 29 30 3 DWILDE(hseZ—M_m
4 5 6 7 8 9
April, 2022 [] DON: Case 4 - Cus... [|WADE:Case 7 - Fr.. [|ADMIN; Case 10 -... || WADE: Case 3 - T..
MO TU WE TH FR 5A sU DWADE:(‘zse!l—T_
1 2 3 .
4 5 6 7 8 9 10
M 12 13 14 15 16 17
18 19 20 21 22 23 24
25 26 27 28 29 30 1 L 12 13 14 15 16
: 3 4 s & 7 & || KEITH:Opportuni.. || ON: Opportunit...
Today None
17
W
Close
Navigation:

e Usethe 1 Fcontrols above the calendar to view calendar entries in previous and next days,
weeks, or months.

Day Week Month
E November, 2021 - January, 2022

e Use the navigation controls in the left panel to quickly select a different day, week, or month.

October, 2021
Hovember, 2021

Jani »

February, 2022 |, ¢
March, 2022
April, 2022 2

3 4 5 6 7 8 9
10 11 12 13 14 15 16
17 18 19 20 21 22 23
24 25 26 27 28 29 30
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e Choose the user from the dropdown list in the top-right corner of the calendar.

Day Week Month All Users |v
Al Users
« » December, 2021 - February, 2022 Me (ADMIN)

Unassigned
DON

TUESDAY WEDNESDAY THURSDAY FRIDAY Sa/SUREITH
Dec 27 28 29 30 31 Jan 1 WADE

Changing Default Calendar Settings

d Work Days Days
] Sunday Start Time Start Time
- MO| | [ Monday [o0000 ] [50000 ] FRIDAY SA/SU ~
4 April, 2022 ¥ iar| | A Tuesdsy Apr1 )
LD T U5 ) G2 =3 =3 MWesnesdey o S portu... || DON:Case 8 -Can... [| DON:Case5-J Y.
[170000 ] [2t0000 ] -
28 29 30 31 1 2 3 [ Thursday 3
4 5 6 7 8 3 10 [AFriday Interval {minutes) || KEITH: Case 1 - B...
Mozl o1s e, [ Saturday . o
18 19 20 21 22 23 M4 56
25 26 27 28 29 30 1 First Day of the Week Default View
=y NS 1 Number of Weeks in Month View Defauit User 16
T (P
Compress Weekend Days in Morth View 17
Close

The Settings screen provides default settings for the calendar. Choose the settings that you want,
and click the Save button.

e Select “Settings” from the Calendar menu at the top of the screen.

e Work Days settings determine which days of the week are displayed when you choose the “work
week” setting at the top of the calendar screen. The following example shows a 4-day work week.

Day Month ® Workweek | O Fullweek [] MultiColumn mode
+ » January 4 -7,2022

I 04 TUESDAY 05 WEDMESDAY 06 THURSDAY 07 FRIDAY I"

You can also set the normal working hours in the day. Appointment times outside of normal hours
are colored grey.

o Days settings determine the time span displayed for each day, and the length of each
appointment time — 15, 30 or 60 minutes.

o First Day of the Week lets you choose which day appears first in work week and full week

displays.
Day Week Month O Workweek @ Full week MultiColumn mode
4 » December 29, 2021 - January 4, 2022
29 WEDNESDAY 30 THURSDAY 31 FRIDAY 01 SATURDAY 02 SUNDAY 03 MONDAY 04 TUESDAY 2

e Number of Weeks in Month View can be from 2 to 6. You can also use the mouse to select the
number of weeks from the left-side calendar navigation panel.

e Compress Weekend Days in Month View splits a calendar cell in half to display Saturday and
Sunday in a single cell.

e Default View lets you select the view that appears when you open the calendar — Day, Week, or
Month.

o Default User lets you choose whose items appear when you open the calendar — your own or all
users’.
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Companies

The Companies screen provides a search field so you can quickly find company information.

Enter partial name, short name, customer number, address information, phone number, email
address, or company optional field information in the Search field.

Press Enter, or click the Search button to find the company record.
o Click the red X to remove search terms. = —— ]| saw

Click the Advanced button to search for companies using ranges for additional company fields.

Highlight the company you want, then click the additional tabs to view company Contacts, Opportunities,
Documents, Cases, Notes, and Communications.

Double-click a row to view or edit company information.

Click the Collections button at the bottom of the screen to view customer transactions, cases,
notes, communications, disputed invoices, overdue invoices, tracked invoices, and promised
payments for the highlighted company. For more details, see Collections Information.

Click the Send Documents button to resend documents to customers — such as outstanding
invoices or recent receipts. See Send Documents under Accounts Receivable and Collections.

Name  [ACME Plumbing | Customer Number =R
Companies Contacts Opportunties Documents Cases Motes  Communications
| Search | [ || Seach | Advanced ||
Order By [ Name ~] s
ID [& Customer Number Name Short Name 3 Street 1 City State/Prov. Courtry /1 e  Phone Number
ACME Plumbing 927 Warehouse Road Kansas City |MO C; 5 (816) 555-3341
9 1550 Astral Construction Co Ltd. ASTRA 418 Canal Drive Austin TX USA (512) 555-9192
2 1105 Bargain Mart - Oakland BMT-OK Bargain Mart Plaza Comer 182nd and... Anytown CA USA (408) 451-8981
11100 Bargain Mart - San Diego BMT-SD Bargain Mart Plaza Comer 182nd and... Anytown CA USA (408) 451-8981
24 BARMART Bargain Mart Stores Inc. BARMART Bargain Mart Plaza Comer 182nd and... Anytown CA USA (408) 355-MART
18 7100 Bashaw Bulldozing BASHAW 2338 Colorado Cres. Burdingame  Ontario (905) 555-1212
10 1580 Break-Away Designs BREAK 743 Wark Street Sacramento  CA USA (916) 555-1422
19 7200 CanAm Industries CANAM 1898 King George Street Tororto Ortario {416) 555-8752
23 9999 Cash Transactions CASH
6 1400 Coastal Bectric Company COAST 586 Tanner Road Tororto Ortarna Canada 6£7182-1087 {416) 555-4799
7 1500 Custom Comfort CUSTO 3741 Main Street Richmond ~ VA USA 23519 (804) 555-7272
11 1600 Dr. Dan Penn PENN 1876 Jackson Street Des Moines 1A USA T84 (515) 555-4728
15 2235 Forester Buiding Supplies FORES #46 North Gate Mall San Franci... CA USA 58132 (415) 555-3830
16 2240 Frame-Up FRAME 908 James Road Houston TX USA 67147 (713) 555-2273
12 1890 J &Y Builders Lid J&Y 333 Ralston Way Sacramento  CA Canada 982746233 (916) 555-9821
31200 Mr. Ronald Black BLACK 2820 Wabash Road Los Angeles CA UsA 50048 (213) 555-0274
13 1570 Mr. Ronald English ENGLI 2375 Hudson Avenue Fairbanks AK UsA 79160 (907) 5551713
8 1520 Mr. Stephen Kershaw KERSH 4730 112th Street Richmond VA Usa 23503 (804) 555-3372
14 2130 Mr. Stroud Oscar Persall PERSA 4931 Trent Strest Philadelphia PA Usa 31247 (215) 5554375
25 NEW My Amazing Company My Amazing 123 Any Street
< >
Page o2 Y Add Delete |l Fromate Frearm Send Documerts... | Change Log
Close
The Opportunities Tab will not appear if you are using the standalone Collections module without CRM.
e Click the Add button to add a new company to CRM and Collections. The company will not be
added as a customer in Accounts Receivable until you click the Promote button.
¢ You add new prospects by adding new companies to CRM and Collections that are not yet linked

to A/R Customers.

o You can add new contacts before adding companies using the Contacts program in CRM and
Collections or using Sage M/T Contacts module (if activated).

o You can then add new companies, and add new or existing contacts to the company records.

o When you are ready, click the Promote button in the Companies window to add CRM
companies to Accounts Receivable. See Promoting Prospects to Customers in A/R.

o If a customer account is added separately in A/R for the new company, you can Link the
CRM and Collections company to the existing A/R company. For details, see Linking
Companies to Customers in A/R.
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e New A/R Customer accounts are automatically added as companies in CRM and Collections
unless you select the “Suspend A/R Integration” checkbox in Setup Options.

e Users only see companies that match the company territories to which they have access.

Drill Down:

e Double-click a row to open up the Company screen and edit company information.

Mama [Pl Consucton Co L1d Customer ber G
Comparies Contacts Opportuniies Documents Cases Notes Communications

Search I | [ Search | Adyanced.. |
Order By [Mame ] &

Short Name = Street 1 Street 2

4 ACME Plumbing E 927 Warshouse Kansas City 5978
g ASTRA __ [HeCanalnee | || Jhuan [T [USA__[77
2 Bargain Mart - Oakland BMT-OK Bargain Mart Plaza  Comer 182nd and Anonn CA UsA 4511

e Highlight a row and click the Collections button at the bottom of the screen to view transactions,
cases, notes, communications, disputed invoices, overdue invoices, tracked invoices, and
promised payments for the highlighted company.

3 M. Ronald Black BLACK 2820 Wabash Fo... Los Angeles CA UsA
Lot D BRG] TFarbanks A USR]
8 M. Stephen Kershaw KERSH 4730 112h Street Richmond VA UsA
14 M. Stroud Oscar Persal PERSA 4931 Trert Strest Phiadelphia PA usa 32
< >
Page of 2 > pl Add Delete Promote Send Documents Change Log

Customer Number 1970 | [5 [ [MrRonald Englsh __—

Botnce [ [

Terms Average Daysto Pay Numberof Faid Invoices | 9|

AsOf Date Curent 1-30 31-60 61-90 Over 30 Total
preri ] | o] | o — g | s —_

Transactions Cases Notes Communications Disputed Invoices  Overdue Invoices  Tracked Invoices  Promised Payments

Only Show Overdue Invoices (credits are ahways shown) |

[H Document Number Payment Number Document Type Document Date Due Date Original Amount  Remaining Amourit  Days Overdue

2022-05-31 2022-06-05 17293 17293 35

You can also double-click a company name to open the Company information screen, and then
click the Collections button there.

Note: If you open the Collections screen from the Companies window, the program ages
documents based on the default aging periods specified in Accounts Receivable.

If you open the Collections screen from the Customer Aging window, the program ages
documents based on the settings that you specify on the Customer Aging screen.

For more details on the Collections screen — and for information on adding new cases, disputed
invoices, tracked invoices and promised payments — see Collections Information.

e Click on the Customer Number column heading or on the icon to the right of the Customer

Number (top-right-hand corner) to open the A/R Customers or the TaiRox Productivity Tools
Extended Customers screen.

Name [ftlConsirction G 4 | comomermmer [0 ][] @

Companies Contacts Opporuniies Documerts Cases Notes Communications

Astral Construction Co Lid Customer Number 44 PO+ R

Bargain Mart - Oakland

Bargain Mart - San Diego Customer Mame: ‘Astra\ Construction Co Lid.

Bargain Mart Stores Inc. . . —
7100 Bashaw Bulldozing ress Contact Processing Invoicing Optional Fields ~ Statistics  Activity Comments
1580 Break-Away Designs .
7200 S Ntionl Account No. | | |
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Companies

e Click the icon to the right of the Customer Number (top-right-hand corner) to open the A/R

Customer Inquiry or TaiRox Extended Customer Inquiry screen.

| cusine [

Name [pstral Construction Co Ltd

Companies  Contacts Opportunities Documents Cases  Notes  Communications

Search [

ACME Plumbing

Look up Customer Addresses and Contact the Customer

7200 Canfn | | Customertio. |4 4 | b #1 (5 [stal Constuction Co lid. | amouris in > Ontaro
9999 Cash Tr

1400 Coastal b Ontario
1500 Custom nd VA
1600 Dr. Dan Documents Receipts Refunds Adustments Pepding OEOrders QEInvoices QF Sales  IC Cortract Pricing hines 1A
2235 Forester] Profle Address Tax/Sales Credit Status Comments Optional Aids. Ship-To Recur. Charges  Activity/Stats nci... CA

e Click on the Streetl column title to open a browser at the Google Maps site for that address.

Name [pstral Construction Co Ltd

| cusine )

Companies

Contacts Opportunities Documents Cases Motes Communications

|| Seamch | Adyanced. |

1200
1570
1520
2130

e Click the Email column heading to send an email to the main company email address.

Name

ACME Plumbing

Bargain May

ACME

Astral Construction Co Ltd ASTRA

Bargain Mart - Oakland

BMT-OK
@ Austin TX78767-6112 USA to 47 X

C & https:i//w... B ¥8

Garlock Sealing z

Technologies

[z19]

Ral:Mac
Aqueduct

841 8 Canal Street
County.Park

Palmyra :
Maip,
S

snBlepuaueg

& (s @ -

Ettain St

rov.

Kansas City MO

I ST
Anytown CA

Anytown CA
Anytown CA
Bulingame  Ontario
Sacramento  CA
Toronto Ontario

Torento Ontario
Des Moines 1A
221 San Franci... CA
Housten TX
Sacramento  CA
Callwood C... BC
Los Angeles CA
Fairbanks AK
Richmond VA
@ @ Philadelphia PA
- >

Hame [stral Construction Co Lid

Companies ~Contacts

Opportunities  Documents  Cases  Notes

Search [

Order By

(408) 451-8931
1408) 555-MART
(905) 5551212
(916) 555-1422
(416) 555-8752

(416) 5554753
(804) 5557272
(515) 5554728
(4155559830
(713)555-2273
(916) 555:9821
(2135550274
(9075551713
(804) 5553372
(215) 5554375

(408) 4518711
(408) 5557575
(905) 5550251
(916) 555-1884
(905) 5550251

(713) 555-0092
(804) 555-1443
(515) 555-2331
(415) 555-9765
(713) 555-1008
(916) 5551112
(213)555-7234
(907) 555-1872
(804) 5550011
(215) 346552311

Inbox - Gmail [m] X
Format Insert Draw v m Discard B Send
A | = [}
Al =a 7
From: morgan thomas@t; om D7'
Jose@bargainmart.com
g amal.oo To: ser’vice@astraI.anma\'I‘com;| A Cc&Bec
contact@break-away.com Subject
Sent from Mail for Windows
info@blackco com
rsenglish@aol com :
kershaw@mail3 netprovider... Mr. Kershaw kershaw @mail3 netprovi
StroudP@alumniphiedy  Mr. Persall sop@alumni phi.edu
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Companies

e Click the Phone Number column heading to open the application associated with phone numbers.

Name

(408) 451-8981
(408) 451-8981
(408) 555-MART
(905) 555-1212

(916) 555-1422
(416) 555-8752

(416) 555-4799
(804) 5557272
(515) 5554728
(415) 555-9830
(713) 555-2273
(916) 555-9821
(213)555-0274

“ax Number

316) 555-8761

(408) 4518711
(408) 4518711
(408) 555-7575
(905) 555-0251
(916) 555-1884
(905) 555-0251

(713) 555-0092
(804) 555-1443
(515) 555-2331
(415) 555-9765
(713) 555-1008
(916) 555-1112
(213)555-7234

Bt L
1 2 3
4 5 6
7 8 9
0 #
- @ -

p—  +151255591926
(CEN < oot v

imber

[Astral Construction Co Ltd Customer Number ERC)

Companies Contacts Opportunities  Doc

|| Seamch | Adyanced. |

itact’s Phone

[= Contact's Email
carj@netgateway com

ba@break-away.com

jeverey@mail CoastalE.uk

| |rank@astral 2ndmail com |

[= Web Ste

hittp://www netservices
www bargainmart com
www.BargainMart.com

www break-away.com

www CoastalE.uk

DrOPenn@ama.org

c

ronaldblack §3@hotmail ¢

www, col

blackeo com

A/R and M/T Integration: If you add a new company to A/R, it will automatically appear in CRM and
Collections with all the A/R contacts — unless you select “Suspend A/R Integration in Setup Options.

Similarly, updating a company in one application — such as adding contacts — will update the
company in the other application.

See Also:

Appendix A - Common Screen Operations for searching, sorting, tabs and common button information.
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Company — Add/Edit

Companies

The Company screen lets you add or change data for a company, add contacts, promote prospects to

customers in A/R, and resend accounting documents to multiple company contacts.

Access: Double-click a row or click the Add button on the Companies screen.

© [ Ia+

Company  Otional Fields

Name  [Mr. Ronald Black ‘

Contacts Opportunties Documents Cases Notes Communications

r

Fax Number (213) 5557234

Web Ste ‘b\ackcu com

| 3
| 3

Email [info@blackeo.com

‘y

S — Ex
Modified On 2021-04-21 Modified By ADMIN Cumency USD »”
[ inactive
Short Name BLACK 1 Casele) o e

t cA T
- | 2l = | 2 Overdue Invaice(s)
Phone Number  [1213) 555-0274 | = < |

Contact’s Name [V Black ‘

| =

Contact’s Phone [213) 5550379

|3

Cortacts Far [ ) - ]

Contact’s Email \mna\dbbck&&@holman com

Preferred Language

[ Send Overdue Payment Reminders

Date of the last Overdue Payment Reminder Minimum days overdue before creating an Overdue

[P e ek Femnder

E (Enter Dto use the system defaul)

[]Send Payment Due Aletts
Date of the last Payment Due Alert 2022{!7{'4

[ Send Invoices

The Opportunities tab won’t appear if you are using the TaiRox Collections module without CRM.

Notes:

=

Address Documents Folder Link Unlink Bromote Send Documents ﬁ
Save I Delete Close

e Click the green Plus button beside the ID field (<) to add a new company.

The field lengths and formatting on the Company window exactly match Sage A/R Customer
fields, so data transferred between TaiRox and Sage 300 A/R is not truncated or reformatted.

e Click the Address button to edit the customer address or verify it on Google Maps.

Click the Drilldown button to
view all customer data
in Sage 300 A/R.

Click “Collections” to view
account issues and
outstanding amounts.

Click to call the number.
Click to send an email.

Choose options for overdue
payment reminders, payment
due alerts and invoices
(including language
preferences for emails).

Click for access to drag and
dropped documents.

Resend A/R and O/E
documents to customers.

Click to edit the customer
address and view location on
Google Maps.

¢ If you have a multilingual Sage 300 installation, you can use the “Preferred Language” setting in
the Company window to send overdue payment reminders emails and invoices to customers in

English, French, or Spanish. See Appendix C for details.

e You can disable overdue payment reminders, payment due alerts, and invoices or change the
minimum days that payment is overdue before sending overdue payment reminders to the
customer. By default, the program uses the setting in Overdue Payment Reminders Setup.

e Use the Link button to link companies to A/R Customers. See Linking Companies to Customers.

e Use the Send Documents button to resend accounting documents — or other documents — to
multiple contacts. See Send Documents under Accounts Receivable and Collections.

e Click the Documents Folder button to view drag and dropped documents in the Windows folder.
¢ Add as many contacts as you need on the Contacts tab. Contacts are fully integrated with the

Sage 300 Multiple Contacts module if you use it.

Down:

e Click the Collections button to view transactions, cases, notes, communications, disputed
invoices, overdue invoices, tracked invoices, and promised payments for the company.

e Click the icon beside Street 1 in the Address popup screen to open a browser and view the

address location on Google Maps.

e Click the icons beside the company Email field or Contact's Email field to send an email.

e Click the icons beside the Phone Number field or Contact's Phone field make a phone call.

e Click the icon beside the Web Site field to open a browser using the customer’s website URL.
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See Also:
Appendix B — Using Data Entry Programs for tabs and common button explanations.

Adding Company Contacts on the Company Contacts Tab

The Contacts tab in the Company window lets you:

Add contacts to existing companies.

Identify which contacts in each company will be emailed statements, letters, invoices, and
overdue payment reminders.

You can add as many contacts to the company as you need on the Contacts tab.

Note: Contacts can be independent of companies in CRM and Collections, or each one can be
added to one or more companies.

To add a contact to any company in CRM and Collections, you can:

Or:

Select the company in the Companies window.
Select the Contacts tab.

Click the “Add” button at the bottom of the form to add a new contact, or click the “Link” button
to add an existing contact to this company.

Open the Contacts window.
Add a new contact or select an existing contact.
Select the Companies tab.

Click the “Link” button to add the contact to an existing company.

Specifying the Recipients for Accounting Documents on the Contacts Tab

If you already use Sage 300 to email accounting documents to customers, CRM and Collections’ Send
Documents features will continue to email statements, letters and invoices to customers if the Delivery
Method for the customer in Accounts Receivable is set to Email or Contact’s Email.

However, to use all Send Documents features — and to send overdue payment reminders, payment
due alerts, and invoices to customer contacts (using the Send Invoices program), you must:

For each company, specify the email recipients for each document on the Contacts tab in the
Company (or Companies) window.

You can specify any number of recipients from the list of contacts for the company. Just double-
click the row and column for the document that you want to add.

| e e @8

ey
e

Yal
Briar
EDWARDCAVENDISHOD... Cavendish Edward

=

Hint: Right-click the column headings in the grid and choose “Hide Most Columns” to easily view
the contact names and the email forms (as shown above). You can reset the columns after
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selecting email recipients, or choose the precise group of fields that you want to display — such as
the email field or Address 1.

ID Contact Code lame. irst Name = Office; Phone (Mobile)
5|CLAIREWHITEDDDDS e laire = it (305) 555-1092

1 DONTHOMSOND0RD1 \rchasing Director (416) 5551056 (416) 555-1091
4 JEFFSINGHO0004 in (415)555-1087  (415) 555-1088
70 JOHNENGLISHO0070 s john e (2125551025 (212) 5551052
2 KEITHSMITHO0002 (212)555-1039  (212)555-1075  (212) 5551004
3 WADEWONG00003 Wong Wade (800} 5551073 (800) 5551004

(B00) 5551048

Note:

e If you do not set up email recipients on the Contacts tab for each company, you cannot send
documents to multiple recipients — or different recipients — for each type of form.

e CRM and Collections also uses the “Preferred Language” setting in the Company window to send
overdue payment reminders, payment due alerts, and A/R and O/E invoices (using Send
Invoices) emails and attached invoices to customers in English, French, or Spanish.

See Appendix C: Editing Email Templates for Payment Due Alerts, Overdue Payment
Reminders, and Send Invoices for details.

e Send Documents features create communications for emailed statements, letters, and invoices
and attach them to company records, so you can look them up later.

Promoting Prospects to Customers in Accounts Receivable

The Companies and the Company screens let you add companies in CRM and Collections to the
Accounts Receivable module as customers.

Typically, the salesperson managing a prospect will email the receivables accounting group and ask them
to promote a company to an Accounts Receivable customer — which will involve assigning a customer
number, a customer group, payment terms, a salesperson and a tax group, and then conducting a credit
check on the new customer.

The sales department should have additional customer onboarding procedures, such as welcoming the
new customer, acquainting them with your services, introducing them to your support staff, documenting
their company contacts, etc.

Access: Highlight the company that you want to promote and click the Promote button on the
Companies screen to add prospects to Accounts Receivable — or open the Company screen and click the
Promote button.

Note: The Promote button is active for all companies that are not linked to customer records in Sage 300
Accounts Receivable.

Once a company is linked to an A/R customer record, any changes in information in one module will

automatically update information in the other module, unless you select the option to “Suspend A/R
Integration” in Setup Options.

You can see in the following screen that the TaiRox company does not yet have a customer number, and
the Promote button is active.

Click the Promote button to display a screen for creating a linked A/R customer record.
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Companies

Name |Margory Hargreaves & Associates

Companies Contacts Opportunies Documents Cases Notes  Communications

Search | | Search Adyanced
Order By | Customer Number i | -
1D [ Customer Number  Mame Short Name [ Street 1 Street 2 City State/Prov. Courtry  Zip/Postal Code  [3 Phone Numbg
HARG 1208 Jordan Rd Callwood C...
11100 Bargain Mart - San Diego BMT-5D Bargain Mart Plaza Comer 182nd and... Anytown CA usa 45112 (408) 451-8981
2 1105 Bargain Mart - Oakland BMT-OK Bargain Mart Plaza Comer 182nd and... Anytown CA LISA 45112 (408) 451-8581
3 1200 Mr. Ronald Black BLACK 2820 Wabash Road Los Angeles CA USA 50048 (213) 555-0274
17 4030 The House Doctors HOUSE 1215 13th Street E Newark NJ UsA 37892 (201) 555-7374
18 7100 Bashaw Bulldozing BASHAW 2398 Colorado Cres. Burdingame  Ontario L7L 2Y9 (905) 555-1212
19 7200 CanAm Industries CANAM 1858 King George Street Toronto Ontario L7Y 321 (416) 555-8752
< >
Page of 2 | 2 Y] Add Delete Collections Send Documents Change Log
Close

Customer || Optional Fields

Customer Number l:l Q

Customer Name |Margory Hargreaves & Associates

National Account |

\

Group Code |

‘

Tems | ‘\|

Q Salesperson Code Salesperson Name

Percentage

Tax Group

Tax Authority Q, Tax Class | Registration Number

Promote. ..

e You must specify the A/R Customer that you want to use, along with the National Account
number (if applicable), the Customer Group Code, Terms, Salesperson Code,, and Tax Group.

Before Promoting:

e Confirm the company currency before promoting the company to Accounts Receivable.

Note: You cannot change the currency once the customer has been added to A/R.

e Provide the accounting department with a customer contact that can provide the business
registration number and email addresses for billing and payment queries.

The onboarding procedures should include documentation of credit policies, payment terms,

preferential pricing, shipping methods, etc.

Notes:

e The field lengths and formatting on the Company window exactly match A/R Customer fields, so
data transferred between CRM and A/R is not truncated or reformatted.

Linking Companies to Existing Customers in Accounts Receivable

If a customer account is added separately — or already exists — in Accounts Receivable, you can Link a

CRM company record to the existing Accounts Receivable record.
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Note that CRM automatically creates a CRM Company Record when you add a customer in Accounts
Receivable — unless you select the option to “Suspend A/R Integration” in Setup Options.

If you added a CRM company and manually added an A/R Customer to match the CRM company,
you may have two CRM companies for the same customer — although only one will be linked to A/R.

You may need to:

e Find the CRM company that was automatically created.
e Unlink and delete the CRM company that was automatically created from the A/R customer.
e Link the CRM prospect company to the A/R customer record that was manually created.

Access: Open the company that you want to link, and click the Link button on the Company screen to
link the CRM record to the existing customer record in Accounts Receivable.

Note: The Link button is active for all companies in CRM that are not linked to customer records in A/R.
You can also see in the screen below that the CRM company does not yet have a customer number.

D l 4+ Name ‘Eacchus Industries Ltd. |

Company Optional Fields Contacts Opportunities Documents Cases  Notes  Communications

Created On Created By I Customer Number | I
Madified On Madified By Cumency CAD @)

[ inactive

Shart Name CTESE{S) . Callections..
Temtory [cA ] [Calfomia ‘ g‘::z: \I::::::))

Phaone Number Eiis)

Fax Number i

) -
Web Ste Fap7 | Costomerhumber | |9
Email Customer Name ‘

Contact’s Name  |Mr. Randy =
Link.. Cancel :l
Contact’s Email :I

Prefemed Language ENG ~

[+ Send Overdue Payment Reminders
Date of the last Overdue Payment Reminder 2022-07-04

[] Send Payment Due Alerts

g‘:;)m:; %Ei::eerrdue TR SR W Ijl {(Enter Dto use the system default)

Date of the last Payment Due Alert 2022-07-04
Send Invoices
Address Documents Folder. Link Unlink: Promote: Send Documents Change Log
Save Delete Close

To Link the CRM prospect to an existing Accounts Receivable account:
e Open the Company that you want to link and click the Link button at the bottom of the screen.
e Select the A/R customer number using the Finder on the form that appears.
e Confirm that the correct Customer Name appears, and then click the link button on the popup.

e Use the Unlink button to remove the connection between CRM and Accounts Receivable.

Dragging and Dropping Documents into the Company Documents Folder and
Linking Documents to a Company

CRM lets you attach any documents to a company record. You can use drag and drop to attach

documents and copy them to the Company Documents folder defined in Setup Options, or you can link
any existing documents on your computer to a company record.
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Companies

Note the following methods for adding documents to companies:

Use Drag and Drop on the Documents tab to copy documents to the company document folder
in CRM and Collections (see Document Folders tab in Setup Options).

Documents that you drag and drop are added to the Documents tab for the company, they are
copied to the company document folder, and they are added to the list of documents maintained
by the Documents program in CRM and Collections.

Use the Add button on the Documents tab to link to a document and add it to the list on the
Documents tab.

When you use the Add button, the document will be added to the list maintained by the
Documents program in CRM and Collections, but the document will NOT be moved to the
company folder.

Use the Link button on the Documents tab to link to a document and add it to the list on the
Document tab.

When you use the Link button, the program displays the list of documents maintained by the
Documents program in CRM and Collections, letting you choose a document to add to the
company’s list. The document will NOT be moved to the company folder.

To drag and drop documents and move them to the Company folder:

1. Click the Documents tab.
2. Drag and drop a document onto the Documents tab. (The grid border turns green, and the pointer

shows that you are dragging a document.)

D [ 4Q + Hame [ACMEPumDg |

Company Optional Fields Contacts Opportunies  Documerts Cases Notss Communications

Search [

| Search

Adyanced...

Order By [Mams

26 —Compare TaiRox CRM with Sage CR
25 - TaiRox CRM Brochure ~

24 - TaiRox Home Page -

23 - TaiRox Price List —

[= Document

hittps://www tairox.com/downloads.cr
https://www tairox.com/downloads/cr...
hittps://www tairox com

hittps://www tairox.com/downloads/or...

|
A 2 Page Comparison Chart i
A 4 Page TaiRox PDF File {
The latest TaiRox news i
This pricelist is always curent i

3. When you release the document, the grid displays the new document, showing the path to the

TaiRox CRM and Collections for Sage 300

documents folder — in this case F:\Sage\Sage300SharedData\company\SAMLTD\TaiRox
CRM\Documents\COMPOO00AACME Proposal Specs.xIsx

D [ Q4 Name [ACMEPumbng |

Company Optional Fields Cortacts Opportunites Documents  Cases MNotes Communications

| [ Search

Advanced

Search

Order By [Mame -] -

haredData‘compa...

Z5 = Taios Crm
24 - TaiRox Home Page —
23 - TaiRox Price List -

TS 7/ W TaIlOK COMmY GOWnloads ar .. A 3 1.
hittps://www tairox .com latest TaiRox news
https://www tairox.com/downloads/or... This pricelist is always cumrent
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Opportunities

The Opportunities program presents a search field so you can search for opportunities. It also includes a
Company search field to find opportunities by company. Double-click a row to open an opportunity record.

The Opportunities program will not appear if you are using the Collections module without CRM.

Name  [Fal Sae | costomer humber [N ]
Opportunities  Orders Documents  Notes

e I || Seach | Adyanced.. |
OrderBy | MName V]2 Q

ID [B Company Name Name Amount Curency Cetairty Stage Assigned To  Status

2 Bargain Mart - San Diego Fall Sale 3,500.00 USD QBROPOSAL KEITH Won
6 Bargain Mart - Oakland Fall Sale 8.500.00 USD 0 PROPOSAL KEITH Won
10 ACME Plumbing Fall Sale 7.500.00 USD 10 PROPOSAL KEITH Won
14 The Courtyard Fall Sale 8.250.00 UL, 40 PROPOSAL KEITH Won
18 Coastal Hectric Company Fall Sale e gelln] 33 PROPOSAL KEITH Lost

22 M. Stephen Kershaw
26 Astral Construction Co Ltd.
30 Dr. Dan Penn

34 J & Y Builders Ltd.

File Help

%] | Ssearch

38 Mr. Ronald Englih Search
46 Frame-Lp

50 The House Doctors
54 Bashaw Bulldozing

OrderBy [ Name v 4

e, ID Name Short Name [3 Street 1 Street 2 Street 3 Sireet 4

o 'r:: o ';'”Hi':; 2 Bargain Mart - Oakland BMT-0K Bargain Mart Plaza  Comer 182nd and... Arytol

70 B: " DM 1t Stg I 1 Bargain Mart - San Diego BMT-SD Bargain Mart Plaza Comer 182nd and. Anyto|
L LGBl A BN Sea s b BARMART Bargain Mart Plaza Comer 182nd and Anytol

74 My Amazing Company
78 New Company

83 Bargain Mart - San Diego
84 Break-Away Designs

Page [ 1] of5 >

Notes:

e You can look up opportunities by opportunity field ranges, as well as by Opportunity Stages,
Opportunity Status, and Territories. Use the Advanced button for selection options.

o Click the red X to remove Searchterms. = —— X]| s

e Each opportunity belongs to one and only one company.
o To look up all opportunities for a single company, click the Company Finder (shown above)
and select the company you want.
o Click the red X to remove the company filter.

Order By [ Name v| % Company [Bamain Mart -Oakland x.Q

ID & Company Name Amount Cumency Certairty Stage Assigned To  Status

e Opportunities must be assigned to a single user.

o CRM updates users’ calendars when you change revisit dates and user assignments. See
Appendix E: Updating Calendars with .ics Event Files.

e Any number of Sage 300 quotes and orders can be linked to an opportunity.
e Users will only see opportunities that match the company territories to which they have access.

e See Copying Opportunities later in this section and see Create Opportunities for instructions on
generating opportunities for multiple companies.

Drill Down:
e Double-click a row to open the opportunity.

e You can also click the Company Name column heading to drill down to the Companies form, or
click the Inquiry button to view customer information.

See Also:

Appendix A - Common Screen Operations for searching, sorting, and using tabs.
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Opportunity — Add/Edit

The Opportunity screen lets you add, change or copy an opportunity. If you are using the stand-alone
Collections module, you will not see an icon for Opportunities.

Access: Click the Add button or double-click a row on the Opportunities screen or on the Opportunities
tab on the Companies screen.

2 Q Name |SDnng Sale ‘

Opportunity  Optional Fields  Orders  Documents  Motes

Company Name  [ACME Plumbing ]

i -
Wodied On Madfied By

S —

Stage UoTE | Q. [Buote based on proposdl

Opened On Expected Close

Revisit On Revisit At

Notes Spring Sale on office fumiture. 237 off mast executive desks and chairs

=l

Comment |Customer is expanding. Could be a good eppartunity for fumiture and equipment sales.

| com Documerts Folder.._ | Change Log

Save Delete Close

e To add a new opportunity, click the green Plus button beside the ID field (+), then click the Finder
button (-) beside the Company Name field to select the company.

e To copy an opportunity, click the Copy button at the bottom of the screen. See Copying
Opportunities. The Copy button becomes active after you click the Add button — or the Save
button if you changed the opportunity first.

e The Revisit On date is used to construct data for the Dashboard program. You can also enter a
Revisit Time after the Revisit date. Enter time in 24-hour format (e.g. 13:00).

Opportunities show up for the revisit dates on the assigned employees’ dashboards, and
assigned users are sent calendar event files when you click the Save button, so revisit dates
appear in their email calendars.

e The list of opportunity stages is maintained by the Opportunity Stages setup program.

e The status can be Open, Won, Lost, or Deferred.

o Besides the Name and Comment fields, all other fields are used in one or more Charts. Charts
provide weighted or un-weighted estimates of the pipeline value categorized in various ways. A
Time to Close Chart provides an assessment of past performance.

e The Notes field can be up to 250 characters long.

e The Comment field can be up to 2,500 characters long.

e Select the Orders tab to create new Quotes and Orders in Sage 300 Order Entry.

e Click the Documents Folder button to view drag and dropped documents in the Windows folder.

e Click the Change Log button to view past changes to the opportunity.

See Also:

Appendix B — Using Data Entry Programs for tabs and common button explanations.
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Dragging and Dropping Documents into the Opportunity Documents Folder and
Linking Documents to an Opportunity

CRM and Collections lets you add any documents to an opportunity. You can use drag and drop to attach
documents and copy them to the Opportunity Documents folder defined in Setup Options, or you can link
any existing documents on your computer to an opportunity record.

Note the following methods for adding documents to opportunities:

e Use Drag and Drop on the Documents tab to copy documents to the opportunity document
folder in CRM and Collections (see Document Folders tab in Setup Options).

Documents that you drag and drop are added to the Documents tab for the opportunity, they are
copied to the opportunity document folder, and they are added to the list of documents
maintained by the Documents program in CRM and Collections.

e Usethe Add button on the Documents tab to link to a document and add it to the list on the
Documents tab.

When you use the Add button, the document will be added to the list maintained by the
Documents program in CRM and Collections, but the document will NOT be moved to the
opportunity folder.

e Usethe Link button on the Documents tab to link to a document and add it to the list on the
Document tab.

When you use the Link button, the program displays the list of documents maintained by the
Documents program in CRM and Collections, letting you choose a document to add to the
opportunity’s list. The document will NOT be moved to the opportunity folder.
To drag and drop documents and move them to the Opportunity folder:
1. Click the Documents tab.

2. Drag and drop a document onto the Documents tab. (The grid border turns green, and the pointer
shows that you are dragging a document.)

e [ | CotoreManter )
Opportunities  Orders  Documents  Notss
Search I | | Seach | Advanced

OrderBy  [Name M

[= Document

53 ACME Propasal Specs xlsx F:\Sage\Sage300\SharedData\compa q

3. When you release the document, the grid displays the new document, showing the path to the
documents folder — in this case F:\Sage\Sage300SharedData\company\SAMLTD\TaiRox
CRM\Documents\COMP00001\Opportunities\OPPO00002\OEORD000000000063.PDF

Ne IS o @ @
Opportunities  Orders  Documents  Notss
Search [ | [ Search | Advanced

OderBy  [Name V] %

[= Document

F:\5age\5age 300"Shared Data‘\company\SAMLTD\ TaiRox CRM\Documents\COMP 00001\Opportunities \OP PO00002\ACME Proposal S
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Copying Opportunities
CRM lets you copy an open opportunity to the current company or to a different company.

This means you can:
e Create standard opportunities for sales or services and apply them to particular companies.

e Duplicate past opportunities to quickly add new opportunities with similar requirements.

To copy an opportunity:
1. Open the opportunity that you want to copy.
2. Click the Copy button at the bottom of the screen, and click Yes when prompted.

Revisit On 20210312 Revisit At 00:00:00

Notes |Spring Sale on office fumiture. 237 off most exscutive desks and chairs

Comment |Customer is expanding. Could be &

Are you sure you want to copy this Opportunity to a new
Oppartunity?

Copy. Documents Folder... Change Log...

Save Delete Close

o The program will display a message stating that the copy was successful. Click OK.
o By default, the new opportunity will be assigned to the current company.

3. To change the company for the opportunity, click the Finder button beside the Company Name
field, and use the Search field to find the new company.

In this case, we are using “bar” to find and select “Bargain Mart — San Diego.”

o [ Q4 Neme [SengSak |

Opportunity | Orders | Documents | Motes

Company Name |ACME Plumbing

T

Created On

Modffied On
Amovrt File Help

Search = | &

OrderBy | Name o] -

Certainty

Stage
Assigned

Short Name 1= Street 1
EMTOK Bargain Mart Plaza Comer 182nd and... Anyto

BMT-5D Bargain Mart Plaza [Comer 182ndand..] | [Anyto|

24 Bargain Mart Stores Inc. BARMART Bargain Mart Plaza Comer 182nd and... Anyto)

s 2 Bargain Mart - Oakland
[

4. Select the new company and edit the new opportunity as required, then click the Add button at
the bottom of the screen.

Adding New Quotes and Orders on the Orders Tab for Opportunities

CRM and Collections provides direct access to Sage 300’s Order Entry program from the Orders tab in
Opportunities. It lets you:
e Add new quotes and orders and link them to opportunities.
The program lists all quotes and orders added in CRM on the Orders tab for the opportunity.

e Link existing quotes and orders to the Orders tab to include quoted and orders that were entered
from the Order Entry module.

This makes it easy to look up opportunity details and each customer’s order history.
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To add a new quote or order to the Orders tab:

o [ 99+ tm [ |
Oppotunty Orders  Documents  Notes
Search [ | | Search | Adyanced..
Order By [ Order Number -
ID 8 Order Number Order Description Customer Number Order Total Created By Modfied By  Bill-To Name
3 ORDODDO0000T0  Jan 2020 1105 687.52 KEITH KEITH Bargain Mart -Oakland  Bargain Mat Plaza 20
4 ORDO00O0000024  Spring 2020 - Ship asapplease 1105 17309 KEITH KEITH Bargain Mart -Oakland  Bargain Mart Plaza 203
5 ORDO0000000027  Summer 2020 1105 587.52 KEITH KEITH Bargain Mart -Oakland  Bargain Mart Plaza 203
6 ORDO0DO0000039  Fall 2020 1105 428253 KEITH KEITH Bargain Mart -Oakland  Bargain Mart Plaza 203
7 ORDO0DO0O000GT  Dec 2020 - No backerderplease 1105 103557 KEITH KEITH Bargain Mart -Oakland  Bargain Mart Plaza 203
8 ORDO0DOO0000E3  Jan 2021 - No backerder 1105 645,93 KEITH KEITH Bargain Mart -Oakland  Bargain Mart Flaza 203
< >
Page of 1 |[ New Guate | | New Order ugirke |
Save Delete Close

1. Open the customer opportunity.

2. Choose the Orders tab.

Opportunities

3. Click the New Quote or New Order button to add a quote or order and display it on the Orders

tab.

Click the Link button to add an existing order to the Order tab.

4. Select a quote or order from the grid to look up or edit order details.
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Contacts
The Contacts program provides a search field so you can immediately find contacts. It also includes a
Company search field to list contacts by company (shown below).

e Click the red X that appears to remove Search terms. — —— x]| s

e Click the Finder button beside the Company field to select a company name.

e Double-click a row to open a contact record.

e Use the “Advanced...” button to search by specific field values and ranges.

Note: The Contacts program lists all contacts added in TaiRox CRM and Collections or with the
Sage 300 Multiple Contacts module (if you use it).

|French. Andrew |

Name

Contacts  Social Media Companies Documents Communications Contact Groups

Search | Search Adyanced.. |

=
= rnone ) [ Phone (Mobile) [S Phone (Cth
(647) 555-1069 (647) 555-1032 (647) 555-1061
] 95 ] 255 p47) 555-1061
15) 555-1058
16) 555101

504) 555-1069

Advanced... |

Order By Company

| Contact Code vl o

First Name: Middle Name Salutation Job Title

Andrew

Last Name
French

ID Contact Code
136 ANDREWFRENCH
129 ANDREW FimsiSiaanias
55 ANDREWK;
18 ANDREWM & Hyejp
92 ANDREW
128 ANNEENGL Search
54 ANNEEVER
91 ANNESING
17 ANNEYALE
87 BETHBLAC

| Name

X | Search

Order By

ID Name Short Name Street 3

[ Strest 1

13 BETHFREN
124 BETHGOLD
50 BETHJENN

2 Bargain Mart - Oakland
1 Bargain Mart - San Diego
24 Bargain Mart Stores Inc

BMT-OK
BMT-5D
BARMART

Bargain Mart Plaza
Bargain Mart Plaza
Bargain Mart Plaza

Comer 182nd and..
Comer 182nd and..
Comer 182nd and..

6 CARLGREH
43 CARLKERS
80 CARLLEMU

117 CARLTHOM
53 CHARLESA
16 CHARLESB

7 CHARLESG

p04) 555-1014
>

@ge Log..

Page I:

| Close

Notes:

e Contacts can belong to more than one company — or they can be unaffiliated contacts that are not
linked to any companies.

For example, you can add a new contact and link it to Bargain Mart Oakland and to Bargain Mart
San Diego.

o Tofind contacts for a single company, click the Company Finder (shown above) and select
the company you want. If you are looking for a particular contact, use the top Search field on
the form to refine your search.

o Click the red X to remove the company filter.

Company ‘Eargam Mart Stores Inc Q

v] 4

Last Name First Name Middle Name Salutation Job Title

[= Phone (Office)

[= Phone (Mobile) [3 Phone (Oth|

e You can also view all contacts that you add in TaiRox CRM and Collections using the Finder in
the Sage 300 M/T Contacts module — if you use it Sage Multiple Contacts.
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Note: Contacts are permanently deleted if you use the Delete button!

If you do not want to permanently delete a contact, edit the contact record and select the
Inactive checkbox.

e Contacts added to an Accounts Receivable customer record will appear automatically on the
Contacts tab for the corresponding (linked) CRM company.

Note, however, that you still need to edit the contact information on the Contacts tab for the
company record to specify any emailed accounting documents that the contact should receive.
See Specifying the Recipients for Accounting Documents on the Contacts Tab.

e Contacts can belong to any number of Contact Groups.

The Add To Group and Add To New Group buttons will add all filtered contacts in the search
results to the group you specify (i.e. all contacts displayed on all current pages of contacts — 7
pages in the example below).

Page of 7 bl Add Delete I Add To Group. Add To New Group. I Change Log
—

Close

e Contacts can also belong to any number of companies. Click the Companies tab to see all
companies linked to the contact.

Name [Vipond. Phiip ]

Contacts  Social Medla Documents Communications Contact Groups

Search |\ | Search Advanced
Order By [ Name v] &
ID Name [= Street 1 State/Prov. Courtry
2 Bargain Mart - Oakland BMTOK Bargain Mart Plaza Comer 182nd and... Anytown CA USA 451
1 Bargain Mart - San Diego BMT-SD Bargain Mart Plaza Comer 182nd and... Anytown CA USA 4511
24 Bargain Mart Stores Inc BARMART Bargain Mart Plaza Comer 182nd and Anytown CA UsA 4511

Import... Philip ‘
@ |edia Companies Documents Communications Contact Groups
Llose nd | Search Advanced
Order By | Contact Cade “l % Compary | 1Q

ID Contact Code Last Name First Name Middle Name Salutation Job Title [= Phone (Offics) [ Phone (Mobile) [= Phone (Oth

You can select four export file formats — MailChimp, Swiftpage, generic Sage 300 Contacts
format, and generic Sage 300 Contacts format with optional fields.

Contacts and Optional Fields

o To export to MailChimp or Swiftpage, the contact must have an email address, a first and last
name, and must have “Yes” in the “Contact consents to receive emails” column. In addition,
they must not be inactive or belong to an inactive or deleted company.

o If exporting to the generic Sage 300 Contacts format with optional fields, the optional fields
appear in a separate workbook.

e Use File > Import to import an “Unsubscribe” list — a file that contains a list of email addresses
(i.e. a single column of email addresses).
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Contacts

Select Type of Import/Export

Unsubscribe

Import File ||

Browse

Cancel

All contacts with those email addresses will have their “Contact consents to receive emails”

setting unchecked (turned off).

e You can add any contacts you like to CRM — either unattached or attached to a company.

For example, you can add your own company to CRM, add your own employees as contacts, and
include them in contact groups. This lets you create contact groups for departments, marketing

projects, etc.

For more information on contact groups, see Contact Groups.

Drill Down:

e Double-click on a row to open up the contact record.

Name [French. Andrew

Cortacts Social Media Companies Documents Communications —Contact Groups

Search ‘

Order By [Contact Code

Last Name
French

D  + Name

Contact Code |ANDREWFRENCH

12021-01-04 Created By

Created On

ADMIN

Contact Optional Fields ~ Social Media Companies  Documents Communications

Contact conserts to receive emails

Contact Groups

This lets you see and edit all the information for the contact.

e Click the Email column heading to send an email to the selected contact.

Name ‘French. Andrew

Contacts  Social Media Companies Documents Communications Contact Groups

Search |

Contact Code

Order By

Contact consents...

Web Site

Notes 1

Inbox - Gmail
Format Insert Draw
B I U = =
From: morgan.thomas@tairox.com

To: AndrewFrench@barmart.com;

RE: PROPOSAL - Any questions?

Options

]ﬂ[ Discard B> Send
s o
7 \
i
2 Cc&Bee

e Click a Phone number column heading to call the selected contact.

See Also:

Appendix A - Common Screen Operations for searching, sorting, tabs and common button explanations.
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Contact — Add/Edit

Contacts

The Contact screen lets you add contacts, change contact information, and link or unlink contacts from

companies.

To select which company contacts are emailed invoices and other accounting documents, see Specifying

the Recipients for Accounting Documents — under “Companies.”

Access: Click the Add button or double-click a row on the Contacts screen or on the Contact tab on the

Companies screen.

T |
Contact Optional Fields Social Media Companies Documents Communications  Cortact Groups
Contact Code |JOENGL|SH | Contact consents to receive emails n E ‘;-:\
— —rs
i e
[ Inactive
Last Name |Eng|ish |
First Name |J° |
Middie Name | |
Job Tile | \
Phone (Office)  [1403) 555-1070 | 3 Phone (Mobi) [403) 555-1065 | =
Phone (Other)  [1403) 5551018 | 3 Faxhumber [} - |
Emai |JOEng|ish@laimx com | =
Wb Ste | |
MNotes 1 | |
Notes 2 | |
Address... Change Log...
Save Delete Close
Notes:

e For a new record, click the green Plus button beside the ID field ().

e Social Media links are provided for information that a contact maintains themselves and is likely
to be current. Choose the Social Media tab to add links to social media sites, such as Facebook,
LinkedlIn, Instagram, Twitter, YouTube — or to add a Skype address or telephone number.

e The “Contact consents to receive emails” checkbox must be checked in order to export the

contact email address to MailChimp or Swiftpage.

e Click the Address button to add contact address information.

e Click the Companies tab to link or unlink contacts from existing companies — and to drill-down on

company information.

Drill Down:

e Click a social media icon to open a browser at the contact's social media page. A Phone icon will

initiate a call.

e Click the Go button (=) beside a phone number to call the contact or click the Go button beside

the Email field to send a new email to the contact.

See Also:

Appendix B — Using Data Entry Programs for tabs and common button explanations.
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Linking Contacts to Existing Companies

Once you add a contact, you can link it to one or more companies. For example, a contact might be a
buyer for one or more outlets — such as Bargain Mart San Diego and Bargain Mart Oakland.

To Link a contact to a company: Select the Companies tab and click the Link button (see below).

Search for the company you want (in this case, we are adding another Bargain Mart outlet), and double-
click the company to add it to the list.

D Q + Name [Whte.Caire ‘
Contact Optional Fields  Social Media Documents  Communications  Contact Groups
Search | | Search Adyanced... |

Order By | Name w | -

ID Name Short Name [ Street 1
2 Bargain Mart - Ozkland BMT-OK Bargain Mart Plaza Comer 182nd and..

Street 3 Street 4 State/Prov. Cou

File Help
Search |bar I
Order By | Name ~ ‘ -
ID Name Short Name [= Street 1 Street 2
2 Bargain Mart - Oakland BMT-OK Bargain Mart Plaza Comer 182nd and...
il Bargain Mart - San Diege ~ EIIESY) Bargain Mart Plaza |Comer 182nd and...| |

24 Bargain Mart Stores Inc. BARMART Bargain Mart Plaza Comer 182nd and...

<

|4 4 Page of 1 | 3 g Link...

Save Delete

To Unlink a contact from a company: Select the Companies tab, select the company from the grid,
and click the Unlink button at the bottom of the screen.

D Q +  Name |Wh'rte‘05\re |

Contact  Optional Fields SocidMedaDocu'neis Communications Contact Groups

Search ‘ | Search Advanced.. I

OrderBy  [Name ~] %

Short Name [= Strest 1 Street 2 Street 3 Street 4

2 Bargain Mart - Oakland BMT-OK Bargain Mart Plaza Comer 182nd and... Anytor CA

W
JEugun bt -SnDego (L5 Borgen Vit Pozs Comer nd ot | 1oy oA [U5]

< >

[4 4 Page o 1 (] Link Change Log..

Save Delete Close
See Also:

Appendix B — Using Data Entry Programs for tabs and common button explanations.
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Adding One Contact to an Existing Contact Group

Once you add a contact, you can add it to one or more contact groups — such as “Alaska Customers” or
“Newsletter Recipients” — and send them group emails.

To add a new contact to an existing contact group:
e Select the Contact from the grid on the Contacts screen.

e Click the Contact Groups tab.

Name ‘S\nan‘ Chares \
Cortacts Social Media Companies Documents Communications | Cortact Groups
Fedh \ Search | Advanced... |
Order By | Contact Code

|
v % Company | | ¢

ID Contact Code
81 CHARLESGRANGE Grange

Middle Name Salutation Job Title [= Phone (Office) [ Phone (Mobile) [= Phone (Oth}
Charles

(703) 555-1097  (703)555-1063  (703) 555-1031

44 CHARLESPERSALL Persall Charles VP Sales (647) 555-1043 (647) 555-1081 {647) 555-105

[ eSS S S O S 1 - = il (A
118 CHARLESSMITH Smith Charles Ms

(636) 555-1070 (636) 555-1001 (636) 555-1092

e Click the Link button on the Contact Groups screen.

Select the group where you want to add the contact.
Adding Multiple Contacts to a New or Existing Contact Group

You can just as easily add multiple contacts to an existing contact group or to a new one.

To add multiple contacts to a contact group:

e Open the Contacts screen and use Search or Advanced Search to select a set of contacts.
Name [Sloan. Charles |
Contacts ~ Social Media Companiss Documents Communications Contact Groups:
Search [ | [ Search
[ Contact Code v & Company
Coc Last Name First Name Middle Name Salutation Job Title [= Phone (Office) (= ) [ Phone (Oth|
Contact Range
Select Contacts By
State/Prov. ~| | Range e
(None)
(None)
1 Reset Defaults
38 DO
75 DO
15 El
e Click the Save button to perform the search / selection
[ ]

Select the Contact from the grid on the Contacts screen.

L«

>

Page of 1 Y Add Delete

Add To New Group

Change Log

Close

e Click the Add to Group or Add to New Group button.

Select the existing group or specify a name for the new group to add the contacts.
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Adding Social Media Links on the Social Media Tab

Contacts

You can add social media links to your contacts to keep your contact information up to date. Social media
links can include links to social media sites, such as Facebook, LinkedIn, Instagram, Twitter, YouTube —
as well as Skype addresses and contact telephone numbers, or FTP servers and Web servers.

To add a new social media link:

e Click the Social Media tab.

e Click the Add button on the bottom of the screen to add a link.
e Click the Name dropdown to select the type of link.

Contact Social Media ~Companies Docy

270 Edmail
256 Facebook

257 Linkedin
269 Skype
258 Twitter
259 YouTybe

Social Media

St L oueon [ ey [
Odersy  [Name | ogpedon || Mediedm ||

Name Skype

M+

Ask fm
s ClassMates
Notes Dropbax
E-mail
Facebook
Plickr
Google+
Instagram
Linkedn
Add Meetup
Pinterest
Reddt

Tumblr
Twitter
Vine
WhatsApp
WordPress
Yelp
YouTube

Save Delete

=

Change Log...

Cancel

>

Page | 1] of1 [ i Delete

Change Log...

Close

Note: The Name dropdown selection determines the social media icon that appears on the
Contact tab for this link.

e Enter the link information in the Link field — such as skype:555-777-8888

o The Link field must include the application protocol so Windows will know which program to
use for launching the link. Windows will use the default application that has been associated
with the protocol. You can change associations in Windows Settings > Apps > Default Apps.

o Do not include a space between the protocol name and the link.

For example, type
skype:5559897777

Not

skype: 5559897777

o Ifthe link includes a space, you must enclose the link text in quotes.

For example, type:
skype:“"fred winkler”

Common protocols are:

- https:
- http:

- tel:

- skype:

- ftp:

hypertext transfer protocol with secure communication

hypertext transfer protocol
uses whatever program has been associated with the tel protocol (such as the

MS telephone app) with a telephone number — e.g. tel:5559897777

to launch skype with a telephone number or contact name

— e.g. skype:5559897777 or skype:"fred winkler”
to launch an FTP program to transfer files from a server
mailto: to send an email to an email address — e.g. mailto:rblack@rblack.com
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Contact Groups

Contact Groups

The Contact Groups program presents a search field so you can immediately find contact groups.

Access: Open from the CRM and Collections Desktop.
or Open the Marketing folder, then open Contact Groups.

Mame ‘Ever)'bud)' ‘ =
Contact Groups | Contacls
Search I Search Advanced
Order By [ Name BE
Crested By ~ Modfied On  Modfied By  Inactive  Inactive On
1 Eveybody All Contacts 20191209 ADMIN 20191208 ADMIN No
3 Holiday Goodies List Chocolale Basket Mailout 20181208 ADMIN 20191208 ADMIN No
2 Newsletter Subscribers Last sert in November 20131208 ADMIN 20191208 ADMIN No
Page of 1 Add Delete Change Log
Closs

e Contact Groups lets you create a list of contacts and give it a name — such as “Alaska

Customers” or “Newsletter Recipients”.
e Contacts can belong to any number of contact groups.

e You can add your own company to CRM, add contacts, then create contact groups for company

departments, sales teams, or projects.

e See Adding Multiple Contacts to a New or an Existing Contact Group for instructions on adding

multiple contacts to groups.

e Click the Actions button (=) at the top of the screen by the Name field and choose Export to
MailChimp or Export to Swiftpage to create a CSV file containing the Contacts for the selected

contact group that you can import into MailChimp or Swiftpage email programs.
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Name (BB ooniacts 1—

Contact Groups ~ Contacts

Export to MailChimp

Export to Swiftpage

= [ Copy Group

Order By [ Name: o] &

To export to MailChimp or Swiftpage, contacts must have email addresses, a first and last name,
must consent to receiving emails (this is a checkbox on the contacts screen), and must not be
inactive or belong to inactive or deleted companies.

To copy an existing group to a new group with a new name, highlight the group in the grid that
you want to copy, select Copy Group from the Actions menu (=), and fill in the New Contact
Group form — as below:
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Contact Groups

Name

[Evenbody

Contact Groups  Contacts

Export to MailChimp
Search [

Export to Swiftpage

ks

Order By

e ¢

Copy Group

7 88 contacts

1 Everybody

3 Holiday Goodies Lis

2 Newsletter Subscribjily

20230419 ADMIN
20210510 ADMIN

Al Contacts

Add Contacts To Another Group

20230419 ADMIN
20210510 ADMIN

|
[

Advanced

Wodfied By  Inactive  Inacive, ™

No
No

To add the contacts in one group to an existing group, highlight the group in the grid that you

want to copy, select Add Contacts To Another Group from the Actions menu (=), then select the

target group in the form that appears.

Name

[Evenbody

Contact Groups  Contacts

Export to MailChimp
Search [

Export to Swiftpage
Order By

Name | &

Copy Group

Add Contacts To Another Group
7 BB cortacts

1 Everybody

20230419 ADMIN 20230419

Al Contacts 20210510 ADMIN 20210510
3 Holiday Goodies List Chocolate Basket Malout 20210510 ADMIN 20210510
2 Newsletter Subscribers Last sent in November 20210510 ADMIN 20210510

Noaricd Un

Advanoed

Inaclive  Inactive On
ADMIN No
ADMIN No
ADMIN No
ADMIN No

Search

Advanced

1 Evenybody.
3 Holiday Goodies List
2 Newsletter Subscribers

Al Contacts
Chocolate Basket Mailout
Last sent in November

20210510 ADMIN
20210510 ADMIN
20210510 ADMIN

Drill Down:

See Also:

18

20210510 ADMIN
20210510 ADMIN
20210510 ADMIN

Double-click on a row to open up the Contact Group program.

Appendix A - Common Screen Operations for searching, sorting, tabs and common button explanations.
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Contact Group — Add/Edit

The Contact Group screen lets you add new contact groups and edit existing ones.

Name |EVE')‘bUdY |

Contact Groups =~ Contacts.

Search | Search Advanced

Order By [ Name V] &

ID Name Notes O Created By Modfied On  Modified By  Inactive Inactive On

1|Everybody ADN 20191209 |ADMIN
3 Holiday Goodies List Chocolate Basket Mailout 20191209  ADMIN
2 Newsletter Subscribers Last sent in November 20151209  ADMIN 20191209 ADMIN No

o [ Q[ veme Freveed =

Created On Created By

- oty

[ inactive

Notes All Cortacts

Change Log...

Save Delete Close

Notes:

e To create a new group record, click the green Plus button beside the ID field ().

e Contact Groups lets you create a list of contacts and give it a name — such as “Alaska
Customers” or “Newsletter Recipients”.

e The Notes field can be up to 250 characters long.

e Choose the Contacts tab to view existing contacts and to link new contacts to this group.

e Click the Actions button (=) at the top of the screen by the Name field and choose Export to
MailChimp or Export to Swiftpage to create a CSV file containing the Contacts for this contact
group that you can import into MailChimp or Swiftpage email programs.

ID Q +  MName |E‘feﬁ'b°d¥ =

p— Export to MailChimp
Group | Contacts
Export to Swiftpage
Created On 20151209 Created By [ADMIN Copy Group
Modified On 20191209 Modified By ADMIN Add Contacts To Another Group
[ inactive
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Contact Groups

To export to MailChimp or Swiftpage, contacts must have email addresses, a first and last name,
must consent to receiving emails (this is a checkbox on the contacts screen), and must not be

inactive or belong to inactive or deleted companies.

To copy the existing group to a new group with a new name, select Copy Group from the Actions

menu (=), and fill in the New Contact Group form — as below:

(]

D [ 0Q + Neme [Evenpody

Group | Contacts.

Created On 20191209 Crested By

Modified On [2019-12-09 Modified By
Cinactve
Notes

[ADMIN
[ADMIN

Export to Mail Chimp
Export to Swiftpage

Copy Group

Add Contacts To Another Group

&

Add

Cancel

(]

D [ 0Q + Neme [Evenpody

To add the contacts in this group to another existing group, select Add Contacts To Another
Group from the Actions menu (=), then select the target group in the form that appears.

Group | Contacts.

Created On 20191209 Created By [ADMIN
Modified On 20191209 Modified By [ADMIN

Cinactve
Notes

File Help
Seach

Export to MailChimp
Export to Swiftpage
Copy Group

Add Contacts To Another Group

Search

OrderBy | Name -

7 BB contacts.

9 Beth's ist

1 Evenybody

3 Holiday Goodies List
8 Johns

2 Newsletter Subscribers

Bryan's coontact it
Beth's customer and prospect st
Al Cantacts

Chocolate Basket Maiout
John's st of prospects
Last sent in Noverber

the Link button.

See Also:

1 Modified B

20230802

20210510 20210510
202190510 202190510
20230731 20230802
20210510 20210510

Adyanced.

ADMIN
ADMIN
ADMIN
ADMIN

See Contact Groups - Contacts Tab for information on adding contacts to a contact group using

Appendix B — Using Data Entry Programs for tabs and common button explanations.
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Contact Groups - Contacts Tab

Contact Groups

The Contacts tab on the Contact Groups screen shows contacts that belong to the group selected on the
Contact Groups tab — and displayed in the Name field at the top of the form. It also lets you add new
contacts or remove contacts from the group, as well as export contacts and copy them to other contact

groups.

e Use the Search field on this tab to find particular contacts in the list.

o Click the red X that appears to remove Search terms.

——P X|| Search

Name ‘Evewbndv =
Contact Groups = Contacts
Search \ Search | Advanced
Order By [ Cortact Code B
Last Name  First Name  Job Title [= Email
L French (647) 5 (i 1032 Andrew French @tairox.com
O 18 ANDREWMURREYD0018  Mumey Director of Sales  (416) 555-1067 (416) 555-1000 AndrewMumey @tairox com

O 52 ANDREWWHITEDO092 White Andrew (604) 555-1000 (604) 555-1049 (604) 555-1069 AndrewWhite @tairox com Yes

O 128 ANNEENGLISHOD1228 English Anne CFO (212) 555-10594 (212) 555-1085 (212) 555-1018 AnneEnglish@tairox.com Yes

O 54 ANNEEVERLEY00054 Everley Anne (B00) 555-1019 (800) 555-1068 (800) 555-1040 AnneEverlsy Etairox.com Yes

O 91 ANNESINGHO0091 Singh Anne (866) 555-1020 (866) 555-1099 (866) 555-1062 AnneSingh @tairox.com Yes

O 17 ANNEYALEDDOT7 Yale Anne (604) 555-1096 (604) 555-1054 (604) 555-1041 AnneYale@tairox.com Yes

O 87 BETHBLACKD0DS7 Black Beth coo (212) 555-1000 (212) 555-1032 (212) 555-1004 BethBlack @tairox.com Yes

O 13 BETHFRENCHD0D13 French Beth (703) 555-1069 (703) 555-1086 (703) 555-1036 BethFrench@tairox.com Yes

O 124 BETHGOLDMANOD124 Goldman Beth (305) 555-1018 (905) 555-1090 (905) 555-1022 BethGoldman@tairox com Yes

O 50 BETHJENNERQDO50 Jenner Beth (636) 555-1073 (636) 5551093 (636) 5551055 BethJenner@tairox.com Yes

O 6 CARLGREENDOD06 Green Cad VP Sales (866) 555-1031 (866) 555-1021 (866) 555-1057 CarlGreen@tairox com Yes

O 43 CARLKERSHAWDD043 Kershaw Car (212 555-1047 (212) 555-1023 (212) 555-1074 CarlKershaw @tairox.com Yes

O 80 CARLLEMUIR0DOBD LeMuir Car (403) 555-1006 (403) 555-1027 (403) 555-1067 CanLeMuir@tairox.com Yes

O 117 CARLTHOMSONO0117 Thomsen Cad (505) 555-1029 (905) 555-1026 (905) 555-107% Car Themson@tairox.com Yes

O 53 CHARLESANDERSONDO... Anderson Charles (212) 555-1016 (212) 555-1005 (212) 555-1006 CharlesAnderson@tairox com  Yes

O 16 CHARLESBRIARDDO16 Briar Charles (636) 555-1085 (636) 555-1048 (636) 555-1087 CharlesBriar@tairax.com Yes

O 7 CHARLESGOLDOODO7 Gold Charles Salesperson (604) 555-1038 (604) 555-1013 (604) 5551016 CharlesGold@tairox com Yes

O 81 CHARLESGRANGEDDD81  Grange Charles (703) 555-1057 (703) 555-1063 (703) 5551031 CharlesGrange @tairox.com Yes

O 44 CHARLESPERSALLOD044  Persall Charles VP Sales (647) 555-1043 (647) 555-1081 (647) 555-1057 CharlesPersall@tairox.com Yes

< >

Page of 7 > bl Link Unlink Change Log
Close

e Contact groups are useful for creating email lists.

e Click the Actions button (=) highlighted in red to perform the following tasks:

‘Everybudy

Name

p— Export to MailChimp
Cortact Groups ~ Contacts
Export to Swiftpage

Search [ Add Group Contacts to a New Group
Order By [Contact Code v~ Add Group Contacts to an Existing Group
Add Selected Contacts to a New Group
] 125 ANDREWFRENCHD0129  French Andrew
O 18 ANDREWMURREY00012  Murey Andrew Director of 5 Add Selected Contacts to an Existing Group
O 92 ANDREWWHITEODDS2  White Andrew

Search Advanced..
1061 AndrewFrench@tairox.com Yes
1017 AndrewMurrey @tairox com Yes
1069 Andrew White @tairox com Yes

o Choose Export to MailChimp or Export to Swiftpage to create a CSV file containing the

Contacts for the current contact group.

Add all of the group contacts to a new group.

Add all of the group contacts to an existing group.
Add all selected group contacts to a new group.

Add all selected group contacts to an existing group.

o O O O

e Click the Link button to search for and add additional contacts to the displayed contact group.

File Help

Search [ Search

Advanced

[ Contact Code V]t

Order By

ID Contact Code Last Name First Name: Middle Name Salutation Job Title:

129 ANDREWFRENCH00129  French Andrew
I T T = S I
[} 18 ANDREWMURREY00018  Mumey Andrew mr Director of Sal
$2 ANDREWWHITEDDO0S2 White Andrew
O 128 ANNEENGLISHO0128 English Amne CFO
O 54 ANNEEVERLEY00054 Everley Anne
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Contact Groups

o Use the checkboxes to select all contacts from the list that you want to add, then click the

Select button at the bottom of the form.

o Use Advanced Search to list all contacts in a particular city, state, or country.

You can also filter contacts based on job title or on contact notes fields.

Note that this form can have multiple pages and that you can select contacts on each page

before clicking the Select button.

e Click the Unlink button to unlink all selected contacts from the currently selected contact group.

Note regarding multi-page contact selection:

o Click the “Select” column heading to select or deselect all contacts on the current page.

Contact consents

Select ID Cortact Code First Name  Job Title [ Phone (Office)
L[ 125 ANDREWFRENCHOOT2S  French Andrew (647) 555-1069
13 ANDREWMURREY00018  Mumey Andrew Director of Sales  (416) 555-1067
52 ANDREWWHITEDD0S2  White Andrew (604} 555-1000
128 ANNEENGLISHO0128  Engish Anne cro (212) 5551094

o Use the navigation buttons at the bottom of the screen to move from page to page to make

your selections.

Page of 7 b P

o Click the Unlick button at the bottom of the screen when you have selected all contacts that
you want to remove from the contact group. The program displays the following warning.

Are you sure you want to remove the selected contacts from
the group?

e
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Send Bulk Email

The Send Bulk Email program lets you send bulk emails from CRM and Collections using bulk email
providers such as MailChimp and SendGrid or using the email server specified in CRM Options.

Send Bulk Email is a CRM and Collections feature. The program will not appear on the Sage 300
Desktop if you are using the Collections module without CRM.

To send bulk emails, you must set up your email server in Options or subscribe to a bulk email provider
and set up your bulk email account using the Bulk Email Accounts program.

The program lets you take advantage of dedicated bulk email provider features, such as:

e Email template editors and pre-built templates for sales and marketing campaigns.

e Subscriber preferences and unsubscribe lists for different audiences and types of emails.
¢ Email forms and custom landing pages.

e Stats for email opening and click tracking.

e Email response handling.

e Customer surveys.

Note that email features vary by provider. These features may not be available from your provider.

L]
Home

v TaiRox CRM and Collections @Q
Gizrepiles Marketing (Send Bulk Email)

Colecton Licensed to: Don Thomson, TAIROX SOFTWARE INC
Dealer TAIROX SOFTWARE INC

cc TAIROX SOFTWARE INC

Collections Reports
Import / Export

I Marketing |

Periodic Processing =,

Sales Reports

Send Documents

Sage

For Help, press F1

@

Bulk Email Accounts | Send Bulk Email Contacts Contact Groups

v

5] Session Date: 2023-07-24 | [B ]

The Marketing folder does not appear on the

TaiRox Collections Desktop

[ Bulkc Email Provider -

Send Lsing Optioral Fields Atachmerts

Bulk Email Provider

Account * [ Q

Subaccount I 1Q

Template |

From Email * [ |

From Name [sample Company Limited ‘

Recipients * [ Contacts cf selected companies -]

Subject [
Body *

Send Close

Notes

e You can use templates on a bulk email provider website or stored on your Sage 300 server, or
you can compose emails on-the-fly using Send Bulk Email.

This lets you quickly send out a new price list to contacts or let customers know that their sales
rep has changed.
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e You can select email recipients from CRM contact groups, A/R customer accounts, or CRM
companies and use unsubscribe lists and email templates stored on a bulk email provider’s
website.

e You can add optional fields to the communication generated by each bulk email batch. The
communication will be linked to all contacts that the email is sent to as well as all companies if the
contacts were derived from selected companies or customers.

e You can add attachments to emails.

e Bulk emails are typically non-transactional and might include newsletters, sales brochures,
general business announcements, or notices of sales manager changes. They provide the same
communication to all recipients, and often have to follow local opt-in or opt-out regulations.

Transactional emails contain information about business transactions — such as a quote, order
confirmation, shipment confirmation, or invoice.

If you have CRM and Collections, you can export contact information and upload it to a bulk email
provider for bulk emails (see Contact Groups), and you can use the Send Statements/Letters to send
informational letters to your customers.

Access: Open the Marketing folder, then open Send Bulk Email.
(The Marketing folder does not appear on the TaiRox Collections Desktop.)

Using the Send Bulk Email Program

1. Choose between sending emails using a bulk email provider such as MailChimp or SendGrid or
sending them using the email server set up in CRM Options.

Send Using * Bulk Email Provider w Optional Fields... Atachments...
Bulk Email Provider
Bulk Emai Provider |"Erail Server (set up in Options)

If you send emails using a provider, the process will be faster and may include more features —
allowing you to personalize emails and use multiple unsubscribe lists for different types of emails.

2. Select the bulk email account if you are using a bulk email provider. The account must already be
set up using the Bulk Email Accounts program in the CRM Marketing folder.

Bulk Email Provider
Account * [SENDGRID

|Q

Unsubscribe
Group

File Key Settings Global Settings ~
Template Q

From £l - Find By [ Show al records ~| | Endiow | | setCrtera

From Name Auto Search

Recipients *

Subject * Description Modiied On Modified By
Body * MAILCHIMP Mail Chimp emai_. ADMIN 2023-11-27 ADMIN

"""""""""""""" SendGrid email ... | ADMIN 2023-11-27 ADMIN
v

< >

Select Cancel

If you selected “Email Server (set up in Options)” instead of a provider, the Bulk Email Provider
fields will not be available. Skip to the “Template” field.

Click the Finder to change your choice of bulk email provider.

3. If you selected a bulk email provider, select the Unsubscribe Group/Subaccount for your email
batch. The group must already be created on the bulk email provider’s website. The type of
unsubscribe list should match the type of email that you are sending.

Bulk Email Provider
Account * [SENDGRID |Q

Unsubscribe sales
Group ‘ X | B
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For example, if you created a NEWSLETTER unsubscribe list, you would choose that group each
time you sent out the newsletter.

Any newsletter recipients that unsubscribe (by clicking the Unsubscribe button or link at the
bottom of the newsletter) will be added to NEWSLETTER unsubscribe list.

Each time you send a newsletter using the NEWSLETTER unsubscribe list, the program will
remove unsubscribed contacts from the recipient list. Other unsubscribe lists will be unaffected.

4. Select the email template that you want to use.

If you are using a bulk email provider, the template must be on the bulk email providers website.

If you are using your own email server, the templates are normally stored in the Sage 300
Company folder: Sage300\SharedData\Company\SAMLTD\TaiRox CRM\Templates. You can use
the Preview button to view the selected template on the Sage 300 server.

I Template ‘F \Sage'5age300"Shared Data\Company \SAMLTD TaiRox CRM'\Templates'Bulkc Email Templates\Spring Sale html xl Q ‘ Preview ‘ I

See Appendix D: Sending Bulk Emails and Using Bulk Email Templates for details.

Alternatively, you can leave the Template field blank and enter the Subject and Body of the email
that you are sending at the bottom of the form.

5. Enter the “From” name and email address that will appear on the email.

From Email * [don.pearson@sanitd.com ‘

From Name [Sample Company Limted |

Recipierts * | Contacts of selected companies w ‘ Select no contacts selected

6. Select the method for choosing email recipients.

Recipients Members of a contact group |v Select nothing selected
. Contacts for selected customers
Subject Contacts for selected companies ‘

Body ‘

Contacts for selected customers lets you specify ranges of A/R customer record fields to select
the list of A/R customers. The program sends emails to all contacts that are associated with the
selected A/R customers. This choice lets you select records by salesperson.

Contacts for selected companies lets you specify ranges of CRM company record fields to
select the list of CRM companies. The program sends emails to all contacts that are associated
with the selected CRM companies. This choice let you select prospects as well as existing
customers.

Members of a contact group lets you choose a group of contacts as email recipients. Use the
Contact Groups program in CRM to create new contact groups.

Note that you can choose only one contact group and that you cannot filter members of the
group. If you need to select members from a group, use Search or Advance Search to select
recipients, then add the selected contacts to a new group.

7. Click the Select button to choose recipients using the method chosen in the dropdown.

To select a contact group, double-click the group you want:

Recipients [Members of a cantact group | [ Seleet ] nething selected

Subj
Body

File Help

Search [ | [ Search Advanced

OrderBy | Name -

Modfied On  Modfied B

7 BB contacts 20230419 ADMIN 20230419 ADMIN
1 Everybody All Contacts 20210510 ADMIN 20210510 ADMIN
3 Holiday Goodies List Chocolate Basket Mailout 20210510 ADMIN 20210510 ADMIN
2 Newsletter Subscribers Last sent in November 20210510 ADMIN 2021-0510 ADMIN
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To select contacts for selected customers or customer groups:

Recipients |Corvta:lslorse\ected:uslamars v“ Select | nothing selected

Customers

Select Customers By Operator From To

S ] [Force ][ee < [ 2
[ (Nore) ~]

‘ (None) Vl

Reset Defaulis

Save Cancel

eny ose

In the above example, we chose “Contacts for Selected Customers”, and then chose all A/R

customers that have salesperson “BB”.

The number of contacts in your selection (therefore, the number of email recipients) appears

beside the Select button.

In the following example, this is 8 customers with 43 contacts — all of whom will get an email

unless they are on the unsubscribe list.

IHeopients [ Contacts for seiected customers v| [TEEed Y 8 customers matched, 43 contacts I

8. Click the Attachments button in the upper-right corner to attach other documents to this email —

such as a price list that you want to attach to the email.

9. Click the Optional Fields button to add optional fields for the communication that is created by this

bulk email.
The communication will be linked to all contacts to which the email is sent, as well as all
companies if the contacts were derived from selected companies or customers.

If you are not using atemplate, and are composing the email on this screen

10. Type the Subject and Body of your email in the last two fields.

Subject |Add hundreds of features to Sage 300 with Productivity Tools

Body \Welcome to the Sage 300 accounting experience!

Did you know that TaiRox Productivity Tools adds hundreds of features to Sage 300, including dozens of enhancements to the Sage 300 Order Entry
lscreen

Productivity Tools lets you manage accourts, customers, vendors, and items across multiple companies. Update hundreds of onders or POs in one step.
|Search for customers, vendors and items using an intemet4ike search engine — and much more

Find out more about TaiTox software products for Sage 200

Send Close

Use the Attachments button to add a standard item for all recipients — like a new price list.

11. Click the Send button when ready, then choose Yes to confirm that you want to continue.

o Send the email to 7 contact(s)?

tes

Viewing Communications Created by Bulk Emails in the Communications
Window

All email communications generated by the Send Bulk Email program appear in the Communications

window — letting you maintain a complete trail of all customer communications.

For more information, see Communications.
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Documents

The Documents program provides a search field so you can immediately find documents. It also includes
a Company search field to restrict documents by company. Double-click a row for document details.

e Click the red X that appears to remove Search terms. e

Name |— Compare TaiRox CRM with Sage CRM - Document  |Pittps ./ www tainax.com/downloads /crm.tairox-crm-sage-crm-compare pdf (B

Documents Companies Contacts Opportunities  Communications

I Search I | | Search Adyanced... I
Order By C

‘ Name

Company

ID Name
26 — Compare TaiRox CRM with Sage CR...

Created

ADMIN

Created On

20191209

Motes Commer:

A 2 Page Comparison Chart

https://eww tairox com/downloads/cr...

25 - TaiRox CRM Brochure — https://Awww tairox com/downloads/cr... A 4 Page TaiRox PDF File 20151209  ADMIN
24 - TaiRox Home Page - https:/Awww tairox com The latest TaiRox news 20191205  ADMIN
23 - TaiRox Price List - https: /7
47 Barmart Quote pdf F:\Sage

46 BAway-DEORDO0000000D0G5.PDF F-\Sage\| File Help
B S P =2 X | ot | Aot |
2 Corporate Notes Order By ‘ Name vl o
3 Corporate Notes
15 Fall Sale Notes \WFSWOP ID Name Short Name [3 Street 1 Street 2 Street 3 Street 4
&7 IR G Ve By LESIE 2 Bargain Mart - Oakland BMT-OK Bargain Mart Plaza  Comer 182nd and Anyig
23 HR Pictures Valentine's Day WWFSHR 1 Bargain Mart - San Diego BMT-SD Bargain Mart Plaza Comer 182nd and... Anytol
29 My Notes Ci\Users 24 Bargain Mart Stores Inc. BARMART Bargain Mart Plaza Comer 182nd and... Anyto)
8 Motes for Beth Jenner \WFSNCO!
9 Motes for Beth Jenner WWESNVCO
11 Motes for J Mumey \\FS\CO
10 Motes for Mike Trudeau WWFSNCO
& Motes for Ringo White WWFSHCO
7 Motes for Ringo White \WFS\COS

Page of 3 [ 1| :

Notes:

¢ Documents can be linked to Companies, Contacts, Communications, Cases, Opportunities, and
Tracked Invoices. (You can also add documents for Tracked Invoices using the Overdue Invoices
program and the Disputed Invoices program.)

o To see all documents added to a single company record, click the Company Finder (shown
above) and select the company you want. You can use the top Search field on the form to
refine your search.

o Click the red X to remove the company filter.

Order By ‘ Name \,| = Company |Eargain Mart - Oakland x| Q

ID Mame [= Document Motes Comment G 2dOn  Created

e To link an existing document to a Company, Contact, Opportunity or Communication:
o Select the document that you want to link.
o Click the appropriate tab.
o Click the Link button.
o Select the Company, Contact, Opportunity or Communication from the Finder.
e To attach documents to Cases and Tracked Invoices:
o Open the Case or Tracked Invoice using the Case or Tracked Invoice program.
o Select the Case or Tracked Invoice.

o Select the Documents tab, and click the Link button (or click the Add button to add a new
document).
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e Document files are not stored in the database. Instead, documents reference various document
storage repositories. Drilling down will open the referenced file.

o Document references can be to Web site URLS.
o Document references can be to local network drives and folders.
o Document references can be to local drives (can only be opened by one user).

Drill Down:
e Double-click a row in the grid to view the document details.

e Click on the Document column heading — or click the “Go” button in the upper-right corner of the
screen (=) — to open the highlighted document in the grid.

See Also:

Appendix A - Common Screen Operations for searching, sorting, tabs and button explanations.
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Document — Add/Edit

Double-click a row in the Documents window to open the Document program and view document details.

The Document screen lets you add links to new documents and edit existing document information.

"

D (Q + Name |-TaiRox Price List - |
Document  Optional Fields Companies Contacts Opportunities Communications Cases  Tracked Invoices
Created On 12021-05-10 Created By IADMIN
Modified On [2021-05-10 Modified By ADMIN
Document |hﬂps:ffwww.talmx.comfdownloadsforderﬁalRox-PnceLlst pdf | Q =
Notes IThis pricelist is always curent
Comment
Change Log..
Save Delete Close
Notes:

e Click the green Plus button beside the ID field (4) to add a new document.

e Click the Finder button (-) beside the Document field to select or view the document location if
on a local or network drive.

e Copy and paste a browser URL to store a web site address.
e The Notes field can be up to 250 characters long.
e The Comment field can be up to 2,500 characters long.

e Click the Delete button to delete the document record. Delete does not delete the document — just
the record with the document link.

e The Optional Fields tab appears if you use the Optional Fields module and assigned optional
fields to documents.

Drill Down:

e Click the drilldown icon (“Go” button [=) to open the document or web page.
See Also:

Appendix B — Using Data Entry Programs for tabs and common button explanations.
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Communications

Communications record all interactions between your company and your customers. You can manually
add any type of communication, including phone calls, text messages, letters, or emails.

Additionally, CRM and Collections records all emails sent to customers by the Send Documents, Payment
Due Alerts, Overdue Payment Reminders, and Send Bulk Email programs as communications — including
statements, invoices, letters, payment due alerts emails, overdue payment reminders, and newsletters.

The Communications program provides a search field so you can immediately find communications. It
also includes a Company search field to restrict communications by company.

Click the red X that appears to remove Search terms. — —— X|[ sax

Double-click a row in the grid to open a communication record.

Name

Communications Contacts Documerts Companies

‘01 January Newsletter |

I Search I

Order By

ID

10

1 01 January Newsletter
2 02 February Newsletter EMAIL Happy St. Valentines Day
3 03 March Newsletter EMAIL St. Patrick'’s Day

4 04 April Newsletter EMAIL Apiil Fools

5 05 May Newsletter

6 06 June Newsletter

7 07 July Newsletter

8 08 August Newsletter

5 09 September Newsletter

11 11 November Newsletter Search X | Search Advanced... |
12 12 December Newsletter =
19 Documents Attached OrderBy  Mame v
16 Documents Attached B = = = - -
) Name Short Name =+ Street Street Stree Stree
17 Documents Atached IC ”:m:‘ W EEE =3 tcct 1 treet 2 treet 3 trest 4
18 Documents Attached 2 Barga!n Mart -Oaklar?d BMT-OK Barga!n Mart Plaza Comer 182nd and... Anyto
13 Your payment for Sample Company Ui 1 Earga!n Mart - San Diego BMT-SD Earga!n Mart Plaza Comer 182nd and... Anytol
24 Bargain Mart Stores Inc. BARMART Bargain Mart Plaza Comer 182nd and... Anytol

14 Your payment for Sample Company L
15 Your payment for Sample Company L
20 Your payment for Sample Company Li

| Search Advanced... |

| Name Comparty

Created On
2015-12-09

Name Notes Comment

Happy Mew Year

Happy Easter
Happy Mid-Summer

File Help
10 October Newsletter

Page of 2 3

Notes:

Communications are associated with Contacts, Documents, and Companies. For example:

A newsletter communication may be sent to all contacts.

A statement may be emailed to two contacts at a particular company.

An overdue payment reminder may be sent to the contacts for a company.
A FAX may be sent to the company number.

O O O O

To see communications for a single company:

o Click the Company Finder (shown above) and select the company you want. You can use the
top Search field on the form to refine your search.
o Click the red X to remove the company filter.

Order By ‘ Name vl - Company |Barga|n Mart - Qakland 0]

1D Name Comment Created On  Createq

CRM and Collections creates email communications when you resend accounting documents
from the Companies window, send statements, letters and invoices, and when you send overdue
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payment reminders, payment due alerts, and bulk emails. Just click the View Email button on the
communication record to view emails and attachments.

The Export Contacts button will create a file containing the contacts previously used for the
selected communication, either in MailChimp or Swiftpage format.

This allows you to follow up a previous mailout to the same group of contacts.

2
JreiChim ] v
Cancel

1
Page of 1 Add Delete Change Log

Close

Note: In order to export to MailChimp or Swiftpage, contacts must have email addresses, first
and last names, must consent to receiving emails (this is a checkbox on the Contact screen), and
must not be inactive or belong to inactive or deleted companies.

Drill Down:

Double-click on a row in the grid to open up the Communication program and view
communication details.

Select a communication and click the Contacts tab to see recipients of emails sent by CRM.

Click the Documents tab to view documents that were linked to the communication.

See Also:

Appendix A - Common Screen Operations for searching, sorting, tabs and common button explanations.
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Communication — Add/Edit

The Communication screen lets you add new communications or edit existing information. It also lets you
view emails sent to customers by the Send Documents, Payment Due Alerts, Overdue Payment
Reminders, and Send Bulk Email programs.

D Q Mame |0\rerdue Payment Reminder for invoice OEINDDO0000000021 |

Communication  Optional Fields Contacts Documents Companies

Cosedor Cosesty
Modiied On Modified By

Type |EMAIL |‘ I |E-Man | | View E-mail... |
Notes Cusstomer Number 1100 Bargain Mart - San Diego
Comment Cverdue Payment Reminder: OEINODDO000D00021 POF

Notes:
e Click the green Plus button (4) beside the ID field to add a new record.

 If adding a new communication, click the Finder button (=) beside the Type field to choose the
communication type.

The list of communication types is maintained by the Communication Types setup program. You
must choose from the list.

e Click the View Email button to view emails created when you resend accounting documents from
the Companies window, send statements, letters and invoices, and when you send overdue
payment reminders from the Overdue Payment Reminders program, or emails from the Payment
Due Alerts program and Send Bulk Email program.

e The Notes field can be up to 250 characters long.
e The Comment field can be up to 2,500 characters long.

e Click the Export Contacts button to create a file containing the contacts previously used for the
selected communication, either in MailChimp or Swiftpage format.

This allows you to follow up a previous mailout to the same group of contacts.

e The Optional Fields tab appears if you use the Optional Fields module and assigned optional
fields to communications.

See Also:

Appendix B — Using Data Entry Programs for tabs and common button explanations.
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Viewing Emails in the Communications Window

All email communications generated by the Send Documents, Overdue Payment Reminders, Payment
Due Alerts, and Send Bulk Email programs appear in the Communications window — letting you maintain
a complete trail of all customer communications.

CRM also keeps copies of all emails that are generated by CRM and Collections, such as overdue
payment reminders, payment due alerts, and emails created by the Send Documents program.

Note: Emails sent using Send Bulk Email are not captured and cannot be viewed in communications. (In
other words, you can view the communication record listing all recipients on the Contacts tab, but you
cannot view the actual email sent to recipients.)
To view emails:
1. Open the Communications window and search for the communication that you want.
In this case, we searched for an “Overdue Payment” for customer 1100.

2. Double-click the communication, then click the View Email button in the Communication window.

Neme  [Overdue Payment Reminderfor inveice OEIND000000000021

Communications Contacts Documents Companies

Search ﬁﬂ@verdue Payment |

Order By [ Name: ~] %

D

Communication  Contacts Documents Companies

Goseton oty

Tz @A\L |Q [EMail \I View E-mail |

Notes [Cusstomer Number 1100 Bargain Matt - San Diego /

< Your payment for Sample Company Limited is overdue - M...

|Ove|due Payment Reminder for inveice OEIN0000000000021

prinvoice_ |[EMAIL

File Message  Help Q Tell me what you want to do
Your payment for Sample Company Limited is overdue
morgan.thomas@tairox.com
To Jenner, William; LeMuir, Harry; Grange, ) Anderson, Y; Everl File Edit View Sign Window Help
o SPDF ’ Home  Tools OEINDOD0000000D... @ Sign In
or ] 48 KB
<
Y P B Q T e e e & B 3
Page [ Dear Mr. Mike Briar,
Qur records show that we haven't yet received p Sample Company Limited Q
listed below. I would appreciate it if you could le 123 Sampte Company Praza
t ‘Any Cty, Any Prowince, VEJ T3 Lj\
payment. Srore. (12314567553 © | [ Change Log
. Fac (12345t
Please include your account number (1240) and =
payment. soa 7o supTo: L= o
) N The Cautyad Sust Ot
The details of all overdue invoices are as follows: T i s o R
U HabaTe +]
Usa
Invoice Date Amount Due

You can then double-click the attachments to see the original documents.

Note: older emails (prior to January 2020) were stored differently in CRM.

Older emails resent from the Company window or generated by CRM for statements, letters,
invoices appear on the documents tab.

And, emalils that are manually attached to a communication also appear on the Documents tab.

To access older emails and emails manually added to communications:

o Select the company in the Companies window and click the Communication tab (or open the
Communications window from the Sage desktop — as shown below).
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Communications

[ HQ

o

e === W
s .
-
e [ w2 b o || D | Cesttenan | [Dameig | [ Bom G | (Gange og. |
[ oo | [ 5 ][ peme | [ oo |
To view the email with attachments, select the Documents tab, and click the Document
column heading.
1[4 48 = |5 Overdue Payment Reminder fo invoice INDOON.. =
o )0 4 Mams [Ovedi Paymene Remnderfor rwoce INDOOD0DI000021 ] |ﬂ;=rh u-ls_ﬂg» :70.
Commuricaion  Confacts Documeris  Comparies: ::"' T e Sert:  Mon 81002020 10:04 AM
Somch oo X [ Semch ] mdyarces. | Sy e e
oy w : | S or

Dear Mr. Jose Grange,

)

e still have not
was due on 11/11/2015.

for 85.87 which

Because we have been unable to Work out payment with you, | regret to inform
you that ff we do not hear from you in 5 days we willreport this issue to the credit
bureau and turn this invaice over to a collection ageney who will eontact you i
regard to payment.

sinceraly,
administrator

P [ 1] w0
e Deiese

L aas Deae | [ e ][ U

[ e o

Ehange: Log
Qs

PR -

Viewing Company information from the Communication Window

TaiRox CRM and Collections for Sage 300

Click the Companies tab, then double-click the row with the company name.

o L 4 Hamn [ - Do ]
‘Corgarr Opnansl Feids  Cortscts  Oppoures  Documerss  Cases Noses  Commurscators:
Soach — st [BEOE | comsany (DR | Conomerturber B0 |5 @
oyt o wearuscn i ey
Clinscte
ot [T & o) Coetins.
» | — Fsere—
Tertory A v fa;; 10 Overdus irvosce)
e m— i ot
e ]
WS rowBegiietoon =}
Enal [ose fbarganman com. =
- ContctsPrne [ =
Gt | G i [
5 O Pt B
Oute o Pl v Paprs s (EEEUOH | P dn v g
[ Sard Pt Dus ibets
ot f e Pyt Due e [
1) 5endt rvcaces
= E Addrens. Documents Foder... e Uik Bromete. ‘Serd Doouments .. Crange Log.
- :I o Seve Lsete Dose.
Com ][ o) |
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Cases

Cases let you track collections issues, support issues, customer appointments, or other situations. You
can also categorize cases by priority and by stage. (See Case Stages for more details.)

The Cases program provides a search field so you can immediately find cases. It also includes a
Company search field to restrict cases by company (shown below). Double-click a row to open the case.

e Click the red X that appears to remove Search terms. = —— X]| s

5l

Name  [Needs Readyto-Post training | customer Number B &

Cases JDocuments Motes

Search \ || Seach | Adyanced.. |
[io C

Order By

D [& Company Name b.gned To  Status

1 Bargain Matt - San Diego Needs Readyto-Past training Suppart Nomal KEITH Open
2 M. Ronald Black Cannot nun Day End Support Nommal b WADE Waitingfor Customer 54
3 The Couttyard Need to renew TPT license Suppart Nommal WADE Open

Normal DON Open

4 Custom Comfort New activation code not working Support
5 J &Y Buiders Lid Database issue - sending log files g

& Mr. Ronald Engish Training for Check Approval
7 Frame-Up
2 CanAm Indufll
9 The Paper b File  Help

10 Bashaw Bull
Search = r X] | search Advanced

Nomal Normal KEITH Open
Open

OrderBy | Name o]

Short Name [ Strest 1 Street 2 Street 4
2 Bargain Mart - Oakland BMT-OK Bargain Matt Plaza Comer 182nd and... Ayt
1 Bargain Mart - San Disgo BMT-SD Bargain Matt Plazs Comer 182nd and Aryt
24 Bargain Mart Stores Inc. BARMART Bargain Mart Plaza  Comer 182nd and... Ao
< >
Page [ jange Log..

| Close

Notes:
e Cases include a “Type” field, which can be Collections, Support, Appointment, or Other.
e Use the Advanced... button to filter cases by field ranges (including Severity, Priority and Stage),

as well as by Case Type, Case Status, and Territories.

o To search cases for a single company, click the Company Finder (shown above) and select
the company you want. You can use the top Search field on the form to refine your search.
o Click the red X to remove the company filter.

Order By [1D v| % Company [Bamain Mart -Oakland Q

ID B Company Name: Pricry Severty Assigned To  Status

e Cases can be assigned to a user or be left for assignment at a later time. Users will only see
cases that match the company territories to which they have access.

e To copy a case, click the Copy button at the bottom of the screen. See Copying Cases. The Copy
button beomes active after you click the Add button — or the Save button if you changed the case.

e CRM and Collections updates users’ calendars when you change revisit dates and user
assignments. See Appendix E: Updating Calendars with .ics Event Files.

Drill Down:
e Double-click a row to open up the Case program and display the case information.
e Click on the icons to the right of the Customer Number (top-right-hand corner) to open the A/R
Customer program or the A/R Customer Inquiry program.
See Also:

Appendix A - Common Screen Operations for searching, sorting, tabs and common button explanations.
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Dragging and Dropping Documents into the Case Documents Folder and Linking
Documents to a Case

CRM and Collections lets you add any documents to a case. You can use drag and drop to attach
documents and copy them to the Case Documents folder defined in Setup Options, or you can link any
existing documents on your computer to a case record.

Note the following methods for adding documents to cases:

e Use Drag and Drop on the Documents tab to copy documents to the case document folder in
CRM (see Document Folders tab in Setup Options).

Documents that you drag and drop are added to the Documents tab for the case, they are copied
to the case document folder, and they are added to the list of documents maintained by the
Documents program in CRM and Collections.

e Usethe Add button on the Documents tab to link to a document and add it to the list on the
Documents tab.

When you use the Add button, the document will be added to the list maintained by the

Documents program in CRM and Collections, but the document will NOT be moved to the case
folder.

e Usethe Link button on the Documents tab to link to a document and add it to the list on the
Document tab.

When you use the Link button, the program displays the list of documents maintained by the
Documents program in CRM and Collections, letting you choose a document to add to the case’s
list. The document will NOT be moved to the case folder.

To drag and drop documents and move them to the Case folder:

1. Click the Documents tab.

2. Drag and drop a document onto the Documents tab. (The grid border turns green, and the pointer
shows that you are dragging a document.)

B SAMLTD - Case

File  Help

D r_" 4+ Name [1841513USD Overdue ‘

Case Documents Notes

Search [ | [CSearch | Advanced

Order By Name [

ID Deleted Name [= Document

3. When you release the document, the grid displays the new document, showing the path to the
documents folder — in this case C:\Sage300SharedData\company\SAMLTD\TaiRox
CRM\Documents\COMP00002\Cases\CASE00002\Order Details.doc

B SAMLTD - Case

File  Help

D r_" 4+ Name [1841513USD Overdue ‘

Case Documents Notes

Search [ | [CSearch | Advanced
Order By Name N

ID Deleted Name [= Document
Order Details.doc

TaiRox CRM and Collections for Sage 300 68 User Guide



Companies, Contacts, Cases, Tasks, Opportunities, and Communications Cases

Case — Add/Edit

The Case program lets you add, edit, and copy a case.

Access: Click the Add button or double-click an existing row on the Cases screen or on the Cases tab
on the Companies screen.

e On the blank Case screen, click the Finder button (") on the right side of the Company name
field to choose the Company Name for the case. When you save a case, the Drill Down button [*
becomes active so you can drill down to company data.

&

D Q Name ‘Cannm run Day End |

Case  Optional Fields Documents  Motes

Company Name M. Ronald Black I LI

G T
p— o

Type [ support <]

AssgnedTo  [WADE Q

Opened On [2021 0108
Revist On |2021-01-08 Revisit At 14:00:00

Stage [+ |} [54-Customer appointment

Notes Logs requested
Reviewed logs and need to remote into the site to troubleshoot

Comment

| com Documerts Folder.. | Chenge Log.

Save Delete Close

Notes:

o Click the green Plus button (+) beside the ID field to add a new case record, then click the Finder
button (-,) beside the Company Name field to select the company.

e Click the Copy button at the bottom of the screen to copy a case. See Copying Cases.

e Revisit On date is used to construct data for the Dashboard program. You can also enter a
Revisit Time after the Revisit date. Enter time in 24-hour format (e.g. 13:00).

Cases show up for the revisit dates on the assigned employees’ dashboards and calendars, and
assigned users are sent calendar event files so revisit dates appear in their email calendars. The
program sends the calendar updates to assigned users when you click the Save button.

e Cases may be of type Collection, Support, Appointment, or Other.

e Stages are user-defined. See Case Stages.

e Use the Appointment case type and the Revisit Time to schedule on-site calls.

e The Notes field can be up to 250 characters long.

e The Comment field can be up to 2,500 characters long.

e Click [4 to drill down to Company data.

e Click the Documents Folder button to view case documents in the Windows folder.
e Click the Change Log button to view past changes to the case.

e The Optional Fields tab appears if you use the Optional Fields module and assigned optional
fields to cases.

See Also:
Appendix B — Using Data Entry Programs for tabs and common button explanations.
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Copying Cases
CRM and Collections lets you copy an open case to the current company or to a different company.

This means you can:
e Create standard cases for service and support calls and apply them to particular companies.

e Quickly duplicate a past collection case for a company.

To copy a case:
1. Open the case that you want to copy.
2. Click the Copy button at the bottom of the screen, and click Yes when prompted.

Revist On |2021-01-08 Revisit A 14:00:00
q
Motes Logs requested

Reviewed logs and need to remote into

W
=

o Are you sure you want to copy this Case to a new Case?

Comment

Yes No

Copy. Documents Folder... Change Log...

Save Delete Close

o The program will display a message stating that the copy was successful. Click OK.
o By default, the new case will be assigned to the current company.

3. To change the company for the case, click the Finder button beside the Company Name field,
and use the Search field to find the new company.

In this case, we entered “bar” to find and select “Bargain Mart — Oakland.”

=

o [ Q4+ MName [CametrnDayEnd |

Case Documerts Motes

Company Name
Created On
Modified On

Mr. Ronald Black

]
T

]
[

Tipe
Severity
Assigned To

Status

Opened On

Revist On 2 Bargain Mart - Oakland BMTOK

[= Street 1 Street 2 Street 4

Bargain Mart Plaza Comer 182nd and Anytol
Stage 1 Bargain Mart - San Disgo BMT-SD Bargain Mart Plaza  Comer 182nd and Anytol

24 Bargain Mart Stores Inc. BARMART Bargain Mart Plaza Comer 18Znd and Anytol
Notes Loas

4. Select the new company and edit the new case as required, then click the Add button at the
bottom of the screen to add the new case.
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Tasks

The Tasks screen lets you:

e Track collection phone call tasks generated by the Overdue Payment Reminders program.

Overdue Payment Reminders lets you send out overdue payment reminder emails to customers
or create collection call tasks so users can easily follow up with customers.

Collection call tasks appear on the dashboard according to revisit dates, provide overdue invoice
information, and generate phone communications to track the outcome of collection calls.

e Manually create tasks for tracking other activities.

Manually created tasks are optionally associated with customer accounts, and can track
collections calls, appointments, to do items, or other CRM and Collections activities.

The Tasks program provides an internet browser-like search field so you can immediately find any tasks —
for example, type “Open” in the Search field to view all open tasks.

e Click the red X that appears to remove Search terms. — X[ s

You can also order the task list by task name, task type, status, revisit date, company name, assigned
user, territory, customer number, and various task dates.

Name ‘Colledian Call - The Yoshida Gardens \ BETSs ZN)
Tasks | Notes
Search [ | Seach
Order By [ID v % Company 1 Q
Compary Name Assigned To  Stalus ClosedOn  DueDate  RevistOn  Revis
The Garden Shop Collection Call - The Garden Shop Collection Cal DON Open 20210108 20210107 12004
Review spring sale webste pages To Do tem KEITH In Progress 20210114 20210112 1200
Bargain Mart Stores Inc Mesting with Bangain Mart Stores - renovation  Appointment DON Open 20210123 20210121 10:00;
Canm Industries Canfim requirements list expected next week - .. Other WADE In Progress 20210129 20210126 1200,
Astral Construction Co Lid. Draw up proposal for new office location To Do tem WADE In Progress 20210114 20210111 12004
| [The Yoshida Gardens Collection Call - The Yoshida Gardens Collection Call WADE  [open [ [ [2021-01-26
ACME Plumbing Collection Call - ACME Flumbing Collection Cal KEITH Open 20210311 12:00
M. Stephen Kershaw Collection Call - Mr. Stephen Kershaw Collection Cal DON Open 20210311 1200
CanAm Industries Collection Call - CanAm Industries Collsction Cal KEITH Open 20210311 12:00
< >
Page of 1 Add Delete Change Log
Close

e To display tasks for a single company, click the Company Finder button and select the company
you want. Click the red X beside the Company field to remove the company filter.

Order By [1D ~| #  Company ([The Yoshida Gardens x| Q

[E Company Name Assigned To  Status Closed On Due Date Revisit On Revisi|

e Tasks include a “Type” field, which can be Collections, To Do, Appointment, or Other. Tasks
created by the Overdue Payment Reminders program have a “Collection Call” type.

e Tasks can be assigned to a company or be unassigned, and they can be assigned to a user or be
left for assignment at a later time.

e Tasks can include a due data and a revisit date, and can be Open, In Progress, or Closed.

o Tasks with revisit dates appear on assigned users’ dashboards. Users will only see tasks that
match the company territories to which they have access.
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e CRM and Collections updates users’ calendars when you change revisit dates and user
assignments. See Appendix E: Updating Calendars with .ics Event Files.

The program sends the calendar update emails when you click the Save button.

Drill Down:
e Double-click a row to open up the Task program and display the task information.

e Click on the icons to the right of the Customer Number (top-right-hand corner) to open the A/R
Customer program or the A/R Customer Inquiry program.

e Overdue Payment Reminders can automatically create payment reminder tasks for calling
customers. See Overdue Payment Reminders and Overdue Reminders Setup.

Collection Call Tasks Generated by the Overdue Payment Reminders Program

The Overdue Payment Reminders program lets you send out overdue payment reminder emails or create
phone call tasks for calling customers concerning overdue invoices.

e You use the Overdue Reminders Setup program to select which action you want to perform for
each overdue invoice aging stage.

For example, you might generate tasks for calling customers with an invoice that’s overdue by
more than 60 days.

e System-generated call tasks with a revisit date appear on the CRM and Collections Dashboard
and provide summary overdue invoice information and drill-down invoice details and customer
and contact information.

e The Overdue Payment Reminders program lets you set a revisit date and assign a user when you
generate a group of payment reminder tasks.
A typical procedure for using Overdue Payment call tasks looks like this:

1. Open the Collections folder on the Sage 300 desktop, then open the Overdue Payment
Reminders program.

2. Click the Update button on the Overdue Payment Reminders screen. The Update button checks
for invoices that have become overdue — or have been paid — since an update was last run.

3. Select particular customers that you want to process — for example, choose all customers with
overdue invoices that you want to assign to a particular staff member.

4. Click the Process Overdue Payment Reminders button to continue.

Search I | [ Search

Order By [ Customer Humioer v % Company I®

Status Last Updated 20200722 | [13:25:44 | By [WADE Updste

Open Pending [Closed [ 5how On Held

|[ Process Overdue Paymert Reminders... ||

5. Specify a user ID and task revisit date for this group of customers, then click the Process button.

e Users find Collection Calls assigned to them on the CRM and Collections Dashboard — or they
can open the Tasks program and filter for their user names in the Search field.

e Users document Collections Calls with a communication which they create directly from the task.

See Also:

Appendix A - Common Screen Operations for searching, sorting, tabs and common button explanations.
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Add Manual Tasks and Update Tasks Created by the Overdue Payment
Reminders Program

The Task program lets you track and update tasks generated by the Overdue Payment Reminders
program and create new tasks for collections, to-do items, appointments, and other CRM and Collections
activities.

Access: Click the Add button at the bottom of the Tasks grid or double-click an existing task row.

The following screen illustrates a Collection Call task generated by the Overdue Payment Reminders
program. Note that buttons for displaying invoice details and creating a communication appear only for
tasks generated by Overdue Payment Reminders. They do not appear on manually-created Call Tasks.

D § \H Neme [Collecion Call - The Yoshida Gardena |

Task  Notes

Company Name I“!\'ni‘daGadznl D
Created On |202HJHI Created By |ADM|N ‘
Modfied On [zuzwl-n | Modfied By [rowm
Type |t_o|ecnmta| ]
AssignedTo [WADE 1Q

Due Date 20210318 |py

Status [ In Progress v]

Revist On |2n2w-u|-25 :g Revist At [00-00:00
Comment ]

Detais. Create Communication

|o«m Payment Reminder

Overdue Payment Reminder
Details. Create Communication. .

e Click the green Plus button (4) beside the ID field to create a new task record.

e Click the Finder button (") beside the Company Name field to link the task to a company.

o Click [4 to drill down to Company data. The button becomes active when you save a task.
o Skip the Company Name field to create a task that is not associated with a company.

e Tasks may be of type Collection, Support, Appointment, or Other.

e The Assign To user field is optional — allowing you to create a group of tasks, and then assign
them to individual users.

e Collection calls created by the Overdue Payment Reminders program have an “Overdue
Payment Reminder” label and buttons for displaying invoice details and creating a
communication.

o Click the Create Communication button to add a new communication. The button name will
change to “View Communication” when you save the communication.
o Click the View Communication button to view or edit the communication.

e The Due Date and the Revisit Date are optional.

The Revisit Date determines when a task appears on the assigned user’'s Dashboard. Optionally
enter a Revisit Time after the Revisit date in 24-hour format (e.g. 13:00).

e The Comment field can be up to 2,500 characters long.
e Click the Notes tab to add a note that can also be searched in the Notes program.
¢ Click the Change Log button to view past changes to the task.

e The program sends calendar update emails to assigned users when you click the Save button.
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See Also:

Appendix B — Using Data Entry Programs for tabs and common button explanations.

View Overdue Payment Reminder Details and Drill Down to Collections Data

Overdue Payment Reminders — Collection Call tasks created by the Overdue Payment Reminders
program — provide a Details button that displays summary data on overdue customer accounts.

- Gty

Overdue Paymert Reminder
Modfied On 2021-06-30 Modiied By [ADMIN
Details. Create Communication.
Type ‘Col\edion Call ‘

Click the Details button to display the Overdue Payment Reminder Details:

Amount | Due Balance

Days Overdue

Close

The popup shows all outstanding invoices — excluding invoices on hold — when the task was created.

Tasks

Click the Drill-Down button by the Company Name field to view all customer and collections data:

E
D [ 1]Q + MName [Collction Call- The Garden Shop
Task | Notes
e ‘TheYnsh\daGardeﬂs ‘ \
Created On Created By DMIN
Modfied ]
Type
Asigned D [ 2|Q) 4 MName [The Yoshida Gardens |
Due Dat “Compary  Optional Fields Cortacts Oppofunties Documents Cases MNotes Communications
1
o
— Created On 2020-08-28 Created By ADMIN e E R
levisit
Commen|  Modfisd On 20210303 Modiied By ADMIN Curency joPN
[ inactive
o
Disputed Invoicels)
| [Defaut Tentt
Termtory [ ] | EL oy ‘ 3 2 Overdue Invoice(s)
Phone Number [Ji%
E
Fax Number
Web S
© Customer Number [7400 | [9 [ [The Voshida Gardens
Email
Contact’s N
Ot AT | patance [ 17.21] [ 19370)
Contact’s Email
Tems Average Days to Pay Number of Paid Inveices
[ Send Overdu Curent 1-30 31-60 61-90 Over 90
| 9| 9| g | 7 | 727
] Send Paymer| ———— ’ ’
oo o] ESactons Cases MNotes Communicatons Disputed bvices Overdue invoices Tracked Invoces  Pramised Payments
e of the
Send Invoiced ] Only Show Overdue Invoices (credits are always shown)
Address... | Document Number Payment Number Documert Type  Document Date Due Date
INDODDODOD00035: 1 Invoice 2020:03-03 20200315 116.490
= TRINV-010.2 1 Invoice 20190204 20190206 812

— e Click the Contacts tab on the Company screen to see the list of company contacts.

Click the Collections button on the Company screen to view outstanding invoices, payments,

cases, notes, past communications, as well as disputed invoices, tracked invoices, and promised
payments.
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Creating Communications from Overdue Payment Reminder Tasks

CRM and Collections makes it easy to document all overdue payment calls — just click the Create
Communication button to create an update for your call summary.

— sy _
Modfied On Modified By Overdus Payment Reminder

Details... Create Communication...
Type [Coliection Call |

Click the Create Communication... button to display the Communication screen:

CRM and Collections creates a communication the first time you click the Create Communication...
button and click the Save button on the Communication screen. The button name changes to View
Communication when you save, so you can see that a communication exists.

e Click the View Communication... button to update the same communication.

Note that the new communication includes a few default pieces of information — such as the
communication name, the type, starting notes, and a list of the overdue invoices in the comment field.

+  Name [Collection Cal - ACME Pmbing

Task  Notes
omin o
e s O] e

Type
Assigned To
Due Date
Sabm D - +  Neme icueqmca ACME Prumbing
Revist On s

Comment

Detads.. | [ View Conmunication... |
fledinca™ ]

-, —
e T A —

Type [prone 1Q [
Notes [Overdue Payment Reminder 20210303-083940-0001 l

Comment INOOO0000000044, INOO00000000050. INOOOO000000056 ’

You can look up all Collections Call communications in the Communications window — and you can also
see them on the Communications tab in the Company window, along with email messages sent by the
Overdue Payment Reminders program — as below:

D[ dQ+ e [N |

wwmw:mmmmlml
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Notes

The Notes program provides a search field so you can immediately find notes, and it includes a Company
search field to restrict notes by company (shown below). Double-click a row to open a note.

e Click the red X that appears to remove Search terms. = —— X|[ s

CreatedOn  Created By Modified 0~ Modfied By ~ Company
8 RE: Quote for Bargain Mart See guote on Documents tab. Updated the "prefe... 2021-01-05  ADMIN 9210105 Bargain Mart Stores Inc.
7 Sent quote, order and inveice to custo... Have resertt the quote, order and invoice tothe c... 2020-12-21 b 20201221  WADE Bargain Mart - San Diego
6 Dec 12 call regarding invoice Called office and talked to the A/P department. R (20 2020-12-21 WADE Dr. Dan Penn
5 Cheque is in the mail a9 2 8 g i 2
4 User's Pemissions Incor!
3 New Mote
2 TaiRox Products File Help
1 TaiRox Customizations | Search

X] [ Search Advanced

OrderBy [ Mame ~] %

ID Name Short Name [ Strest 1 Street 2 Street 3 Street 4
2 Bargain Mart - Oakland BMT-OK Bargain Mart Plaza Comer 182nd and. Anytol
1 Bargain Mart - San Diego BMT-SD Bargain Mart Plaza Comer 182nd and.. Anytol
24 Bargain Mart Stores Inc. BARMART Bargain Mart Plaza Comer 182nd and.. Anytol
<
e [ I

¢ Notes can be attached to Companies, Tasks, Promised Payments, Opportunities, and Tracked
Invoices. (You can also add notes for Tracked Invoices using the Overdue Invoices program and
the Disputed Invoices program.)

e To add a note, click the Add button and select the type of entity the note is for.

Typically, you add notes by opening the company, disputed invoice, overdue invoice, promised
payment, opportunity, or case, and then go to the Notes tab and click the Add button.

e Notes can be several thousand characters in length.

e To search notes for a single company, click the Company Finder (shown above) and select the
company you want. You can then use the top Search field on the form to refine your search.

e Click the red X shown below to remove the company filter.

Order By |Created On ~ ‘ - Company ‘Bargaln Mart - Ozkland x | '.'._‘(

ID Mame Created On  Created By Modfied On ~ Modffied By ~ Company

e Users can only see notes that match the company territories or opportunities/cases/invoices/
promised payments to which they have access.

¢ Use the “Advanced” search button to view notes for companies, tasks, tracked invoices, promised
payments, or opportunities.
Drill Down:
e Double-click on a row to open the Note window to see the contents.
¢ Click the “For” column heading in the grid to drill down to the entity to which the note is attached —

either a company, case, tracked invoice, promised payment, or opportunity.

See Also:

Appendix A - Common Screen Operations for searching, sorting, and common operations.
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Note

— Add/Edit

The Note program provides maintenance functionality.

Company |Eargain Mart - Oakland |
Created On Created By
Modiied On 20201208 Modified By
Name +
Naote TaiFox is a software development company 100% focused on providing |nno\rat|\re solutions to the Sage E’.DD U\ccpac)
communities. The TaiRox development team has over 120 years of experience developing Sage
including our best selling product TaiRox Productivity Tools. Sage 300 resellers engage TaiRox to develop Iarge and
small customizations for their clients.
See https://www tairox .com.about-us-2 himl
Change Log...
Save Close
Notes:

e Notes are always linked to a single entity — a company, case, tracked invoice, promised payment,
or opportunity. (Invoices that have notes added using the Overdue Invoices program and the
Disputed Invoices program appear as tracked invoices.)

e Click the Add button (<) beside the Name field to add another note for the same entity.

o Notes may be several thousand characters in length.

To add a note for a company, case, tracked invoice, promised payment or opportunity:

e Click the Add button at the bottom of the Notes grid, and select the type of entity to which you are
attaching the note — for example, “Company”.
ID Name Cresied On  Created By  Modfied On  Modfied By  Company
5 Chegue is in the mail 20201221 WADE 20201221 WADE Bargain Mart - Oakland
6 Dec 12 call regarding invoice Called office and talked to the A/P depatment. R... 2020-12-21  WADE 20201221 WADE Dr. Dan Penn
9 March 12 call regarding invoice: Called office and talked to the A/P depatment. R... 20210315 KEITH 20210315 KEITH Dr. Dan Penn
Page of 1 Company Change Log Close
Case
Tracked Invoice
Promised Payment
Task
Opportunity
¢ Choose the entity from the Finder. In this case, we entered “bar” as the search term in order to
select Bargain Mart — San Diego.
File Help
Seach  bar | X| | Seach | Aduanced
OrderBy | Mame v] =
Short Name = Street 1 Street 2 Street 3 Street 4
2 Bargain Mart - Oakland BMT-OK Bargain Mart Plaza Comer 182nd and. Anytol
i [EHTSD __[Bagan Mar Plaza [Comer 1820dand. [ liy
24 Bargain Mart Stores Inc. BARMART Bargain Mart Plaza Comer 182nd and... Anytol
e Enter the information for the Note, and click the Add button.
See Also:

Appendix B — Using Data Entry Programs for tabs and common button explanations.
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Sales Reports and Charts

TaiRox CRM and Collections includes sales reports and charts to provide a quick overview of your
company’s sales performance.

e Charts show the Sales Pipeline, Open Opportunities, or Time to Close.

e The Sales Activity Report shows the number of new opportunities, quotes, orders and
communications for a range of users and range of dates.

The Sales Activity Report uses the Crystal Reports engine for Sage 300, letting you print to
standard Sage print destinations and export data to PDF, Word, or Excel spreadsheet formats.

Access: Open the Sales Reports folder, then select the charts or the report that you want to see.

S
Home

v TaiRox CRM and Collections ol

T Sales Reports (Charts)
Collections Reports Licensed to: Don Thomson, TAIROX SOFTWARE INC
Import / Export Dealer:
Marketing G
Periodic Processing

| Sales Reports | I =
Send Documents nn
= 5 Charts Sales Activity Report

S3QE | For Help, press F1 Session Date 20210517 | [y _ |

Note: The Sales Reports do not appear if you are using the TaiRox Collections module without CRM.

CRM and Collections also includes a set of collections charts and reports. See Collections Reports and
Performance Charts for details.

Charts
The Charts program quickly presents opportunity data in various forms.

e Select TaiRox CRM and Collections > Sales Reports > Charts.

e Select the chart that you want to view — Sales Pipeline, Open Opportunities, or Time to Close.
e Choose charting options.

e Click the Create Chart button.

The Charts program creates a completely editable Excel spreadsheet containing the consolidated data
and the chart. The terms “Category” and “Series” are consistent with their use in Excel.

Chart Options Sample Chart
Sales Pipeline
Amounts (in Source)
Chart [ Uss Weighted Amounts Cumency Created 2020-11-01 12:38

»UNQUAL
Close | " QUALIFIED

| | I | = MEETING
» PROPOSAL

o 20000 40000 60000 20000 100000

Amount

Sales Pipeline
Weighted Amounts (in Source)
Chart [ Use Weighted Amounts Cumency Created 2020-11-01 12:40
[Chan Ta “I

= UNQUAL
(Gt o asareo

= MEETING

+ = PROPOSAL
L] 5000 10000 15000 30000 25000

Amount
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Sales Reports

Chart Options

Sample Chart

Chatt Open Opportunities ~| [Use Weighted Amounts Cumency
——
=1

Creai Chart Close

Amount

Open Opportunities
Weighted Amounts (in Source)
Created 2020-11-01 12:43

o.-l—

UNGUAL QUALIFIED MEETING PROPOSAL
Stage

- e Voot prots
Category Expected Clase Date ~| BaseDate [2022:03-13 Group By
o ——

[ Crecte Chart Close

Open Opportunities
Weighted Amounts (in Source)
Created 2020-11-01 12:44

o HH I

202001 2020-02 202005
Expected Close Date - Month

202004

-
Category Date Closed | BaseDate [2022:03-13 Group By
Seres Hurmber of Groups

i
5T

Days.
oBBEEBE3E

Time To Close
Created 2020-11-01 12:46

1 lbidh

P F S F D P DS D D
93"5’90{;@1@99@1@{9&

=ADMIN
. mooN
[ =kETH

WWADE

Date Closed - Month

Sales Activity Report

The report shows the number of new opportunities, quotes, orders and communications for a range of

users for a specified time period.

To print the Sales Activity report:

1. Select TaiRox CRM and Collections > Sales Reports > Sales Activity Report.

2. Specify a date range for the report and the range of users that you want to include, then click the

Print button.

Dete  [20210501

To [20210531

|Q T [z (e}

User  [ADMIN

Frint Close

The Sales Activity Report appears as follows:

2021-05-31 11:05:57AM Sample Company Limited Page 1
Sales Activity
Date  [2021-05-01)Ta[2021-05-31]
Users [ADMIN]To[££777777]
User ID User Name New Opporiunities Hew Quotes HewOrders ~ Communications
ADMIN Administrator 1 1 B 12
DON Don Fenske 12 1 10 18
KEITH keith Rider 10 12 13 20
WADE w/ade Woodsman k] 15 n 18
4 Users pnnted
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Change Log and Change Log Report

CRM logs every change to every field for each key entity, and lets you view all record changes on-screen
and print comprehensive change log reports.

[ )
Home

v TaiRox CRM and Collections "
ra—p— ] Change Log (Change Log)
Collections Licensed to: Don Thomson, TAIROX SOFTWARE INC
Collections Reports Dealer:

Import / Export o

Marketing

Periodic Processing P =

Sales Reports Q

S Docurmente Change Log Change Log Report
Setup.

 TaiRox Productivity Tools .

Sage  ForHelp, press F1 Session Date: 2023-10-24  [Bj

Access: Open the Change Log folder, then select the Change Log icon to view log changes on the
screen, or choose the Change Log Report icon to print summary change log reports.

You can also view change logs for individual entity records by clicking the Change Log button at the
bottom of each entity screen — such as Companies, Contacts, Tasks, or Promised Payments screens.

Viewing Change Logs
Access: Open the Change Log folder, then select the Change Log icon.

To view log entries:
e Choose the entity you want to view, or choose All in the first field to list all entities.

e Enter an ID for an entity in the Entity ID field to filter the list. In this example below, enter Entity ID
“12” to list only the changes for the Company ID 12 — J & Y Builders.

e Enter a search term to find changes fast — like “ADMIN promise” to view all promised payments
added or changed by the ADMIN user.

e Select arow in the top grid to display all changes for the selected record in the bottom grid.

The following example shows company record changes made by Carla. The row for Dr Dan Penn has
been highlighted in the top grid, and you can see the old and new field values in the lower grid.

137 20210525 1:5741PM  CARLA  Company

136 20210525 1:5652PM  CARLA  Company

Modfied By ADMIN CARLA
Moified On 20201017 20210525
Phone Number 5155554728 6466044728
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e Double-click a row in the bottom grid to open a window for side-by-side comparisons. This is
particularly useful for comparing Notes.

Old Value New Value
ADMIN CARLA
20201017 20210525

51555547281

Old Value New Value
[5155554728] 16466044728

| Close

Printing Change Log Reports

The printed log provides a summary of all record changes, listing the CRM use and the changed record.
To see change details, use the change log viewer.

Access: Open the Change Log folder, then select the Change Log Report icon.

The Change Log Report lets you select a range of dates and users to report, choose each of the entities
that you want to include in the report, and choose whether to order the report by date or by user.
To print the Change Log Report:

1. Select TaiRox CRM and Collections > Change Log > Change Log Report.

=

User ‘ “:“ To ‘zzzzzzzz “:“

Include
[ Cases
] Commurications
[V Comparies Nene
] Contacts

] Disputed nvoices

Al

Bt Cose

2. Specify a date range for the report and the range of users that you want to include.
3. Choose the entities for the report.
4. Specify the report sort order.
5. Click the Print button.
2021-05-25 2:18:59PM Sample Company Limited
Change Log - Summary
Date [2021-05-24] To [2021-05-28]
User I [1To[72277727]
Sort By [Date, User ID]
Include: [Companies]
Date User IDY Entity Entity ID  Event Reference
2021-05-25 CARLA Company 1z Modify J &Y Builders Ltd.
Company 12 Modify J &Y Builders Ltd
Company 1 Modify Dr. Dan Penn
2021-05-25 KEITH Company 2 Medify Bargain Mart - Oakland
Company 5 Medify The Courtyard
Company 7 Medify Custom Comfort
Company 13 Modify Mr. Ronald English
Company 19 Modify CanAm Industries
Company 20 Medify The Royal Cavendish Co.
Company 21 Medify The Yoshida Gardens

TaiRox CRM and Collections for Sage 300 81 User Guide



Accounts Receivable and Collections Dashboard and Calendar Views of Assignments

Accounts Receivable and Collections

Dashboard and Calendar Views of Assignments

The Dashboard and Calendar provide two different views of all open tasks, opportunities, cases, tracked
invoices, disputed invoices, and promised payments for the selected day, week, or month that are
assigned to you, all, or no users.

Note: Opportunities will not appear on the dashboard if you are using the standalone Collections module.

These views do not display closed cases, tasks, tracked invoices, or promised payments, or opportunities
that are won/lost. (Tracked invoices includes all invoices — overdue and disputed — with a revisit date.)

For details, see the Dashboard and Calendar sections earlier in this User Guide.

Dashboard view Calendar view

» March - April, 2022

TUESDAY WEDNESDA THURSDAY

u
22 v
A4 5 N
s e FRIDaY saysu -
29 £ 31 Apr1 2
s = DON: Opportumity.. | [ e
Wit Case - B
s s

4 s . ;
1 ]DOMCaed G | WADE: Cae 7 Fi [|ADMIN:Cae 18- | WADE: Cae 3 - Th
, | WADE: e T

Sie
Tack - Megting wih Bargain Mat Scres - renavation
Cpportunty - Weter Sae

Tack - Canies socuromerts ke expected et week - hesp nmind  Candm indsirea
Task - Colection Cal - The Yosda Gardens The Yostida Ganders

e[ ez b owe o

Double-click an item to open a case, task, opportunity, disputed invoice, tracked invoice, or
promised payment.

e Click on the Company Name column heading on the dashboard to open the Company program
for the selected company and view company information.

Notes:

e Today: The session date is used by default on the Dashboard and Calendar screens. If you
change the date, click the Today button to quickly return to the session date, retaining the day-
week-month state.

e Navigation Arrows: Use arrows to the top of the screen to navigate to the previous or next day,
week or month.

e Day, Week or Month: Display items with a revisit date for the selected day, week or month.

e Me, All Users, Unassigned, or Other User: “Me” displays items assigned to the logged in user.
“All Users” shows all items the logged-in user is allowed to see, “Unassigned” shows cases,
tasks, disputed invoices, overdue invoices, and promised payments that are not assigned to any
users. You can also see items assigned to specific other users if you have permission to view
them.

e Refresh button on the Dashboard: This button reloads the data from the database (changing
states does not do this).

o All displayed tasks, cases, opportunities, tracked invoices, and promised payments on the
dashboard are selected and sorted by their Revisit Date. Items without a specific Revisit Time
display 12:00 AM.

See Appendix G: CRM and Collections Security for details on dashboard and calendar security settings.

TaiRox CRM and Collections for Sage 300 82 User Guide



Accounts Receivable and Collections Customer Aging

Customer Aging

The Customer Aging program in the Collections folder provides a lightning-fast way to see customer
aging information, print a quick report, and drill down to overdue and disputed invoices, tracked invoices,
communications, collection cases, promised payments, and notes for the displayed customers.

Change Log

v TaiRox CRM and Collections @

Collections (Customer Aging)

Collections

I Licensed to: Don Thomson, TAIROX SOFTWARE INC

Collections Reports
Import / Export
Marketing

Periodic Processing
Sales Reports

Send Documents

Setup

Soge | ForHelp, pressFi

Dealer:
cc

R R R R | |

| Q Q Q Q ‘2 ‘s
Customer Aging | Disputed Invoices  Overduelnvoices  Tracked Invoices  Promised Payments  Overdue Payment  Payment Due Alerts
Reminders

[:#] Session Date: 2023-10-24

Customer Range

Corert o 2290710
BsOFDate [20220801 | gy T 0] 5117 950] | ect Customers By T T
ate 75} . ~
P02 0401 | 431 Bl 5 ] | omemer Mber d s N
Cut-Off Date :ml :Ml %l Billng Cycle | [BILLMT ) [BILLMT Q
;”"T"“" Souree ~ Nl o/ —o — [Goce =] e Q W Q
TR
ummary E Tertory Code - ‘ 727772
nclud Curent 164,215.090]
Age Unappied Credit Notes and Deb Notes Exciude Disputed invoices «ffmm—
Bge Receipts, Unapplied Cash and Unappied Prepayments | By Date | EAGr Shaw Desiments Dverde by or More Days. e Go
5 Customer Number  [BCompany Name Cumency  Customer Group Days Overdue
100 Bargain Mart - San Disge USD wHL ] 3256 0.00 9269 18862
105 Bargain Mart - Oakland USD WHL il 732284 778223 000 101648
240 The Coutyard ©ousm we % 000 000 451844 000
1400 Cosstal Flectric Company ~~ $7+  CAD  WHL 5 50190 sTREs 2315871 000
1500 Custom Confort s we 7 000 6745645 000 000
1550 Aatsl Construction Co Lid USD WHL . 000 000 2051213 000
1580 Break-Away Desians USD WHL 58 o0 000 17844395 000
7100 Bashaw Buldozng | owe 2 0.00 35057 0.00 000
7300 The Royal Cavendish Co GBP WHL 4 1455053 444896 17.00409 om0
7400 The Yostida Gardens s PN WHL 5 [ 1800 8737 [}
< >
Page of 1 Expott. Print Close

Select “Summary” or “Detail” from the Display dropdown and click the Go button to view outstanding
accounts. You can also print the data on the screen and export it to an Excel spreadsheet.

Notes:

The above screen provides a “Summary” display with one summary line for each customer that
matches the selection criteria.

e You

@)
O
@)

O

can select options to match the Sage 300 aging calculations.

The As-Of Date lets you specify the date on which to report the receivables.

Enter a Cut-Off Date to only include transactions that are on or before the date you specify.
Use the “Include Current” checkbox to display or exclude the current amounts. Note that you
can set the number of days overdue to include as “current”.

Select all or a range of customer numbers, national accounts, customer groups, billing cycles,
short names, account sets, territory codes, currency codes, current customer currency
balance, current functional currency balance, customer name, salesperson code, on-hold
status, start date, or customer optional fields.

Age unapplied documents as current or by date.

Select “Exclude Disputed Invoices” to ignore disputed invoices. (See Disputed Invoices.)
Only show documents overdue by x Days or more. (This is a display option only. It does not
affect aging totals, and it does not affect aging reports or exported data.)

e Each line shows the collection buckets for a customer on the As Of Date. This date defaults to the
session date, but you can change it with the pop-up calendar.
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e Totals for each aging period are displayed at the top of the screen. Note that aging totals only
include the amounts for customers that are included in the selection criteria.

e The Flags column shows if the customer account in A/R is on hold (*) or has unapplied credit ($),
and whether the company has open cases (!), disputed invoices (?), or promised payments (+).

Choose “Detail” from the Display dropdown, and click the Go button, to view outstanding documents
— as below.

e The Customer Aging Detail grid shows unpaid documents.

[H Customer Number 8 Company Name Curency  Customer Group  [H Documert Number ~ Documert Type  Document Date Document Amount

1100 Bargain Mart - San Diego [ UsD WHL TRANV-001 Invoice 2022-01-01 1.397.20 1,84
1100 Bargain Mart - San Diego ! usD WHL TRINVOT1 Interest 20220207 9269 E
1105 Bargain Mart - Oakland usp WHL TRINV-002 Invoice 20220201 1,126.51 101
1105 Bargain Mart - Oaldand #  USD WHL TRINV-008 Invoice 20220301 732284 778
1240 The Courtyard ! usp WHL TRINV-004.1 Inveice 20220202 541959 464
1400 Coastal Electric Company $7+  CAD WHL TR-INV-006 Invoice 20220115 1.139.62 9
1400 Coastal Electric Company $?+  CAD WHL UC0000000000000000...  Unapplied Cash  2022-02-03 2563223 -2313
1500 Custom Cormfort ! usD WHL TR-INV-004.2 Invoice 20220202 68.006.48 6745
1550 Astral Construction Co Ltd. $  UsD WHL PY0000000000000000...  Receipt 2022-02-21 -568.204.49 -19.81
1550 Astral Construction Co Ltd $  usD WHL UC00D000000000D000... Linapplied Cash ~ 2022:02-19 -696.16 69
1580 Break-Away Designs UsD WHL PPO000000000000000...  Prepayment 20220219 1542381 -10
1580 Break-Away Designs usD WHL TRINV-005.1 Invoice 20220130 178,007.33 178,54
7100 Bashaw Bulldozing 1 caD WHL TRINV-0D5.2 Inveice 20220206 2844232 5
7300 The Royal Cavendish Co. GBP WHL TRLRE-004.2 Invoice 20220227 13365 1
7300 The Royal Cavendish Co. GBP WHL TR-NV-005.3 Invoice 20220209 19.058.97 17.80
7400 The Yoshida Gardens JPN WHL PP0000000000000000...  Prepayment 20220204 93,298 -8
7400 The Yoshida Gardens $ PN WHL TRANV-010.2 Invoice 20220204 812

7400 The Yoshida Gardens $ PN WHL UC00D000000000D000... Linapplied Cash ~ 2022:03-10 12638 11
< >

e The Flags column for documents shows disputed invoices (@) and invoices with payment
schedules (#), and shows if the company has promised payments (+), unapplied credit ($), open
cases (!), or other disputed invoices (?), and whether the customer account in A/R is on hold (*).

Drill Down:

e Click the Customer Number column heading to open the A/R Customers window (or A/R
Extended Customers if you have TaiRox Productivity Tools).

e Click the Customer Name column heading to open the CRM and Collections Company window.

e Click the Document Number column heading on the Detail grid to display the original document in
A/R or O/E.

e Double-click a row to open the Customer Information window — to view customer invoices, case
information, documents, notes, communications, disputed invoices, overdue invoices, tracked
invoices, and promised payments.

Adding a New Collection Case, Disputed Invoice, Tracked Invoice, or Promised
Payment for a Customer

e Double-click the customer row to open the Collections window.

e Go to the Tasks tab, Disputed Invoices tab, Tracked Invoices tab, or Promised Payments tab.

Bargain Mar - San Diego
Bargain Mar - Oakland [

1200 Mr. Ronald Black ” Customer Number ]ﬁo | ENC] ‘Mr. Stephen Kershaw

1210 ACME Plumbing

1240 The Coutyard 0 |[&=2 Eniz

1400 Coastal Bectric Company [ 118938 [USD 158308| [cAD

150 Coron ot A sl |

T e Sicsten Kershicn g | I | T Average Daysto Pay Nuber o Paid ices

1580 Break-Away Designs s OF Dete E=rt 1-30 31-60 61-90 Over 90 Total

1600 Dr. Dan Penn

1970 M. Ronald Engish 20220711 [ 0o | 0.00] | 000 | 118936 [ 000 | 1.189.36]

4030 The House Doctors T

T Boshaw Buldoang 0 : Cases INmes c Disputed Invoices IDvefdue Invoices  Tracked \nvmcesl Promised Paymerts I

7200 CanAn Industries !

7300 The Royal Cavendish Co. L] Only Show Overdue Invoicss feredits are always shown)

7400 The Yoshida Gardens

8830 ‘The Paper Hangers ! Document Number Documert Type Documert Date Onginal Amount ~ Remaining Amount  Days Overdue

BARMART Bargain Mart Stores Inc. INOODDO0D000019 Invoice 20220403 20220415 384669 7] 87
INOODDO00000020 Invoice 20220404 20220415 631.80 9439 87
INOODD000000042 Invoice 2022:0405 20220415 244580 660.75 &7

e Click the Add button at the bottom of the tab.
|« 3

Pae [ 0 cf0

Delete

Close

You can also add notes and communications by choosing the appropriate tab and clicking Add.
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e Fillin the case, disputed invoice, tracked invoice or promised payment information, assigning the
employee and the revisit dates for cases, disputed invoices, and promised payments.

&
| .

This example shows the screen
ooy e S for adding a new case.
Created On - Created By ]
Wodbedon || woateany | ]
Type Collection v
oy P
eite [ __]Q
s
Gvion  [FTTT 1t
Revist On -
Stage 1Q [
Notes
Comment.

Copy Documents Folder. Change Log.

Add Delete Close.

Printing an Aged Trial Balance

To print customer the aging results on the screen:

e Select the criteria for the customer aging report, and click the Go button.
e Click the Print button at the bottom of the screen to print the results.

I i
0354720 ‘Select Customers By |me ~ To
Q |[ZZzzzzzzzzzz

Customer Number

105.967.650]
Group Code.
0.000)
(None)

[ o=
116.319.640|

leiellx

[17o [9599]
To [ETL]

sent Y]
ota, it Note, Interast, Urappliad Cask, Prapaymant, Racspt, Refimd, Adusmant]

&5
[Customer Cammey]

L3 w6 60 Over 50
Doc.Daie  DueDateor CheckRecpt No. Current Day Days Day: Ds Totul
1200 Ms Ronald Blak
N IN0000000000IS 142806 142806
N TRCRE06 26461 26461
N TRINVO03 10596765 10596765
D X} Ti%% 7% X} T06.23228 10768032
1520 Me Staphen Karshare
N IND00000O00O0IS 329669 329668
N INO0000000002D 6315 43150
usD ) T3R8 % ) 70 TIRE
1600 D DinPam
N TRINV-0101 10,0912 1009012
UC UCO0000000000000000005 1014 10142
usD BT % 7% ) 00901 EEER]
‘Report Touk usD poE T3S 7% ) TE3E% TIS7751
DB: Debic Note I Ervotce IT: Inserest Charge PI: Prepayment UC: Unapplied Cash MC: Miscellansous Recefe
cF z a DF: Applisd Db (fomi I ED: Earned Dizcount T
GL: Gatnor Loz (mulizurrancy lsdeos) B Becsipr O -0 ED: Rounding F: Refrd

Note: The program matches rules for the Aged Trial Balance reports in Sage 300 A/R. This means:

e lItignores options to “Exclude Disputed Invoices” and “Only show documents overdue by x days”.

e |t also ignores the “Age Unapplied Credit Notes and Debit Notes” and the “Age Receipts,
Unapplied Cash and Unapplied Prepayments” options.
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Exporting an Aged Trial Balance to a Spreadsheet

To export the customer aging results displayed on the screen:

e Select the criteria for the customer aging report, and click the Go button.

e Click the Export button at the bottom of the screen to export the results to an Excel spreadsheet.
e Choose the path and filename for the spreadsheet file.

[ )| CotenerFeme
Select Customers By From To

AsOFDate [20221205 |1 10,354 73] - .

e 22120 ] Customer Number [ Q [z Q

CuCHDate | - |m 105,967,650 i

Group Code

~][RTL 1 R ]
Curency 0.000) ‘ ‘ ‘
{Nene) ~
Display 0,001
{None) v

116.319.640)

Include Curent

Page of 1 Expott Bt Close

Summary Spreadsheet:

£ Search (A+Q)

file  Home Inset  Pagelayout  Formuas  Data  Review View  Add-ins  Help Bl Tools © Comments 4 Share
D14 - F | =sum(D2:D13) d
A [ c [ 3 F € H 1 B
1 CustomerNo.  Customer Name Currency Current 1-30 31-60 61-90 Overso Total
2 f100 Bargain Mart - San Diego usp 0.00 1838.48 0.00 0.00 0.00 1898.48
3 1105 Bargain Mart - Oakland usp 0.00 1016.48 0.00 0.00 0.00 1016.48
4 200 Mr. Ronald Black usp 264.61 105967.65 0.00 0.00 0.00 106232.26
5 f210 ACME Plumbing usp 0.00 204215.45 0.00 0.00 0.00 284215.45
6 (1240 The Courtyard usp 4163.34 0.00 0.00 0.00 0.00 4163.34
7 [1500 Custom Comfort usp 63006.48 0.00 0.00 0.00 0.00 63006.48
8 1520 Mr. Stephen Kershaw usp 0.00 35158 0.00 0.00 000 35158
9 1550 Astral Construction CoLtd. usp 542662.42 0.00 0.00 0.00 000 542662.42
10 1580 Break-Away Designs usp 0.00 172901.68 0.00 0.00 000 17290168
11 1600 Dr. Dan Penn usp 10230.58 0.00 0.00 0.00 000 10230.54 |
12 7100 Bashaw Bulldozing cap s779.62 0.00 0.00 0.00 000 5779.62
13 [7300 The Royal Cavendish Co. cep 7194.80 0.00 0.00 0.00 0.00 7154.80
1 642301.81 568371.32 0.00 0.00 000  1210673.13
=
sheett | @ oI ] |
Ready T3 Accessibility: U i) M - ————+ 100m

Detail Sheet:

£ search
fle  Home et Pagelaout Formas  Dafa  Revew View  Addvins  Hep Bl Tools © Comments 5 Share -
H2s - # | sumimarsan
A 5 c o £ 3 [ H ' J % L ]

1 Customer No. Customer Name Currency

1100 Borgain Mart - San Diega uso
3 DowmeniType  Dowment No. DocumeniDate  DueDate ShipTolor., PO Number Cument 1w -6 -9 overso Total
4 inwoice. TRNv-001 m.0101 220110 ssaant 000 185848 [ .00 0o 189648
s o0 prers [ 000 0m 199,48
5 Date UseriD note
7 2022.01-10 ADMIN Customer aims axcess shigping chargas an invoice.
s
S Customer Mo, Customer Name Currency
10108 Bargain Mart - Gakland uso
11 DoumentType  Decument N, DocumeniDafe  DueDale StipTolor, PO Number Curent 1w -8 £-90 Overs Total
12 invoice TRINv-002 Wr0101  W20110 27483 000 L0165 o0 000 000 101545
13 [ 1osa [ wow ] 101608
1 Date Useri Mot
13 2072.01-10 ADMIN Let Keith know If there are any Issues wiih collections, The customer may have some cash-law issues.
15
17 Customer o, Customer Name Curency
18 fiz00 M. Ronald Bladk uso
15 DocumentType  Document o, DocumentOate  DueDate ShipTolor. PO Number Current 10 T 190 oversn Tol
20 ivorce TRCRE-006 maoa02 Wz 20461 0 000 000 00 861
21 nvoice TRANV-003 maor B2 n7n 0w wsosnes 0.0 v 00 10596765
n o061 10596765 [ w00 oo 10629226
n
34 Customer to. Customer Nama Currancy
5 0 ACME Plumbing uso
25 DoumentType  Documentio, DoumentDale  DueDate ShipToloc, PO Number cument 10 -8 61-90 oversn Tol
27 inwoice TRANV-007 maperer  mmarn oo musas .00 0 zmansas
| [ T o o o maess

gl

nea B m oo - ' o

Note:

o If “Include Current” is not selected, the Current column will not be included in the export.

e Document details include the ship-to location and the PO number.

o Notes on the detail report appear following customer summary lines.

e An Aging Summary includes the totals of each exported currency in multicurrency systems.

--- SUMMARY ---
Currency Current 1-30 31-60 61-90 Over 80 Total
uso 17,145.27 67,456.45 193,648.25 108,832.75 0.00 387,082.72
CAD -21,208.46 978.68 0.00 0.00 0.00 -20,229.78
-4,063.19 68,435.13 193,648.25 108,832.75 0.00 366,852.94
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Collections Information — Drilling Down from Customer Aging

Collections Information — Drilling Down from Customer Aging

e Double-click a row in the Customer Aging grid to view the Collections screen.

The Collections screen displays collections-related information, including the transactions, cases,
notes, communications, disputed invoices, overdue invoices, tracked invoices, and promised
payments for the customer, along with the customer credit limit, balance, terms, average days to

pay and number of paid invoices.

e You can also access the Collections screen from the Company window, Overdue Invoices,
Overdue Payment Reminders, and Payment Due Alerts.

See Companies, Overdue Invoices, Overdue Payment Reminders, and Payment Due Alerts.

Note:

o If you open the Collections screen from the Customer Aging window, the program ages
documents based on the settings that you specify on the Customer Aging screen.

o If you open the Collections screen from the Companies window, the program ages
documents based on the default aging periods specified in Accounts Receivable.

Transactions tab:

T | ] am L T i

I et o ot i s

E -

Cases tab:

=

Click the buttons between the Customer Number
and Customer Name to drill down to the A/R
Customer record and to Customer Inquiry.

Click the Checkbox to show only overdue
invoices.

Click the Document Number column heading to
view the entry details for the selected document in
A/R or O/E — such as the invoice or receipt.

Click the buttons between the Customer Number
and Customer Name for customer information.

Select “Show Closed” to see closed cases.

Double-click a case in the grid to open the Case
window and view case details.

Click the Add button to add a new case, or click
the Delete button to delete the selected case.

For more information, see Cases.

Notes tab — for notes added to the company:

TaiRox CRM and Collections for Sage 300
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Click the buttons between the Customer Number
and Customer Name for customer information.

Double-click a note in the grid to open the Note
window and view the note details.

Click the Add button to add a new note, or click
the Delete button to delete the selected note.

For more information on notes, see Notes.
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Communications tab — for all company communications:

Click the buttons between the Customer Number
and Customer Name for customer information.

Double-click a communication in the grid to open
the Communication window and view the details.

Click the Add button to add a new
communication, or click the Delete button to
delete the currently selected communication.

For more information on notes, see
TR S ’ Communications.

=1

Disputed Invoices, Overdue Invoices, Tracked Invoices & Promised Payments tabs:

These tabs show disputed invoices, all overdue
invoices, tracked invoices, and promised
payments for the current company.

Select “Show Closed” to see closed disputed
invoices, overdue invoices, or promised
payments.

Choose a tab, then double-click an item in the grid
to view the details. Click the Add button for
disputed invoices, tracked invoices, or
promised payments to add a new item.

For more information, see:

e Disputed Invoices e Overdue Invoices
e Tracked Invoices e Promised Payments

Note the following points:

Disputed Invoices lets you track invoices that are being disputed by a customer. See Disputed
Invoices.

Overdue invoice records are created and displayed on the Overdue Invoices screen and on the
Overdue Payment Reminders screen.

The Flags column shows disputed invoices (@) and invoices with payment schedules (#), and
shows if the company has promised payments (+), unapplied credit ($), open cases (!), or other
disputed invoices (?), and whether the customer account in A/R is on hold (*).

Promised Payments document the special arrangements for payment from customers with
overdue or disputed invoices.

Tracked Invoices are all invoices with attached notes or documents, or have an assigned user or
revisit date, or are on hold.

If you add a note or document to a disputed invoice or overdue invoice, that invoice becomes a
tracked invoice and will also appear on the Tracked Invoices tab, along with all notes and
documents.

All notes and documents on these tabs are also accessible through the Notes and Documents
programs.
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Disputed Invoices

Disputed Invoices lets you track invoices that are being disputed by a customer.

If you add documents or notes to a disputed invoice, the disputed invoice will also appear on the Tracked
Invoices screen, where you can also see the attached documents and notes.

e You can assign disputed invoices to a specific user or leave them unassigned.

o Disputed invoices appear on the Dashboard and Calendar according to the revisit date you
specify.
Assigned disputed invoices appear on the assigned user’s dashboard. Unassigned invoices
appear on the dashboard when you view items for All users.

e An option on the Customer Aging screen lets you include or ignore invoices in dispute.

e Disputed invoices are flagged on the Overdue Invoices and_Overdue Payment Reminders screen,
so you can hold reminder emails.

e You can add as many documents and notes as you want to disputed invoices to track activity.

Access: Open the Collections folder, then open Disputed Invoices.

L]
Home

~ TaiRox CRM and Collections o

ChangeLog Collections (Disputed Invoices)

Collections

Collections Reports

Licensed to; Don Thomson, TAIROX SOFTWARE INC
Dealer
Import f Export =

Marketing

Periodic Processing ?

Disputed Invoices

R

Overdue Invoices

)

Tracked Invoices

Promised Payments  Overdue Payment  Payment Due Alerts
Reminders

‘2 2

«

Customer Aging

Sales Reports

Send Documents.

Setup

Soge

For Help, press F1 Session Date: 2023-10-24 | [B§

Search [

Order By

[ Customer Number V] & |cﬂmpaw Bargain Mart - 5an Diego

Status
Open

[ Closed

e Customer Humber Company Name

Bargain Mart - San Diga

[ Invoice Number invoice Date  Due Date Invoice Amount Balance Amourt in D

%] | Search Advanced

[BMT-5D  |Bargain Mart Plaza [C:
B T

Bargain Mart Plaza  Comer 182nd and.

24 Bargain Mart Stores Inc

To Search for disputed invoices:

e Use the top Search field on the form to find disputed invoices.

Enter a partial invoice number, customer number, or company name in the Search field at the
top of the screen, and press the Enter key.

You can also enter values for company optional fields, so if you have a “sales rep” company
optional field, you can search quickly for disputed invoices for a particular sales rep.

Click the red X that appears to remove Search terms. = — X][ s

e}

o

e Use the Company Finder (shown above) to search for a single company.

o Click the Finder button () at the end of the Company field (shown below) and enter part of
the company name to restrict disputed invoices to a single company.

o Click the red X beside the Company field to remove the company filter.

Search I | Search

Order By [ customer Number v| s Company [Bargain Mat - 5an Dieg x| Q
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Notes:
e Click the Status checkboxes to display both Open and Closed disputed invoices.
e Double-click a disputed invoice in the grid to view the disputed invoice information.
e Click the Add button at the bottom of the screen to add a new disputed invoice.

¢ Disputed invoices include a “Documents” tab and a “Notes” tab where you can add the details for
disputed invoices.

e Use the Disputed Invoices Report to view the status of disputed invoices.

Drill Down:

e Double-click a row in the grid to open up the Disputed Invoice information screen.
e Click the Invoice Number column heading to drill down on the invoice.

Search [ | | Search
Order By [ Customer Number ] % Compary [Bargan Mar -San Diego %] Q

Status

Open [ Closed

ID Status  [B Invoice Number [ Customer Number  [H Company Name Invoice Date  Due Date WoicE o Amourt in Dif

INO0DO0D000006D Bargain Mart - San Diego

e Click the Customer Number column heading to drill down to the A/R Customer (or Extended
Customers form if you have TaiRox Productivity Tools).

Search [ | search
Order By [ Customer Numper “] % Company [Bargan Mani-San Diego x| 2

Status

Open [ Closed

ID Status  [B Invoice Number [® Customer Number M Company Name Invoice Date  Due Date Invoice Amount Balance Amourt in Dif
Bt - San Diego

Customer Number 4 4

Customer Name |Bargain Mart - 5an Diego |

Address Contact Processing Inwoicing Optional Fields  Statistics  Activity Comments

National Account No |BAHMAHT |Q |Bargain Mart Stores. Inc. ‘

e Click the Company Name column heading to drill down to the CRM company information.

Search [ | | Search
Order By [ Customer Number “] % Company [Pargan Mar -San Dego %] Q

Status

Open [ Closed

ID Status  [H Invoice Number M Customer Number Name v o 01 Balance Amourt in Di

D [ TQ + Name [Bargsin Mat-San Diego ‘

Company Optional Fields Cortacts Opporiunities Documerts Cases  Motes Communications

Created On By Ezmhiris ENa)
Modfied On Modfied By Eoerey USD ]

[inactive

P 1 Casels) Collections

1 Disputed Invoicels)

Street 1 [Bargain Mar Plaza |3 9 Overdue hvoicels)
Street 2 Comer 182nd and 34h Street | Promised Payment(s)
See Also:

Appendix A - Common Screen Operations for searching, sorting, tabs and common button explanations.
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Disputed Invoices — Add/Edit

Access
click an

: Click the Add button on the Disputed Invoices screen to add a new disputed invoice or double-

existing row to view the disputed invoice record.

Disputed Invoi

Created On
Modffied On

Description

Revist On
Assigned To

Status
Notes

Save

o [ 825

Company Name |Bargain Mart - San Diego I [ I

Customer Number E R
Invoice Number ||NDDDDDDDDDDDGD D L
Invoice Date Invoice Amount uso

Amount in Dispute 54.00

ce  Documents Motes

EROETS | conesy
s

|Ship within 2 days

2020-07-28 Rewisit At 00:00:00
'WADE Q

T | cerscven [ ]
- Company says that item on invoice damaged and new item was added to separate order
- Shipping believes that replacement was shipped immediately and that additional item was in second order
Change Log...
Delete Cloge

Notes:

Drill D

Click the green Plus button beside the ID field (<) to add a new disputed invoice record.
Click the Finder button (") beside the Company name field to choose the company with the
disputed invoice. (The Finder becomes inactive after you add the invoice.)

Select the disputed invoice using the Finder beside the Invoice Number field.

Enter a disputed amount. You can order disputed invoices by disputed amount on the Disputed
Invoices screen, helping you focus on larger disputes.

Enter a Revisit On date. This determines when disputed invoices appear on the Dashboard. You
can also enter a Revisit Time after the Revisit date. Enter time in 24-hour format (e.g. 13:00).

Assign the disputed invoice to an employee so it will appear on their dashboard. If you do not
assign the invoice to a particular employee, it will appear when you view items for “All.”

Days Open shows how long the dispute has been open — or was open before it was closed.
Change the status to Closed once the invoice dispute is resolved.

The Notes field can be up to 250 characters long. Click the Notes tab to add notes up to 2,500
characters long for the disputed invoice.

Click the Change Log button to see the details for recent changes.

own:

Click the Drill-Down button [ by the Company Name to drill down to Collections company data.

Click the Drill-Down button [ by the Customer Number field to view A/R customer data with the
Extended Customers screen.

Items on the Documents and Notes tabs appear with Tracked Invoices:

All disputed invoices with attached notes or documents appear in the Tracked Invoices program
with the same list of documents and notes.
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You can attach and view documents and notes for invoices using Disputed Invoices, Overdue
Invoices, and Tracked Invoices programs. The attached items are displayed on the tabs of all
three programs.

When you add a note or document to an invoice using the Disputed Invoices or Overdue
Invoices program, the invoice will appear in the Tracked Invoices program.

All documents added to the Documents tab are also accessible through the Documents program.

All notes added to the Notes tab are also accessible through the Notes program.

Dragging and Dropping Documents into the Invoice Documents Folder and
Linking Documents to a Disputed Invoice

CRM and Collections lets you link any documents to a disputed invoice. You can use drag and drop to
attach documents and copy them to the Tracked Invoices Documents folder defined in Setup Options, or
you can link any existing documents on your computer to a disputed invoice record.

Drag and drop copies documents for Tracked Invoices, Overdue Invoices, and Disputed Invoices to
the Tracked Invoices folder specified in CRM and Collections Setup Options.

Note the following methods for adding documents to disputed invoices:

Use Drag and Drop on the Documents tab to copy documents to the tracked invoice document
folder for CRM and Collections (see Document Folders tab in Setup Options).

Documents that you drag and drop are added to the Documents tab for the disputed invoice, and
you can view them on the Documents tab for Tracked Invoices. They are also copied to the
tracked invoice document folder, and added to the list of documents maintained by the
Documents program in CRM and Collections.

Use the Add button on the Documents tab to link to a document and add it to the list on the
Documents tab.

When you use the Add button, the document will be added to the list maintained by the
Documents program in CRM and Collections, but the document will NOT be moved to the tracked
invoices document folder.

Use the Link button on the Documents tab to link to a document and add it to the list on the
Document tab.

When you use the Link button, the program displays the list of documents maintained by the
Documents program in CRM and Collections, letting you choose a document to add to the
disputed invoice’s list. The document will NOT be moved to the tracked invoices document folder.

To drag and drop documents and move them to the Tracked Invoices document folder:

1. Click the Documents tab on the Disputed Invoice screen (see below).

2. Drag and drop a document onto the Documents tab. (The grid border turns green, and the pointer

shows that you are dragging a document.)

D 1Q +

Dispued Invoice | Documents INmas

Search [ Search | Adyanced...
Order By [ Hame M
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3. When you release the document, the grid displays the new document, showing the path to the
documents folder.

o [ 43+

Disputed Invoice = Documents  Notes

Search [ || search | Advanced

Order By [ Mame ] -

[= Document

37 Price List - Office Renoxdsx F:\Sage\Sage300"SharedData‘compa...

See Also:

Appendix B — Using Data Entry Programs for tabs and common button explanations.
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Overdue Invoices

The Overdue Invoices program displays a selectable and sortable list of overdue invoice records.

e Click the Update button to recalculate the list of overdue invoices using today’s date.

The
and

program creates new overdue invoice records, updates existing records for overdue invoices,
closes records for paid invoices.

e Double-click an invoice to open the “tracked invoice” record for the invoice.

o

You can attach documents and notes to overdue invoice records to track activity.

If you add documents or notes to an overdue invoice record, the overdue invoice will also be
listed on the Tracked Invoices screen.

You can put invoices on hold and select a reason for the hold.

CRM will not send overdue payment reminders to customers for “on hold” invoices.
Use the “Show On Hold” checkbox to include/exclude on hold invoices from the list.
You can display prior overdue invoices by selecting the Closed checkbox.

You can assign overdue invoices to a specific user and set a revisit date.

Assigned overdue invoices appear on the assigned user’'s Dashboard and Calendar
according to the revisit date you specify.

If you set a revisit date, but do not assign the invoice to a specific user, the invoice appears
on the dashboard when you view items for All users.

Use the Overdue Payment Reminders program to assign user tasks for overdue invoices.

e Click the “Process Overdue Payment Reminders” button to go directly to the Overdue Payment
Reminders program to send emails to customers and to create tasks for following up on overdue
payments. See Overdue Payment Reminders.

You can also view overdue invoices and overdue accounts on the Customer Aging screen.

Access: Open the Collections folder, then open Overdue Invoices.

0
Home

v TaiRox CRM and Collections ~
Change Log Collections (Overdue Invoices)
Collections Reports Dealer
Import / Export. c
Marketing
Periodic Processing oy i

£ £,
X ) R R ) 7 :
CustomerAging  Disputed Invoices | OverdueInvoices | TrackedInvoices  Promised Payments  OverduePayment  Payment Due Alerts
Send Documents: Reminders
Setup .
Sage | For Help, pressF1 [ Session Date: 2003-10-24 | [

Search [

| Search

Ordler By [ Customer Humber |~ G 19

Status
Open [JClosed

2 Open No

3
Last Updated [20210301 | [10:14:08 | g, [ADMIN Update

Process Overdue Payment Reminders..

Company Neme [ Ihvoice Number Days Overdue Invoice Date Balance Curency

Bargain Mart - San Diego TRANV-001

1100 Bargain Matt - San Diego TRINV-OTT 2 20210207 5265 USD
3 Open No $ 105 Bargain Matt - Oakland TRINV-002 52 20214101 101648 USD
4 Open No 11200 M. Ronald Black TRCRE0E 16 20210202 26461 USD
5 Open Yes 11200 M. Ronald Black TRANV-003 4 20210101 10596765 USD
6 Open Ho | 1240 The Coutyard TRANV-004.1 17 202140202 4548.44 USD
7 Open No 1580 Break-Anay Designs TRINV-005.1 2 20210130 178.552.39 USD
8 Open No 1600 Dr. Dan Penn TRINV010.1 16 202140208 10.090.12 USD
9 Open No 7300 The Royal Cavendish Co TRANV-005.3 19 20210209 17,804.09 GBP
10 Open No 7400 The Yoshida Gardens TRANV010.2 2 2021020 74 PN
< >
Page of 1 Close
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e The Flags column shows disputed invoices (@) and invoices with payment schedules (#), and
shows if the company has promised payments (+), unapplied credit ($), open cases (!), or other
disputed invoices (?), and whether the customer account in A/R is on hold (*).

e Additional grid columns show on hold status for the invoice, assigned users, and revisit dates.

e Click the Invoice Number heading to drill down to invoice details.

Using the Search Field and the Company Field to Look Up Overdue Invoices

Use the Search field and the Company field to restrict the display of overdue invoices to a group of
companies or to a single company.

e Use the Search field at the top of the screen to filter your overdue invoice selection.

| = | ~ X [ search

Order By [ Customer NumBew, v % Company | S
Status Last Updated |2021-03-29 | |m 3538 | By |ADM\N Update
A 0pen [ Closed &) Show On Hold

Process Overdue Payment Reminders

ID Status OnHold [HFags [H Custome: Number  [E Company Name Invoice Number Days Overdue Invoice Date Balance Cumency|
Bargain Mart - 5an Diego TR-INV-001 2021-01-01 184862 USD

Bargain Mart - 5an Diego TR-INV-011 202102407 9269 USD
Bargain Mart - Oakland TR-INV-002 2021-01-01 1.016.48 USD

In this example, we entered “bar” as the search string to look up overdue invoices for all branches
of Bargain Mart. You can also use the Company field to look up invoices for a single company.

o Click the red X at the end of the Search field to remove search terms. e

Search using company optional field values: You can also enter values for company optional
fields in the Search field. For example:

o If you have a “sales rep” company optional field, you can search quickly for overdue invoices

for a particular sales rep.
o If you have a “terms” optional field, you could do a special run for a particular group of
customers.

e Usethe Company field at the top of the screen to list overdue invoices for a single
company.

Search

Search [

Order By [ Customer Number o] |Com,,a,., M. Ronald Black. X]| f."l
Status Last Updated [20210329 | [1038:38 | By [ADMIN Update
[AOpen [ Closed [ Show On Hold
Process Overdue Payment Reminders..

ID Status OnHold [ Fags [B Customer Number  [H Company Name [8 Invoice Number Days Overdue Invoice Date Balance Cumsncy|
TRCRE-008 2021-0202 26461 USD
Mr. Ronald Black TR-NV-003 60 20210101 105.967.65 USD
o Use the Company field to view overdue invoices for the selected company only.
o Click the Red X to remove the company filter.

In this example, in the above example, we are listing all invoices for Ronald Black.

Overdue aging perdiods are specified in Setup Options.

Double-Click an Invoice to Add Notes, Track the Invoice, and Change the Invoice
Status

The program opens the Tracked Invoice screen when you double-click and invoice, allowing you to attach
additional invoice information and change the status of the invoice. You can:

¢ View summary invoice information and drill down to customer and invoice details.

e Add the invoice as a new Tracked Invoice.
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e Assign the invoice to a user and add a revisit date so it appears on the user’s dashboard.
e Add notes and documents to the invoice.

e Put the invoice on hold.

Note: All on-hold invoices, assigned invoices, and invoices with attached notes or documents are
Tracked Invoices.

You create a tracked invoice when you click the Add button on the Tracked Invoices form.

Search [ | | Search
Order By | customer Number = Company [MrRonald Black x| Q
Status -
Last Updated  [2021-06:29 | [10:33:38 | By  [ADMIN Update
Open [Closed [ Show On Hold

Process Overdue Payment Reminders

ID Status OnHold  [H Fags Customer Number Company Name [H Invoice Mumber verdue Invoice Date Balance Curency|
Mr. Ronald Black TR-CRE-006 20210202 26461 USD

TR-INV-003 [0 20210101 105.967.65|US

D

Tracked Invoice  Documents Notes

Company Name  [Mr. Ronald Black R
- pe—"rs
Modfied On Modified By
Customer Number B R
Document Number L]
Document Date Amount USD
Due Date Balance
g Frern [lnv With Dist Code Dt Line Aopling Orly Two Lines For Dis 2
Page|  grate Close
Revist On Revist At
Assigned To Q

e You can attach documents and notes for any overdue invoice on the Documents and Notes tabs.

You can attach and view documents and notes for invoices using the Overdue Invoices program,
Disputed Invoices program, and Tracked Invoices program. The attached items are displayed on
the tabs of all three programs.

e You can assign invoices to users — to Keith, in the above example.

e You can put invoices on hold and select a reason for the hold.
e All documents added to the Documents tab are also accessible through the Documents program.
e All notes added to the Notes tab are also accessible through the Notes program.

Drill Down to the Original Invoice, Collections Data, CRM Company Record, and
A/R Account Record

Search I | | Search
Ordler By | customer Number ~| % Company | Q
Status
Last Updated 20220517 | (143654 | gy  [ADMIN Update
Open [JClosed [ Show On Hold

Process Overdue Payment Reminders

ID Status On Hold Flags [H Customer Number any Name [H Invoice Number Days Overdue Invoice Date Balance Cumency|
Barga an DIego Sy 20180101 184862 USD
7 Open Ne # 100 Bargain Mart - San Diego TRANVOTT 38 201302407 9269 USD

e Select the invoice/company that you want to view data for, then click the column heading to drill
down to the data you want.
o Click the Invoice column heading to view the original invoice information.
o Click the Flags column heading to view collection data. See Collections Information.
o Click the Company Name column heading to view company information maintained by CRM

and Collections.
o Click the Customer Number column heading to view the A/R Customer record.
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Dragging and Dropping Documents into the Documents Folder and Linking
Documents to an Overdue Invoice

e Use drag and drop to attach documents to tracked invoices and copy them to the Documents
folder defined in Setup Options.

OR

e Use the Add or Link buttons to link documents on your computer to an overdue invoice record.

Note the differences in the following methods for adding documents to tracked invoices:

e Use Drag and Drop on the Documents tab to copy documents to the invoice document folder in
CRM and Collections (see Document Folders tab in Setup Options).

Documents that you drag and drop are added to the Documents tab for the invoice. They are also
copied to the invoice document folder, and they are added to the list of documents maintained by
the Documents program in CRM and Collections.

e Use the Add button on the Documents tab to link to a document and add it to the list.

When you use the Add button, the document will be added to the list maintained by the
Documents program in CRM and Collections, but the document will NOT be moved to the tracked
invoices document folder.

e Usethe Link button on the Documents tab to link to a document and add it to the list.

When you use the Link button, the program displays the list of documents maintained by the
Documents program in CRM and Collections, letting you choose a document to add to the
invoice’s list. The document will NOT be moved to the invoices document folder.

To drag and drop documents and move them to the Invoices document folder:

1. Click the Documents tab on the Overdue Invoice screen (see below).
2. Drag and drop a document onto the Documents tab. (The grid border turns green, and the pointer
shows that you are dragging a document.)
o[ 4 +
Tracked Invoice Mates
Search I Search  Advanced... |

Order By

| Name

ID Name

Notes

TaiRox CRM and Collections for Sage 300 97

When you release the document, the grid displays the new document, showing the path to the
documents folder.

o [3q+

Tracked Invoice Documents  Notes

Search |
OrderBy [ Mame ~| %

Search

Advanced I

30 Price List - Office Reno xdsx

F:\5age"Sage300"SharedData‘\company \SAMLTD" TaiRox CRM\Documents"\COMP 00001 \ARInvoices ARI.
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Tracked Invoices

The Tracked Invoices program lists all invoices that have notes or documents attached, are on hold, are
assigned to users, or have a revisit date.

When you add a note or document to any invoice — using the Tracked Invoices program, Disputed
Invoices program or Overdue Invoices program — or assign the invoice to a user or put it on hold — that
invoice becomes a tracked invoice and will also appear on the Tracked Invoices screen.

e Assigned tracked invoices appear on the assigned user’s Dashboard and Calendar according to
the revisit date you specify.

Unassigned invoices appear on the dashboard when you view items for All users.
e All tracked invoices appear in the grid on the Tracked Invoices screen.

e The Tracked Invoices program also lets you add notes and documents for payments and credit
notes, which will also appear in the list on the Tracked Invoices screen.

Access: Open the Collections folder, then open Tracked Invoices.

L]
Home

v TaiRox CRM and Collections 2

o Collections (Tracked Invoices)
Sallechons ] Licensed to: Don Thomson, TAIROX SOFTWARE INC
Collections Reports Dealer
Import / Export o
Marketing
Periodic Processing U e
—
| £ £
! ) R % 7 ]
CustomerAging  Disputed Invoices  Overdue Invoices | Tracked Invoices | Promised Payments  OverduePayment  Payment Due Alerts
Send Documents Remindurs
Setup .
Sage  ForHelp, pressF1 Session Date: 2023-10-24 | [B§

Search [ Search

Order By |Cusmmer humber V| e ICompany
Status

Open

[ Closed

On Hold
No
No
Yes
Yes
No
No
Yes
No
No
No
No

Document Number Customer Number Comp... Transaction T2 Document Type Document Date Due Date Amourt
56563
1.035.57
123.235.57
563.87
68,006.48
244580
15,198.30
350.30
2844232
2486
169.50

X| | Seach | Advanced.. |

Short Name
2 Bargain Mart - Oakland BMT-OK Bargain Mart Plaza Comer 182nd and
1 Bargain Mart - San Diego BMT-SD Bargain Mart Plaza Comer 182nd and..
24 Bargain Mart Stores Inc. BARMART Bargain Mart Plaza Comer 182nd and.

To Search for tracked invoices:

e Open the Tracked Invoices program and enter a partial invoice number, customer number, or
company name in the Search field and press the Enter key.

You can also enter values for company fields and company optional fields, so if you have a “sales
rep” company optional field, you can search quickly for tracked invoices for a particular sales rep.

o Click the red X at the end of the Search field to remove search terms. = — X][ s

Or Click the Finder button () at the end of the Company field and enter part of the company name
to restrict tracked invoices to a single company (as shown below).

o Click the red X beside the Company field to remove the company filter.

Search [ | Search
Order By ‘Custcmer Number Vl = Company ‘Eargam Mart - San Diega X ‘ qQ
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e The following example shows a tracked credit note. The program also lets you track credit/debit
notes and payments.

Search [ | | Search
Order By [ Customer Number ~] *  Company [Bargain Matt - San Diego %] Q
Status
Fopen [Closed

On Hold [® Document Number  [H Customer Number & Company Name Transaction Type  Document Type  Document Date  Due Date

No Bargain Mart - San Diego Cre te 2020-06-05 2020-06-05
No INDDOOODODD00GD 1100 Bargain Mart - San Diego 1 Invoice 2020-06-30 2020-07-30 565.

e Click the Add button at the bottom of the screen to add a new tracked invoice.

Page of 1

Delete Close

Notes:
e Use the Status checkboxes to display Open and Closed tracked invoices in the grid.
e Double-click a tracked invoice in the grid to view the tracked invoice information.

e Tracked Invoices include a “Documents” tab and a “Notes” tab where you can add the details for
tracked invoices.

e Assigned tracked invoices appear on the assigned user’s Dashboard according to the revisit date.

Drill Down:

o Double-click a row in the Tracked Invoices grid to display the Tracked Invoice information.

o q+
Tracked Invoicel Documerts  Motes I
Company Name  [Bargain Mart - Oaidand Q
cosston s
Modified On Modiied By
Customer Number a
Document Number )}
Document Date  [2021-06-05 Amount
Due Date 2021-06-15 Balance

Desciiption

=
&
o
&
0
]
a
[
=
@
&
&

Status Open

Revisit On Revisit At 100:00:00
Assigned To Q

[10n Hold Reason On Hold | Disputed Invaice -]

Documents Folder... Change Log..

Save Closs

e Click the green Plus button beside the ID field (4) to add a new tracked invoice record.

e Click the “Documents” tab and “Notes” tab to view or attach documents and notes.
e Click the Documents Folder button to view documents in Windows File Manager.

e Click the Drill-Down button [%] by the Company Name field to drill down to CRM company data.

e Click the Drill-Down button [ by the Customer Number field to view A/R customer data with the
A/R Customers screen or Extended Customers screen (if you have TaiRox Productivity Tools).

e Click the Drill-Down button [ by the Document Number field to view the original invoice.
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Drill down from the Tracked Invoices grid:
e Click the Document Number column heading to drill down to the original document.

Search [ | [ searcn |
Order By ‘Customer Number v| - Company ‘Eargain Mart - Oakland » ‘ Q

Status

Open [ Closed

On Hold [E Document Number T Customer Number C ame Transaction Type  Document Type  Document Date  Due Date
Invaice 2020-06-05 2020-06-15

(T3 A L I 1N 0D00000000059 > pQ Ertered By ADMIN

Customer No. |11D5

=] a ‘Eargain Mart - Oakland

1

Invoice  Customer Taxes Optional Felds Sales Split Rates Totals

e Click the Customer Number column heading to drill down to the A/R Customers screen — or to the
TaiRox Extended Customers screen if you use TaiRox Productivity Tools.

On Hold [H Document Number  [B Customer Number = Transaction Type  Document Type Document Date  Due Date
Yes IND00000D0000SS ; E Invoice 2020-06-05 2020-06-15

Customer Number |4 4 | 2 C( =+ a * Required

Customer Name |Eargair1 Mart - Oakland |

Address Contact Processing Inwoicing Optional Fields ~ Statistics  Activity Comments

National Accourt No. |EﬁHMf\HT | Q |Eargain Mart Stores, Inc. |

¢ Click the Company Name column heading to drill down to the company information kept by CRM
and Collections.

On Hold [4 Document Number B Customer Number lame Transaction Type  Document Type Document Date  Due Date
Yes INDOOOOOD00005S 1105 Invaice 2020-06-05 2020-06-15

o [ BQ + Name [BarwainMati-Oakland |

Company  Optional Fields Contacts Opportunities Documents Cases Notes Communications

Cossin [ _| coaedty  POMN B8

s et e [
[ Inactive
Short Name Casels)
Disputed Invoicels)
=y |CA v‘ |CA 1 Owerdue Invoice(s)
Phone Number ~ [[408) 451-8381 Fromised Payment(s)
See Also:

Appendix A - Common Screen Operations for searching, sorting, tabs and common button explanations.
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Add Notes and Documents, Assign Users and Revisit Dates, Put Invoices on Hold

Access: Click the Add button on the Tracked Invoices screen to add notes or documents to a new
invoice, to assign users and revisit dates, and to put invoices on hold.

Double-click a row in the grid to view the status and attachments for an existing tracked invoice.

T —

Tracked Involcel Documents  Motes I

Company Name ‘Eargain Mart - Oakland |
— p—

Modfied On Modfied By

Cuseme oo B

Document Number

Document Date Amourt USD

Due Date Balance

Description ‘No backarder please

Revisit On Revisit At

Assigned To Q ] I

[10n Hold Reason On Hold | Disputed Invoice ~] <

Documerts Folder. Change Log

Save Close

Notes:

Click the green Plus button beside the ID field (4) to add a new tracked invoice record.

Click the Finder button (") beside the Company Name field to choose the company with the
tracked invoice. (The Finder becomes inactive after you add the tracked invoice.)

Select the tracked document using the Finder beside the Document Number field. (The program
actually lets you tracked any A/R document — not just invoices.)

Assign a user and a revisit date to display the tracked invoice on the dashboard.
Select the On Hold checkbox to place an invoice on hold. Use the dropdown to select a reason.
Click the Documents Folder button to view documents in Windows File Manager.

Click the drilldown buttons [ to see CRM and Collections company information, A/R customer
and account information, and invoice details.

When finished tracking a document, change the Status to “Closed” to remove the tracked invoice
from the Tracked Invoices grid.

Click the Change Log button to see the details for recent changes.

Documents and Notes Tabs

Click the Documents tab to link documents to the tracked invoice.
Documents listed on the Documents tab are also accessible through the Documents program.
Click the Documents Folder button to view drag and dropped documents in the Windows folder.

Click the Notes tab to add notes for the tracked invoice. Notes listed on the Notes tab are also
accessible through the Notes program.

You can also access notes and documents for disputed or overdue invoices using the Disputed
Invoices and Overdue Invoices programs.
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Dragging and Dropping Documents into the Documents Folder and Linking
Documents to a Tracked Invoice

e Use drag and drop to attach documents to tracked invoices and copy them to the Documents
folder defined in Setup Options.

OR

e Use the Add or Link buttons to link documents on your computer to a tracked invoice record.

Note the differences in the following methods for adding documents to tracked invoices:

e Use Drag and Drop on the Documents tab to copy documents to the tracked invoice document
folder in CRM and Collections (see Document Folders tab in Setup Options).

Documents that you drag and drop are added to the Documents tab for the tracked invoice. They
are also copied to the tracked invoice document folder, and they are added to the list of
documents maintained by the Documents program in CRM and Collections.

e Use the Add button on the Documents tab to link to a document and add it to the list.

When you use the Add button, the document will be added to the list maintained by the
Documents program in CRM and Collections, but the document will NOT be moved to the tracked
invoices document folder.

e Usethe Link button on the Documents tab to link to a document and add it to the list.

When you use the Link button, the program displays the list of documents maintained by the
Documents program in CRM and Collections, letting you choose a document to add to the
tracked invoice’s list. The document will NOT be moved to the tracked invoices document folder.
To drag and drop documents and move them to the Tracked Invoices document folder:
1. Click the Documents tab.

2. Drag and drop a document onto the Documents tab. (The grid border turns green, and the pointer
shows that you are dragging a document.)

o [ BQ+

Tracked Invoice  Documents  Notes

Search [ Search | Advanced..
Order By [Name o -

[= Document Notes Comment

3. When you release the document, the grid displays the new document, showing the path to the
documents folder.

D Q+

Tracked Invoice  Documents  Notes

Search | Search Advanced.. |
Order By |Name -

[= Document

51|Price List - Office Reno

See Also:

Appendix B — Using Data Entry Programs for tabs and common button explanations.
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Promised Payments

Promised Payments lets you track promises made by customers for the settlement of accounts.

Promised Payments with a revisit date appear on the dashboard for assigned employees — or for All
employees if the promised payment has not been assigned.

Access

: Open the Collections folder, then open Promised Payments.

£J
Home

~ TaiRox CRM and Collections -
Change Log Collections (Promised Payments)
L ollechiog ] Licensed to: Don Thomson, TAIROX SOFTWARE INC
Collections Reports Dealer:
Import / Export o
Marketing
Periodic Processing e Ty
‘ z
Sales Reports @ FO\ ?Q ?Q ?O\ £ £
Customer Aging  Disputed Invoices ~ Overdue Invoices  Tracked Invoices | Promised Payments | Overdue Payment  Payment Due Alerts
Send Documents
Reminders
Setup .
Soge | For Help, press F1 Session Date: 2023-10-24 4

Search

‘ Search

Order By

|Comparw Name V| e I Company s

Status
open

[ Closed

ID Status

Customer Mumber B Company Name ate P e *romise; Amourt Pa

Mr. Stephen Kershaw = . 5 12:00:00 AM  DON

Page of 1 Add.. Delete Close

Notes

TaiRox

Enter a customer number, partial company name, or assigned user in the Search field.

You can also enter values for company optional fields, so if you have a “sales rep” company
optional field, you can search quickly for promised payments for a particular sales rep.

o Click the red X at the end of the Search field to remove search terms. = —— X| sa=
o Use the Finder button () beside the Company field to restrict promises to one company.

Use the Order By field to view promises by Date Promised, Amount Promised or Revisit Date.
Use the Status checkboxes to display Open and Closed promised payments.

Assign promised payments to a specific user or leave them unassigned.

o Promised payments appear on the Dashboard and Calendar according to the revisit date you
specify. Assigned promises appear on the assigned user’s dashboard. Unassigned promises
appear on the dashboard when you view items for All users.

You can add as many notes as you want to promised payments to track activity.
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¢ Promised payments are flagged on the Customer Aging, Overdue Invoices, and Overdue
Payment Reminders screens.

e Use the Promised Payments Report to view the status of promised payments.

Drill Down:

e Double-click a row in the grid to display the promised payment information.

ID Status 8 Customer Number  [H Company Name Date Promised  Amount Promised Amount Paid Curency
1550 2,000.00{USD
M. Stephen Kershaw

0 [ 12+

Fromised Payment  Nates.

Company Name  [Asiral Construction Co Ltd &

— —
p— Mt

e Click the Company Number column heading to drill down to the A/R Customer record for the
highlighted promised payment.

ID Status Customer Number  [H Company Name Date Promised ~ Amourtt Promised Amourt Paid Curency Revist On Revisit At Assig|
Mr. Stephen Kershaw 2021-01-15 39, 2021-01-15  12:00:00AM  DON|

00 0.00 USD
202101-20 7.500.00 2,000.00) 2021-01-19 120000 AM [KEIT

a2 -n— R pp—
Customer Name |Asra\ Construction Co Ltd New |

Address  Contact Processing  Inyoicing  Optional Fields ~ Statistics  Activity  Comments.

e Click Company Name column heading to drill down to the TaiRox CRM and Collections company
information for the highlighted promised payment.

Search [

Order By [ Customer Number = Fr
Status

A0pen [ Closed

Date Promised Amount Promised Amourt Paid Cumency Revisit On Revisit At Assig|
1.789.00 20210115 12:00:00 AM  DON|

2021-01-20 7.500.00 2.000.00] 20210119 [1200:00 AW _[KEIT|

D [ HQ 4+ Nme [fstal Construction Co Ltd. <™ |

Company Optional Fields Contacts Opportunities Documents Cases Netes Communications

Created On [0200223 | Created By [ADMIN s M@

e You can drill down from the TaiRox Company screen to the A/R Customer record and to all
collections data.

o Click the icon to the right of the Customer Number (top-right-hand corner) to open the A/R
Customer program.
o Click Collections button to view all Collections information for the customer.

o [ BQ + MName [fstalConstuctionColid ‘

Compary Optional Fields Contacts Opporunties Documerts Cases Netes Communications

Created On Created By Customer Number B
Modfied On Modified By ] )

[Jinactive

Short Name Casefs)
Strest 1 [s18 Canl Dive = g:::j: :::‘:‘::*‘::

Strest 2 [ | 1 Promised Payment(s)

Street 3 ‘ ‘

See Also:

Appendix A - Common Screen Operations for searching, sorting, tabs and common button explanations.
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Promised Payments

Promised Payments — Add/Edit

Access
anewp

: Click the Add button on the Promised Payments screen (shown in the previous section) to add
romised payment.

D

Company Name
Created On
Modified On

Date Promised

Amourt Paid
Revisit On
Assigned To
Status
Notes

Save

Promised Payment |~ Notes

Customer Number

Amount Promised

|Mr Stephen Kershaw
)20-1
2021-01-05

2-22

i

Created By

Modfied By
1520

I}
=

=
=
El
&

[EE

1,789.00

Revist At

=2
=4
El
@

[=]

o
o
2
3

ON

- Met with Stephen on Monday. He was waiting for his customer to pay for goods that we shipped him
- He agreed to full payment by January 15. | will check for payment then

Change Log...

Delete Close

Notes:

Click the green Plus button beside the ID field (<) to add a new promised payment record.

Click the Finder button (") beside the Company name field to choose the company with the
promised payment. (The Finder button becomes inactive after you add the promised payment.)

Enter the date promised and the promised amount. You can sort promised payments by promised
amount and date on the Promised Payments.

Enter a Revisit On date. This determines when promises appear on the Dashboard. You can also
enter a Revisit Time after the Revisit date. Enter time in 24-hour format (e.g. 13:00).

Assign the promised payment to an employee so it will appear on their dashboard. If you do not
assign the promise to a particular employee, it will appear when you view items for “All.”

Change the status to Closed once the promised payment has been received.

Use the Notes field to list invoices covered by the payment and receipt information when payment
is received. The Notes field can be up to 250 characters long.

Click the Notes tab to add notes up to 2,500 characters long for the promised payment. Notes
listed on the Notes tab are also accessible through the Notes program.

Click the Change Log button to see the details for recent changes.

Drill Down:

See Al

Click the Drill-Down button [} by the Company Name field to drill down to TaiRox company data.

Click the Drill-Down button [ by the Customer Number field to view A/R customer data.

SO.

Appendix B — Using Data Entry Programs for tabs and common button explanations.
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Overdue Payment Reminders

The Overdue Payment Reminders program:

¢ Emails overdue payment reminders to customers with overdue accounts

The program generates different reminder emails for different overdue aging stages. It lists alll
overdue customer invoices in each email, lets you attach the overdue invoices as PDF files, and
sends emails to multiple company contacts. Emails are kept as communications.

e Creates dashboard tasks for users to call customers concerning overdue invoices

Tasks appear on the CRM and Collections Dashboard and provide overdue invoice information
required for following up on overdue invoices.

You can run the program interactively from the Sage 300 Desktop or run the program as a Windows
Scheduled Task. See Overdue Payment Reminders Setup and refer to the Scheduler User Guide.

Use Payment Due Alerts to send reminder emails to customers about upcoming invoice payments.

Use the Overdue Invoices program to view overdue invoices, assign overdue invoices to users, put
invoices on hold, and to attach documents and notes to document the collections process.

Access: Open the Collections folder, then open Overdue Payment Reminders.

L]
Home.

~ TaiRox CRM and Collections ol

Change Log Collections (Overdue Payment Reminders)

Licensed to: Don Thomson, TAIROX SOFTWARE INC
Collections Reports. Dealer
Import / Export @
Marketing
Periodic Processing F ? F ? P P

£ £

Sales Reports S Q Q Q Q z £

Customer Aging  Disputed Invoices  Overdue Invoices  Tracked Invoices  Promised Payments | Overdue Payment | Payment Due Alerts
Send Documents

Reminders
Setup. v
Sage | ForHelp, press F1 F) Session Date: 2023-10-24 | [

[ sesn [ Seach | Advarced._ |
Oty Pt Overn T G | I3
Al Mone Last Updated  [2021-06-23 ] ||4:4555 ] By Imum
Select [ Customer Number Company Name 0 (oic verdue A y Template
W |1580 ]1- 1 1Late b
O 1200 M. Ronald Black [ 47 2-Past Due 2
O 7o The Royal Cavendish Co $ 15 1-Late 1 17,804.09 37.389.52 GBP Creste Task  Tlatetd |
O 1s00 Dr. Dan Penn 16 1-Late 1 10,0012 1044799 USD Send Emal  Ilatebd
O 1240 The Coutyard ! 17 1-Late 1 464844 5830.25 USD Send Emal  1latebd |
O 1o Bargain Mar - San Diego ! 52 2-Past Due 2 1.941.31 5.177.85 USD Create Task  2PastDuetxt
O nes Bargain Mart - Oakland ! 52 2-Past Due 1 1.016.48 19.461.12 USD SendEmal  2PastDue bt |
O 700 The Yoshida Gardens 25 1-Late 1 7% 17.214 JPN Send Emal  TLatetat
< > |
| Create Overdue Payment Reminders | Log
Close

CRM and Collections lets you specify four overdue color-coded invoice stages and specify an action for
each aging stage — either Send Email or Create Task — which you can change at runtime.

You specify the aging period details, the default action (Send Email or Create Task), and the email default
template for each Email aging stage in the Overdue Payment Reminders Setup program in the CRM and
Collections Setup folder.
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Note also that you can specify From Email and Reply To Email addresses for payment reminders with the
Overdue Payment Reminders Setup program.

o Double-click a row on the Overdue Payment Reminders screen to view summary information for
a company’s overdue invoices.

[®4 Company Mame [H Fags Days Overdue Stage Invoices Overdue  Amount Overdue Balance Cumency Action

Break-Away Designs 42 2-Past Due 1 178,552 39 183.280.11 USD Send Email
Custom Comfort 1 = 67.456.45 69.593.35 USD Send Email
Send Email
Send Email
Send Email
Send Email

Invoice Mumber = = Balance Days Overdue
TRINV-005.3 19.058.97 2021-02-12
TR-INV-010.4 719480 20210308

Note: CRM and Collections also uses the “Preferred Language” setting in the Company window to
send overdue payment reminders emails and invoices to customers in English, French, or Spanish.
See Appendix C for details.

Procedure for Sending Overdue Payment Reminders and Creating Tasks

You can run Overdue Payment Reminders daily, bi-weekly, or weekly — whatever works best for you.

1. Open the Collections folder, then open the Overdue Payment Reminders program.

Note that Overdue Payment Reminders can only be run by collections users, who must have
access to all territories and be assigned “Collections” security rights if Sage 300 security is in use.

2. Click the Update button to check for new overdue accounts, close paid invoices, and to
recalculate invoice aging.

Update also checks how much time has elapsed since the last payment reminders were

generated to see which overdue accounts are eligible for new reminders, and it checks if invoices
have been put on hold.

Pending ~ Processed

Search [ | [ Seach | Advanced.. |
Order By [ Amount Overdue | 4 Company 1Q
T o o
Note:

o The program lists overdue customer accounts. Double-click a line in the grid to see the
customer’s overdue invoices.
- Accounts appear if at least 1 invoice exceeds the “Minimum days overdue before creating

an Overdue Payment Reminder” for the customer, and is not on hold.

o Days Overdue is the number of days for the most overdue invoice.

o Adging Stages are defined on the Overdue Payment Reminders Setup program in the Setup
folder. They determine the default Action.

o Customers will not appear if the minimum number of days between payment reminders has
not elapsed.

o Customers will not appear if their overdue invoices are on hold.

3. Click the All button to send emails or generate call tasks for all companies with outstanding
accounts, and use the checkboxes in the Select column to cherry-pick customers.

Last Updated [202106:23 | [14:4558 | g, [ADMIN Updats

Select  [H Customer Number [H Company Name [BFlags Days Overdue Stage invoices Overdue  Amount Overdue Balance Curency
Break-Anay Designs 291-Late 17855239 18328011 USD Create Task

Mr. Ronald Black ! 47 2 - Past Due 106,232.26 109.946.82 USD Create Task
The Royal Cavendish Co. 19 1-Late 17.804.09 37.389.92 GBP Create Task
Dr. Dan Pern 16 1-Late 10,090.12 10,447.99 USD Send Email
The Courtyard 17 1-Late 4548.44 5830.25 USD Send Email
Bargain Mart - San Diego 52 2-Past Due 1540131 5.177.85 USD Create Task
Bargain Mar - Oakland 52 2 - Past Due 1016.48 1946112 USD Send Email

z
L

O
O
O
O
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How to assign phone call tasks to different users:

o Select all the customers with a Phone Call action that you want
assigned to the same user.

o Click the Create Overdue Payment Reminders button at the
bottom of the screen.

o Specify a user for the new tasks, select a revisit date, and click the
Process button.

o When all emails and tasks have been processed, select the next
group of customers that you want assigned to a different user.

4. Double-click the Action to switch between sending emails and creating tasks.

The Action column shows you whether the program will send an email or create a collection task
for this customer. The default settings come from the Overdue Payment Reminders Setup
program.

Select [B Customer Number [B Company Name Flags Days Overdue Stage Invoices Overdue  Amount Overdue Balance Curency  Action Template

00 1580 Break-Away Designs 291-Late 1 17855239 183.280.11 USD Create Task  1Late b
1200 Wi, Ronald Bizck ! 47 2-Past Due 2 10623226 108,846.82 USD Crete Task  2PastDuebx
0O 7w “The Royal Cavendish Co. s 19 1-Late 1 1760409 3738952 GBP Create Task  Latebt

O 1600 Dr. Dan Pemn 16 1-Late 1 1009012 1044799 USD SendEmail  Latebt

O 1240 “The Courtyard ' 171-Late 1 454844 583025 USD SendEmail  lLatebt
1100 Bargain Mart - San Diego ! 52 2-Fast Due 2 154131 5,177.85 USD Create Task  2PastDuend
1 2

m] 1

1105 Bargain Mart - Oakland 52 2-Past Due
7400 The Yoshida Gardens 25 1-Late

1,016.48 19,461.12 USD Send Email 2PastDue bt
74 17.214 JPN La‘ehrl
Create Task
L
5. Double-click the email template file name select a different template.

o Highlight the email filename and click the Template column heading to display the email.

6. Click the “Create Overdue Payment Reminders” button at the bottom of the form when you
are ready to continue.

The program will warn you if the overdue invoice data wasn’t updated today.

The overdue invoice data has not been updated for today.
Since the overdue payment reminders are based on this data
it is strongly recommended that you update the data before
proceeding.

Do you want to continue?

=
&

Click the Yes button to continue.

7. Select options for emails and tasks in the form that appears.

Email Task
Attach copies of the invoices Assign To WADE Q
Attachments... Revist On 2024-01-25 |

Process Cancel

o If any selected customers have a Send Email action, you can:

- Select “Attach Copies of the Invoices” to include PDF copies of overdue invoices with
emails.

— Click the Attachments button to add additional attachments to all of the payment reminder
emails — such as your policy on overdue accounts.
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Emal
| EAAttach copies of the invoices

|

Process

Add Delete Close

Use “drag and drop” to add attachments, or click the Add button to search for
attachments using Windows File Explorer.

o If any selected customers have a Create Task action, you can specify a user name in the
Task options to assign tasks for this set of companies to a single user.

Specify a Revisit Date to ensure that the call appears on the assigned user’s dashboard.

o Ifyou click the Process button without specifying a revisit date for tasks, the program
displays a warning to let you know that the task will not appear on the Dashboard.

‘Warning: Tasks will not appear on the Dashboard unless you
specify a Revisit On date.

Do you want to continue?

Yes Mo

8. Click the Process button on the popup options screen to send the reminder emails or create
tasks for the selected companies.

9. When processing is finished, select another set of customers to email or to create more
call tasks and assign them to a different user:

o Select one or more companies from the remaining list of companies.

o Choose who to assign the next group of tasks, and specify a revisit date.

o Click the Process button again to send the reminder emails and/or generate tasks for the new
set of selected companies.

e Click the Processed tab to see past payment reminders.

Typical Email Sent for “Delinquent” Accounts

The email can include a summary of the overdue invoices, a summary of all invoices, an aging summary,
and PDF attachments. The following example shows overdue invoices and an aged overdue summary.

T
a

Sank Tue 642031 1226 P

Ui - Papmert Overcue
004 2F0F (6.8) (1) ARTR.NV-O05.3 FDF (7 K1 (1) ARTR 80v-009.3 FDF (7 KB [£) ARTR 300104 5O (7 €8}

Dear Mr. Willam Cavendish, -
One o more of your invoices s seriously overdue.

Because we have been unable to work out payment with you, I regret to inform
you that if we do not hear from you in 5 days, we will report this issue to the credit
bureau and turn your account over to a collection agency who will contact you In
regard to payment.

The details of all averdue invoices are as follows:
Invoice Date Amount  Due Balance Days Overdue
TR-CRE-004.2 2/27/2021| 133.65 3/29/2021  133.65 78

TR-INV-005.3 | 2/9/2021 |19,058.97 2/12/2021 17,804.09 123
TRINV-009.2 | 3/5/2021 |16,098.64 4/4/2021 | 14,558.53 72
TR-INV-010.4 | 2/6/2021 | 7,194.80 3/8/2021 | 4,414.49 99
Total: 36,910.76
Overdue invoice balances by days overdue:
1- 30 Days 31- 60 Days 61 - 90 Days Ower 90 Days Total

0.00 0.00 14,692.18 22,218.58 | 36,910.76

sincerely,
Administrator

tiicationsQhaies coen
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Note: To create payment reminders using the Overdue Payment Reminders program, you must:
e Set up Overdue Payment Reminders using the Overdue Payment Reminders Setup program
o Edit email templates for overdue invoice stages in the Overdue Payment Reminders Setup
program.
e Select the recipients for overdue payment reminders on the Contacts tab for companies.

Setting a Minimum Number of Days Overdue Before Creating Payment Reminders
and a Minimum Number of Days Between Payment Reminders

CRM and Collections lets you set a minimum number of days (for example, 7 or 14 days) between
payment reminders in the Overdue Payment Reminders Setup program. The program will not send an
email message to a customer — or create a Collection Call task — until the minimum number of days has
elapsed.

The program also lets you set a minimum number of days that an invoice must be overdue before
creating an overdue payment reminder —so you won’t send a reminder as soon as the due date passes.
You can change the default number of days overdue before creating an overdue payment reminder for
individual customers on the Company screen for the customer.

Using the Update Button to Create, Update and Close Pending Reminder Records

The Update button creates new pending overdue payment reminder records for overdue invoices
according to the aging periods specified in Overdue Payment Reminders Setup — unless you specified a
minimum number of days before creating an overdue payment reminder for individual companies.

Pending ~ Processed
Search [ | [ Search | Adyanced.. |
Order By [ Company Name | % Company ‘ Q

il — Lot Updeted [PI2T0530 | 117854 | 5, [PON || pame |

Double-click a row in the Overdue Payment Reminders grid to see the overdue invoices

[8 Customer Number
7100 Bashaw Bu

35057 615.99 CAD
178.552 39 183.280.11 USD
6745645 69,593.35 USD
26481 109,946 82 USD

ing
Break-Away Designs

464544 5,830.25 USD

2221858 3738392/GeP |

17.214 JPN

N__.___H

TRANV-005.3 20210208 19.05857 20210212
TRANV-010.4 20210206 718480 20210308 441448

o

Using the Search Field and Company Field to Filter Overdue Payment Reminders

You can restrict the display of customers with pending overdue payment reminders to make it easier to
select a subset of customers for processing.

e Usethe Search field at the top of the screen to filter your overdue account selection.

Pending ~ Processed

X| | Seach | Adyanced

Company 1 Q

184131 5,177.85 USD
12 1-Late 1 1.016.48 19.461.12 USD Send Email 2P

In this case, we searched for “Bargain” to get all Bargain Mart stores. The Company field would
have restricted us to one location.
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You can also search by Stage — for example, to create reminders for all “Delinquent” customers.

o Click the red X at the end of the Search field to remove search terms. = —— X][ s
o Use the Advanced... button to filter cases by different customer field ranges.

Filter using company optional field values: You can also enter values for company optional
fields in the Search field.

In the following example, we filtered on the “Salesperson” optional field to create phone call tasks
for a single salesperson.

Pending ~ Processed

Search [al X| | Seach | Adyanced
Orcer By Company Name: v| % Ccompany | 1Q

A Hore Las Upcteg 0710630 | [131645 | Lpdaa

[H Company Name [ Aags Days Overdue Stage Invoices Overdue  Amourt Overdue Balance Curency

ak-Away Designs -Past Due J }

1580 Break-Away D 56 2- Past Dux 1 17855239 183,280.11 USD
O 1200 M. Ronald Black 43 2-Past Due 1 26461 109.546.82 USD
O 700 The Yoshida Gardens 52 2-Past Due 1 7 17.214 JPN

o In our example, the “KW” letter combination doesn’t appear in any company names. Consider
adding a non-alphabetic character to any optional fields that you want to use for filtering — for
example, use *KW as the Salesperson code instead of “KW”.

o If you have a “terms” optional field, you could do a special run for a particular group of
customers.

e Usethe Company field at the top of the screen to filter for a single company.

Pending Processed

Search [ | [ Search | Advanced
Orclex By [ Customer Numoer o] & | Company |Mr. Renald Biack x| 2
e v TR

Select [B Customer Number [B Company Name [B Rags  Days Overdue Stage Invoices Overdue  Amourt Overdue Balance Curency  Action
O 1200 Mir. Ronald Black 15 1-Late 1 26461 108,946.82 USD Send Email  1Lg

o Use the Company field to send reminder emails or to create call tasks for the selected
company only. The Company field provides a SmartFinder to quickly find the company.
o Click the Red X to remove the company filter.

More Details on Creating Overdue Payment Reminders

e Click the Update button to update the list of customers with pending overdue payment reminders
based on the aging stages that you defined in Overdue Payment Reminders Setup.

The program takes into account the time elapsed since payment reminders were last created for
customers to see which customers are eligible for new reminders.

o Customers will not receive reminders unless the Send Overdue Payment Reminders
checkbox is selected in their company records.
o Customers will not receive reminders for invoices that are on hold.

e For each company, you can set the minimum number of days that a payment must be overdue
before creating an overdue invoice record. See the Company window to change the minimum
number of days. The default number of days is set in Overdue Payment Reminders Setup.

The program will not create an overdue invoice record for an invoice until the minimum number of
days specified for the company is reached.

You can also turn off overdue payment reminders by unchecking the “Send” option for individual
companies on the Company screen.

[+ Send Overdue Payment Reminders

Date of the last Overdue Payment Reminder 2024 0204 gm;m %ﬁi:;:rrdue EeoE s g U Ijl (Enter Oto use the system default)
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You can put invoices “On Hold” using the Overdue Invoices and Tracked Invoices
programs.

For example, you might put an invoice on hold because it's being disputed or if the invoice is for a
good customer who is always a little late with payments.

o [ 39q+

Tracked Invoice  Documents ~ Motes

Compary Name  [Bargain Mart -Oakland S8

Geseton s
Mt sty

Customer Number L] @

Document Number ]

s e
Due Date 2020-06-15 Balance
Description [No backorder please

Revisit On Revisit At [00.00:00

Assigned To DON Q

I [~10n Hald Reason On Hold | Disputed Invoice ~

Disputed Invoice
Under Review

Sent to Collections Agency
Promised Payment
Other

Documents Folder... Change Log..

Save Close

Select options for creating payment reminder on the Create Overdue Payment Reminders
popup screen.

The following screen appears when you click “Create Overdue Payment Reminders:

Email Task
Attach copies of the invoices Assign To ADMIN
Mtachments... Revisit On I:I
Process Cancd

Select “Attach copies of the invoices” to attach a PDF of each overdue invoice to payment
reminder emails.

You select the report formats for A/R and O/E invoices on the Overdue Payment Reminders
Setup screen.

Click the Attachments button to add additional attachments to all of the overdue payment
reminder emails — such as your policy on overdue accounts.

You can use “drag and drop” to add attachments, or click the Add button on the Attachments
screen to search for attachments using Windows File Explorer.

Specify a user for tasks and specify a revisit date to add the task to the user’s dashboard.

The progran sends 1 email per customer or creates 1 call task listing all overdue invoices.
Invoices that are on hold will not be listed in emails or on call tasks.

Click the Process button to generate emails or tasks for all customers with an “X” in the
Select column.

The program will display status messages as it generates each payment reminder.

When all payment reminder emails and tasks have been generated, TaiRox Collections will
display a message that includes the number of payment reminders generated (sent emails and
new tasks) and whether any errors occurred.
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Overdue Payment Reminders

Index  Priority Description

1 Message QOverdue Payment Reminders complete.

2 Message & Overdue Payment Reminders were processed.

< >
Description: Overdue Payment Reminders complete
Source: 09:51:43 -

.

When you close the message window, TaiRox Collections will update customer records with the
date of the last overdue payment reminder.

70 Mimimum days overdue before creating an Overdue
Payment Reminder

Click the Log button on the Overdue Payment Reminders screen to see the list of all successful
email transmissions and tasks. The log also lists all email recipients.

[+ Send Overdue Payment Reminders

Date of the last Overdue Payment Reminder ljl (Enter 0to use the system default)

You will see an error in the log file if no email recipients were defined for a company. You can add
contacts, then run the email program again to send the reminders.

Send Email started.
From E-mail:
Subject: Your payment for Sample Company Limited is overdue
Recipients:
Trudeau, Jose <JoseTrudeau@tairox.com>
Vipond, Joseph <JosephVipond@tairox. com>
Sloan, Joe <JoeSloan@tairox.com>
English, Jo <JoEnglish@tairox.com>
French, Beth <BethFrench@tairox.com>
Kershaw, Elizabeth <ElizabethKershau@tairox.coms
Persall, Philip <PhilipPersall@tairox.com>
Attachments:
ARTR-CRE-006. PDF
Send Email completed.
Create communication started.
Create communication completed.

Overdue Payment Reminders complete.|

One Overdue Payment Reminder was processed.

The Log file lists all email recipients for companies that got emails and all tasks created for
reminder phone call.

Additional Features on the Overdue Payment Reminders Grid

Pending ~ Processed

Search [

Search

Adyanced... |

Ordler By [ Customer Number v] s Company

\
= =

Al Hone

Last Updated By |ADMIN

&
&
a

Invoices Overdue

Amount Overdue

Action

[8 Customer Number B Company Name
Mr. Ronald Black
The Courtyard
Break-Away Designs

The Royal Cavendish Co.
The Yoshida Gardens

nooooooks

[B Fags Days Overdue Stage
51 2-Past Due
51 2-Past Due
151-
161~
281-
181-
241-

194131
101648
264.61
454344
178.552 39
17.804.09
74

Balance Cumency
5.177.85 USD
18,461.12 USD
109.946.82 USD
5.830.25 USD
183.280.11 USD
37.389.92 GBP
17.214 JPN

Send Email
Send Email
Send Email
Send Email
Send Email
Send Email
Send Email

Note the following features on the Overdue Payment Reminders screen and grid:

o Displays the date when the list was last updated, along with the ID of the user who ran the

TaiRox CRM and Collections for Sage 300

update. The date will be updated again when you click the Update button.

Shows the number of days overdue of the oldest overdue invoice, the total amount overdue, the
account balance and currency, the default action for the reminder, and the default template if the
type is an email.
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Flags A/R customers that are on hold (*), and companies with promised payments (+), unapplied
credit ($), open cases (!), or disputed invoices (?).

Provides drilldown to overdue invoices, A/R customer information (click the Customer Number
column heading), CRM and Collections customer data (click the Company Name column
heading) and Collections information (click the Flags column heading).

Double-click a line in the grid to see a list of overdue invoices.

Click the Processed tab to see past payment reminders.

Viewing Overdue Payment Reminders Communications and Sent Emails

Select the Communications tab on the Company screen to view payment reminder email
communications.

Double-click the email communication entry, then click the View Email button to see the email
with all attachments.

] §Q 4+ Mame [MrFonad Black |

Customes Number 1200 M Ronakd Biack | T

] 15y 4  Name [Overie Payment Reminder 20210630 1507330001 ]

Commumcaton Contacts Decuments  Companies

CesiedOn  [BZ60 | Cesteds,  [OMN

[RDMIN

file  Message  Help Q' Tell me what youwant to do

Your payment for Sample Company Limited is overdue

©y Reply | %) Reply Al

— To. Trudeau, Jose: Vipend, Joseph; Sloan, Joe; English, Jo; French, Beth; Kershaw, Elizabeth;
Persall, Phil

[F) smosewsror
w| 47KB

Hi Mr. Black,

Our records show that we haven't yet received payment for ane or listed below. | would iateit it
you could let me know when we can expect payment.
Please include your account number (1200) and invoice numbers with your payment.

Expot Cortacts,. | | Change Log

The details of all overdue invoices are as follows:

Cose

Invoice: TR-CRE-006
Date: 2019-02-02
Amount: 264.61
Due: 2019-02-15
Balance: 264.61
Days Overdue: 15
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Payment Due Alerts

The Payment Due Alerts program sends payment reminder emails to company contacts before their
invoices are due. Payment due emails list all unpaid — but not overdue — customer invoices in each email.

You can run the program interactively from the Sage 300 Desktop, or you can run the program as a
Windows Scheduled Task. See Payment Due Alerts Setup and refer to the Scheduler User Guide.

The program lets you attach due invoices as PDF files, and sends emails to multiple company contacts.
Sent emails are kept as communications.

See Overdue Payment Reminders to send emails and create tasks for following up on overdue invoices.

CRM uses the same contact list for each company for payment due alerts and for overdue payment
reminders. You select the recipients for both types of reminders on the Contacts tab for each company.

Access: Open the Collections folder, then open Payment Due Alerts.

L]
Home

v TaiRox CRM and Collections 2

Terppler Collections (Payment Due Alerts)
I Collections | Licensed to: Don Thomsan, TAIROX SOFTWARE INC
Collections Reports Dealer:
Import / Export et
Marketing
Periodic Processing F F F F U U
=] ;3 ;3
Sales Reports S Q Q Q Q, £ £
Customer Aging  Disputed Invoices  Overduelnvoices  Tracked Invoices  Promised Payments ~ Overdue Payment | Payment Due Alerts
Send Documents Rermindor
Setup .
Sage | ForHelp, pressF1 Session Date: 2000824

Pending ~ Processed

Search [

|
Order By [ company Name <14 Ccompay | 1q

A None Last Updated  [20210706 | [17.08:00 | gy  [ADMIN || Update

[H Customer Number  [H Company Name Flags Invoices Due
7100

&
||

[} 1500 Custom Comfort 1 67,456 45 69.593.35 USD
O 7300 The Royal Cavendish Co. 1 441449 37.389.92 GBP

Create Payment Due Aletts

Close

You specify the email template for payment due alerts, along with Email subject, From Email, Cc and Bcc
settings on the Payment Due Alerts Setup program in the CRM Setup folder.

Notes:

e The program includes invoices on payment due alerts that are within the number of days before
the due date that is set in Payment Due Alerts Setup.

e Invoices will appear on only one payment due alert. After that, the program ignores them.

¢ Invoices that are past the due date will not appear on a Payment Due Alert.
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Payment Due Alerts

e |f you do not send payment due alerts frequently, some invoices could be skipped.

o Double-click a row on the Payment Due Alerts screen to view summary information for a

company’s upcoming invoices.

Pending  Processed

Order By
A

Select

Search [

|| Search

Adyanced... |

[ Company Name

More

I

Last Updated  [2021-07-06 | [1

Update

Customer Number

Company Name

Custom Comfort

Flags

Invoices Due

Amourt Due

69,593.35 USD

By [ADMIN
ey

Date Last DA [i] Template

Note: CRM also uses the “Preferred Language” setting in the Company window to send payment due
alerts emails and invoices to customers in English, French, or Spanish. See Appendix C for details.

Procedure for Sending Payment Due Alerts

You can run Payment Due Alerts daily, bi-weekly, or weekly — whatever works best for you.

1.

TaiRox CRM and Collections for Sage 300

Open the Collections folder, then open the Payment Due Alerts program.

Note that Payment Due Alerts can only be run by collections users, who must have access to all
territories and be assigned “Collections” security rights if Sage 300 security is in use.

Click the Update button to check for eligible customer accounts.

Update also checks how much time has elapsed since the last payment due alerts were
generated to see which customer accounts are eligible for new reminders. It also checks if
invoices have been put on hold.

Pending ~ Processed

Search [ Adyanced |

Company |Q

Lt s u

Order By [ Company Name o &

Al None

Note:

o The program lists customer accounts with invoices that are due within the Minimum number
of days before due date to send a Payment Due Alert. (This is a Payment Due Alerts Setup
setting.)

o Double-click a line in the grid to see the customer’s due invoices.

- Accounts appear if at least 1 invoice is within the “Minimum number of days before due
date to send a Payment Due Alert” for the customer, and is not on hold.

o Customers will not appear if the Minimum number of days between Payment Due Alerts has
not elapsed.

o Customers will not appear if their invoices are on hold.

Click the All button to send emails for all companies with due invoices, and use the
checkboxes in the Select column to cherry-pick customers.

Pending ~ Processed

Search [ Search | Advanced |

|
S

Order By [ Company Name v % company |

Al

Select  [H Customer Number

Last Updated  |2021-07-06

Update

[ADMIN

[H Company Name
Bashaw Bulldozing
Custom Comfort

The Royal Cavendish Co.

67.456.45
441449

69.593.35 USD
37.389.92 GBP

116

Date Last PDA ] Template

User Guide



Accounts Receivable and Collections Payment Due Alerts

4. Double-click the email template file name select a different template.
o Highlight the email filename and click the Template column heading to display the email.

5. Click the “Create Payment Due Alerts” button at the bottom of the form when you are ready to
continue.

The program will warn you if the “payment due” data wasn’t updated today.

The pending payment due alerts have not been updated for
today. It is strongly recommended that you update them
before proceeding.

Do you want to continue?

Yes

1=
o

Click the Yes button to continue.

6. Select options for emails in the form that appears.

Email
Attach copies of the invoices
Attachments. ..

Frocess Cancel

o You can select “Attach Copies of the Invoices” to include PDF copies of due invoices with
emails.

o Click the Attachments button to add additional attachments to all of the payment reminder
emails — such as your policy on overdue accounts.

Add Delete Close

7. Click the Process button on the email options screen to send the payment due reminder
emails for the selected companies.

8. When processing is finished, companies that were sent emails are removed from the list.
You can:

o Close the Payment Due Alerts program, or select one or more companies from the remaining
list of companies to send emails.

o Use “drag and drop” to add attachments, or click the Add button to search for attachments
using Windows File Explorer.
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Sample Reminder Email for Pending Invoice Payments

Payment Due Alerts

The email can include a summary of pending invoices, as well as PDF attachments.

Al d 9

U+ v

B vessace

Your payment for Sample Company Limited is due - Message (HTML)

[=l®
v @

From:
Subject:

receivables@samitd.com
Your payment for Sample Company Limited is due

_1Message ' (&) INV-005.1.POF (27 KB)

INOOO0046.PDF (45 KE)

Sent:  Tue 9/8/2020 10:37 AM

» &

Dear Don Ellington,
We are letting you know that payment for one or more of your invoices is due soon.

The details of the invoices are as follows:

Balance
1,680.69
599.30

Due
2020-07-19
2020-08-02

Amount
1,680.69
599.30

Invoice Date
INO003071 | 2020-06-19
IN0003095 | 2020-07-03

If you have any questions, please call me at . I will be happy to answer them.

Thank you for keeping your account current.

Sincerely,
Administrator
morgan.thomas@tairox.com

R -

Yale, Jose

Using the Update Button to Create, Update and Close Pending Reminder Records

The Update button creates new pending payment reminder records for invoices according to the setting
for Minimum number of days before due date to send a Payment Due Alert specified in Payment Due

Alerts Setup.

Pending | Processed
Search | [ seach | Advanced.. |
OrderBy [ Company Name “] 4 Company 1Q

Last Updated  [2021:0706 | [1708:00 | gy  [ADMIN I Update |

A Nore

Double-click a row in the Payment Due Alerts grid to see the pending invoices

Pending ~ Processed

Search | Advanced_. |

Search [
Company | | Q

Order By [ Company Name

Al

Select  [B Customer Number

Using the Search Field and Company Field to Filter Payment Due Alerts

You can restrict the display of customers with pending payment due alerts to make it easier to select a

subset of customers for processing.

e Usethe Search field at the top of the screen to filter your account selection.

User Guide
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\
Order ompany Name - Company ‘ ‘\(

Al HNone Last Updated  [2021-07-07 ||11 1911 | By ‘ADMIN | Update

Flags Inveices Due Amount Due

1 92 69

In this case, we search for “bar” and came up with one Bargain Mart store. The Company field

would have restricted us to one location.

o Click the red X at the end of the Search field to remove search terms. = —— %|[ s

Search using company optional field values: You can also enter values for company optional

fields in the Search field.

In the following example, we filtered on a “Salesperson” optional field to send emails to the

customers for a salesrep. You could also use an optional field to filter by region or customer type.

Pending  Processed

Search =) — %] | Seach | Adyanced..
Order By TCompany Name “| % Compay | k!
a Hone Last Updated  [2021-07:07 | [111917 | gy [ADMIN || Updte

Select Customer Number B Company Name Flags Inveices Due Amount Due Balance Cumency  Date Last PDA @] Template
] 1100 Bargain Mart - San Diego 1 9269 5,177.85 USD
O 700 The Yoshida Gardens. 1 7 17214 JPN

o Consider adding a non-alphabetic character to any optional fields that you want to use for

filtering — for example, use “*keith” as the code instead of “KEITH”.

o If you have a “terms” optional field, you could do a special run for a particular group of
customers.

e Usethe Company field at the top of the screen to filter for a single company.

Pending Processed

Search [ Search | Adyanced
Order By [Company Name = | Company |The Yeshida Gardens x| Q I
A None Last Updated  [20210707 | [11:9911 | By [ADMIN Update

Select [ Customer Number  [B Company Name 5 Flags Invoices Due Amount Due Balance Curency ~ Date Last PDA ] Template

1 74
o Use the Advanced... button to filter cases by different customer field ranges.

o Use the Company field to send reminder emails for the selected company only.
o Click the Red X to remove the company filter.

Additional Features on the Payment Due Alerts Grid

Pending ~ Processed

Search [ || Seamch | Adyanced.. |
Order By | Company Name ©] % comay | 1q
Al Hone Last Updated [2021-07-06 | [17:08:00 | gy [ADMIN Update

Select  [H Customer Number  [H Company Name Flags Inveices Due Amount Due Balance Cumency  Date Last PDA ] Template
B |w 50.57 £15.99|CAD
O 1500 Custom Comfort 1 67.456.45 65.593.35 USD
O 7 The Royal Cavendish Co. 1 441449 37.389.92 GBP

Note the following features on the Payment Due Alerts screen and grid:

e Displays the date when the list was last updated, along with the ID of the user who ran the
update. The date will be updated again when you click the Update button.
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Shows the number of invoices due, the total amount due, the account balance and currency, and
the default email template.

Flags companies with promised payments (+), unapplied credit ($), open cases (!), or disputed
invoices (?).

Provides drilldown to the A/R customer information (click the Customer Number column heading),
CRM and Collections customer data (click the Company Name column heading) and Collections
information (click the Flags column heading).

Double-click a line in the grid to see a list of due invoices.

Click the Processed tab to see past payment due alerts.

Viewing Payment Due Alerts Communications and Sent Emails

Select the Processed tab on the Payment Due Alerts screen.

Highlight the alert that you want to view, and click the Company Name column heading.to
drill down to the Company data.

Select the Communications tab on the Company screen to view payment due alert email
communications.

Double-click the email communication entry.

Click the View Email button to see the emails.

Pendind Processed

Compary |

[8 Customer Number | [BCompany Name

Bashaw Buldozing

D [ AQ + MName [CustomCorfot

Company Contacts Opportunities Documents Cases Nmei Cammumca\mnsl

Search [ | [ search | Advanced
Order By Name ~| -

+  Name [Payment Due Alert 20210707-150603-0001

S Sample Company Limited - Payment Due Soon - Message (HT.

File Message  Help Q  Tell me what you want to do

Sample Company Limited - Payment Due Scon \I View Emai_ |

<) Reply | € ReplyAll | —> Forward
To Kurth, Pete; Penn, W. H; Flemming, Lloyd; Singh, John Mon 2021-07-07 1:54 PM

ARTR-INV-004PDF

W azke ¥
Dear Mr. J. Everley,

We are letting you know that payment for one or more of your invoices is due soon.

The details of the invoices are as follows:

Invoice Date Amount Due Balance
TR-INV-004 | 2019-01-15 | 3,798.72 2019-03-16 | 1,480.58

If you have any questions, please call me at 7785551234. I will be happy to answer

them.

Thank you for keeping your account current. Erport Contads. Chonoe Lo
Sincerely,

Administrator Close

7785551234
morgan.thomas@tairox.com
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Send A/R and O/E Invoices to Multiple Customer Contacts

The Send Invoices program is a powerful and flexible replacement for Sage 300 programs that email A/R
Invoices and O/E Invoices to customers.

You can run the program interactively from the Sage 300 Desktop, or you can run the program as a
Windows Scheduled Task. See Send Invoices Setup and also refer to the Scheduler User Guide.

*
Home

~ TaiRox CRM and Collections A
Change Log Send Documents (Send Invoices)
Collections
Licensed to: Don Thomson, TAIROX SOFTWARE INC
Collections Reports Dealer:
Import / Export o
Marketing
Periodic Processing =, B D I?
Sales Reports
Send Send AR Invoices  Send O/E Invoices | Send Invoices
| Send Documents | Statements/Letters
Setup "
Sage | ForHelp, press F1 Session Date: 2023-1 Bi

Search | | Search Adyanced
Order By | Invoice Number o Compary ‘ | w.'_“‘

Documents Document Date

[ AR Invoices [10/E Invoices []0/E Credt/Debit Nates Fom | - - |8 To [mEEEiz31 |

Email Template ‘ SendInvoice.html ~ Preview

Al None Lost Updated 20240405 |[15:15:17 | By  [ADMIN Updaie

Customer Number  [E{Company Name Source Appl. Invoice Number Invoice Date

INOD0O0OD0D00063 2024-01-03
1105 Bargain Mart - Oakland OE INODOOO00000064 2024-01-12 1.630.19

||
[
O 4030 The House Doctors OE INODODOD0D0006S 2024-0-12 1.548.30
O 2130 Mr. Stroud Oscar Persall OE INODODODOD0D06E 2024-0-27 95526
O 2130 Mr. Stroud Oscar Persall OE INODODODOD00067 2024-02-06 296373
O 1970 Mr. Ronald English OE INODODODOD0006S 2024-02-07 54875
O 1400 Coastal Hectric Company OE INODODODOD0006S 2024-02-09 3,066.70
O 1210 ACME Plumbing OE INODODOD0D00070 2024-02-10 1.656.51
O 1970 Mr. Ronald English OE INODODODG000071 2024-02-16 344733
O 1970 Mr. Ronald English OE INODODO00000073 2024-03-12 1.269.79
O 1890 J &Y Builders Ltd OE INODODO00000074 2024-03-12 2126.08
O 2130 Mr. Stroud Oscar Persall OE INODODO0000007S 2024-03-23 2,790.11
O 1400 Coastal Hlectric Company OE INODODO00000076 2024-03-24 6.799.89
O 1200 Mr. Ronald Black OE INODODO00000aT7 2024-04-02 4,084.97
(I 1200 Mr. Ronald Black OE INODODO00000078 2024-04-02 40053 ¥
< >
|4 4 Page of 4 Send Documents Log Close

The Send Invoices program lets you:

e Quickly select all unsent A/R and O/E invoices and email them to multiple customer contacts per
company, then use the checkboxes to cherry-pick the invoices that you want to send.

¢ Find individual customers using the SmartFinder or use Advanced Search to select customers by
up to 4 customer record fields or optional fields — such as the customer number, national account,
customer group, currency, salesperson, or territory. Then use the checkboxes to refine your list.

e Select and preview email templates at run time — letting you tailor your message for different
customer groups, sales regions, countries, etc.

¢ Send emails that match each invoiced company’s preferred language. See Sending Emails and
Invoices Using the “Preferred Language” Company Setting.

¢ Add additional attachments to each email — such as your overdue payment policies.
e Click the Preview button to view the body of the selected Send Invoices email template.

If you have a multi-lingual Sage 300 system, the preview appears in the user’s language, if you
are running in French or Spanish and you created French or Spanish email templates.
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e Send invoices and credit notes created by Service Manager, a Technisoft product that integrates
with Sage 300. Note that the program does not print invoices.

The program treats invoices from other 3 party programs as if they originated in A/R.

e Log all email activity and creates a separate communication for each recipient to document the
emails, so you can view all past emails and attachments in the communications window.

Note: Send Invoices does not resend invoices that have already been sent. Use the Send Documents
function in the Companies window to resend invoices to customers.

To email invoices to customers, you must set up recipient email addresses:

Either provide an email address for each company or principle company contact on the A/R
Customer Address tab and and choose Email or Contact’'s Email as the Delivery Method in the
A/R Customer record (on the Processing tab).

AND/OR

For each CRM company, select the company contacts that should receive A/R and O/E invoices
on the Contacts tab of the CRM Company screen.

Name  [ACME Plumbing | Customer Number [1210 EBR
Search [ | [ Search | Adyanced..

a

Order By [ Cartact Code ]

Contact Code Last Name First Name [= Email A/RInvoices AR Statemerts  O/E Invoices X/Q Payment Reminders
ANDREWMURREYD0018  Murrey Andrew AndrewMurey &tairox com
ANNEYALEDDD17 Yale Anne AnneYale@tairox com
CHARLESBRIARD0016 Briar Charles CharlesBriar@tairox com
EDWARDCAVENDISHOD... Cavendish Edward EdwardCavendish @tairox.com

[Faoks e

RICHARDFUTOKWAD0020 RichardFutokwa @tairox. com

The program sends emails to email addresses specified by the customer's delivery method in A/R
as well as to all contacts set up as invoice recipients recipients in CRM (as shown above).

See Select Recipients for Emailed Invoices, Statements, Letters, Payment Reminders and Payment Due
Alerts for details.

Note: CRM also uses the “Preferred Language” setting in the Company window to send emails and
invoices from the Send Invoices program in English, French, or Spanish. See Appendix C for details.

Also note that you must set up the email settings in the Send Invoices Setup program before you can
send documents. See Send Invoices Setup for details.

Delivery Method Must be “Email” in the A/R Customer Record to Email the
Company or the Main Contact Email Addresses

If the Delivery Method set in the A/R Customer Record (on the Processing tab) is Email (Customer) or
Email (contact), TaiRox Collections will send to that email address IN ADDITION TO the contact email
addresses defined on the company’s Contacts tab (shown above).

If you do NOT want to Email invoices to some customers, specify “Mail” as the Delivery Method in A/R
on the Address tab of the A/R Customer Record AND deselect A/R and O/E invoices for all contacts on
the company's contacts tab.

You can then do a print run for unsent invoices using the O/E Invoices or A/R Invoices functions in the
Send Documents window.
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Using the Send Invoices Program
1. Choose the Send Invoices program from the Send Documents folder.

2. Click the Update button to update the grid with all unsent, selected documents (in this case A/R
and O/E invoices) in the selected date range.

If you use Service Manager V/M — Technisoft's Service and Maintenance software — you will see
two additional checkboxes in the Documents section for selecting V/M invoices and credit notes.

3. Click the All button to select all checkboxes for the current page of the grid.

Note that this is page 1 of 4 in the grid. You can lengthen the window by dragging the bottom
border, and you can use the page navigation buttons to move to each new page.

Click the All button on each grid page to include all unsent documents.

Search | | Search Advanced...
Order By | Invoice Number v| - Company | | ._"‘-
Documents Document Date
AR Invoices O/ Invoices []0/E Credit/Debit Notes = .- \ To |w3/5~12-31 |
Email Template |Sand|n\fclce.|'rtml w Preview Aftachments...
None Last Updated (20240405 |[15:1517 | By  [ADMIN | I Update I
Sele [8 Customer Number  [BJCompany Name Source Appl. [® Invoice Number Invoice Date Invoice Amourt [l
1500 OE INODOODDDOD00G3 20240103
(] 1105 Bargain Mart - Oakland OE INODOOOD00000E4 20240112 1.630.19
4030 The House Doctors OE INODOODD00D00G6S: 20240112 1.548.30
2130 Mr. Stroud Oscar Persall OE INODOODD00D00GE: 2024-01-27 955.26
2130 Mr. Stroud Oscar Persall OE INODOODD00D00E7 2024-02-06 2.963.73
O 19570 Mr. Ronald English OE INODO00D0000063 2024-02-07 54875
(] 1400 Coastal Electric Company OE INODOODD00D00ES 20240209 3,066.70
O 1210 ACME Plumbing OE INODOODD0000070 20240210 1.656.51
(] 1570 Mr. Ronald English OE INOD0OODD000071 20240218 344733
O 1970 Mr. Ronald English OE INODO00D0000073 20240312 1.269.79
O 1850 J & Builders Ltd OE INODOOOD0000074 20240312 2.126.08
2130 Mr. Stroud Oscar Persall OE INOD0ODD00D007S: 2024-03-23 2,790.11
O 1400 Coastal Hlectric Company OE INODOODD0000076: 2024-03-24 6.799.89
O 1200 Mr. Ronald Black OE INODOODD0000O77 2024-04-02 4,084.97
[ 1200 Mr. Ronald Black OE INODOODD0000078 2024-04-02 40053 ¥
< >
I Page of 4 > bl I Send Documents Log.. Close

In the screen above, we are sending O/E invoices to customers 1500, 4030, and 2130 on page 1
of the grid.

4. You can select a different email template from the dropdown list.
o The Template dropdown lists all “html’ and “txt” type messages stored the following folder:
C:\<Sage300SharedData>\Company\<companylD>\TaiRox CRM\Templates\Send Invoices
Click the Preview button to see the email template with sample customer data.

See Appendix C: Editing Email Templates for Payment Due Alerts, Overdue Payment
Reminders, and Invoices for information on creating email templates.

5. Click the Send Documents button to send the emails.
Page of 4 L

e Choose Yes when asked to confirm that you want to “send documents”. If you click No, you
can continue to edit the Send Invoices fields or close the program.

Log... Close

e The program will show progress bars as it generates PDF attachments and sends the emails.
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Viewing “Send Invoices” Emails on the Communications tab

Send A/R and O/E Invoices to Multiple Customer Contacts

You can view all email communications generated by Send Invoices on the Communications tab for the

company (or contact) or by opening the Communications window from the Sage desktop.

To view emails from the Companies window:

1.

Select the company in the Companies window and click the Communications tab.

You can also click the Communications tab for individual contacts or open the Communications

window from the Sage desktop to see communications.

Double-click the communication you want to view, then click the View Email button in the

communication window. You can double-click the attachments to see the invoices.

Name  [Bargain Mat -San Diego Customer Namber ENc)
T e |
Search I | | Search | Advanced. |

Order By

umber 1100 Bargain Mart - San Diego | At

@

File ~ Message  Insert  Options  FormatText  Review  Help  Aftachments Q Tellme

[~

| RE: Attached Invoices

To view and print the attached inveices, double-click on an attachment, and then choose File, Print when the invoice is
displayed. To save the invoice, copy it from this e-mail to another folder on your computer.

Sample Company Limited Invoice
K
notifications@tairox.com || 3 Reply | € ReplyAl | —> Forward J
To Thomson, Don; Smith, Keith; Wong, Wade English, John Wed 2022-02-02 10:53 AM
ARINTS67.PDF o /
| 448 «—

See Appendix C: Editing Email Templates for Payment Due Alerts, Overdue Payment Reminders, and

Invoices for information on creating and editing email templates.
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Send Statements, Letters, and Invoices to Multiple Recipients

CRM provides three programs for emailing and printing statements, letters, and invoices to multiple

recipients, logging all email activity, and creating communications for each recipient to document the
emails.

L
Home

~ TaiRox CRM and Collections Q
Tersale: Send Documents (Send Statements/Letters)
Collections :

Licensed to: Don Thomson, TAIROX SOFTWARE INC
Collections Reports Dealer:
Import / Export cc
Marketing
Periodic Processing = = D
Sales Reports ‘?\
Send Send A/R Invoices Send O/E Invoices Send Invoices
Send Documents I Statements/Letters
Setup v
S{.\ge For Help, press F1 Session Date: 2023-07-17 E é

The following CRM programs effectively replace three standard Sage 300 programs:

Send Statements/Letters: Replaces Sage 300 A/R Statements / Letters / Labels (in the A/R
Customer Reports folder).
Send A/R Invoices: Replaces Sage 300 A/R Invoices (in the A/R Transaction Reports folder)

Send O/E Invoices: Replaces Sage 300 Invoices (in the O/E Forms folder)
Use the Send Invoices program to email all new A/R and O/E invoices to groups of customers.

Note: Before you can email accounting documents with these programs, you must use the Accounting
Documents Setup program to specify the contents of your emails.

You must also make sure that each company record includes an email account or contact’s email
account, or has additional company contacts set up as email recipients for each document.

To email documents to customers, you must:

1. Select the “Customer” Delivery Method when you print Statements, Letters, or Invoices from
CRM —just like in A/R.

If the Print function Delivery Method is set to “Print Destination”, CRM will NOT send emails.
AND have the recipient email addresses set up

2. Either provide an email address for each company or principle company contact on the A/R
Customer Address tab and and choose Email or Contact’'s Email as the Delivery Method in
the A/R Customer record (on the Processing tab).

CRM uses the email templates set up in the Accounting Documents Setup function.
AND/OR

For each CRM company, select the accounting documents that each company contact
should receive on the Contacts tab of the CRM Company screen.

D ‘ 1"". 4+ Name |Eargam Mart - San Diega

Company Dphnna\ﬁeldsﬂppnrtunmes Documents Cases MNotes Communications

Search [

Order By Contact Code vl s

DonThomson
JohnEnglish @,
Keith Smith @1ai
[Wa

TaiRox CRM and Collections for Sage 300 125 User Guide



Accounts Receivable and Collections Send Statements, Letters, and Invoices to Multiple Recipients

Using Email or Contact’s Email addresses after you set up accounting documents:

If the Delivery Method set in the A/R Customer Record (on the Processing tab) is Email or Contact’s
Email, CRM will send to that email address IN ADDITION TO the contact email addresses defined on the
company’s Contacts tab (shown above).

If you do NOT want to send to the Email or Contact's Email addresses, specify “Mail” as the Delivery
Method in A/R on the Address tab of the A/R Customer Record.

See Select Recipients for Invoices, Statements, Letters, Payment Reminders and Payment Due Alerts.

Communications are not created if the Delivery Method in A/R is “Mail” and accounting
documents are not set up:

If the Delivery Method set in the A/R Customer Record is Mail, CRM will not create a communication.

Mixing print and email delivery methods
If some of your statements, letters or invoices are emailed to customers, and others are printed using the
“Mail” delivery method, please note the following points:

e Emailing is performed first, and then the program prints accounting documents which will be sent
out by mail.

e Depending on the Sage 300 Print Destinations, some user intervention may be required when
emailing is complete. For example, if your Sage 300 print destination is Preview, several print
preview windows may appear that you will need to deal with.

Sending Statements/Letters

This program lets you email statements and letters to multiple contacts per customer and record each
email as a communication. The screen is almost identical to the A/R Statements/Letters/Labels screen.

CRM’s Send Statements/Letters uses the emails defined with the CRM Accounting Documents Setup
program.

You should set up the email recipients for your customers (on the Contacts tab in the CRM Company
window) before using this program to send out accounting documents.

(®) Statement O Letter Use Statement ARSTMT11.RPT Browse...
IDeIi\rery Method | Customer v I
Run Date [2021-03-09 Cutoff Date 20210309 Age By
Select  Criteria
Aocoun Tpe
Select By From To
National Account | |Q [zZzZIZZ Q
Sort By Then By Then By Then By
| {None) ~ | | {Mone) V| | {None) V| ‘ {None) -
Send Documents Resend Statement ... Log... Close
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Notes:

e You MUST set the Delivery Method on this screen to “Customer” in order to send emails. If you
select “Print Destination”, all statements will be printed to the Sage 300 print destination.

e Statements and letters are added as PDF attachments to the customer email.

e Specify email messages for statements and letters with the Accounting Documents program.

The “From Email” setting in Accounting Documents overrides the email setting in CRM Options.

e Specify the recipients for statements and letters on the Contacts tab for each company. See
Specify Email Addresses for Statements, Letters, Invoices, and Payment Reminders.

Depending on the Delivery Method set in A/R for each company, the program will also send
emails to the company email address or the primary contact’s email address listed on the
Company tab.

e If you have set up one or more contacts to receive accounting documents in the CRM Company
window, and you set the Delivery Method in the A/R Customer record to Mail, CRM will send
emails only to the recipients listed in the Company window — not to the Company or Primary
Contact email address.

All company contacts with accounting documents set up will get statements or letters emailed to
them — no matter which Delivery Method is set in the A/R Customer record.

o If some statements or letters are printed, all emails will be processed first, and then printed
documents.

Resend Statements

-

Resend Statement | Additional Copy v |

Use Statement [ARSTMT11.RPT | Browse

Delivery Method | Customer ~ | Mational Account Statements
From To

et C——— 1qa  [mm== q

Send Documents Log... Close

e Click the Resend Statements button to reprint or resend a range of statements selected by date
and customer number.

e Choose a reason — either because of an incomplete statement run or to print or send an
additional copy.

e Use the Send Documents function in the Companies window to resend A/R and O/E documents —
including past statements — to individual customers.

Sending A/R Invoices

This program lets you email A/R Invoices to multiple contacts per customer and record each email as a
communication. The screen is almost identical to the A/R Invoices screen in the A/R Transaction Reports
folder.

The program sends one email to each email address and attaches up to the maximum number of
invoices specified by the Attachment Limit setting on the Accounting Document tab for the specific
company. If you have more invoices, it will attach them to a subsequent email.

Specify 1 for the Attachment Limit setting to send 1 invoice per email to customers, if they request it.

TaiRox CRM and Collections for Sage 300 127 User Guide



Accounts Receivable and Collections Send Statements, Letters, and Invoices to Multiple Recipients

You can also choose to have a single attachment that includes ALL invoices up to the maximum, or send
separate attachments for each invoice.

Use Invoice |!"'\RD|NVO-RPT | Browse ...

[ Reprint Previously Printed Invoices
Select By

(®) Batch/Entry No.

(O) Customer/Document No.

From To
Batch Na. | 1| Q | 55-5-5-55555| Q
Entry No. | 1qQ | 5988888| ()
Send Documents Align Log... Cloze

I Delivery Method | Customer e

[]Create a separate PDF for each invoice

You define Emails for Send A/R Invoices using the CRM Accounting Documents Setup program.

Notes:

You MUST set the Delivery Method on this screen to “Customer” in order to send emails. If you
select “Print Destination”, all invoices will be printed to the Sage 300 print destination.

Specify email messages for invoices using the CRM Accounting Documents Setup program.

The “From Email” setting in Accounting Documents overrides the email setting in CRM Options.

Invoices are added as PDF attachments to the customer email.

You can include all invoices in a single PDF for each customer (this is the default Sage 300
setting), or you can create a separate PDF for each invoice.

Emails for companies with Accounting Documents set up are sent to all contacts specified on the
Contacts tab in the CRM Company window for each company.

Depending on the Delivery Method set in A/R for each company, the program will also send
emails to the company email address or the primary contact’s email address listed on the
Company tab.

If you have set up one or more contacts to receive accounting documents in the CRM Company
window, and you set the Delivery Method in the A/R Customer record to Mail, CRM will send
emails only to the recipients listed in the Company window — not to the Company or Primary
Contact email address.

All companies with accounting documents set up will get invoices emailed to them — no matter
which Delivery Method is set in the A/R Customer record. (The invoice printing function must use
the “Customer” Delivery Method.)

If some invoices are printed, all emails will be processed first, and then printed documents. (The
program will print [not email] invoices for customers that have no email recipients set up.)

Like the Sage 300 Send A/R Invoices program, there is no way to skip the summary invoices that
originate in OE. Use the Send Invoices program to email A/R invoices and detailed O/E invoices.

Resend Invoices

Select “Reprint Previously Printed Invoices” to resend them to customers.

Use the Send Documents function in the Companies window to resend documents and
statements to individual customers.
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Sending O/E Invoices

This program lets you email Order Entry Invoices to multiple contacts per customer and record the emails
as communications. The screen is almost identical to the O/E Invoices screen in O/E Forms.

The program sends one email to each email address and attaches up to the maximum number of
invoices specified by the Attachment Limit setting on the Accounting Document tab for the specific
company. If you have more invoices, it will attach them to a subsequent email.

Specify 1 for the Attachment Limit setting to send 1 invoice per email to customers, if they request it.

Send O/E Invoices emails are defined using the CRM Accounting Documents Setup program.

Use Invoice |::)E|NVD1 RPT | Browse.._

From Invaice | | Q

From Invaice | Q
IDeIivery Method Customer - u

[JInclude Invoices Already Printed
[ Print Serial /Lot Mumbers
[Jinclude Backordered tems

] Prirt Kit Componert ftems

[ Prirt Bills ©f Material Componert ftems
[ Retainange

Send Documents Align Log... Close

Notes:

e You MUST set the Delivery Method on this screen to “Customer” in order to send emails. If you
select “Print Destination”, all invoices will be printed to the Sage 300 print destination.

e Specify email messages for invoices using the CRM Accounting Documents Setup program.

The “From Email” setting in Accounting Documents overrides the email setting in CRM Options.
¢ Invoices are added as PDF attachments to the customer email.

e Emails for companies with Accounting Documents set up are sent to all contacts specified on the
Contacts tab in the CRM Company window for each company.

Depending on the Delivery Method set in A/R for each company, the program will also send
emails to the company email address or the primary contact’s email address listed on the
Company tab.

e If you have set up one or more contacts to receive accounting documents in the CRM Company
window, and you set the Delivery Method in the A/R Customer record to Mail, CRM will send
emails only to the recipients listed in the Company window — not to the Company or Primary
Contact email address.

All companies with accounting documents set up will get invoices emailed to them — no matter
which Delivery Method is set in the A/R Customer record. (The invoice printing function must use
the “Customer” Delivery Method.)

e If some invoices are printed, all emails will be processed first, and then printed documents.

o Use the Send Invoices program to email A/R invoices and detailed O/E invoices.
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Resend Invoices
e Select “Include Invoices Already Printed” to resend them to customers.

e Use the Send Documents function in the Companies window to resend documents and
statements to individual customers.

Viewing Emails in the Communications window

All email communications generated by Send Documents programs and overdue payment reminders
created by Overdue Payments are available in the Communications window — letting you maintain a
complete trail of all customer communications.

To view emails:

1. Open the Communications window.

2. Double-click the communication that you want to view. (Use Company Search to view
communications for a single company.)

Name  [Pverdus Payment Reminderforinvoice OEING000000000021

Communications Contacts Documents Companies

Aa+

Communication Contacts Documents Companies

Name  [Dverdus Payment Reminder for invoice OEINODOD030000E21

01 Januar
2 02 Februg
3 03 March|

] cessn oty [
‘2&3"57“ Modified On 0210303 | Modiied By o
e

7074y ]| Tyee [EMAL | [Ewai H vewzmar ]
808 Augus | Notes [Cusstomer Number 1100 Bargain Mart - San Disge
9 09 Septer

10 10 Oictobs

1111 Noven Your payment for Sample Company Limited is overdue - Messa...

12 12 Decen

26 Collection| File Message  Help Q  Tell me what you want to do
19 Documen|
16 Documen| To Jenner, William; LeMuir, Harry; Grange, J: Anderse
17 Documen|
File Edit View Sign Window Help
18 oomeny 2] OEIND0D0000000045 PDF
27 Emai fol W 48Ke v =—P | fome Tools OEIN0D000000000... X @ Sign In
14 Youran | Oyr records show that we haven't yet rece 3 0
< - ) s ‘Eﬂ ‘)ﬁ @ @ Q 171 663% v 69. =4 :0
listed below. I would appreciate it if you cc
Page payment. o)
. ; i Poe
Please include your account number (1240 Sample Company Limited #or20, 2020 ‘ 1
123 Sampee Compary Flaza Invoice Number
' . Ay Ty iy Prange, VEL ST
The details of all overdue invoices are as fq LG A i NOOLO000000%5 LT%
RS
Invoice Date Amoun/ ?
S0ia To- Ship To: =
IN0000000000045 2020-04-20 |1,796.4 e Coutyara Fosta Qutet
15545 Sneaman Crescent Box 157
Farmans, Ak 19183 Pocta Oust 754
' i B

3. Click the View Email button in the communication window to display the email.
You can then open the attachments to see the original documents.

Note that older emails generated by Send Documents programs (prior to January 2020)
were stored differently in CRM.

See Open older emails for more information.
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Resend Individual Documents from the Companies Window

The Send Documents button lets you quickly and easily resend existing A/R or O/E documents (invoices,
orders, receipts, statements, etc.) or other attachments to any customer or contact email address directly
from CRM.

e Type the body of the email on a standard email form or use a previously-saved email template.

e Select any of the company and contact email addresses in CRM. Cc and Bcc values can default
to prior values (see user settings).

e Select any prior A/R and O/E documents to add as attachments.

e Click the Send button to generate and attach PDF’d documents and send the email.

¢ View all past emails and attachments in the communications window.

To start, click the Send Documents button in the CRM Companies window.

See Options for details.

Note: You must set up the email settings in Setup Options before you can send documents.

Name |M:ME Plumbing | Customer Number ZNC]
Companies Contacts Opportunities Documents Cases Motes  Communications
Search | | Search Advanced... |
Order By [ Name v] &
ID [H Customer Number Name = Street 2 City /Prov. Courtry Phone Number
927 Warehouse Road Kansas City |MO 5 (816) 555-3341
9 1550 Astral Construction Co Ltd.  ASTRA 418 Canal Drive Pustin TX USA 787676112 (512) 5559192
2 1105 Bargain Mart - Oakland BMT-OK Bargain Mart Plaza Comer 182nd and... Anytown CA USA 45112 (408) 451-8981
11100 Bargain Mart - San Diego BMT-5D Bargain Mart Plaza Comer 182nd and... Anytown CA USA 45112 (408) 451-8981
24 BARMART Bargain Mart Stores Inc BARMART Bargain Mart Plaza Comer 182nd and... Anytown CA USA 45112 (408) 555-MART
18 7100 Bashaw Bulldozing BASHAW 2358 Colorado Cres Buriingame  Ontario L7L 2Y9 (905) 555-1212
10 1580 Break-Away Designs BREAK 743 Wark Street Sacramento  CA USA 93721 (916) 555-1422
19 7200 CanAm Industries CANAM 1898 King George Street Toronta Ontario L7y 321 (416) 555-8752
23 9999 Cash Transactions CASH
6 1400 Coastal Electic Company COAST 586 Tanner Road Toronta Ontario Canada  67182-1087 (416) 5554799
7 1500 Custom Comfort CUSTO 3741 Main Street Richmond VA usa 23519 (804) 555-7272
11 1600 Dr. Dan Penn PENN 1876 Jackson Street Des Moines  |A usa 72784 (515) 555-4728
15 2235 Farester Buiding Supplies FORES #H4E North Gate Mall San Franci... CA UsSA 58132 (415) 555-9830
16 2240 Frame-Up FRAME 508 James Road Houston TX USA 67147 (713) 555-2273
12 1830 J &Y Builders Ltd. J&Y 333 Ralston Way Sacramento  CA Canada 982746233 (916) 555-9821
28 Margory Hargreaves & Asso... HARG 1208 Jordan Rd Callwood C... BC
31200 Mr. Ronald Black BLACK 2820 Wabash Road Los Angeles CA Usa 30048 (213) 555-0274
13 1570 Mr. Ronald English ENGLI 2375 Hudson Avenue Fairbanks AK USA 79160 (307) 5551719
8 1520 Mr. Stephen Kershaw KERSH 4730 112th Street Richmond VA Usa 23503 (804) 555-3372
14 2130 Mr. Stroud Oscar Persall FERSA 4931 Trent Street Philadelphia PA usa 3247 (215) 5554375
€ >
Page of 2 | Add. Delete Link... Unlink Promote.. Collections... Change Log...

Close

Creating New Email Communications with A/R and O/E Document Attachments

Send Documents lets you send or resend A/R and O/E documents or miscellaneous attachments to
customer contact email addresses maintained in CRM and Collections.

To compose and send emails:

1. Open the Companies window, select the customer that you want to contact (click the row in the
grid), and click the “Send Documents...” button. Or double-click a company name to open a
company record, and then click the “Send Documents...” button on the Company screen.
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Check that you have the correct name and customer number at the top of the screen.

Name [Mr. Ronald Black | | customer humper  [1200 B/
Communication  Recipients A/RInvoices A/R Receipts O/EOrders O/E Invoices 0/E Credit/Debit Notes  A/R Statements

Email Message  |REQDOCS Qb I Attachments. I
Subject [Documents Requested by Sample Company Limied |
Ce [ |
Bec [ |
ReoTo | |
Body. Dear Nr. Black:

[The documents that you requested have been attached to this email. i you reqire anything else. or f you have any mor questions please contact me at (123) 456-7890.
Note: You require Adobe Acrobat Reader to view attachments. Adobe Acrobat Readeris available from wwiw.adobe.com.

Regards

Ms. Smth

‘Send Documents Close

o Fillin the email subject and the body of the email message or choose a message template
from the Finder beside the Email Message field. The Finder displays all “Letter” type
messages stored with Accounts Receivable.

See Email Message Templates and Variables Supported by “Send Documents” Emails.

Note: The email body can be up to 2,500 characters long.

o Click the Attachments button to attach miscellaneous documents from your computer or
network to this email. See Sending Miscellaneous Emails and Email Attachments to Contacts
for more information.

o Add email addresses in the Cc and Bcc fields to send copies (or blind copies) to other
recipients in your company. To Cc or Bcc multiple recipients, separate the email addresses
with commas or semicolons.

o Add a Reply To email address to handle customer queries.

Note: The Reply To address overrides the “From Email” address specified on the Email tab
in CRM Options.

Click the Recipients tab and select the recipients from the list of company contacts:

Cnmmun\zﬁlmn}vﬁlnvmces A/R Receipts O/EOrders O/E Invoices  O/E Credit/Debit Notes ~ A/R Statements
Search [ Search | Adyanced..

Order By [ Cortact Code o] .

ID Contact Code First Name

Middle Mame Salutation Job Title Phone (Office) Phone (Mobile)

O 18 ANDREWMURREY Murey Andrew Directorof Sales  (416) 5551067 (416)555-1000 (4
17 ANNEYALE Yale Anne (604) 5551086 (604)555-1054 (6(
O 16 CHARLESBRIAR Briar Charles (636) 5551085 (636)555-1048 (6

EDWARDCAVENDISH __[Cavendish ____JEdwaed | | | (2]
O 20 RICHARDFUTOKW Futokwa Richard Hs Purchasing Director (800) 555-1038  (800)555-1037 (8¢

To add a company recipient that is not in the contact list.

e Double-click a recipient to open the Contact window, and then click the New button (+) beside
the Contact Code field.

e Fill in the contact information, and click the Add button. The new contact will be automatically
linked to the current company.

Select the A/R and O/E documents that you want to attach to the email from the tabs at the top of
the screen. For A/R invoices, you can include or exclude fully paid invoices from the list.

Communication Reﬂp\aﬂlsNRRece«pts O/ECrders  O/E Invoices O/ Credit/Debit Notes ~ A/R Statements

Search | Search | Adyanced. |
Order By [ Document Number ] % [ include Fully Paid Transactions
Attach  Document Type (B Document Number  Document Dabe Due Date  Fully Pad  Invoice Description  Amourt Due [BBatch/Entry No.  Posting Date  Fiscal Year Fiscal Perid
Credit Note CROD0000000000000. . 2021-03-09 20210309 No -1,07059 66-1 20210309 2 03
Invoice INDODODOD000000000... 20200730 20200829 Yes Orsite Installation 000 61-1 20200730 2020 07
2020 05
O Invace INVCORPOO3 20200518 20200617 Yes 000 57-1 20200518 2020 05
[1  Credt Note TRLRE-D02 20190203 20190203  Yes Cred Note Appl To | 0.00 45-1 20150203 2018 02
O  Credt Note TRCREQ0S 20190327 20130327 Yes Cred Note Appl To |. 000 52-1 0190227 2019 03

Add miscellaneous attachments using the Attachments button on the Communication tab.
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If you have use Service Manager V/M — Technisoft's Service and Maintenance software — you will
see two additional tabs for selecting Invoices and credit notes.

Communication ~Recipients A/R Invoices A/R Receipts O/EOrders O/E Invoices  O/E Credit/Debit Notes  A/R Statements§ V/M Invoices /M Credit Notes
Search [ Search | Advanced

Order By [ Pasting Number v] % [ hclude Fuly Paid Transactions

Attach B Posting Number Site Number

[ INVDDDO00DD3 1210
1 INVDDDOO0D16

5. Click the Options button on each accounting document tab to choose the A/R or O/E forms that
you want to use for creating PDF attachments. Each form also provides a set of printing options:

Communication memlsNRReemn‘s O/EOrders  O/E Invoices  O/E Credit/Debit Notes  A/R Statements
Search Seach | Adyanced.. |
Order By Document Number ~| % [ include Fully Paid Transactions
Attach  Documert Type  [4 Document Number  Document Dat Due Date Fully Paid  Invoice Description ~ Amount Due [ Batch/Entry No.  Posting Date  Fiscal Year Fiscal Periq
[ Credt Hote CROO0D000000000000... 2020-D6-30 2020-06-30  Yes Project and Job Co. 000 25-4 2020-06-30 2020 06
0O  Invoice IN0000000000000000... 2020-06-30 20200705  No Project and Job Co. 566.48 25-3 202006-30 2020 06
O Invoice INODDOODOO0D00000O... 2020-07-30 2020-08-05 No Equipment Maintains 406.27 61-2 202007-30 2020 07 .
e Pmen @m0 A/R Invoice
E " ThcaEws Meww s w options
O  nvoice ) TRINV0 5 s s o Choose the
Cancel
Crystal report for
emailing
A/R invoices.
Page of 1
Send Documents Close
Use Reospt  [FRRCFTAPT Bromc® A/R Receipts options
e Choose the Crystal report for emailing, and
O Summary choose a detail or summary report format.
Corce
Use Quots Browse.. Quote options
[] Use Custom Form ™
et Kt oot e Choose the Crystal report for emailing quotes,
] Print B OF ateil Comporent ems and select report options.
Cancel
Use Certirmaion Browss
B e s Order Confirmation options
[ Use Custorm Fom Choose the Crystal report for emailing quotes,
Pt Comperet tens and select report options.
[ Print Bills Of Material Component ftems
Cencel
Use Invoice Browse...
[ Print Serial/Lot Numbers ) )
[ incde Backerdered tems O/E Invoice options
[ Use Guston Fom Choose the Crystal report for emailing quotes,
it K& Componert tens and select report options.
[ Print Bills Of Material Component ftems
[]Retainange
Cance
Use Credi Note Browse...
5 S e O/E Credit/Debit Note options
[[] Use Custom Form . . .
D s Choose the Crystal report for emailing credit/debit
] Pat il OF Materil Component e notes, and select report options.
[]Retainange
Cancel
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6. Click the Send Documents button to send the email.

Name

Subject
Cc

Bee
Reply To
Body

]| | o 8
Communication
Email Message  [REQDOCS Q D_

[1ar- Ronald Biacic

Recipients A/R Invoices A/RRecsipts O/EOrders O/Elnvoices O/E Credit/Debit Notes  A/R Statements

Atachmerts...
[Documents Requested by Sample Company Linied |
\ |
\ |
\

Dear Mr. Back:

(The documents that you requested have been attached to this email. I you reauire anything else. or f you have any more questions please contact me at (123) 456-7890
Note: You require Adobe Acrobat Readerto view attachments. Adobe Acrobat Reader is available from wivw.adobe.com.
Regards

Ms. Smith

Send Documents I

Close

o Choose Yes when asked to confirm that you want to “send documents”. If you click No, you

can continue to edit the email content.

The program will show progress bars as it generates PDF attachments and sends the email.

The program will display a message when the email is sent, and then return to the
Companies window when you acknowledge it.

Sending Miscellaneous Emails and Email Attachments to Contacts

Send Documents also lets you attach any documents on your computer (or on the network) to the email

and send it to multiple company contacts.

You can also send emails that do not have any attachments. CRM will save the email as a
communication, maintaining a complete contact email history.

To attach documents:

1. Click the Attachments button on the Communication tab.

Cammunication ~Recipients  A/R Invoices A/R Receipts O/EOrders O/ Invoices O/ Credit/Debit Notes  A/R Statements.
Emai Message [REQDOCS QR |_|Mamm_
Subject ‘Ducumenls Requested by Sample Company Limted

]
Drag and drop attachments into the Attachments window.

Add Delete Clase

Or click the Add button on the Attachments window to browse to the documents that you want to
add.

o

TaiRox CRM and Collections for Sage 300

To delete a document from the list, select the document and click the Delete button or press
the Delete key on your keyboard.
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3. Click the Close button when you have added all your attachments.

When you close the window, the Attachments button will show you the number of attached
documents. Click the button to open the Attachments window and edit the list.

| Attachments (2)... |

4. Edit the email and select email recipients from the Recipients tab, and then click the Send
Documents button to send the email.

The following message will appear if you did not select any accounting documents to resend
to recipients.

o You have not selected any documents to send.

Are you sure you want to send documents?

tes

5. Click Yes to send the email with only the miscellaneous attachments.

Viewing “Send Documents” Emails on the Communications tab

All email communications generated by Send Documents are available on the Communications tab for
the company (or contact) or by opening the CRM and Collections Communications window from the Sage
desktop — letting you maintain a complete trail of all customer communications.

To view emails from the Companies window:

1. Select the company in the Companies window and click the Communication tab (or open the
Communications window from the Sage desktop).

2. Double-click the communication you want to view, then click the View Email button in the
communication window. You can double-click the attachments to see the original documents.

Name [Bargain Mart - Oakland

T ———— |
Search [ | | Search Adyanced

Order By [ Hame ~] 2

5@

Notes

Customer Number 1105 Bargain Mart - Oakland EORDO0D0DOCD0DE3 PDF

D [ ®Q + Name [Reauested Documents Atached

Communication ~Contacts Documents Companies

- P
Madfied On Madied By KETH

Type [EmAL | [Eval | | View Email |
Notes (Custemer Number 1105 Bargain Mart - Oakland

=] Attached - Message (Pla = ]
Commert o/E File Message Help Q Tell me what you want to do

10/E Inj

[~

Requested Documents Attached

in.saintj Reply | < Reply All Forward
o martin.saintjohn@samltd.com ) Reply ) Reply —> Forwar

To C com; . airox.com Maon 2020-12-21 11:29 AM

OEORDOGDOCOCD0DE3.PDF OEINODDD000000059.PDF
* ] 49KB w | 40KB

Requested documents attached:

The documents that you requested have been attached to this email. Please let me know if you have
any question or if you require any more information.

Regards,
g Change Log.
Martin

Note that older emails (prior to January 2020) were stored differently in CRM.
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To access older emails:

o Open the Communications window from the Sage desktop — as shown below — or select the
company in the Companies window and click the Communication tab.
e
—
o -
Foge 1 o o s | Bt s | | Bt L. oo | (oo
@)

To view the email with attachments, select the Documents tab, and click the Document
column heading.

TRl = Grerdue Payment Remindes foremooce PR =121 [

T +  Hanm Do Fopmes e e WRHROOIOCET i M -@
from - Sent Mon 8/10/2020 10:04 a8

Conmacaton Corsss ooty Conpanes " N ——

= g | oo ] s | Sublet  Overdu Fayment Reminder for lce TRSOS00E000021

Ontes By Narma -r" i S o

Dear Mr. Jose Grange,

‘We st have not recelved payment far Invoice AINOUDODIBODOZ] for 95,57 which
was due on 11/13/2015.

Bacause w have bsen unable to work out payment with you, | regret to inform
ou that if we da not hear from you in 3 days we will repart this ssue ta the credit
Bureau and turn this Invoiks over o a callection agancy who will contact you
regand to payment,

vvvvvvv

|
F==re

page [ 0] w0

= =

Themsen, Don FUFEEY -
[ Sewe s

Dom |

3. To view Company information from the Communication window, click the Companies tab, then
double-click the row with the company name.

= ] Cesaon  [FEHT | ovesany  POWH P
ool e Nobiwitn  [RUHH | moiedty DR oy i
P Ol
! Strn T - Gt
=) ERL
= v s
= s e
ot e [T a
B e [0
RETTR| Pon oo e vt Ok [ o gt st
)
s SmiDvamen. | | Qergelon
Pon [ ]a e ][ o
[ o
|| =

Email Message Templates and Variables Supported by “Send Documents” Emails

You can create and save standard email messages to use with the Send Documents program. Use the

Finder to select existing message templates. The Finder displays all “Letter” type messages stored with
Sage 300 Accounts Receivable.

®s

Name

ALTD - Send Documents

[Mr. Ronald Black

File Key Settings Global Settings

Communication  Recipients AR Invoices  A/R Rece]

Email Message [REGDOCS =]

Ce

S —
o E—
Body Dear Mr. Black:

The documents that you requested ha

Find By: | Show al records ~ Find Now

[ Auto Search

Message Typs

Message ID Description

Set Criteria

(123) 456-7390.

Note: You require Adobe Acrobat Real

Email Subject Email Body
Letter (Email) DEFAULT Overdue letter Overdue accou Dear SCUSTOM
REQDOCS oM.
v
< >
Cancel

TaiRox CRM and Colle

ctions for Sage 300
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To create and save a hew message:

1. Click the Zoom button beside the Email Message field to display the A/R Messages form.

-

® SAMLTD - Send Documents - [m]

- ‘Mr S _
Commurication  Recipients A/R Invoices A/R Receipts  0/E Orders

Email Message [REQDOCS qQ —— P | Messzge Type Letter (E-mai) MessageD |4 4 [FESDASH
Subject |Dn:uments Requested by Sample Company Limited Description |Raquamd Documents ‘
e | Last Maintsined [po22o1-12 Clinsctive
Bee [
Email Subject [Docments Requesied by SCOMPANY_NANE ‘
Reply To [
Body Deor i Black Dear SCUSTOMER CONTACT
IThe documents that you requested have been attached to tis emal. Fyou require amyhing else, r f you have any more
The documentsthat you equested have been attached ] | docunerts il you eaueded have been i
ote: You require Adobe Acrobat Readerto view Stachmy |\ 1. vou require Adobe Acrobat Readerto view attachments. Adobe Acrobat Reader is avalable from www adobe.com
Fegards, Regards,
M. Smith SCOMPANY_CONTACT
Save Delete Close

2. Click the New button (+) on the right side of the Message ID field.

3. Enter a name for the new email template (the Message ID), and enter a Description and Email
Subject.

Compose the message using any of the variables listed below.
Click the Add button.

Email Variables

You can use the following variables in all email messages:

Email Message Variable Value to Insert

$COMPANY_CONTACT Company Contact from CRM & Collection’s Company record
$COMPANY_NAME Company Name from CRM & Collection’s Company record
$CUSTOMER_ID A/R Customer ID

$CUSTOMER_CONTACT Customer Contact from the A/R Customer record
$CUSTOMER_NAME Customer Name from the A/R Customer record

$COMPANY_FAX Company Fax Number from CRM & Collection’s Company record
$COMPANY_PHONE Company Phone Number from CRM & Collection’s Company record
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Collections Reports and Collections Performance Charts

TaiRox collection charts and reports cut through surplus data to provide a quick overview of your

company’s collections performance. Along with the Customer Aging program, they help you monitor and
manage your company’s receivables.

TaiRox Collections provides two kinds of reports:
e Charts that show the effectiveness of your company’s credit and collection policies.

Charts create Excel spreadsheets containing the consolidated data and the chart. The
spreadsheet is completely editable.

e Reports that show the current status, details, and currency totals for all or a selection of your
company’s disputed invoices, overdue invoices, payment reminders, and promised payments.

Reports use the standard Crystal Reports engine for Sage 300, letting you print to standard Sage
print destinations and export data to PDF, Word, or Excel spreadsheet formats.

Access: Open the Collections Reports folder, then select the chart or report that you want to display.

L]
Home

~ TaiRox CRM and Collections -
ChangeLog Collections Reports (Avg. Days To Pay Chart)
Collections
Licensed to: Don Thomson, TAIROX SOFTWARE INC
| Collections Reports | Desler
Import / Export o
Marketing
Periodic Processing I I I = = = =
Salles Reports o LLLLS LLLLS
Avg.DaysToPay  Avg.DaysOverdue Effectivencssinder  Disputed Invoices  Overdue Invoices  Overdue Psyment  Promised Payments
S Dearmas Chart ch Reminders
Setup
~ TaiRox Productivity Tools .
Sage  ForHelp, press F1 Session Date: 2023-10-24 | [B

Average Days to Pay

The program charts the average number of days clients take to pay their bills, indicating the effectiveness

of your company’s credit and collection policies, and allowing you to see the effectiveness over time of
policy changes.

0
Home
P

~ TaiRox CRM and Collections

Collections Reports (Avg. Days To Pay Chart)

clizsime Licensed to: Don Thomson, TAIROX SOFTWARE INC
Collections Reports Desler

Import / Export

Marketing

Periodic Processing

Sales Reports L

Avg.DaysToPay | Avg.Days Overdue Effectivenessindex  Disputed Invoices  Overdue Invoices  Overdue Payment  Promised Payments
Chart Chart Chart Reminders

Session Date: 2023-10-24 | [&

To chart Average Days to Pay:
1. Select TaiRox CRM and Collections > Collections Reports > Avg. Days to Pay Chart.

2. Select customers using a range of customer record and customer optional fields.

Customers

Select Customers By From To

Customer Number

Frefermed Customer
(None}
(None}

<<l <]l ¢

Create Chatt Close

TaiRox CRM and Collections for Sage 300 138 User Guide



Accounts Receivable and Collections

3. Click Create Chart.

The program will display the chart and data in separate worksheets in an Excel workbook.

K

Average Days To Pay
Created 2020-04-30 10:03

Days

1

o

WS <l
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Average Days Overdue

Collections Reports and Collections Performance Charts

The program charts the average number of days that invoices are overdue before being paid. This is also
a measure of your company’s credit and collection policies, and allows you measure their effectiveness

over time.

[
Home

~ TaiRox CRM and Collections 2

Ghange Log Collections Reports (Avg. Days Overdue Chart)
Collections

Collections Reports

Import / Export

Licensed to:
Dealer:
[<¢]

Don Thomson, TAIROX SOFTWARE INC

Marketing

Periodic Processing

EffectivenessIndex  Disputed Invoices  Overdue Invoices
Chart

Overdue Payment  Promised Payments
Reminders

Sales Reports

S Avg.DaysToPay | Avg. Days Overdue
en: ks Chart Chart

Setup

~ TaiRex Productivity Tools

Soge

For Help, press F1 Session Date: 2023-10-24 | [

To chart Average Days Overdue:
1. Select TaiRox CRM and Collections > Collections Reports > Avg. Days Overdue Chart.

2. Select customers using a range of customer record and customer optional fields.

Customers

Select Customers By

To

Customer Number

4

Prefemed Customer

(None}

(None)

<Ll e«

Closs

3.

Click Create Chart.

The program will display the chart and data in separate worksheets in an Excel workbook.
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Average Days Overdue
Created 2020-04-30 10:02

QQDQDQ'\Q’\& & o ‘”w*w“'e*e“‘.@’

TSI a em@aw@m@ o @i@? P
Date Paid (Month)
| .

Collections Effectiveness Index

The Collections Effectiveness Index (CEI) show the percentage of receivables that have been collected in
each month over the past year. It compares the amount that was collected in each month during the
year to the receivables that were available for collection.

Essentially, this metric shows how quickly your company collects outstanding receivables. An
effectiveness index near 80% or above indicates a very effective collections process, while an index of
50% and below is low and should be investigated.

The formula for the effectiveness index includes the total credit sales for each month. Because Sage
does not differentiate between credit sales and cash sales, this program considers invoices paid on or the
day after the invoice date to be cash sales, and all other invoices to be credit sales.

Beginning Receivables + Monthly Credit Sales — Ending Total Receivables

X 100
Beginning Receivables + Monthly Credit Sales — Ending Current Receivables

The program includes invoices, debit notes, and interest in the sales total.

[
Home

v TaiRox CRM and Collections A . 5
Collections Reports (Effectiveness Index Chart)

Licensed to: Don Thomson, TAIROX SOFTWARE INC
ports. Dealer:

Import/ Export
Marketing

Periodic Processing I = =2 =2 =2
s —

Avg D o T Pay  Avg.Days Overdue | Effectivenessindex | Disputed Invoices  Overdue Invoices  OverduePayment  Promised Payments
Chart Chart Reminders

Send Documents

Setup
~ TaiRox Productivity Tools

Sage | ForHelp, press F1 Session Date: 2023-10-24  [B

To chart the Effectiveness Index:
1. Select TaiRox CRM and Collections > Collections Reports > Effectiveness Index Chart.
2. Click Create Chart.

The program will display the chart and data in separate worksheets in an Excel workbook.
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Collections Effectiveness Index
Created 2022-04-14 13:34
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Disputed Invoices

This report that let you review the current status, details, and currency totals for all or a selection of your
company’s disputed invoices. You can print the report for all assigned disputed invoices, for unassigned
invoices, or for invoices assigned to a specific user.

Reports use the standard Crystal Reports engine for Sage 300, letting you print to standard Sage print
destinations and export data to PDF, Word, or Excel spreadsheet formats.

.
Home

v TaiRox CRM and Collections " . . .
Change Log Collections Reports (Disputed Invoices)

Licensed to: Don Thomsen, TAIROX SOFTWARE INC

Avg.DaysToPay  Avg.Days Overdue  Effectivenessindex | Disputed Invoices | Overdue Invoices  Overdue Payment  Promised Payments
Chart Chart Reminders

v TaiRox Productivity Tools

Sage  ForHelp, press Fi Session Date: 2023-10-24 | [&

To print the Disputed Invoices report:
1. Select TaiRox CRM and Collections > Collections Reports > Disputed Invoices.

2. Specify the contents of the report using the options on the following screen, then click the Print

button.

=

n [ =

invoice Number | | W [rrzmmmzzzEZZZZTZZZZ. |
Customer Number l:l':: To ‘fﬁ(

Customer Group l:l'fﬁ( To -’}

Include Open
Include Closed
Include Notes

[fssign 2N {
Sort By Then By
[ Invoice Number ][ None) -
Print Close

Range Fields: The program lets you select disputed invoices using a range of invoice numbers,
customer numbers, customer groups, and creation dates.

Include Open/Closed/Notes: Use the checkboxes to print open and/or closed records and to
print all Notes that are attached to the Notes tab for disputed invoices.
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The contents of the Notes field on the Disputed Invoices tab always appear on the report. (See
example below.)

Assigned To: Select this checkbox and use the Finder to print all disputed invoices assigned to
a single user. Leave the field blank to print all unassigned disputed invoices.

Sort By: You can choose two levels of sorting — by invoice number, customer number, customer
group, currency, assigned user, creation date, number of days open, and revisit date. For
example, you can group all disputed invoices by assigned to user, then list by currency within
each group.

Days Open: This is the number of days that the disputed invoice record has been Open —
calculated as Days Open = Current Date — Created On Date. If the record has been closed,
the calculation is Days Open = Closed On Date — Created On Date

The program will print or display the disputed invoices report using the Sage 300 print destination
that you selected.

60312020 953:15AM Sample Company Limited Page 1
Disputed invoices
CreatedOn [ To[12/31/5898]
k [ITol;
Customer Number [ITo[zz2222277777)
Customer Group [ITo[z22222)
Include Open [Yes]
Inchude Closed [NeJ
Inchude Notes [Yes]
Assigned To [Anyone]
SortBy [Invoice Number]
D CusiomerNo.  Customer Name Invote Number Days Amt nDspute Cum. AssignedTo RevsdOn  CresledOn CresiedBy Stahus
v Dake  DueDaie Inv_ Amount Balance
11210 ACME Plumbing INDODOOODOO00SS 8 138.00 USD  FRED 62412000 5262020 ADMIN Open
53172020 652020 138.35 13635
Referto the Notes tabfor details on dispute and meetings with customer.
1D: 16 Created On:6/26/2020  Created By: ADMIN Name: June 11 mestng with customer
Met with customer regarding dispute on June 11
Issue:
- Deliverywas late. Customerrequired defivery by May &
- Orderwes incom rejecteditem
- Following upwith sales toverity customerstory
2 1108 Bargain Mart - Oakland INDODDOODOD0DSS 8 25000 USD  FRED 6232020 5262020  ADMIN Open
652020 6152020 1,038.57 1,03657
Have not yet metwith the sales about this order because rep is on sick leave - meeing Friday June 19,
Summary
Currency Total In Dispute:
UsD 388.00
2Disputed Invoices printed

o This example includes a note added to the Notes tab for the first disputed invoice for ACME
Plumbing.

The other freeform text is from the Notes field on the Disputed Invoice tab.

o The program prints a summary of the total amount of disputed invoices for each currency at
the end of the report.

Overdue Invoices

This report that let you review the current status, details, and currency totals for all or a selection of your
company’s overdue invoices. You can print the report for all assigned overdue invoices, for unassigned
invoices, invoices that are on hold, or for overdue invoices assigned to a specific user.

Reports use the standard Crystal Reports engine for Sage 300, letting you print to standard Sage print
destinations and export data to PDF, Word, or Excel spreadsheet formats.
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£l
Home

~ TaiRox CRM and Collections 2

Change Log Collections Reports (Overdue Invoices)

Collections
Licensedto:  Don Thomson, TAIROX SOFTWARE INC

Collections Reports Dealer:

= «
Avg.DaysToPay  Avg.Days Overdue Effectivenessindex  Disputed Invoices | Overdue Invoices | OverduePayment  Promised Payments
Chart Chart Chart er
~ TaiRox Productivity Tools .
Sage | ForHelp, press F1 [] Session Date: 2023-10-24 | [§

To print the Overdue Invoices report:
1. Select TaiRox CRM and Collections > Collections Reports > Overdue Invoices.

2. Specify the contents of the report using the options on the following screen, then click the Print

button.
=
Crastad On 20220801 To [39551231
Invoice Number |Q T |[EEzzzzZzZZZIZIZZZZZZZ |Q
Customer Number Q To Q
Customer Group Q To |ZZZZZZ Q
R ™
Include Open [Clénclude Notes Select
Include Overdue Payment @A
[ include Closed
Reminders )0n Hold
[ Assigned To ADMIN } ) Not On Hold
Sort By Then By
[ Days Overdue | [ Customer Number ]
Print Close

Range Fields: The program lets you select overdue invoices using a range of creation dates,
invoice numbers, customer numbers, customer groups, and days overdue.

Include: Use the checkboxes to print open or closed records, to print notes that are attached to
the Notes tab for overdue invoices, and to include overdue payment reminder emails or tasks.

Select: You can print a report that only shows invoices that are on hold or not on hold. The
report flags all on hold invoices.

Assigned To: Select this checkbox and use the Finder to print all overdue invoices assigned to
a single user. Leave the field blank to print all unassigned invoices.

Sort By: You can specify two levels of sorting using the invoice number, customer number,
customer group, currency, assigned user, creation date, stage, days overdue, and revisit date.
For example, you can group invoices by assigned to user, then list by currency within each group.

The program will print or display the overdue invoices report using the Sage 300 print destination
that you selected.
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2020-03-30 12:20:14PM Sample Company Limited Page 1
Overdue Invoices

Created On [2020-01-10] To [395-12-31] Overdue Invoices Last Updated: 2020-01-10
Invoice Humbx (1 To[Z2Z227777777 777 7777777
Customer Number [1600]
Customer Group [1Te[222227]
Days Overdue [10] To [98589]
Include Open [fes] Include Hotes [Yes]
Include Closed INo] Include Overdue Payment Reminders  [Yes]
Select (a0
Assigned To [Anyone]
Sort By [Days Overdue, Customer Number]
ID Customer Humbes | Currency | Invoice Number mv. Date / Imv_ Amount / Days ~ Assigned To/ Sialus
Customer Name: Fags Due Date Balance Overdue RevisitOn
61 1500 CAD INOODOOOD000024 2018-10-12 26272 77 Open
Dr. Dan Penn 2019-10-25 37.76
OPRID:20210929-122551-0003  CreatedOn:2013-10-28  Created By: ADMIN Create Task
64 1600 cAD INDODDDODOD0D12 2019-08-10 W5 13 KETH Open
Dr. Dan Fenn 2019-09-08 9854 2019-10-27
"ONHOLD™ |
NOTEID: 3 Created On-2015-10-06 Created By ADMIN Name: Invoice item prices in dispute

Customer claims 3 verbal agreement with sales for a 15% discount on tems. Check with Bryan.

Summary
Currency Total
CAD 13630
2Overdue Invoices printed
Company Flags: - Customer is on hold $ - Company has unapplied credit |- Company has open cases 7 - Company has disputed invoioes -+ - Company has promised payments
Invoice Flags #- Invoice has a payment schedule @ - Invoice is being disputed

o Print selection criteria appear at the top of the report. This report lists invoices for customer
1600, one of which is assigned to Keith.

o Notes and overdue payment reminders (OPRs) are optionally printed for each invoice.

o Company flags show whether the customer is on hold or has unapplied credit, open cases,
disputed invoices or promised payments. Invoice flags show whether the invoice has a
payment schedule or is disputed.

o The program prints a summary of the total invoice amounts by source currency.

Overdue Payment Reminders

This report that let you review the details and currency totals for all or a selection of your company’s
pending or processed (sent) payment reminders. You can print a summary or detail report, print the report
for a range of customer groups, customer numbers and date processed, and sort the details using the
selection criteria.

Reports use the standard Crystal Reports engine for Sage 300, letting you print to standard Sage print
destinations and export data to PDF, Word, or Excel spreadsheet formats.

~ TaiRox CRM and Collections e . X
@l Collections Reports (Overdue Payment Reminders)

llection:
(Eukec o Licensed to: Don Thomson, TAIROX SOFTWARE INC

Collections Reports Dealer:

Import / Export «
Marketing

Periodic Processing I =] =] = [=- |
Sales Reports JLilh LLLLY LLiik
S Avg.DaysToPay  Avg.Days Overdue  Effectivenessindex  Disputed Invoices  Overdue Invoices | Overdue Payment | Promised Payments
end Documents Chart Chai Reminders
Setup.
~ TaiRox Productivity Tools .
8age | For Help, press F1 [ Session Date: 2023-10-24 | B

To print the Overdue Payment Reminders report:
1. Select TaiRox CRM and Collections > Collections Reports > Overdue Payment Reminders.

2. Specify the contents of the report using the options on the following screen, then click the Print
button.
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]

Report Type
Report Format
Customer Group

Customer Number

Date Processed

Sort By

—
E—

Then By

U

Customer Number ~ | Date Processed

Collections Reports and Collections Performance Charts

T

Then By
{None)

To
To

Print

Close

Report Type: Choose “Pending” to list the payment reminders that will be sent if you process
them now, or choose “Processed” to list payment reminders that have already been sent to

customers.

If you select “Processed”, you can also choose the range of processing dates for the report.

Report Format: You can print a “Summary” report that lists each customer and amount overdue,
or print a “Detail” report that lists each outstanding document for each customer.

Range Fields: The program lets you select overdue payment reminders using a range of
customer groups, customer numbers, and date processed (if you are reporting processed

reminders).

Sort By: You can specify three levels of sorting using the customer groups, customer numbers,
and date processed. For example, you can group reminders by customer number, then by date

processed for each customer.

The program will print or display the overdue payment reminders report using the Sage 300 print

destination that you selected.

2023-06-06 :48:02AM
Overdue Payment Reminders - Processed

Customer Group [1To[ZZ27Z7]

Customer Number [1To[Z272272777777]

Date Processed [2022-07-01] To[3989-08-01)
Report Format [Detaill

SortBy [Customer Number, Date Processed]

Customer Number  Customer Name

Sample Company Limited

Date Processed DaysOver  Number Amount Overdue Cumency Acfion

IO Bargan Mart - 5an Diego
Document Numbes Doc. Date

202-07-15 66 2 154131 USD Create Task
Doc. Amount Due Date Balance Days Overdue

TR-INV-001 2022-05-01
TR-INV-011 2022-06-07
Customer Number  Customer Name:

1.397.20 2022-05-10 1.848.62 66
92,69 2022-06-07 9269 38

Date Processed DaysOver Number Amount Overdue Currency Action

1105 Bargain Mart - Oaldand
Document Number Doc. Date

2022-07-15 66 1 1.016.48 USD Create Task
Doc. Amount Due Date Balance Days Overdue

TR-INV-002 2022-01-01
Customer Number  Customer Name:

1,126 51 2022-05-10 101648 66
Date Processed DaysOver  Number Amount Overdue Cumency Action

1200 Mr. Ronald Black

2022-07-15 61 2

Document Number Doc. Date Doc. Amount Due Date Balance Days Overdue
TR-CRE-006 2022-06-02 26461 2022-06-15 264 61 30
TR-INV-003 2022-05-01 12323557 2022-05-15 105,967 65 81
Summary
Currency Total
usb 109,190.05
3 Overdue Payment Reminders

106,232 26 USD Create Task

Fage 1

o Print selection criteria appear at the top of the report. This report lists payment reminders that
were processed on July 15, 2022.

o Document details are optionally printed for each reminder.

o The program prints a summary of the outstanding amounts for reminders by source currency.
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Promised Payments

This report that let you review the current status, details, and currency totals for all or a selection of your
company’s promised payments. You can print the report for all assigned promised payments, for
unassigned promises, or for promised payments assigned to a specific user.

Reports use the standard Crystal Reports engine for Sage 300, letting you print to standard Sage print
destinations and export data to PDF, Word, or Excel spreadsheet formats.

Collections Reports (Promised Payments)

License
Dealer:
[ee

d to: Don Thomson, TAIROX SOFTWARE INC

Avg.DaysToPay  Avg.Days Overdue  Effectivenessindex  Disputed Invoices  Overdue Invoices  Overdue Payment | Promised Payments
Chart Chart Chart Reminders

Setup

~ TaiRox Productivity Tools

Sage | For Help, press F1 [] Session Date: 2023-10-24 | [

To print the Promised Payments report:
1. Select TaiRox CRM and Collections > Collections Reports > Promised Payments.

2. Specify the contents of the report using the options on the following screen, then click the Print
button.

=

Date Pomised | -~ | To
[ S
Customer Number | |Q 1o |[zZzZzzz ) q
N [FU

Include Open

Include Closed

Include Notes

Assigned To KEITH Q

Sort By Then By
[ Date Promised ][ None) v

Prirt Close

Range Fields: The program lets you select promised payments using a range of dates
promised, customer numbers, customer groups, and creation dates.

Include Open/Closed/Notes: Use the checkboxes to print open and/or closed records and to
print all Notes that are attached to the Notes tab for promised payments.

The contents of the Notes field on the Promised Payments tab always appear on the report. (See
example below.)

Assigned To: Select this checkbox and use the Finder to print all promised payments assigned
to a single user. Leave the field blank to print all unassigned promised payments.

Sort By: You can choose two levels of sorting— by date promised, customer number, customer
group, currency, assigned user, creation date, and revisit date. For example, you can group all
promised payments by assigned to user, then list by currency within each group.

The program will print or display the promised payments report using the Sage 300 print
destination that you selected.
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Accounts Receivable and Collections Collections Reports and Collections Performance Charts

61312020 SI57:10AM Sample Company Limited Page 1

Promised Payments

Date Promised [1To [12/21/2999]

CrestedOn [1To[12:31/9999]

CustomerNumber  [] To [222222222727)

Customer Group [1Telzz2222]

Include Open [ves]

Include Closed [No]

Inchide Notes [Yes]

Assigned To [Anyone]

SortBy [Date Promised]
D CustomerNo. Customer Name Dale Promised  Ami Promised AmtPaid Cur. AssinedTo ReveiOn CreaiedOn CreatedBy Stahus
21970 Mr. Ronald English 81972020 13,000.00 0.00 USD CARLA B25/202)  S262020  ADMIN Open

Mr English purchased goods on behalf of a client who subsequently changed their reguiremnts
— Some tems have nowbsen exchanged and payment wilbe 15 days sfter final deivery.
D: 17 Created On: 6/1/2020 Created By: ADMIN Name: Kitting item changes for order #8967

#OFFICE SPL KIT — kitting #1 replaced with Kitng #2
#OFFICE KIT — kit #1 - update following items

D1-606/B - replace with D1-608/8
D2-613/B - replace with D2-850/8

31500 Custom Comfort 7113(2020 7,850.00 0.00 USD KEITH 7232020  626/2020  ADMIN Open
11880 Break-Away Designs 711412020 500.00 0.00 USD CARLA B/19/2020  5/26/2020  ADMIN Open
41500 Custom Comfort 73112020 12,870.00 6,000.00 USD  ADMIN 732020 626/2020  ADMIN Open

Qutstanding amount to be paid in two instaliments
-1 - dueJune 30~ 6,000.00 USD - Paid
-2 - dueJuly 31 - §,370.00 USD

Summary
Currency Total Promised Total Paid
UsD 34,220.00 6,000.00
4Promised Payments printed

o This example includes a note added to the Note tab for the first promised payment (ID 2) for
Mr. Ronald English.

The other freeform text is from the Notes field on the Promised Payment tab.

o The program prints a summary of the total amount promised and total paid by source
currency.
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Periodic Processing Create Opportunities
Periodic Processing

C 2 Q Q

Create Oppu:urtunities* Close Invoices Sync Cuntacts* Sync Companies

* Create Opportunities appears if you are using the CRM and Collections module (not the standalone Collections module)
* Sync Contacts appears only if you are using the Sage 300 M/T Contacts module

The Periodic Processing folder includes tasks that are part of your regular procedures. Note that you can
also automate several CRM and Collections tasks using the task Scheduler, in the Setup folder.

Create Opportunities

The Create Opportunities program lets you:

e Specify the group of customers for which you want to create opportunities using fields from the
A/R customer record and CRM optional fields. (For example, you can specify a range of A/R
customer IDs and specify the account rep ID in an optional field.)

You can cherry-pick from the resulting group to exclude individual companies.

¢ Specify the information that you want to appear for each opportunity — including opportunity
optional fields.

e Generate the opportunities in one process.

Create Opportunities will not appear on the Sage 300 Desktop if are using the Collections
module without CRM.

Access: Select TaiRox CRM and Collections > Periodic Processing > Create Opportunities.

Company Rangs

From To

~| |2 f |Q

[vone) ]
[ Mone) ]
[vone) |
[ Mone) ]

Opportunity
Name [ Opportunity Details

Order By [Mame -

Include 1D Name Shart Name [ Street 1

Process Select Al Select None Log.. Close

TaiRox CRM and Collections for Sage 300 148 User Guide



Periodic Processing Create Opportunities

Notes:

e The program creates opportunities for Companies that are also A/R Customers. It does not create
opportunities for prospects.

e By default, the Company Range fields will display the last selection criteria used to create
opportunities.

Specify the group of companies for which you are creating opportunities

You can specify ranges using A/R Customer fields for company selection — including the customer
number, national account, group code, account set, terms, billing cycle, interest profile, payment
code, tax group, currency code, customer price list, inventory location, ship-via code, and territory
code. You can also use any of the optional fields that you use for companies in CRM and Collections.

Company Range
Select Companies By From To

Tenmitory Code ~| [ca q fea Q
Sales Rep | [kw Q [kw Q
Rental Customer
(None)

Customer Number
National Account
Group Code
Account Set
Terms

Billing Cycle
Interest Profile
Payment Code Load
Tax Group

Currency Code
Customer Price List

] [Yes ][ Yes -

Invertory Location Opportunity Details

Ship Via Code:
Account Class
Courier

Freight Method
Payment Method
Rertal Customer

Street 4

13 Street 1

For example, the above screen shows customer selection by the Territory field and by two company
optional fields — Sales Rep and Rental Customer.

Load the list of companies and choose which require opportunities:

Toad
Opportunity /
Name [ / Opporuniy Delais...
Order By [ Name M ‘

Include D Name Short Nams = Street 1 Shest 4
] 2 Bargain Matt - Oakland BMT-OK Bargain Mart Plaza Comer 182nd and Anyiown  CA USA
O 1 Bargain Mart - San Diego BMT-SD Bargain Mart Flaza Comer 182nd and... Aniown CA USA
0 24 Bargain Mart Stores Inc BARMART Bargain Mart Plaza Comer 182nd and Anfiown  CA UsA
O 10 Break-Away Designs BREAK 743 Wark Street Sacramento CA USA
0 15 Forester Buiding Supplies FORES #46 North Gate M. SanFrandi.. CA UsA
O 12 4 Y Buiders Lid. Jay 333 Ralston Way Sacramento CA Canag

e Click the Load button to display the list of companies that match the selection criteria.

When the Load button is pressed, the program will display the companies in the range you
specified.

o You can adjust the company range, if necessary, then click the Load button again.

e Click the Select All and Select None buttons at the bottom of the screen to include all or none of
the companies loaded in the grid.

Select Al Select Mone

e Click the Include column to “cherry-pick” companies:

Include ID Name Short Name [= Shest 1
O 2 Bargain Mart - Oakland BMT-OK Bargain Mart Plaza Comer 182nd and Anytown CA USA
1 Bargain Mart - San Diego BMT-5D Bargain Mart Plaza Comer 182nd and... Anytown CA USA
O 24 Bargain Mart Stores Inc. BARMART Bargain Mart Plaza Comer 182nd and... Anytown CA USA
10 Break-Away Designs BREAK 743 Wark Street Sacramento CA USA
O 15 Forester Building Supplies FORES H46 North Gate M San Franci... CA USA
lk 3 Mr. Ronald Black BLACK 2820 Wabash Ro... Los Angeles CA USA
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Create Opportunities

Click the Opportunity Details button to add the opportunity information:

Opportunity

Name [

o[ Opportunity Detais..

Order By

Opportunity | Optional Fields
2 Bargain

1 Bargain
24 Bargain
10 Break-A
15 Forester
1208 Y B

Name

Amount
Centainty

]
O
]
O

3 Mr.Rong | Stage

e Click the Opportunity Details button to add opportunity details.

The program will display the

Opportunity screen, letting you fill in opportunity fields and optional fields for opportunities.

e Click the Close button on the Opportunity details form when you are finished. The Name of the
opportunity will now appear in the Name field on the Create Opportunities screen.

Opportunity

Name |[Lease Discourts |

| [ Bopertoniy Detais. 3

Note: You MUST complete the opportunity Name and Stage fields. All other information is optional.
Note also that the program will not allow you to create duplicate opportunities — so you cannot create
an opportunity for the same customer with the same name and creation date.

Click the Process button to create the opportunities:

Include

[= Street 1
Bargain Mart Plaza
Bargain Mart Plaza
Bargain Mart Plaza
743 Wark Strest

Short Name: Street 4
BMT-OK
BMT-SD
BARMART
BREAK

10 MName

2 Bargain Mart - Oakland

1 Bargain Mart - San Diego
24 Bargain Mart Stores Inc.
10 Break-Away Designs
15 Forester Building Supplies
12 J &Y Builders Ltd

3 Mr. Ronald Black

Comer 182nd and...
Comer 182nd and
Comer 182nd and...

OROROEC

Are you sure you want to create Opportunities for
I companies?

Anmytown
Anytown
Anmytown
Sacramento
San Franci...
Sacramento
Los Angeles

Log

[ T SelctHone

Close

e Click the Process button at the bottom of the screen to proceed.

e Click Yes to confirm that you want to create the opportunities.

The following message will appear if the opportunities were created successfully:

Meszage

Description: Create Opportunities complete. There were 3 Opportunities
created.

Source: 16:34:34 -

=
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Create Opportunities

If you did not specify a name or stage for the opportunities, you will see a message like this. Close
the message and click the Opportunity Details button to add the opportunity name or stage.

Emor
Description: Invalid input. Stage cannot be blank.

Source: 16:37:28

i

Click the Log button to confirm which opportunities were processed:

5/5/2020 11:37:12 AM Create Opportunities
5/5/2020 11:37:12 AM

5/5/2020 11:37:12 AM Performed by user: A
5/5/2020 11:37:12 AM

5/5/2020 11:37:12 AM Company Range

started.

DMIN

5/5/2020 11:37:12 AM Customer Number From [] To [ZZZZZZZ7727277]
5/5/2020 11:37:12 AM

5/5/2020 11:37:12 AM Opportunity

5/5/2020 11:37:12 AM Name: Summer Furnishings Sale 2020
5/5/2020 11:37:12 AM Amount: 1,000.000

5/5/2020 11:37:12 AM Certainty: 50

5/5/2020 11:37:12 AM Stage: QUALIFIED

5/5/2020 11:37:12 AM Assigned To: ADMIN

5/5/2020 11:37:12 AM Status: Open

5/5/2020 11:37:12 AM Opened On: 5/5/2020

5/5/2020 11:37:12 AM Expected Close: 8/15/2020

5/5/2020 11:37:12 AM Revisit On: 6/1/2020

5/5/2020 11:37:12 AM Revisit At: 12:00:00 AM

5/5/2020 11:37:12 AM Notes: Sale dates -- July 15 to Aug 15
5/5/2020 11:37:12 AM Comment: Printed brochure and email campaign to commence June 1.

5/5/2020 11:37:12 AM

5/5/2020 11:37:12 AM Creating Opportunity for Customer BARMART...

5/5/2020 11:37:12 AM Customer BARMART Opportunity ID 86 created.

5/5/2020 11:37:12 AM Creating Opportunity for Customer 1580...
5/5/2020 11:37:12 AM Customer 1580 Opportunity ID 87 created.
5/5/2020 11:37:12 AM Creating Opportunity for Customer 7200...
5/5/2020 11:37:12 AM Customer 7200 Opportunity ID 88 created.

5/5/2020 11:37:12 AM
5/5/2020 11:37:12 AM 3 record(s) created.
5/5/2020 11:37:12 AM
5/5/2020 11:37:12 AM

The Log lists:

e The user and the type of operation performed.

e The range of customers specified.

e The opportunity details.

e Each customer that was processed and whether the records were updated.
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Close Invoices

The Close Invoices program closes all open Disputed Invoices and Tracked Invoices when the A/R
invoice has been paid, written off, or cleared from A/R (so it has a 0 balance).

Access: Select TaiRox CRM and Collections > Periodic Processing > Close Invoices.

This program closes all open Disputed Invoices and Tracked Invoices where the A/R
Invoice has been paid.

Close Tracked Invoices

Process Close

To run the Close Invoices program:
1. Select TaiRox CRM and Collections > Periodic Processing > Close Invoices.
2. Choose whether you want to close Disputed Invoices and Tracked Invoices.

3. Click the Process button.
The program will display a message showing the number of closed records.

Index  Priority Description
1 Message 13 disputed invoices were closed.
2 Message 20 tracked invoices were closed.

£ >
Description: 13 disputed invoices were closed.
Source: 13:25:15-
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Sync TaiRox Contacts with M/T Contacts

Sync Contacts is a program that quickly identifies contacts in TaiRox CRM and Collection that are missing
from the Sage 300 M/T Contacts module and M/T Contacts that are missing from CRM.

Sync Contacts appears if you have Sage 300 version 2020.1 or higher installed and have activated the
Sage 300 M/T Contacts module.

Note on upgrading to Sage 300 2020.1 or higher: If you are already running CRM and Collections
and have just updated to a Sage 300 version with the M/T Contacts module (2020.1 or higher),
perform the following steps to add your TaiRox contacts to the M/T Contacts module and to individual
A/R customer records:

e Run Sync Contacts to add all TaiRox contacts to the Sage 300 M/T Contacts module.

e Run Sync Companies to add all contacts linked to TaiRox companies to their corresponding
A/R Customer records.

Access: Select TaiRox > CRM and Collections > Periodic Processing > Sync Contacts to display
the following screen.

Welcome to the Sync Contacts Wizard.
This wizard will help you identify and resolve any differences between the contacts in TaiRox CRM and the contacts in Sage Multiple Contacts.

Contacts are uniquely identified by their contact codes. I a contact in TaiRox CRM and a contact in Sage Muttiple Contacts have the same
contact code then they represent the same contact

Previous Close

Note: Make sure that “Suspend M/T Integration” is NOT selected in Setup Options. The
Sync Contacts program is disabled if you select the Suspend M/T Integration option.

The following message appears if you try to run Sync Contacts when M/T Integration has been disabled
in CRM and Collections Setup Options:

Meszage

Description: M/T integration has been suspended in TaiRox CRM Options.
Sync Contacts cannot be performed.

Source: 16:41:21 -
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CRM and Collections automatically synchronizes TaiRox contacts data with M/T Contacts data
unless you deliberately suspend M/T integration. See Setup Options for more information on M/T
Contacts synchronization.

With integration on, if you add a contact in Sage M/T Contacts, the contact will be added to the
contacts list in CRM and Collections. Similarly, if you delete a contact from CRM and Collections, the
contact will also be deleted from the M/T Contacts module.

Notes:

e Click the Next button to check that contacts are synchronized. If contacts match, the following
message appears:

Good news! The contacts in TaiRox CRM match the contacts in
Multiple Contacts.

Screen #2 —contacts in TaiRox CRM and Collections only

If contacts appear in CRM and Collections that are NOT in the M/T Contacts module, the following screen
appears.

These contacts are in TaiRox CRM anly.

Indicate which contacts in TaiRox CRM should be copied to Sage Multiple Contacts.

Al None

MName

E-mail

CHARLESGRANGE charlesgrange @faifax.com Charles Grange

Previous Next Close

To copy all TaiRox contacts to M/T Contacts:
e Click the All button to select all contacts that are only in CRM and Collections.
e Double-click the Copy column for each entry to select or de-select individual contacts.
¢ Click the None button to de-select all contacts.

e Click the Next button when you have finished selecting contacts and move to the next Sync
Contacts screen.
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Screen #3 — contacts in the Sage M/T Contacts module only

If contacts appear in the M/T Contacts module that are NOT in TaiRox CRM and Collections, the following
screen appears.

These contacts are in Sage Multiple Contacts only.

Indicate which contacts in Sage Multiple Contacts should be copied to TaiRox CRM.

Al None

Name

E-mail

Contact Code

cartthompson @fairfax.com Carl Thompson

Previous Next Close

To copy all M/T Contacts contacts to TaiRox CRM and Collections:
e Click the All button to select all contacts that are only in the M/T Contacts module.
e Double-click the Copy column for each entry to select or de-select individual contacts.
e Click the None button to de-select all contacts.

e Click the Next button when you have finished selecting contacts and move to the next Sync
Contacts screen.

Screen #4 — contacts with different field values in TaiRox and Sage M/T Contacts

The following screen appears for contacts that appear in TaiRox CRM and Collections and in Sage’s M/T
Contacts module but have different field values in each program.

These contacts are in both TaiRox CRM and Sage Muttiple Contacts but have different values for ane or more fields.
Choose which version of each contact is to be retained.

Double-click on a contact code to see how they differ.

Change All None ~ |

TaiRox CRM E-mail TaiRox CRM Name

Contact Code

ANDREWFRENCH

Action

Andrew French

None

Previous Next Close
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To reconcile differences between TaiRox contacts and Sage M/T Contacts:

o Double-click individual lines in the grid to see the record differences between contacts in TaiRox
CRM and Collections and contacts in Sage’s M/T Contacts module.

Change Al | None ~

Contact Code TaiRox CRM E-mail
ANDREWFRENCH AndrewFrench@bammart com

‘ TaiRox CRM

o Double-click the Action column, then choose from the dropdown to reconcile differences for one
contact.

Contact Code TaiRox CRM E-mail TaiRox CRM Name
None . | ANDREWFRENCH AndrewFrench @bamart com Andrew French

None
Use Multiple Contacts Contact

Choose None to leave the differences between records, or choose to use the TaiRox CRM data
or the M/T Contacts data for the record.

e Use the Change All dropdown to select the same procedure for all contact differences in the list.

Choose None to leave the differences between records, or choose to use the TaiRox CRM data
or the M/T Contacts data for both records.

Change All MNone e
Use TaiRox CRM Contact
N Use Multiple Contacts Contact
one

Screen #5 - click the Finish button to make all selected changes
e On the final screen:

o Click the Finish button to make all selected changes.
o Click the Close button to exit without making any changes.
o Click the Previous button to revisit prior screens to check your edits.

e All updates are listed on the screen as the program completes them:

Click the Finish button to complete the specified changes.

Contact CHARLESGRANGE has been added to Multiple Contacts.
Contact CARLTHOMPSON has been added to TaiRox CRM.
Contact ANDREWFRENCH from TaiRox CRM has been copied to Muttiple Contacts |

Finish

Previous Mext Close
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Sync TaiRox Companies with Sage 300 A/R Customers

Sync Companies is a program that quickly identifies which TaiRox CRM and Collections companies have
data that is inconsistent with the linked customer record in Accounts Receivable.

If you use the Sage 300 M/T Contacts module, Sync Companies will also compare the contacts added
to TaiRox companies with the contacts added to A/R customers to see if they match.

Note on upgrading to Sage M/T Contacts: If you are already running TaiRox CRM and Collections
and have just acquired the Sage Multiple Contacts module, perform the following steps to add your
CRM contacts to the M/T Contacts module and to individual A/R customer records:

e Run Sync Contacts to add all TaiRox CRM and Collections contacts to the M/T Contacts module.

¢ Run Sync Companies to add all contacts linked to CRM companies to their corresponding
A/R Customer records.

Access: Select TaiRox > CRM and Collections > Periodic Processing > Sync Companies to display
the following screen.

Welcome to the Sync Companies Wizard

This wizard will help you identify any A/R customers that do not have a company in TaiRox CRM, as well as identify and resolve any differences
between the A/R customers and their comesponding companies in TaiRox CRM.

“You should run the Sync Contacts Wizard befare running this wizard.

Previous Close

If you do not use M/T Contacts, the final message “You should run the Sync Contacts Wizard ...” will not
appear on the Sync Companies screen (shown above).

Note: Make sure that “Suspend A/R Integration” is NOT selected in Setup Options. The
Sync Companies program is disabled if you select the Suspend A/R Integration option.

The following message appears if you try to run Sync Companies when A/R Integration has been
disabled in CRM and Collections Setup Options:

Meszage

Description: A/R integration has been suspended in TaiRox CRM Options.
Sync Companies cannot be peformed.

Source: 16:42:14 -

Bunt
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A/R synchronization.

unlinked and flagged as deleted.

CRM and Collections automatically synchronizes company data with A/R customer account
information unless you deliberately suspend A/R integration. See Options for more information on

With integration on, if you add a customer in A/R, the customer will be added as a company in CRM
and Collections. Similarly, if you delete a customer in A/R, the CRM and Collections company will be

Notes:

e Regarding inactive customers: Sync Companies only considers active customers when

checking if a customer has a corresponding company in CRM and Collections.

If you need to add an inactive customer to CRM and Collections:

o Open the inactive customer in the A/R Customers program.
o Make the inactive customer active, and save the change. The record will be automatically

sync’d with the record with CRM and Collections.

o Make the customer record inactive again, and save the change.

¢ If all company data matches with A/R customer data, the following message appears when you
click the Next button to check that companies are synchronized.

Good news! The companies in TaiRox CRM are in sync with
the customers in Accounts Receivable,

e If you do not use the M/T Contacts module — or if “M/T integration” is suspended in Setup
Options, the program will only compare companies to customers. It will not compare contacts.

Screen #2 — A/R customers missing from TaiRox CRM and Collections

If Accounts Receivable customers are missing from TaiRox CRM and Collections, the following screen

appears.

These A/R customers do not have comesponding companies in TaiRox CRM.

Indicate which customers should be imported into TaiRox CRM.

Al None

Customer Name

Customer Number
2240

Frame-Up

Previous Next

Close
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To import missing A/R customers into CRM and Collections:

e Click the All button to select all customers that are only in Accounts Receivable and import them

into CRM and Collections.

e Or double-click the Import column for each entry to select or de-select individual A/R customers.

e Click the None button to de-select all A/R customers.

e Click the Next button when you have finished selecting customers and move to the next Sync
Companies screen.

Screen #3 — A/R customers with different field values than in TaiRox CRM and
Collections

The following screen appears for A/R customers that appear in TaiRox CRM and Collections but have
different field values in each program.

There are differences between these A/R customers and their comesponding TaiRox CRM companies.
Choose whether the values from the TaiRox CRM company orthe values from the A/R customer should be used.

Double-click on the customer number to see details on how the twa differ.

Change Al MNone ~ |

Action Customer Number | Company Name Customer Name

lart - Oakland
None 1200 Mr. Ronald Black Mr. Ronald Black
None 1580 Break-Away Designs Break-Away Designs
None NEW My Amazing Company My Amazing Company
g
Previous Next Close

To reconcile differences between A/R customers and TaiRox companies:

e Double-click individual lines in the grid to see the record differences between A/R customer
records and companies in TaiRox CRM and Collections.

Change Al \ None v \

Company Name Customer Name
Bargain Mart - Oakland Bargain Mart - Oakland
1200 Mr. Ronald Black Mr. Ronald Black

Break-Away Designs Break-Away Designs

Action

Cortact’s Name Mr. Gany Johnson Mr. Jose Grange

e Double-click the Action column, then choose from the dropdown to reconcile differneces for one

contact.

Change Al [ None ~

Action Customer Number Company Name Customer Name

None 1105 Bargain Mart - Oakland Bargain Mart - Oakland

| None M 1200 Mr. Ronald Black Mr. Ronald Black

Noms 1580 Break-Away Designs Break-Away Designs
NEW My Amazing Company My Amazing Company
Use A/R Customer

Choose None to leave the differences between records, or choose to use the TaiRox data or the

A/R Customer data for both records.
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e Use the Change All dropdown to select the same procedure for all companies and customers in
the list.

Choose None to leave the differences between records, or choose to use the TaiRox CRM data
or the A/R customer data for both records.

Change Al [None Jv]

Company Mame Customer Name

Bargain Mart - Oakland Bargain Mart - Oakland
Mr. Ronald Black Mr. Ronald Black

Screen #4 - click the Finish button to make all selected changes
e On the final screen:

o Click the Finish button to make all selected changes.
o Click the Close button to exit without making any changes.
o Click the Previous button to revisit prior screens to check your edits.

e All updates are listed on the screen as the program completes them:

Click the Finish button to complete the specified changes.

A TaiRox CRM company has been created for customer 2240,
A/R Customer 1105 has been updated to match the TaiRox CRM company.

A/R Customer 1200 has been updated to match the TaiRox CRM company.
A/R Customer 1580 has been updated to match the TaiRox CRM company.
A/R Customer NEW has been updated to match the TaiRox CRM company.

Finish

Previous Mext Close
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Setup and Maintenance Screens
® 0; 10; 10; 10; 19; g &

License Information Options Overdue Payment  Payment Due Alerts Send Invoices Opportuntity Stages Case Stages Communication
Reminders Types
= = v
\
10, E © ® X \J 10
Territories Users Optional Fields Accounting  Import Prod. Tools’|= Create Demo Data Remove CRM Data XOQS5cheduler.exe Bulk Email Accounts*
Documents Contacts
Notes:

e Import Prod. Tools Contacts appears only if you use Productivity Tools and do not use the Sage
300 M/T Contacts module.

o XQSceduler.exe launches the CRM Job Scheduler for Overdue Payment Reminders and
Payment Due alerts. You can also start it directly from the Windows File Manager.

e Bulk Email Accounts — in the Marketing folder — lets you enter setup information bulk email
accounts. It does not appear if you are using the Collections module without CRM.

License Information
The License Information icon lets you enter the CRM and Collections License code.

Note: The Client ID and Company information must exactly match that shown by the Sage 300
License Manager.

TaiRox CRM and Collections 6.1A

— Build 8278 created on 2022/08/31
- 5 Y

The Latest TaiRox CRM and Collections Features
TaiRox Home Page
® 2009-2022 TaiRox Software Inc.

System Manager Version |{6.9.»‘\} (300 Premium) (Build 20) (Product Update 2) |
Company |TAIROX SOFTWARE INC |
Cliert ID 400588569 |

Licensee |TﬂIROX SOFTWARE INC |
License | 100050-955555-20240301-51162937618355280737740276590957 |

Expiry Date  [2024-03-01

Save Purchase Close

The Help About menu choice shows build information and links to the TaiRox web site.

TaiRox CRM and Collections 6.14

Build 8278 created on 2022/08/31

The Latest TaiF ox CRM and Collections Features
TaiRox Home Page

® 2009-2022 TaiRox Software Inc.

System Manager Version |{6.9.»‘\] (300 Premium) (Build 20) (Product Update 2) |
Company |TmHox SOFTWARE INC |
Cliertt 1D |4DDD533569 |
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Options

Options include settings that apply to all CRM and Collections users. For information on changing settings
in data entry grids, see Appendix B: Using Data Entry Programs.

Options Tab

Options  Email Calendar Document Folders  Customer PDFs

Email Archive Folder ‘F:'-Sage'-.SageBDD'-.SharedData'-.ComDany'-.SAMLTD “TaiRox CRM“\Documents‘\Sent Emails | Browse..

[ 5uspend A/R Integration
[15uspend M/T Integration

Save Cloze

Email Archive Folder: This is the default folder where emails created by Send Documents and Overdue
Payment Reminders are stored as EML files. The files are referenced in CRM as Communications. (EML
files store the complete email, including attachments.)

If you do not specify an archive folder, EML files will be stored in the Sage 300 Shared Data folder under
COMPANY\<company ID>\TaiRox CRM\Documents. This setting lets you use a different location.

You can use UNC file paths to specify the archive folder (such as \ComputerName\C$\SentEmails).

Suspend A/R Integration: This checkbox lets you disable automatic updates between Accounts
Receivable customer records and CRM company records.

Note: Sync Companies is disabled if you select the Suspend A/R Integration checkbox in Setup
Options. Do not suspend A/R Integration while setting up CRM.

Leave this box unchecked to automatically synchronize customer and company records in Accounts
Receivable and CRM.

Suspend M/T Integration: This checkbox appears only if you are using the Sage Multiple Contacts
module. It lets you disable automatic updates between Sage 300 M/T Contacts records and the contacts
listed in the CRM Contacts program.

Note: Sync Contacts is disabled if you select the Suspend M/T Integration checkbox in Setup
Options. Do not suspend M/T Integration while setting up CRM.

In addition, Sync Companies will not compare contacts added to CRM and Collections Companies and
A/R Customers if you suspend M/T Integration.

More about CRM and Collections / Accounts Receivable Integration

CRM and Collections / Accounts Receivable integration synchronizes corresponding customer records.
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If you change a field that is common to CRM companies and A/R customers (including optional fields and
contacts), the linked customer record or company record will also be updated.

e If you insert a new company record in CRM and Collections (or A/R), the record will also be
inserted in A/R (or CRM and Collections).

e If you add a contact to a company in CRM, the contact will be added to the A/R customer record.
e If you add a record with a new territory in A/R, the new territory will be added to CRM.
e If you delete a customer in A/R, the CRM company will be unlinked and marked as deleted.

Email Tab

Options  Email  Calendar Documert Folders  Customer PDFs

Email Server Settings

Server Name |smtp.grna|\.cnm |
Server Pott Use SSL

Usemame |ncrtrf\cations @tainox.com |
Password ‘ """""" |
From Email |nntrf\catinns@lairnx com |

Send Test Email

Save Close

Email Server Settings: These settings are used by the following programs:
e Send Documents functionality in the Companies window to resend documents to customers.

e The Send Statements/Letters, Send A/R Invoices, Send O/E Invoices, and Send Invoices
programs in the Send Documents folder.

e Send Bulk Email program unless you use a bulk email provider like MailChimp or SendGrid.
e By default for the Overdue Payment Reminders program, Payment Due Alerts program and Send

Invoices program if you do not add settings with Overdue Payment Reminders Setup, Payment
Due Alerts Setup, and Send Invoices Setup.

Send Bulk Email lets you send batches of emails to contact groups, company contacts, or A/R customer
contacts using the specified email server or using bulk email providers like MailChimp or SendGrid. This
program is available only with CRM and Collections.

Send Invoices provides flexible customer selection criteria for emailing A/R and O/E Invoices to customers.

Send Documents lets you resend past customer documents to one or more customer contacts. See
Resend Individual Documents from the Companies window for more information.

For more information on sending statements, letters, and invoices to customers, see Send Statements,
Letters, and Invoices to Multiple Recipients.

Server Name: Enter the name of the outgoing message server for CRM emails.
Server Port: Enter the SMTP port number.
Use SSL: Check this box to have the email communication SSL encrypted.

See the “Use SSL” note under “Send Test Email,” below.
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Username: Enter the account user name for sending emails.

Password: Enter the password for the user account.

From Email: Provide the default From Email address that you want to use for emails created by
CRM and Collections. (You can't always separate the From Email from the Username email.)

If this field is left blank, the default From Email address for CRM documents will be the user’s email
address in Sage 300.

Note: Depending on your SMTP server, this address may need to match the one you enter in
the Username field — or it may not work unless you set up an email alias. Consult your SMTP
server document for details about sending emails.

See the following sections for more information on overriding the From Email address for specific
email programs:

e For A/R Statements and Letters and for A/R and O/E invoices use the Accounting Documents
Setup program to override the default From Email.

e For Overdue Payment Reminders and Payment Due Alerts, use the Overdue Payment
Reminders Setup program and Payment Due Alerts Setup program to override the default From
Email.

You can also override the default From Email address when you resend documents from the
Company window by specifying a new address in the Send Documents window.

For more details on emailing documents, see Step 13: Add settings for emailing overdue payment
reminders, and payment due alerts to customers and Step 14: Add settings for emailing invoices,
statements, letters to customers.

Send Test Email: Click this button to test email settings. The program will prompt you for an email
address, and then send a test email.

Mail To ‘mnrganlhnmas@taimx com

OK Cancel

A number of different messages can appear depending on whether the test was successful. If the test
fails, you should also check the log file — “C:\Users\<username>\AppData\Local\Temp\TaiRox CRM and
Collections.log”.

Message Eror Eror

Description: Send Test Email succeeded Description: Linable to establish a TCP or TLS connection to the SMTP Description: Authentication failed. Confimm that the usemame and password
server. Confimn that the server name, port number, and securiy options are are comect
Source: 11:4%:10- comect
Source: 12:05:12-|
Source: 11:58.02-

Note that you can send test emails to multiple recipients by separating the email addresses with commas
or semicolons.
Note regarding “Use SSL” if unsupported by the SMTP server

If you select the “Use SSL” checkbox, CRM will first try to send a test email securely. If it does not
succeed, it will try to send a test email insecurely. If the secure test fails, but the insecure test is
successful, the program will display the following message.
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% Message ==
Messzge
Description: Send Test Email failed with "Enable 551" checked. However, s
Send Test Email succeeded with "Enable SSL' unchecked. Mail Server
(SMTP) mysqglserver does not support ‘Enable S5L" so it should be
unchecked
Source: 13:16:23-
Print Help ...

If this message appears, it means that:

e Your SMTP server does not support current email communication styles on the port provided.
(The "Use SSL" checkbox has different meanings for different email sending mechanisms.)

e You should uncheck “Use SSL” to send emails without SSL protection.

Calendar Tab

Options Email Calendar Document Folders  Customer PDFs

Select which entities will update user calendars
[ACases

Opportunities

Tasks

Save Close

Select which entities will updates user calendars: Select the entities that you want to update users’
calendars when you change revisit dates and user assignments. You can update users’ calendars for
changes to cases, opportunities, and tasks.

Note:

e CRM and Collections does not send calendar files when tasks are generated by the Overdue
Payment Reminders program. However, it will send calendar reminders when you change the
revisit date or user for tasks generated by Overdue Payment Reminders.

e “Opportunities” will not appear if you are running the Collections module without CRM.
CRM and Collections generates .ics files when employees add or change revisit dates and user

assignments for cases, opportunities, and tasks, and sends them to the “Email 1” address entered in
Sage 300 for the assigned — and unassigned -- user.

.ics files (iCalendar files) are plain text files containing the details for a calendar event or a to-do
item. Typically, they are sent as attachments to emails that you can save to a calendar, such as the
calendar in Outlook or the Google calendar.

For more details on ics files and setting up users for receiving emails, see Appendix E: Updating
Calendars with .ics Event Files.
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To set up TaiRox CRM and Sage 300 to send calendar event files you must also:
e Add “Email 1” email addresses for all users in Sage 300 > Administrative Services > Users.
TaiRox CRM and Collections sends calendar events to the Email 1 email address.

e Add the settings for your email server on the Email tab in CRM and Collections > Setup >
Options.

Use the Send Test Email button to test the email server settings.

Document Folders Tab

Options Emaill Calendar Document Folders  Customer PDFs
Folders for storing documents related to various entities
Folder
Case F:\Sage"5age300"Shared Data\company . SAMLTDTaiRox CRM\Documents\{COMPID}\Cases\[CASEID}
Tracked Invoice F:\Sage"5age300"Shared Data‘company . SAMLTDTaiRox CRM‘\Documents \{COMPID} AR Invoices {ARINID}
Opportunity F:\Sage"Sage300"Shared Datacompany*.SAMLTD TaiRox CRM\Documerts\{COMPID}\Opportunities\ {OPPOID}
Save Close

The Document Folders tab lets you organize sales and accounting documents according to your
company’s unique needs — and in any location accessible from the CRM and Collections server.

Note: The Opportunity entry will not appear if you installed the Collections module without CRM.

The default settings shown above store all CRM and Collections documents, for each company, under
the Sage 300 “SharedData\Company\<companylD>\TaiRoxCRM\Documents” folder — as shown below:

v | Documents A Name Date modified Type Size
~ || CompanylD 1 documents File folder

File folder

CompanylD 1 decuments
v || CaseDocuments CompanylD 2 decuments

CaselD & CompanylD 3 documents

File folder
CaselD 10

~ Opportunity Documents
OpportunitylD 10
OpportunitylD 11

~ || Tracked Inveice Documents
Tracked InvoicelD 5

~ || CompanylD 2 documents
Case Documents
Opportunity Documents
Tracked Invoice Documents

CompanylD 3 decuments

In this example, company documents are stored in the Documents\CompanyID folder, and documents for
Cases, Tracked Invoices, and Opportunities are stored below that in the Cases, ARInvoices, and
Opportunities subfolders.
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Alternatively, you can store case, tracked invoice, and opportunity documents separately from all other
documents, as in the following example:

Case C:%Sage300Shared Data \company SAMLTD  TaiRox CRM"Cases\ {COMPID{CASEID}
Tracked Invoice C:\Sage3005haredData company . SAMLTD TaiRox CRM\ARInvoices \{COMPIDFARINID}
Opportunity C:\Sage3005hared Data company SAMLT D TaiRox CRMOpportunities {COMPIDFOPPQID}

If you use drag and drop to attach documents companies, cases, opportunities and invoices, they are
automatically copied to foders that you specify here.

Note: Tracked Invoice documents include all documents attached to invoices using the Tracked
Invoices, Overdue Invoices, and Disputed Invoices program.

In this example, all cases are stored in one folder, all tracked invoices are stored in another folder, and all
opportunities are stored in a third folder, with subfolders for companies and folders below that for
individual opportunities and cases.

v Case Documents Case Documents

~ || CompanylD1 CompanylD 1 documents
CaselD 8 CompanylD 2 documents

v [ CompanylD 2 CompanylD 3 documents
CaselD 9 Opportunity Documents.
CompanylD 1 decuments
CompanylD 2 decuments
CompanylD 3 decuments
~ | | Opportunity Documents
v || CompanylD 1
OpportunitylD 11
v || CompanyiD2
Oppertunity 10

If you want, you can have the root opportunity and case folders anywhere on the network, so, for
example, cases could be located on an Accounting server, and opportunities on a Sales server.

The document folder paths include the following variables for specifying folders with names for the
Company ID, Case ID, Tracked Invoice ID, and Opportunity ID.

Vaiable name Variable Example — specification in Options and actual generated path

Company ID {COMPID} \TaiRox CRM\Documents\{COMPID}
\TaiRox CRM\Documents\COMP00003

Case ID {CASEID} \TaiRox CRM\Documents\{COMPID}\Cases\{CASEID}
\TaiRox CRM\Documents\COMPO00003\Cases\CASE00009

Tracked Invoice ID {ARINID} \TaiRox CRM\Documents\{COMPID}TrackedInvoices\{ARINID}
\TaiRox CRM\Documents\COMPO00003\TrackedInvoices\ARINO0015

Opportunity ID {OPPOID} \TaiRox CRM\Documents\{COMPID}NOpportunities\{OPPOID}
\TaiRox CRM\Documents\COMPO00003\Opportunities\OPPO00082

Note: You can use the company ID variable for company document paths, case documents paths,
tracked invoice doument paths, and opportunity document paths.

However, you cannot use the company ID variable for contact document paths or communication
document paths because contacts do not have to belong to a company, and communications can belong
to contacts, companies, opportunities, or cases.
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Customer PDFs Tab

Click the A/R and O/E Invoice and Credit Note Options buttons to choose the report and report options to
use for generating A/R and O/E invoices and credit/debit notes attached to emails sent by the Overdue
Payment Reminders program, Payment Due Alerts program, and Send Invoices program.

e The A/R Invoice Options apply also to A/R Credit and Debit notes.
e The “V/M” invoice and credit note buttons appear if you use Technisoft's Service Manager
application for Sage 300.

Note: The reports and options specified here are shared by the Overdue Payment Reminders program,
Payment Due Alerts program, and the Send Invoices program, so the invoices generated by all three
programs will match.

Options Email Calendar Document Folders  Customer PDFs

A/R Invoice Options..
O/E Invoice Options

Q/E Credit Note Options...

WM Invoice Options..

VIM Credit Note Options...

Also note:
e The Crystal Report form used for A/R and O/E invoices and CR/DR notes is set on this tab.

By default, the program will browse to the AR\ENG or OE\ENG folder to let you choose the report
for invoices.

e Do not specify a path when you choose an invoice print form in CRM Options.

Options Email Calendar Document Folders ~ Customer PDFs

=

A/R Invoice Optiel | s Invoice DEINVOTRPT Browise...

[ o/Einvoice 0619 (1 pryy seiatLot pumbers
O/E Credit Note 0@ [ Include Backordsred ftems
[ Use Custom Form
[ Print Kit Component kems
[ Print Bills Of Material Component ftems

[ Retainage

If you are running a multi-lingual Sage 300 system, the Overdue Payment Reminders program,
Payment Due Alerts program, and Send Invoices program will use the preferred customer
language from the appropriate language folders. (This will not work if you include a path to a
specific folder.)
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Overdue Payment Reminders Setup

These settings are used by the Overdue Payment Reminders program (in the Collections folder) to send
overdue payment reminder emails to customers with overdue invoices or create phone call tasks to
followup on overdue accounts.

To send overdue payment reminder emails you must also specify email addresses for overdue payment
reminders on the Contacts tab for each company record.

Settings  Scheduling

Overdue Payment Reminder Stages

Days Overdue Label Color  Action Email Template

\ 1 [ H [l | [] [sendEmal | [1aterim || Preview

‘ 31| | SD‘ |2' Past Dus ‘ D ‘ Send Email v| 2PastDue html ~ || Preview

‘ 61| ‘ 5Dl |3' In Amears ‘ D ‘ Send Email v| 3inAmears html ~ || Preview

‘ Overl ﬂ |4- Delinquent ‘ D ‘ Send Email u| 4Delinquent html ~| | Preview
Minimum days overdue before creating an Overdue Payment Reminder Mtachments
Minimum number of days between Owerdue Payment Reminders

Install Cument Templates

Fomat

Email Subject |Samp\e Company Limited - Payment Overdue

From Email |
Reply-To Email

|
Ce |
Bec |

Create a Communication When You Send an Email
Email Archive
Folder ‘F \Sage"Sage 300" SharedData‘\Company SAMLTD\TaiRox CRM\Documents'Sent Emails ‘ Browse

Organize By ‘ Save All Sent Emails in the Email Archive Folder by Year and Month ~ ‘

Save Close

Note: CRM uses the “Preferred Language” setting in the Company window to send overdue payment
reminder emails and invoices to customers in English, French, or Spanish. See Appendix C for details.

Settings Tab

Overdue Payment Reminder Stages

Days Overdue: The default settings are standard aging buckets, but you can change the date ranges.
CRM uses these aging buckets to assign overdue invoices to invoice stages when you click the Update
button on the Overdue Payment Reminders form or Overdue Invoices form. See Overdue Payment
Reminders for information on using the Overdue Payment Reminders program.

Label: You can change the labels used to describe each overdue invoice stage. Labels appear on the
Overdue Payment Reminders form.

Color: Double-click the Color square to change the color used for each overdue stage on the Overdue
Payment Reminders form.
Action: The program supports two actions:

e Send Email — to send payment reminders using the selected email template to company contacts
when the company’s oldest invoice reaches this overdue stage.

e Create Task — to create a collections task for calling up a customer when the company’s oldest
invoice reaches this overdue stage.

The Overdue Payment Reminders program performs the action specified for the oldest overdue invoice.
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Email Template: Choose the default email message that you want to send to customers for each
overdue invoice stage. You can edit the default template files or add your own.

Note also that the “Format” setting on this tab determines whether only overdue documents, or all unpaid
documents, are included in the table on overdue payment reminder emails.

You can override the default email message templates specified here when you process overdue
payment reminders.
Note the following points regarding template locations:
e During installation, the program copies the email templates to the following program directory:
\<Sage300>\XQ61A\Templates\Overdue Payment Reminders

e When you first activate CRM and Collections for a new company, the program copies the email
templates to the following company directory

C:\Sage300SharedData\Company\<companylD>\TaiRox CRM\Templates\Overdue Payment Reminders
e The Setup program looks in the company directory for Overdue Payment Reminder templates:
C:\Sage300SharedData\Company\<companyID>\TaiRox CRM\Templates\Overdue Payment Reminders

You can get the most recent templates installed by program updates by clicking the “Install Current

Templates” button. It will copy new templates from \XQ61A\Templates\Overdue Payment Reminders to
the company folder.

| Install Current Templates |

Note that the program will copy over the previous templates of the same name. You should
rename templates that you are using to ensure they aren’t replaced.

See Appendix C: Editing Payment Due and Overdue Payment Reminders for information on editing
reminder email templates and using templates that match the target company’s preferred language.

Note that the Overdue Payment Reminders program uses the email template for the oldest invoice that's
overdue when it sends out overdue invoice payment reminders. So if you have an email that's over 90
days overdue, the program will send the email for the oldest overdue email stage (unless you change the
default aging periods).

The Template dropdown is greyed out if the action is Create Task.

Preview: Click the Preview button to view the body of the selected payment reminder email template.

Note: The Preview button will use the default program for the file type that’s set up in Windows File
Explorer. For example, the default program may be your internet browser.

Attachments: Click the Attachments button to add additional attachments to all of the overdue payment
reminder emails — such as your policy on overdue accounts.

You can use “drag and drop” to add attachments, or click the Add button on the Attachments screen to
search for attachments using Windows File Explorer.
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Settings  Scheduling

Overdue Payment Reminder Stages
Days Overdue Label Color  Action Emal Template

I | s
~ Preview
~ Preview

N

Minimum days overdue before creating an Overdue Payment Reminder: Specify the default
minimum number of days that an invoice must be overdue before marking it as an overdue invoice and
creating a reminder email or phone call task.

You can change this setting for individual companies in the Company window. (For example, you may
have customers whose payment is always late or that may have different payment terms.)

Minimum number of days between Overdue Payment Reminders: If you do not specify a minimum
(e.g. 10 days), the program will let you create a new reminder each time you run Update and process
payment reminders. This can result in customers getting reminders on two consecutive days, if you send
out reminders daily, unless you specify a minimum number of days between reminders.

Format: Select Overdue Invoices to only list overdue invoices, debit notes, and interest charges on
overdue payment reminders, or select Account Summary to list all unpaid documents and unapplied
credits. Use the Preview button to see the difference between Overdue Invoices and Account Summary
formats.

Email Subject: Specify the subject line that you want to appear on all overdue payment reminder emails.
From Email: Specify the “From Email” address that you want to appear on overdue payment reminders.

Reply-To Email: You can also specify a different email address that will be used when recipients reply to
your overdue payment reminder emails.

Cc / Bcc: Add email addresses in the Cc and Bcc fields to send copies (or blind copies) to other
recipients in your company. To Cc or Bcc multiple recipients, separate the email addresses with commas
or semicolons.

Create a Communication When You Send an Email: Select the “Create a Communication” checkbox
to create a communication when overdue payment reminders are emailed to customers.

Note: This checkbox creates a communication for each email recipient. See Selecting Recipients for
Emailed Invoices, Statements, Letters, Payment Reminders and Payment Due Alerts.

Email Archive Folder: Specify a different archive folder for overdue payment reminders. If you do not
specify a folder, CRM will use the folder specified on the first tab in the Options form.

If you do not specify a folder in the Options form, CRM will store EML files in the Sage 300 Shared Data
folder under COMPANY\Company ID\TaiRox CRM\Documents. (EML files include the email message
and all attachments.)
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Organize Documents: This dropdown lets you save archived overdue payment reminder emails in
subfolders of the Email Archive Folder you specified above, organized by Year (ArchiveFoldern\YYYY),
Year and Month (ArchiveFolder\YYYYMM) or Year, Month, and Day (ArchiveFolder\YYYYMMDD).

Notes On using Overdue Payment Reminders

e You can turn off overdue payment reminders on the Company screen for each customer.
See the Company window to change reminder settings for individual customers.

e You specify the company contacts that receive emails on the Contacts tab on the
company screen.

e For each company, you can set the minimum days that a payment must be overdue before
sending an overdue payment reminder, and you can set the minimum number of days between
overdue payment reminders and payment due alerts.

e You can attach copies of overdue invoices to the emailed payment reminders.

e You can change the email template specified here when you process reminder emails. See
Overdue Payment Reminders.

e Send emails that match each company’s preferred language. See Sending Emails and Invoices
Using the “Preferred Language” Company Setting.

Scheduling Tab

The Scheduling tab provides the email and task assignment options that will be in effect when running
Overdue Payment Reminders as a background Windows scheduled task. (These options also appear in a
popup window when you click the “Create Overdue Payment Reminders” button when generating
payment reminders interactively from the Collections folder.) See the CRM and Collections Scheduler
User Guide for information on setting up Windows scheduled tasks.

The substitution variables let you provide user information for emails when the program is run as a task.

Settings  Scheduling
Send Email
Attach copies of the invoices

Substitution Variables

Variable Name

SUSER_NAME admin
SUSER_PHONE 7788812019
SUSER_EMAIL1

SUSER_EMAIL2

Create Task

e [ 1Q
Revisit On days after creation

Generate overdue payment reminders, but do not send emails or create tasks for customers with
Unapplied Credit

Disputed Invoices

Promised Payments

Send Email settings: Apply to any selected customers that have a Send Email action.
o Select “Attach Copies of the Invoices” to include PDF copies of overdue invoices with emails.

e Use the Variables values to provide the name, email address, and phone number that you want
to appear in emails when the program is launched from a scheduled task. (Note that the actual
task user may be the Sage 300 Admin user, but you may want emails to be from the Accounts
Receivable manager.)
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Create Task settings: These settings apply to any selected customers that have a Create Task action.

Create Task
Assign To DON 4

Revisit On days after creation

e You can specify a user name in the Task options to assign tasks for this set of companies to a
single user.

e Specify the number of days following run time that the call task should appear on the assigned
user’s dashboard.

e The “V/M” invoice and credit note buttons appear if you use Technisoft's Service Manager
application for Sage 300.

Exclude Customer settings: Choose which customers to exclude from emails or tasks.

Generate overdue payment reminders, but do not send emails or create tasks for customers with
Unapplied Credit

Disputed Invoices

Promised Payments

Editing Overdue Payment Reminder Templates

See Appendix C: Editing Payment Due and Overdue Payment Reminders for more information on editing
email templates.

Note that each recipient receives only one email per mailout. For example, the following HTML overdue
payment reminder email — 4Delinquent.html — might be sent to customers whose oldest invoice payment
is over 90 days overdue.

Dear Dr. Penn,
One or more of your invoices is seriously overdue.

Because we have been unable to work out payment with you, I regret to inform you
that if we do not hear from you in 5 days we will report this issue to the credit
bureau and turn your account over to a collection agency who will contact you in
regard to payment.

The details of all overdue inveices are as follows:

Invoice Date Amount Due Balance Days Overdue
INOOOO0O00000039 05-Apr-20 1112.43 |15-Apr-20| 283.18 138
INOOOOO00000052 31-May-20 138.35  05-Jun-20 138.35 87
Sincerely,

Administrater

Overdue Payment Reminder templates are ANSI text or HTML files that provide the contents of the
reminder emails. Make sure that you use a plain text editor — like Notepad — to edit email templates.

Template files must be saved in ANSI text format — not in a Unicode variant. You can check the format by
opening the fie in Notepad and clicking File > Save As. The Encoding appears at the botton of the form.

File name: | 2PastDue.tet v‘

Save as type: | Text Documents (*:bxt) ~

P . CEncoding A v> T

The Overdue Payment Reminders Setup program looks for email template files in the following location:
<SharedData>\COMPANY\<OrgID>\TaiRox CRM\Templates\Overdue Payment Reminders

See Sending Emails and Invoices Using the “Preferred Language” Company Setting for more information
on template folders.
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Payment Due Alerts Setup

Payment due alerts are email reminders sent to customers before a payment is due to remind them and
encourage prompt payment. Overdue payments are not included in payment due alerts; they are handled
by the overdue payment reminders program.

Before you can send payment due alerts, you must also specify email addresses for overdue payment
reminders on the Contacts tab for each company record.

Settings ~ Scheduling

Number of days before due date to send & Payment Due Alert

Minimum number of days between Payment Due Alerts

Email Template | DueSoon html ~ Preview Attachments...

Email Subject |Sample Company Limited - Payment Due Soon

From Email |sent @samitd.com

Cc |CC @samitd.com

|
|
Reply-To Email |reph.'@samhd com ‘
|
|

Bec |

[] Create a Communication When You Send an Email
Email Archive
Folder |F: \Sage*Sage300hSharedData"\Company SAMLTD  TaiRox CRM\Documents'Sent Emails ‘ Browse..

Organize By | Save All Sent Emails in the Email Archive Folder by Year and Morth w ‘

Save Close

Note: CRM uses the “Preferred Language” setting in the Company window to send overdue payment
reminder emails and invoices to customers in English, French, or Spanish. See Appendix C for details.

Settings Tab

Number of days before due date to send a Payment Due Alert: Specify the number of days before
payments are due to send reminders. This number applies to the invoice that is closest to being due.

Minimum number of days between Payment Due Alerts: If you do not specify a minimum (e.g. 10
days), the program will let you create a new alert each time you run Update and process payment due
alerts. This can result in spamming customers.

The Minimum number of days between Payment Due Alerts must be less than the Minimum number
of days before the due date to send Payment Due Alerts. This ensures that an alert will be sent for
each invoice before it becomes due.

This means that it you run Payment Due Alerts daily, an alert will go out for each invoice with the
number of days specified before the due date.

Email Template: Choose the default email message that you want to send to customers to remind them
of invoice payments. You can edit the default template files or add your own — and you can override the
default email message templates when you process payment due alerts.

Note the following points regarding template locations:

e During installation, the program copies the email templates to the following program directory:
\<Sage300>\XQ61A\Templates\Payment Due Alerts
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e When you first activate CRM and Collections for a new company, the program copies the email
templates to the following company directory

C:\Sage300SharedData\Company\<companyl|D>\TaiRox CRM\Templates\Templates\Payment Due Alerts

e The Payment Due Alerts Setup program looks in the company directory for Payment Due Alerts
templates. Template files must be stored in the following folder to be selected by the program.

C:\Sage300SharedData\Company\<companylD>\TaiRox CRM\Templates\Payment Due Alerts
You can get the most recent templates installed by program updates by copying the new templates from
\XQ61A\Templates\Payment Due Alerts to the company folder. Make sure that your current templates
have a different name from the templates installed by CRM and Collections.

Preview: Click the Preview button to view the body of the selected payment due alert email template.

Note: The Preview button will use the default program for the file type that’s set up in Windows File
Explorer. For example, the default program may be your internet browser.

Attachments: Click the Attachments button to add additional attachments to all of the payment due
alerts emails — such as your policy on overdue accounts.

You can use “drag and drop” to add attachments, or click the Add button on the Attachments screen to
search for attachments using Windows File Explorer.

Settings  Scheduling

=

Browse...

Add Delete Close -

Email Subject: Specify the subject line that you want to appear on all payment due alert emails.
From Email: Specify the “From Email” address that you want to appear on payment due alerts.

Reply-To Email: You can also specify a different email address that will be used when recipients reply to
your payment due alert emails.

Cc /Bcc: Add email addresses in the Cc and Bcc fields to send copies (or blind copies) to other
recipients in your company. To Cc or Bcc multiple recipients, separate the email addresses with commas
or semicolons.

Notes On using Payment Due Alerts

e The program includes invoices on payment due alerts that are within the number of days before
the due date that is set in Payment Due Alerts Setup.

e Invoices will appear on only one payment due alert. After that, the program ignores them.

e Invoices that are past the due date will not appear on a Payment Due Alert.
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e |f you do not send payment due alerts frequently, some invoices could be skipped.

e You can turn off alert emails on the Company screen for each customer. See the Company
window to change settings for individual customers.

e You specify the company contacts that receive emails on the Contacts tab on the
company screen.

e For each company, you can set the minimum number of days between payment due alerts.
e You can attach copies of due invoices to the payment due reminder emails.

e You can change the email template specified when you process reminder emails. See Payment
Due Alerts.

e You can send emails that match each company’s preferred language. See Sending Emails and
Invoices Using the “Preferred Language” Company Setting.

Scheduling Tab

The Scheduling tab provides the email options that will be in effect when running Payment Due Alerts as
a scheduled background task.

See the CRM and Collections Scheduler User Guide for information on setting up Windows scheduled
tasks for sending Payment Due Alerts.

The substitution variables let you provide user information for email variables when the program is run as
a scheduled task.

Settings  Scheduling
Send Email
Aftach copies of the invoices

Substitution Variables

Variable Name

SUSER_NAME
SUSER_PHONE
SUSER_EMAILT

admin
7789340285
john@samitd.com

SUSER_EMAIL2

Save f Close ¢

Send Email settings
o Select “Attach Copies of the Invoices” to include PDF copies of invoices with emails.

e Use the Variables values to provide the name, email address, and phone number that you want
to appear in emails when the program is launched from a scheduled task. (Note that the actual
task user may be the Sage 300 Admin user, but you may want emails to be from the Accounts
Receivable manager.)

Editing Payment Due Alert Templates

See Appendix C: Editing Payment Due and Overdue Payment Reminders for more information on editing
email templates. Note that each recipient receives only one email per mailout.
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Payment Due Alert templates are ANSI text or HTML files that provide the contents of the reminder
emails. Make sure that you use a plain text editor — like NotePad — to edit email templates.

Template files must be saved in ANSI text format — not in a Unicode variant. You can check the format by
opening the fie in Notepad and clicking File > Save As. The Encoding appears at the botton of the form.

File name: | Invaices.txt V‘

Save astype: | Text Documents (*.txt) ~

A Hide Folders Cncoding: | ans| D[ s | Cancel

The Payment Due Alerts Setup program looks for email template files in the following location:
<SharedData>\COMPANY\<OrgID>\TaiRox CRM\Templates\Payment Due Alerts

See Sending Emails and Invoices Using the “Preferred Lanqguage” Company Setting for more information
on template folders.

TaiRox CRM and Collections for Sage 300 177 User Guide



Setup and Maintenance Screens Send Invoices Setup

Send Invoices Setup

The Send Invoices program sends posted invoices to all recipients. You specify the company contacts
that receive invoices on the Contacts tab on the company screen.

Note: If you select A/R Invoices or O/E invoices for a company contact, the program will send that
recipient A/R Invoices, O/E Invoices, and O/E CR/DR notes — as well as documents created by
Technisoft’s Service Manager for Sage 300 (if you have it), and any A/R summary invoices created
by other third-party programs for Sage 300.

Before you can send invoices to recipients, you must also select email addresses for invoices on the
Contacts tab for each company record.

Settings  Scheduling

Email Template ‘ SendInvoice html V| Preview Attachments...

Email Subject ‘Sample Company Ltd. - Invoice./Facture

From Email ‘Dun @samitd .com

Ce ‘Don @samitd .com

|
|
Reply-To Email ‘AR@samltd.cum ‘
\
\

Bce ‘

Create a Communication YWhen You Send an Email
Email Archive
Folder ‘F: \Sage\Sage300"5hared Data \Company \SAMLTD \TaiRox CRM"Email Archve Folders ‘ Browse...

Organize By ‘ Save Al Sert Emails in the Email Archive Folder by Year and Month v‘

Save Close

Note: CRM uses the “Preferred Language” setting in the Company window to send emails and invoices
to customers in English, French, or Spanish with the Send Invoices program. See Appendix C for details.

Settings Tab

Email Template: Choose the default email message that you want to send to customers with invoices.
You can edit the default template files or add your own — and you can choose a different email message
template when you run the Send Invoices program.
Note the following points regarding template locations:
e During installation, the program copies the email templates to the following program directory:
\<Sage300>\XQ61A\Templates\Send Invoices

e When you first activate CRM and Collections for a new company, the program copies the email
templates to the following company directory

C:\Sage300SharedData\Company\<companyID>\TaiRox CRM\Templates\Templates\Send Invoices

e The Send Invoices Setup program looks in the company directory for Send Invoices templates.
Template files must be stored in the following folder to be selected by the program.

C:\Sage300SharedData\Company\<companylD>\TaiRox CRM\Templates\Send Invoices

Preview: Click the Preview button to view the body of the selected Send Invoices email template.

Note: The Preview button will use the default program for the file type that’s set up in Windows File
Explorer. For example, the default program may be your internet browser.
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You can get the most recent templates installed by program updates by copying the new templates from
\XQ61A\Templates\Send Invoices to the company folder. Make sure that your current templates have a
different name from the templates installed by CRM and Collections.

Attachments: Click the Attachments button to add additional attachments to all of the invoice emails —
such as your policy on overdue accounts.

You can use “drag and drop” to add attachments, or click the Add button on the Attachments screen to
search for attachments using Windows File Explorer.

Settings | Scheduling

Add Delele Close
Cose

Email Subject: Specify the subject line that you want to appear on all invoice emails.
From Email: Specify the “From Email” address that you want to appear on invoice emails.

Reply-To Email: You can also specify a different email address that will be used when recipients reply to
your emails.

Cc / Bcc: Add email addresses in the Cc and Bcc fields to send copies (or blind copies) to other
recipients in your company. To Cc or Bcc multiple recipients, separate the email addresses with commas
or semicolons.
Notes On using Send Invoices

e Invoices must be posted and unprinted to appear in an email run.

e You can turn off invoices on the Company screen for each customer. See the Company
window to change settings for individual customers.

e You specify the company contacts that receive emails on the Contacts tab on the
company screen.

e You can change the email template specified when you process emails. See Send Invoices.

e You can send emails that match each company’s preferred language. See Sending Emails and
Invoices Using the “Preferred Language” Company Setting.

Scheduling Tab

The Scheduling tab provides user settings that will be in effect when running Send Invoices as a
scheduled background task.

See the CRM and Collections Scheduler User Guide for information on setting up Windows scheduled
tasks for sending invoices.
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Settings  Scheduling
Send Email
Substitution Variables
Variable Name Value

ADMIN
SUSER_PHONE

SUSER_EMAIL1
SUSER_EMAIL2

Save Cloze

Send Email Substitution Variables

e Use the Variables values to provide the name, email address, and phone number that you want
to appear in emails when the program is launched from a scheduled task. (Note that the actual
task user may be the Sage 300 Admin user, but you may want emails to be from the Accounts
Receivable manager.)

Editing Send Invoices Templates

See Appendix C: Editing Payment Due and Overdue Payment Reminders for more information on editing
email templates. Note that each recipient receives only one email per mailout.

Send Invoice templates are ANSI text or HTML files that provide the contents of the reminder emails.
Make sure that you use a plain text editor — like NotePad — to edit email templates.

Template files must be saved in ANSI text format — not in a Unicode variant. You can check the format by
opening the fie in Notepad and clicking File > Save As. The Encoding appears at the botton of the form.

File pame: | Invoicestxt V‘

Save as type: | Text Documents (*.xt) v

~ ideFlder <= ) Conce

The Send Invoices Setup program looks for email template files in the following location:
<SharedData>\COMPANY\<OrgID>\TaiRox CRM\Templates\Send Invoices

See Sending Emails and Invoices Using the “Preferred Lanquage” Company Setting for more information.
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Opportunity Stages

Opportunity Stages is a maintenance program that lets administrators specify the stages of an
opportunity. See Opportunities for information on using opportunities.

Opportunity Stages will not appear if you are using the Collections module without CRM.

CRM creates a default set of stages when you create the CRM database, but you can change the stages
to suit your company. The opportunity stages should match the steps in your sales process.

Code |4 4 [MEETING I» " Q+

Description [Mesting |
Created On 2022-05-10 Created By

Modified On Modfied By

Notes
Save Delete Close
Notes:

e The Sort Order determines the order for listing the opportunity stages in drop-down lists and
charts.

e When your CRM data is first activated, the following stages are created. You can add more
stages, and change the order.

o UNQUAL (sort order 1)
o QUALIFIED (sort order 2)
o MEETING (sort order 3)
o PROPOSAL (sort order 4)

For example, you might add “NEGOTIATION” to the default set.

¢ When an opportunity stage is marked Inactive, it will no longer be presented as an option when
adding new opportunities. An inactive stage will continue to be displayed in grids and charts if
present in the selected data.

e The Notes field can be up to 250 characters long.
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Case Stages

Case Stages is a maintenance program that lets administrators specify the stages of collection, support,
appointment, or other processes. See Cases for more information.

Cases include a “Type” field, which can be Collections, Support, Appointment, or Other, and you can set
the sort order for case stages to separate the stages by case type.

For example, if you have collection cases only, your codes might look like this: “REMINDER”,
“DEFAULTNOTE”, “DEMAND”, and “LEGAL”.

However, if you have different types of cases, you might have codes like C1, C2, C3, and S1, S2, S3 —
with appropriate descriptions for collection and support cases, and use the sort order to list collection
case stages first in the Finder.

All stages are user-defined. You do not have to use them.

Code 4 4 [0 [» » Q +

Deescription |Opening collection case with customer |
Created On 2022-03-12 Created By

Modified On 2022-09-12 Modified By

[ Inactive
ot Order
MNotes Opening collection case
Save Delete Close
Notes:

e The Sort Order is a number used for presenting data in the Finder and in drop-down lists and
charts.

In this example, the Finder on the Cases screen shows stages with sort order 1-9. The first stage
listed is for an appointment, the next group shows collection stages, and the last group is for
support issues.

Description Modified On Modified By Inactive
Al Appointment ADMIN 20210302 ADMIN No
C1 Opening collection case with ... ADMIM 20210302 ADMIN Ma
c2 Case stil open ADMIM 20210302 ADMIN Mo
ca Case resclved ADMIN 20210302 ADMIN Mo
51 51 - Issue logged with suppot  ADMIN 2021-03-02 ADMIN MNa
52 52 -Issue escalatedto level 2 ADMIN 2021-03-02 ADMIN Mo
52 53 - Level 2 contact made ADMIM 20210302 ADMIN Mo
S4 - Customer appointment
55 55 - Support issue resolved ADMIN 20210302 ADMIN Mo

e When a case stage is marked Inactive, it will no longer be presented as an option when adding or
updating cases. An inactive stage will continue to be displayed in grids and charts if present in the
selected data.

e You can use the notes to describe what action should be taken at each stage, who should be
informed, etc.

e The Notes field can be up to 250 characters long. Use it to describe what steps should be
performed at each stage.
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Communication Types

Communication Types is a maintenance program that enables administrators to identify the different
types of communications.

Code |4 4 [EMAL » » Q +
Description |E-|'"'|ai| |
Created On 2022-05-10 Created By
Modfied On Modfied By

[ Inactive

Notes

Save Delete Close

Notes:

e When data is activated, the following types are created:

EMAIL
FAX
MAIL
PHONE
TEXT

¢ When a communication is marked Inactive, it will no longer be presented as an option when
adding new communications. An inactive type will continue to be displayed in grids if present in
the selected data.

O O 0O O O

e The Notes field can be up to 250 characters long.
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Territories

Territories is a maintenance program that enables administrators to add the territories to which
companies belong, and to specify which users have access to each territory.

All new customer companies must be assigned to a territory when they are set up. The territory can be
any that you imported from Sage 300 or added in CRM and Collections — or can be the default (blank)
Territory.

Note: CRM and Collections restricts what a Sage 300 User can see based on the territories to
which they belong.

e [ |
Tentones | B
Search | Search
Order By [ Code v
ID Code Created On  Created By I
1 Default Temtory 20131209 ADMIN
2 AK Alaska 20191209 ADMIN Y
3 CA Calfomia 20191209  ADMIN ’
T e ani5120 o 12
5 MO MO 20191209  ADMIN 2
6 NJ NJ 20151209  ADMIN 2
7ON ON 20191209 ADMIN .
8 PA PA 20191209 ADMIN 2
9TX TX 20191209  ADMIN 4
10 VA VA 20151209 ADMIN 4
£ >
Page of 1 Add... Delete Change Log...
Close

Options when using Territories:

e CRM and Collections users can be granted a right to see company data for all territories. This is
a switch in the User record that effectively turns off all restrictions based on territory for that user.

e CRM and Collections users can be granted a right to see companies in any number of specific
territories. There is no hierarchy of territories — this provides maximum flexibility.
To assign a user to aterritory
e Add the user to Sage 300.
e Add the user to CRM and Collections with the Users Setup program.
o Select All Territories for the user in the Users Setup program, or add a list of Territories.
OR

o Select a territory in the Territories Setup program, and add users to the User tab. You can
select All Territories for users that you add to User tab to grant them access to all territories.
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Users

The Users program presents a search field so you can immediately find users if you have more than one

page. Double-click a row to open the user record.

User must be added to CRM and Collections and assigned to territories — or all territories — before they
can enter or view any company data.

Note: TaiRox CRM restricts what a Sage 300 User can see based on the territories to which they belong.

UserD  [ADMIN User Name  [Administrator |
Users  Temitories
Search [ Search
Order By [ User D -
1D User ID User Name Al Temitories Created On Created By Nodifi
1 ADMIN Administrator Yes Administrator 20210510  ADMIN 20214
4 DON Don Fenske Yes Non Admin 20210510  ADMIN 20214
3 KEITH keith Rider Yes Non Admin 20210510 ADMIN 20214
2 WADE Wade Woodsman Yes Non Admin 20210510 ADMIN 20214
£ >
Page of 1 Add... Delete Change Log...
Close

To add a user to CRM and Collections

TaiRox CRM and Collections for Sage 300

Click the Add button.

Click the Finder button on the User screen that appears. (see screen below)
Select the Sage 300 User from the Finder.

Click the Add button, then Close the User window.

Double-click the All Territories column to provide access to All Territories, or go to the Territories
tab and click the Link button to add a list of territories to which the user has access.

A CRM and Collections user must first be added to Sage 300 as a user.
Users can be assigned to a list of territories, or they can be assigned to all territories.

The CRM and Collections user “ADMIN” is created when CRM and Collections data is activated.
All other CRM and Collections users must be added with the Users program.

The Territories tab has a Link button for granting selected user access to one or more territories.
The Unlink button removes that access.
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User popup window for adding new users and viewing existing ones

The User popup window lets you add Sage 300 users to CRM and Collections and edit existing users.

User Optional Fields User Optional Filds

T cosaion coseit

ModfiedOn [ - - | ModfiedBy | | Modiied On Modied By

Oinactive Dinactive

User ID I R+ | User ID [kemH |+ [eeth Rider

[ Al Temitories Al Tenitories

Notes Notes Nor Admin

Change Log Change Log

Notes

o All CRM users must first be added in Sage 300 as Sage 300 users.
e Individual Sage 300 users must then be added as CRM users before they can use CRM.
e The Notes field can be up to 250 characters long.
e The Optional Fields tab appears if you use the Optional Fields module and assigned optional
fields to users.
To Delete a User from CRM and Collections
e Select the user in the grid on the Users tab.
e Click the Delete button or press the Delete key.

e You can view deleted users by right-clicking the Title bar on the grid and choosing Show Deleted.

UserlD  [KEITH User Name ~ [keith Rider |

Hide User ID 20210510

Restore Defaults & 2022122
20210510

KEITH +  Show Deleted 20210510
MORGAN ‘B8 20230419
WADE an es 2021-05-10

To Undelete a User from CRM and Collections
e Use “Show Deleted” to see the deleted user.

o Double-click the Deleted column for the user you want to undelete.

UserD  [KEITH User Name  [Keth Rider |

Users  Tenitories

Search [

Order By User ID ~| 2

Created On
20210510 ADMIN

2022-11-22 ADMIN
20210510 ADMIN

20230419 ADMIN
20210510 ADMIN

e Confirm that you want to undelete the user.
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To Link a User to a Territory

e Select the user from the grid on the Users tab, then select the Territories tab.

UseriD  [KEITH UserName ~ [keith Rider |

2 20210510 AQ
9 T Texas 20210510 AQ
3 CA Calfomia 20210510 AQ

Page of 1 Unlirk Change Log.

Close

e Click the Link button (or press the Insert key in the grid).

e Enter the code for the territory, or use the Finder to select it.

To Unlink a User from a Territory

e Select the user from the grid on the Users tab, and click the Unlink button (or press the Delete
key).

e Users will no longer appear in the grid for this territory.

See Also:

Appendix A - Common Screen Operations for searching, sorting, tabs and common button explanations.

Appendix B — Using Data Entry Programs for tabs and common button explanations.
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Optional Fields

Optional Fields is a maintenance program that lets administrators specify the optional fields that will
appear on the Company, Contact, Opportunity, Case, User, Document and Communication screens.

TaiRox optional fields are searchable, sortable and displayed in grids. For example, if you add a “sales
rep” optional field to company records, you will see the “sales rep” field in the Companies window grid,
and you can list companies in “sales rep” order or select all companies for a particular sales rep.

You can also specify company optional fields to search for disputed invoices, overdue invoices, tracked
invoices, and promised payments, allowing you to find items by “sales rep” (using our previous example).

In addition, CRM and Collections synchronizes optional field values if optional fields for a company are
the same as the optional fields for an A/R Customer.
To use optional fields in CRM and Collections:

e First, add optional fields to Sage 300 using Common Services > Optional Fields. You can also
add values for a Finder list when you add the fields.

e Second, add the Sage 300 optional fields to CRM and Collections using TaiRox CRM and
Collections > Setup > Optional Fields.

Location [ Contacts -]
Q, Optional Field Optional Field Description Q, Default Value | Value Description | Required | [l
PROSPECT PROSPECT ‘Yes No No
REASON Reason for reject No Nor
SALESREP |SelesFen N0 | | [t ]

v
< >
Save Delete Close

o Ifthe list is empty, just click the Finder in the first column heading to select the new optional field
from the list that appears.

If the list already contains optional fields, click the Insert key, and then click the Finder to select
the new optional field from the list.

e Double-click the Value Set field to set a default value for the field.

e Use the Finder in the Default Value field to select from values or enter a default value if no list of
values exists.

¢ When an optional field for a company is the same as an optional field for an A/R Customer, the
Promote function (Promoting a Company to an A/R Customer) will copy this field to the A/R
Customer's optional fields.

e If you add an optional field to CRM and Collections that is already used for A/R customers, the
program will display a message stating that the optional fields match. You can click the Yes
button to set the values for the new field to the values in A/R records.
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Accounting Documents

Accounting Documents is a maintenance program that lets administrators specify Email messages and
various email options for Send Statement/Letters, Send A/R Invoices, and Send O/E Invoices.

Send Documents (Send Statements/Letters) The Accounting Documents program lets you
specify email messages for three programs in the
- = D @ Send Documents folder — Send Statements/Letters,
Send A/R Invoices, and Send O/E Invoices.

Send Send A/R Invoices Send O/E Invoices Send Invoices
Statemnents/Letters

Access: Open Setup > Accounting Documents.

Name [ AR Statement ]

Created On 0220510 | Created By [ADMIN
Modiied On [0220812 Modiied By

[ inactive

From Emal [ |
Reply To Email | |
S [ |
- | |
S [Documerts Atached for SCUSTOMER_NUMBER SCUSTOMER_NAWE I3
Body Documents Atached =
Aitachment Limt | 0] (Ofor nolmi)

Notes

[ Create & Commurication When You Send an Email
Email Archive
Archive Folder ‘F' Sage\5age300'\SharedData\Company\SAMLTD\TaiRox CRM\Documents'\Sent Emails | Browse.

Organize By | Save Al Sent Emails in the Email Archive Folder v

Save Close

Name (of accounting document): Select the document type from the “Name” dropdown for which you
want to set up message and server settings —i.e. A/R Statement, A/R Letter, A/R Invoice, or O/E Invoice.

Once you choose the document type, you can specify the properties and email message for this
document type, as well as where to store copies of all sent emails.

Note that this form does not apply to Overdue Payment Reminders, Payment Due Alerts or the Send
Invoices program.

Inactive Checkbox: Select this checkbox if you do not want to email this document type.

The “Inactive” checkbox lets you set up email settings and contact email addresses before activating the
Send Documents feature.
Specify the Email message settings for the currently selected accounting document:

Note that the accounting documents on this form use the email server settings in CRM Options. This
screen lets you change some of the information on the emails sent to customers.

Reply To Email: CRM lets you use a different Reply To address for each form. This allows
customers to reply to different email addresses for statements, letters and invoices. The Reply To
address overrides the “From Email” address specified on the Options form.

Cc and Bcc: Each form can also have different email addresses Cc’d or Bec'd.
To Cc or Bcc multiple recipients, separate the recipient email addresses with commas or semicolons.
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Subject and Body: Enter the subject and the content of your email. CRM adds information to the
email from the customer record.

Accounting Documents

e Click the Zoom button by the Subject and Body fields to insert customer-specific data, or press F9

in the subject or body field. (F9 may not work in some versions of Windows or if using a VM.)

Body Dear SCUSTOMER_CONTACT: 5]
The aitached statement reflects your accourt balance as of SCUTOFF_DATE. To view and piint the statemert, double-click on the
statemert icon, and then choase File > Print when the statement is displayed. To save the statement, copy # from this email to
another folder on your computer.

Atachment Uit | 0] (Dfor il

Notes AR Letter

Name Description

SCUSTOMER_NUMBER
SCUSTOMER_NAME

[ Create a Communication When Y | SCUSTOMER_CONTACT
SSTATEMENT_BALANCE
SOUTSTANDING_BALANCE  Outstanding Balance

Customer Number
Customer Name
Customer Contact Name
Statement Balance

Email Archive

Archive Folder SSTATEMENT_DATE

:Sava Al Sert SCUTOFF_DATE
SCOMPANY_PHONE

SCOMPANY FAX Comnany Fax Nimher

< >

Statement Date
Statement Cutoff Date
Company Phone Number

Browse...

"

Note: You can copy the default email messages from Sage 300 A/R Statements/Letters/
Labels, A/R Invoices, and O/E Invoices screens to CRM’s Accounting Documents screen.

For example:

1. Select email recipients on the Contacts tab for each company (on the Company
screen in CRM).

2. Open A/R Statements/Letters/Labels and select “Statement” or “Letter” as the
document type.

Select “Customer” as the Delivery Method.
4. Click the Zoom button (') to the right of the Email Message field.

5. Highlight the body of the email, and press Ctrl-C to copy or right-click and choose
Copy.

6. Select A/R Customer Statement at the top of the Accounting Documents form and
paste the text into the email body (Ctrl-V or right-click and select Paste).

Attachment Limit: This setting controls the maximum number of attachments that can be included
with an email. CRM will create additional emails if the maximum number of attachments is exceeded.

When sending invoices, CRM sends a single email to each company contact with all invoices that
meet the selection criteria attached. In some circumstances (if this number is too large) emails may
be rejected because there are too many attachments. Senders have no way of knowing if an email is
rejected for this reason.

Notes: Add any notes you like — such as when or why you last updated the email, why the
accounting form is currently “Inactive,” etc. The field is up to 250 characters long.

Create a Communication When You Send an Email:

Select the “Create a Communication”

checkbox to create a communication when documents are emailed to customers.

Note: This checkbox creates a communication for each contact that receives an email. See the
next section for Selecting Recipients for Emailed Invoices, Statements, Letters, Payment

Reminders and Payment Due Alerts.

Email Archive Folder: Specify a different archive folder for each document type. If you do not
specify a folder, CRM will use the folder specified on the first tab in the Options form.
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If you do not specify a folder in the Options form, CRM will store EML files in the Sage 300 Shared
Data folder under COMPANY\Company ID\TaiRox CRM\Documents. (EML files include the email
message and all attachments.)

Organize Documents: This dropdown lets you save archived emails in subfolders of the Email

Archive Folder you specified above, organized by Year (ArchiveFolder\YYYY), Year and Month
(ArchiveFolder\YYYYMM) or Year, Month, and Day (ArchiveFolder\YYYYMMDD).
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Select Recipients for Emailed Invoices, Statements, Letters,
Payment Reminders, and Payment Due Alerts

You use the Contacts tab in the Company window to select the company contacts that are emailed
invoices, statements, letters, overdue payment reminders, and payment due alerts.

To email statements, letters, and invoices to customers, you must:

1. Specify the “Customer” Delivery Method when you print Statements, Letters, or Invoices from
CRM and Collections.

If the Print function’s Delivery Method is set to “Print Destination”, CRM will NOT send emails.
AND select the contacts that will receive the emails

2. Provide an email address for each company or principle company contact on the A/R
Customer Address tab and choose Email (customer) or Email (contact) as the Delivery
Method in the A/R Customer record (on the Processing tab).

CRM will use the email templates set up in the Accounting Documents Setup function.
AND/OR
Select the contacts for each company on the Contacts tab on the CRM Company screen.

D [ 1]} 4  Name [Bargan Mart - San Diego |

Company amnamemsoppmunmas Documents Cases Notes Communic ations

Search [ | | Search Advanced
Ocerdy [CotsstCoe ] ¢

ices A/RReceipts  A/R Statements O/ Order Corfirmations

DonThemson@tairox.com

JohnEnglish@tairox com X
Keith Smith @tairox. X

Using Email or Contact’s Email addresses after you set up accounting documents:

If the Delivery Method set on the A/R Customer Record Processing tab is Email (customer) or Email
(contact), CRM will send to that email address IN ADDITION TO all contacts selected for the document
type on the Contacts tab in the Company window.

e CRM will not create a communication if the Delivery Method for the A/R customer is “Mail” and
accounting documents are not set up (in Setup > Accounting Documents).

e |f you do not want to send to the Customer Email or Contact Email addresses specified in the A/R
Customer Record, specify “Mail” as the Delivery Method in A/R customer records.

e If you select Email (multiple contacts), you must also select the accounting documents for each
contact on the Contacts tab.

How to Select Email Recipients on the Contacts tab for Each Company

For each company, you must select the email recipients for each document on the Contacts tab in the
Company (or Companies) window. You can specify any humber of recipients for each document from the
list of CRM and Collections contacts for the company.

Send Statements, Letters, and Invoices: TaiRox’s Send Documents features will email statements,
letters and invoices to customers if their Delivery Method in the A/R customer record is set to Email
(customer), Email (contact) or Email (multiple contacts). It will also create a communication for
statements, letters and invoices and attach it to the company.

If you select Email (multiple contacts), you must also select the accounting documents that each contact
receives on the Contacts tab in the Company window for each CRM and Collections company.
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XQ Payment Reminders: You must select XQ Payment Reminders on the Contacts tab in the Company
window for each Overdue Payment Reminders and Payment Due Alerts email recipient.

Send A/R Invoices and O/E Invoices. CRM and Collections’ Send Invoices program sends A/R and
O/E invoices and CR/DR notes to all contacts if you select A/R Invoices and/or O/E Invoices in the
Contacts grid. Essentially, if any of these flags is set, the program will send all receivables type
documents.
To Select Email Recipients for each company and document type

e Select the company in the CRM and Collections Companies window.

e Choose the Contacts tab for the company.

e For each contact row, double-click the column for the document that you want to email.

D .'_" +  Name [Bargain Mart - San Diego |

Company Optional Fields| Contacts |Opportunities Documerts Cases Motes Communications

Search [ || Search Adyanced
Order By Contact Code ~|

AR invoices  A/RReceipts  A/R Statements  O/E Order Confirmations O/E Invoices O/ Credit/Deb O/EQuotes  X/Q Payment Reminders

DonThomson @tairox com

JohnEngish@tairox com
KethSmith @tairox com

Hint: Right-click the column headings in the grid and choose “Hide Most Columns” to easily view
the contact names and the email forms (as shown above). You can reset the columns after
selecting email recipients.

ID Cortact Code First Name ERET— v Job Tile Phone (Office)  Phone (Mobike)

13 BETHFRENCH00013 French Beth EeeilEm (703)555-1069  (703) 5551086 (703) 555-103¢
14 ELIZABETHKERSHAWOD... Kershaw Bizabeth Restore Default cro (305)5551040 (3055551010 (309) 555-108
12 JOENGLISHO0012 English Jo estore Jetautts (403)5551070  (403)5551065  (403)555-101
11 JOESLOANOOOT! Sioan Jos Fide Most Columns |, €00 (2505551076 (250) 555-1045 (250} 555-104
10 JOSEPHVIPONDOOOT0  Vipend Joseph (647)555-1041  (B47)555-1082  (647) 555-103:
9 JOSETRUDEAU0000S  Trudeau Jose (125551083 (212) 5551067 (212) 555107

If you do not add contacts for each company, the Send Documents programs will
use the Delivery Method defined for the company on the Processing tab of the A/R
Customer record. See below.

Customer Number * 4 4 [1210 MO+ a * Required
Customer Name EME Plumbing ‘

Address Comad\n!uicing Optional Fields ~ Statistics  Activity Comments
Account Type Print Statements

Accourt Set |USA | Q |Accounts Receivable, Cther |
Tems Code |N3’D | Q |NH 30 Days |
Biling Cycle |B\LLMT | qQ |Momhry Biling Cycle |
Interest Profile |INTWHS | Q |\rﬂerest Profile - Wholesale |
B Eaie [CHECK | [Eheck |
Defivery Method Mail [ || check Language  [ENG v

Cred Bureau Infoma, M2l

Number Email (contact) I:I Date I:I

Email {muttiple contacts)

e Note that the Send Documents programs will honor the Delivery Method setting if Accounting
Documents are not set up for the company.

This means that the program will also print statements, letters and invoices if the delivery method
is “Mail.”

e |If a company no longer wants to receive emails, uncheck the recipients on the Contacts tab, as
well as set the delivery method to “Mail” on the A/R Customer account Processing tab.
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Set Up Bulk Email Accounts

The Bulk Email Accounts program stores email account information for sending bulk emails to customers.
You must get an email account with a supported provider and enter the account information here before
you can use the Send Bulk Email program in the Send Documents folder.

Note:

e Bulk Email Accounts will not appear on the Sage 300 Desktop if you are using the
Collections module without CRM.

e Bulk Email Accounts appears in the Marketing folder — not in Setup.
TaiRox CRM also lets you send bulk emails using the SMTP email server specified in CRM > Setup >
Options if you do not subscribe to a bulk email service.

General steps for setting up bulk emailing with a bulk emailing service:

1. Subscribe to MailChimp or SendGrid services (or other services supported by CRM and
Collections) — or use the SMTP server specified in Setup > Options.

2. Add bulk email service account information to CRM using the Bulk Email Accounts setup program
in the Marketing folder. (This program is not in the CRM Setup folder.)

3. Create contact groups in CRM for sending bulk emails. You can also choose email recipients by
selecting ranges of CRM companies or ranges of A/R customer accounts.

4. Log in to your bulk email service to:

o Create email templates for bulk emails.
o Create unsubscribe groups for each kind of emails that you send.
o Associate your sending domain with the bulk email provider (if feature is available).

etc.
Subscriber features are dependent on the email service provider.
5. Send test emails to a limited group of recipients.

For more information on setting up email templates for bulk emails, see Appendix D: Sending Bulk Emails
and Using Bulk Email Templates.

Access: Select TaiRox CRM and Collections > Marketing > Bulk Email Accounts.

ot 144 b b Q+
Description |SendGnd bulk mailing account |
— cesetty
Madiied On Modified By
[ Inactive l:l
Provider | SendGrid ~ | e diie = Erd
APl Key | . R ¥ e |
APl U |hﬁp5:f/ap\.5endgrid.com/\r3 |
Notes Account for sendng bulk emails to customers|

Save Delete Close
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To add account details for a bulk email account:

First, subscribe to an emailing service such as MailChimp and SendGrid and follow their
instructions for getting a suitable API key for CRM program access.

See Using CRM'’s Send Bulk Emails Program, in Appendix D, for details.

Choose your subscription provider from the Provider dropdown list. CRM and Collections
currently supports bulk emailing through MailChimp and SendGrid. More providers will be added
in future.

Enter the API key supplied by your email provider. (You may have to generate it while logged in
to the email provider’s website.)

The Send Bulk Email program uses the API key to log in to the bulk email provider’'s website
when you perform a bulk email run.

If you are creating the key, you must give it sufficient permissions to perform a bulk email run. For
example, if you use SendGrid, the API key should have “Full Access”, which allows CRM to
access GET, PATCH, PUT, DELETE, and POST endpoints within the selected permission.

You can enter any notes with the account record.

For information on setting up email templates for bulk emails, see Appendix D: Sending Bulk Emails and
Using Bulk Email Templates.
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Import Productivity Tools Contacts from TaiRox Productivity Tools

If you use TaiRox Productivity Tools and you have set up contacts in the TaiRox Extended Customers
program, you can import your A/R contacts into CRM and Collections. Productivity Tools lets you add
multiple contacts to Sage 300 A/R customers.

The Import Prod. Tools Contacts program does not import contact information from Accounts Receivable
customer records.

Note: This program will not appear in the CRM and Collections Setup Folder if you
activated the Sage 300 Multiple Contacts module.

See Appendix F: Exporting and Importing Companies, Contacts and Notes for information
on importing contacts from other contact management programs.

Customer Range
Select Customers By From To
| - | | | Q |ZZZZZZZZZZZZ | Q
| (None) w |
| (Mone) w |
| (Mone) w |
| (Mone) ~ |
| (Mone) w |
| (None) w |
Additional Criteria...
| Insert Only V| [ Include Inactive Customers
[ Include Inactive Contacts
Process Log... Close
Notes:

e Use “Import Prod. Tools Contacts” to import contacts from TaiRox Extended Customers when
initially setting up the CRM data — using the Insert Only operation. You can also filter contacts
belonging to specific customers if you want.

e Operations include Insert Only, Update Only, and Insert and Update.
e An option is provided for including inactive contacts or contacts for inactive customers.

e Optional fields are not imported using this program.
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Create Demo Data

Create Demo Data quickly creates demonstration data from Sage 300 sample data or from a copy of a
production database. The data is created relative to the Sage 300 session date.

Maximum MNumber of Companies to Create 5(]
Average Number of Contacts
Average Number of Opportunities
Create Close

Important Notes:

e Create Demo Data can only be run on databases with empty CRM and Collections tables.

o Create Demo Data marks the database as “Demo”. In that state a warning message appears
whenever the Sage 300 desktop is opened.

. Waming! You are in TaiFox CRM demno mode. You must run Remaove CRM
)| Data to exit this mode. Any TaiRox CRM data entered in demo mode will be
== lost when Remove CRM Data is un.

e You can run Remove CRM Data on a database marked as Demo. Remove CRM Data will delete
all CRM and Collections tables and deactivate the application, removing CRM and Collections
entries from common services.

Notes:

e AKkeyreason to create demonstration data is so that sales pipeline charts generated from
opportunities will look meaningful.

e A pseudorandom number generator (aka a deterministic random bit generator) is used to vary the
data in a consistent way. This means companies will have no contacts, one contact or several
contacts. The same holds true for other entity relationships. Dates will also be varied.

e All demonstration data is created relative to the session date. Some data (e.g. created-on and
modified-on dates) will be set to a value earlier than the session date ("the past").

e Opportunity stages and communication types are varied as might be expected in a typical
pipeline.

e Opportunities have special dates (expected-closed, revisit-on) that would normally be set to a
value later than the session date (“the future”), unless the opportunity stage has been won or lost;
in which case, these dates and the closed-on date will be in the past.

e Contact names are created with various first and last name combinations so that searching will
find more than one name in a search (e.g. same first name) and yet the first and last names will
be different.

e Optional fields are not created using this program.

TaiRox CRM and Collections for Sage 300 197 User Guide



Setup and Maintenance Screens Create Demo Data

A/R and M/T Integration are suspended in CRM Demo Data:

Note that A/R and M/T Integration are suspended when you create CRM Demo Data. If you look in
Setup Options, you will see that both “suspend integration” options are checked, as below.

Suspend AR Integration
[+]i5uspend M/T Integration;

If you select Sync Contacts or Sync Companies, then following messages will appear.

Message Message

Description: M/T integration has been suspended in TaiRox CRM Options. Description: A/R integration has been suspended in TaiRox CRM Options.
Sync Contacts cannot be performed. Sync Companies cannot be performed.

Source: 09:14:47 - Source: 09:15:22 -

Note that A/R and M/T Integration are suspended for your protection!

Integration is suspended to ensure that CRM does NOT update the Sage 300 Multiple Contacts
and Accounts Receivable data.

If you created Demo Data with SAMLTD or SAMINC — or with a copy of your company database
and want to see the results of A/R and M/T Integration, you can turn on integration in Setup

Options.

If you uncheck the “Suspend xx Integration checkboxes, the program will display a message like this:

The Suspend &/R Integration option should be checked when
in Demo Mode unless you are certain “Sample Company
Limited' is a test company.

Are you sure you want to turn off Suspend A/R Integration?

e
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Remove Demo Data

Remove CRM Data quickly deletes all CRM and Collections tables and deactivates the application,
removing CRM and Collections entries from Common Services.

Are you sure you want to remove TaiRox CRM data and de-activate TaiRox CRM?

Erter YES and then click on OK to proceed
oK Close

You must type YES — all uppercase — to enable the OK button.

Important Notes:

e Create Demo Data marks the database as "Demo". A warning message will appear whenever
you open a Sage 300 demo database, stating that you are in Demo mode.

e Remove CRM Data is the only way to exit Demo mode for that database.
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XQScheduler

The CRM and Collections Scheduler lets you create Windows scheduled tasks to automatically send
Overdue Payment Reminders, Payment Due Alerts, and Send Invoices to customers. It also lets you
update overdue payments in the Overdue Payments program grid. See the Scheduler User Guide.

CRM provides two ways to send overdue payment reminders, payment due alerts and invoices to clients:

e Interactively — using the Overdue Payment Reminders, Payment Due Alerts, and Send Invoices
programs to select recipients and choose runtime options.

e Inthe background using a Windows Scheduled Task — using the runtime settings on the
Scheduling tabs for the Overdue Payment Reminders Setup program, Payment Due Alerts Setup
program, and Send Invoices Setup program.

See the Scheduler User Guide for instructions on creating Windows Scheduled Tasks.

e Start the Scheduler and select User Guide from the Help menu to see the User Guide.

File | Help

‘ User Guide |

License Information

TaiRox Home Page 300\SharedData\Company\SAMLTD\TaiRox CRM\ScheduIedTaaks\[| Open..

About Save...

General steps for creating Windows Scheduled Tasks for overdue payment reminders and
payment due alerts:

e Enter default program settings using the Overdue Payment Reminders Setup, Payment Due
Alerts Setup, and Send Invoices Setup programs.

The Settings tabs for the setup programs include default settings for using the programs
interactively or when launched by Windows scheduled tasks.

The Scheduling tabs provide the email and task assignment options that are in effect when
running the programs as scheduled tasks. Most of these options appear in a popup window when
you run the programs interactively from the Collections folder.

e Run the CRM and Collections’ Scheduler program and enter Sage 300 login settings and email
natification information.

e Save the XML parameter file for running Overdue Payment Reminders, Payment Due Alerts, and
Send Invoices to the Shared Data Folder for your company.

e Use the Create Scheduled Task button on the CRM and Collections Scheduler’s Settings tab to
create a basic scheduled task.

o Use the Start Task Scheduler button to open the Windows Task Scheduler and change security
options to run the task whether the user is logged on or not.

e Set the task to run with the highest privileges.

The CRM and Collections Scheduler program creates a basic Windows scheduled task that points to the
current XML path and name.

Make sure that the Windows task points to the correct XML file. This is the most common error made by
Sage 300 consultants not familiar with the Task Scheduler.

Also, the task created by the CRM and Collections Scheduler will not run on a regular basis until you edit
the task and provide Windows login credentials.
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Appendix A: Common Screen Operations

Using Tabs, Search, Advanced Search, and Sorting

Tabs display more information for the item selected in the first tab:

When a row in the main display grid on the first tab is selected, clicking on another tab shows all of the
entities that are linked to the selected entity. New entities can be added from those additional tabs.

Contacts and documents can be linked to any entity (a many-to-many relationship).

For example, select a company on the Companies tab, and then view all contacts, opportunities, etc. for
the selected company on the other tabs.

Companles Contacts Opportunties Documents Cases  MNotes  Communications
Oppurlunmes Orders  Documents  Motes

Contacts Social Media Companies Documents Communications Contact Groups

Communlcatlons Contacts Documents Companies

Cases Documents  Notes

TTasks | Notes

I Documents Companies Contacts Opportunties  Communications

Search:

Searching works "like an internet search engine".

e Enter a single word (or part or a word) and press Enter or click the Search button to display all
entities with that word in any text field.

e Enter a second word to refine the search. The second word can also be in any text field — such as
“pblack” and “los” for Ronald Black in Los Angeles.

I Search |b|ack

{  Advanced.. I
e Click the red X at the end of the Search field to remove search terms. —— X]|[ Sem

Company search filter:

On many screens you can filter your search with the Company field.

| Search | Search Advanced.. |

Order By | Name - | - I Company  |Astral Construction Co Ltd. x| Q

e Click the Company Finder (shown above) and select the company you want.

You can use the top Search field on the form to refine your search after selecting the company.

e Click the red X in the Company field to remove the company filter.

| Order By Last Name v % Compeny [Bargan Mai -Ockiand x| Q |

ID Deleted [® Company Name e First Mame e Position Phone (Office) Phone (Mobile) Phene (Othe|
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Advanced:

To search by a specific value or range of values (e.g. a date range), use the Advanced Search
capabilities.

For some records — such as Opportunities — Advanced Search also lets you select subsets of these
values, such as the opportunity status.

=

Opportunity Range

Select Opportunities By Operator From To

| Revisit On V| ‘ Range ~ | |2‘]2‘}"D'HTI ‘ |2ﬂ2ﬂ-12—31 |
|{None} V|

| {None) ~ |

Select Opportunty Stages Select Opportunity Status Select Temtories

[m] Unql?l..al'rhed ~| [CJ0pen Aaska ~
|| Qualrfled Wan Califomia

Meeting Lost Default Temitony

Proposal Defemed lowa

Quote based on proposal v T2 Misso i v
Select Al Select None Select Al Select None Select All Select None
Resst Defaults
Sorting:

Each display grid for entities has an appropriate drop-down that lets you select the sort order.

Hovering above the icon to the right of the drop-down will show "Ascending" or "Descending”, the current
order. Clicking on this icon will reverse the sort order.

Order By Name -

Navigation:

Navigate through multi-page lists using the navigation icons, or enter the page number and tab out of the
field.

I Page | 1| of 2 [ 2 | I Add... Delete Promote... Collections... Send Documents... Change Log..

el Close
| & |

Drag the bottom of the window to enlarge it and increase the number of items displayed in the grid. The
program will return you to the first page of items when you change the grid size.

Using Common Buttons on CRM and Collections Forms
Add

Adds a new entity. You can also use the Insert key while in the grid. Or, on some forms, use the
+ button.

Delete

Deletes the currently selected entity (after confirmation). You can also delete entries by pressing
the Delete key while in the grid.
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You can recover deleted entities.

Double-click the title bar on the grid, and select "Show Deleted" from the dropdown menu to
display deleted entities, then double-click the deleted entity to restore it.

erl  [KEITH Userl  [KEITH

Users Tetoies Users Tetories

Search [
Order By

0 Oeleted  User ID

Hide Uses 10

0221122 Are you sure you want to undelete User 'KETH'T
Restore Defoults 20210510

Show Deleted

Z
2 WADE [Ee—— Y ton a5t AoMm 2 wiADE = ;210510 AoMN

Link / Unlink / Promote

Are used when two types of entities can be linked together. Promote is a special case of Link that
connects a CRM Company to an A/R Customer.

Unlink removes the link by deleting a row in the link table.

"Show Deleted" will not show a deleted link, but the link can easily be re-added.

Change Log

Every change to every field in every key entity is logged. When viewing a change log, select a
row in the top grid to display all changes in the bottom grid.

In this example, the Opportunity Stage and Revisit Date have been changed by user KEITH, and
the program has also updated the Modified By and Modified On values.

Entity Opportunity ‘2 ‘ |Fa|| Sale |
Search ‘ ‘

Search

Order By [Date v .

Ertity ID  Event

445 20210310 8:00:00 AM  KEITH OFFO MODIFY OPPORTUNITY

444(2021-0308  [EEEETIKEITH OFFO |2 [MODIFY OPPORTUNITY

< >
Page of 1
New Value
Modified By ADMIN KEITH
Modfied On 20201213 20210309
Revisit On 20210314 20210320
Stage PROPOSAL QUOTE
< >

Close

You can double-click a row in the bottom grid to open a window for side-by-side comparisons.
This is particularly useful for comparing Notes.
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Appendix B: Using Data Entry Programs

CRM and Collections data entry programs let you enter and edit data using familiar Sage 300 controls. All
CRM records — such as companies, contacts, opportunities — include an ID that’s displayed beside the
main entity name. The ID is a unique number, internally generated by CRM and Collections.

Data for each record appears on tabs, similar to Sage 300 entry screens. For example, the Company
maintenance program has tabs for the Optional Fields, Contacts, Opportunities, Documents, Cases,
Notes, and Communications that are linked to the company.

D O 4+ Name |Eargain Mart - San Diego |

Compary Optional Fields Cortacts Opportunities  Documerts Cases  MNotes  Communications

EE=aiien Created By Customer Number E
o e e \

[ inactive

T 1 Caselg) Collections...
Temitory |C}\ v| |Ca||fom|a 1 Disputed Invoice(s)

1 Owerdue Invaice(s)
Phone Mumber |(405} 451-8981 | = Promised Paymentis)

Click the Contacts tab to see the linked contacts for the company. If you have a large number of contacts
attached to a single company, use the Search function to narrow down the contact list — as below.

D O 4+ MName |Earga|n Mart - San Diego |

Company Optional Fields | Contacts | Opportunities Documents Cases MNotes  Communications

ISearch ‘da I X ‘ Search Adyanced... |

Order By | Contact Code =

ID Contact Code Last Name First Name Middle Name Salutation Phane (Office) Phone (Mabile) Phone (Cther)

White Claire (305) 555-1042 (305) 555-1092 (305) 555-1044

There are many ways to drill down to data from different locations.

Add, Delete, Link, Unlink and Change Log Buttons

Some or all of the following buttons will appear on each tab of a maintenance program.

Page of 1 Add Delete Link Uniink Change Log

Close

Add: Lets you add new entries by popping up an entry form.

Delete: Deletes entries. Note that deleted entries are retained in the database and can be viewed by
right-clicking the title bar on the grid and choosing "Show Deleted".

ID Deleted |User D

All Temtories Created On Created By

Hide User ID Administrator 20210510 ADMIN

Yes 2022-11-22  ADMIN
Restore Defaults

N Yes Non Admin 20210510  ADMIN
I o lonfdon (20210510
o
6 MORGAN show Deleted Yes 20230419 ADMIN

2 WADE Wade Woodsman Yes Non Admin 20210510 ADMIN
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Link: The same document can be linked to multiple entities of any type. Clicking Link adds a link to an
existing document. It does not create a new document.

Unlink: Alink to a document can be removed. This removes the link by deleting a row in the link table.

"Show Deleted" will not show a deleted link (the link can be easily re-added).
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Appendix C: Editing Email Templates for
Payment Due Alerts, Overdue Payment
Reminders, and Send Invoices

Template Locations on Sage 300 Servers

The CRM and Collections installation program installs eight email templates for the Overdue Payment
Reminders program and two templates each for the Payment Due Alerts program and Send Invoices
program in the Templates subfolder for the CRM and Collections application:

\<Sage300>\XQ61A\Templates\Overdue Payment Reminders
\<Sage300>\XQ61A\Templates\Payment Due Alerts
\<Sage300>\XQ61A\Templates\Send Invoices

- + Dive2(F) > Sege » Saged00 » XQSIA » Templates » Overcue Payment Reminders
XQS1A A Nam . Date modified
@ Latehtml
ESH TLatetst
TLaste et
€ 2FasiDucimi
PastDuesxt

When you activate CRM and Collections for a new company, activation also copies the email templates to
the following company-specific folders — so they are available to the Overdue Payment Reminders Setup,
Payment Due Alerts Setup and Send Invoices Setup programs.

C:\<Sage300SharedData>\Company\<companylD>\TaiRox CRM\Templates\Overdue Payment Reminders
C:\<Sage300SharedData>\Company\<companylD>\TaiRox CRM\Templates\Payment Due Alerts
C:\<Sage300SharedData>\Company\<companylD>\TaiRox CRM\Templates\Send Invoices

o Email templates must be in the correct company folders to be selected by the Overdue Payment
Reminders, Payment Due Alerts Setup and Send Invoices Setup programs.

e You can also add French and Spanish versions of email templates in language-specific
subfolders, such as the following:

C:\<Sage300SharedData>\Company\<companylD>\TaiRox CRM\Templates\Send Invoices\FRA

Templates in language subfolders are used according to the “Preferred Language” setting for
companies. See Sending Emails and Invoices Using the “Preferred Language” Company Setting
in this appendix for details.

If you are updating CRM and Collections, you can copy any new templates for Overdue Payment
Reminders and Payment Due Alerts from the program folders to the \Company\<companylD>\TaiRox
CRM\Templates\ folders.

Include tairox-logo.png when you copy new sample emails to your sample data and company folders.
New email templates include an embedded logo — see Addng a Logo for more information.

For Overdue Payment Reminders, you can click the “Install Current Templates” button on the Overdue
Payment Reminders Setup screen to copy new templates from \XQ61A\Templates\Overdue Payment
Reminders to the company folder.

| Install Current Templates |

TaiRox CRM and Collections for Sage 300 206 User Guide



Appendix C: Editing Email Templates Template Locations on Sage 300 Servers

Note that the program will copy over the previous templates of the same name. You should rename
templates that you are using to ensure they aren’t replaced.

The email templates provide the body text for emails. The subject, email sender, Cc and Bcc addresses
come from the Overdue Payment Reminders Setup program, Payment Due Alerts Setup program and
Send Invoices Setup program.

The sample email templates include one HTML email and one text-only email template for each of the
four aging stages used by the Overdue Payment Reminders program and one HTML email and one
text-only email template for the Payment Due Alerts program and Send Invoices program.

By default, programs use HTML versions of the default templates. You can change the selection
using Overdue Payment Reminders Setup, Payment Due Alerts Setup, and Send Invoices Setup.

The following screen shows the email header fields on the Overdue Payment Reminders Setup screen for
Overdue Payment Reminders.

Format Overdue Invoices ~

Email Subject [Sample Company Limited - Paymeni Overdue

From Email |AR@samhd com

Ce [

Bee [Don@samitd com

\
\
Reply-To Email  [AR@samitd.com ‘
\
|

Important Information Message if Templates Have Significantly Changed

The message may be different in later versions of CRM and Collections.

For example, as of September 2020, this message appears when you click the Process Overdue
Payment Reminders button if any payment reminder templates — or if the email subject line — included a
$DOCUMENT macro.

f -
% Important Information [é]

Waming: One or more of the Overdue Payment Reminder templates do NOT include the macro
S0OVERDUE_INVOQICES and/or the email subject line contains macros beginning with SDOCUMENT.

Explanation: Overdue Payment Reminder emails now consolidate all overdue invoices into a single email,
instead of sending a separate email for each overdue invoice. Atable of overdue invoices is inserted into the
email body at the posttion marked by the macro SOVERDUE_INVOICES. Macros beginning with
SDOCUMENT will be replaced by the details from the most overdue invoice.

We suggest you make changes to the templates and/or the email subject line before sending overdue
payment reminders. See Appendix C in the User Guide for instructions.

[ Send Overdue Payment Reminders ]

In June 2023, we dropped the deprecated macros starting with $DOCUMENT _. They can no longer be
used with payment due alerts or with overdue payment reminders.

In September 2020, we added the $OVERDUE_INVOICES macro to insert a table with all overdue
invoices into payment reminder emails. See the list of macro variables later in this appendix.

To cancel the mailout and update your email templates, click the cancel button.

Note: The email subject, from email address, reply-to email, Cc and Bcc fields are set in the
Overdue Payment Reminders Setup, Payment Due Alerts Setup and Send Invoices Setup programs.
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HTML and Text-Only Email Templates

CRM and Collections provides one HTML email and one text-only email template for each of the four
aging stages used by the Overdue Payment Reminders program, and provides one HTML email and one
text-only email template for the Payment Due Alerts program and for the Send Invoices program.

You select the default email templates that you want to use in the Overdue Payment Reminders Setup
and Payment Due Alerts Setup, and Send Invoices Setup programs. You can override the default
templates at runtime.

Settngs | Scheduing Setings | Scheduing
Overdue Payment Reminder Stages
Number of days before due date to send a Payment Due Alert I
Days Overdue Lobel ColorActon Emai Template
Mirimum number of days between Payment Due Alers
1 -Late SendEmal  ~| | TLate himl v | Prevew
Emai Template | DueSoon hinl Preview Atschments
[ [2-Past Due [] [sendEmat | [zPastouetim To] | Frevew =i Template. | DueSoon i e
Sample G Uimted - Payment Dus 5
[2-1n Arears [ [SerdBnal ] [ILtehind Preview Emal Subject ample Company Limted - Payment Due Soon
[Ove] [0 [2-Denauert [ [sendbmal | pleeise Fa— From Email sent @samitd conl
2PastDue bt Reply-To Emai  |reply@samitd com
2PastDue vine e
Miimum days overdue before creating an Overdue Payment Reminder g}nzzars Triml e e amkd com
InAmears bt
P en G e et JinArears_yv1 st m
4Delinquert Hml
Fort Pt
ADelnauent v1bt [ACreate 2 Communication When You Send an Emai
Emai Sbject [Sample Company Limted - Paymert Overdue sample-wthdogo hil S
il Archive
From Emai [Salea@samtd.com e { e et ST = | [
Reply-To Emai  |Sales@eantd com Organize By | Save Al Sent Emals in the Emai Archive Folderby Year and Morth <]
o [ \
Bee [Pon@samid com | = o

e Email templates must have an “html” or a “txt” extension and must be in the following directories
in order to be selected.

C:\<Sage300SharedData>\Company\<companylD>\TaiRox CRM\Templates\Overdue Payment Reminders
C:\<Sage300SharedData>\Company\<companylD>\TaiRox CRM\Templates\Payment Due Alerts
C:\<Sage300SharedData>\Company\<companylD>\TaiRox CRM\Templates\Send Invoices

e Click the Preview button to see how the email will appear to recipients.

The following example illustrates the main difference between the HTML and text-only email
templates — where the HTML template displays overdue invoices in a formatted table, the text-
only template lists the invoice details vertically.

[ previewhtml
G @  @File | C/Users/dont/AppDatailocal/lemp/pr.. A @ g 1=

Dear Don Ellington,

File Edit Format View Help
Our records show that we haven't yet received payment for one or more invoices |Hi Don Ellington,
listed below. I would appreciate it if you could let me know when we can expect

payment. listed below. I would appreciate it if you could let me know when we can expect
payment.

Our records show that we haven't yet received payment for one or more invoices

Please include your account number (091223) and invoice numbers with your
payment. Please include your account number (891223) and invoice numbers with your
payment.

Details as of 2020-09-15:

Details as of 2020-89-15:

Invoice Date Amount | Due Balance | Days Overdue Tnvoice: INGBO3ETL
D 1 2020-86-19
IN0003071 | 2020-06-19 | 1,680.69 | 2020-07-19 | 1,680.69 58 A:Ent: 1,680.69
Due: 2020-07-19
INO003095 [ 2020-07-03 | 599.30|2020-08-02| 599.30 44 Balance: 1,680.69
Days Overdue: 58
Total: 2,279.99
Invoice: INOG@3095

D 1 2020-87-83
If payment has already been sent, please disregard this notice. A:ﬁint: 599.30

Due: 2020-88-02
If you have any questions, please call me at 778-555-1234. I will be happy to an gatance: 599.30
them. Days Overdue: 44

Thank you for your prompt response to this request and for your continuing

business If payment has already been sent, please disregard this notice.

. If you have any questions, please call me at 778-555-1234. I will be happy to
Sincerely, answer them.
Administrator
778-555-1234 Thank you for your prompt response to this request and for your continuing
busi .
morgan.thomas@telus.com usiness
Sincerely,
Administrator

morgan. thomas@telus. com

Ln1.Col 1 100%  Windows (CRLF)  UTF-3

Note: The Preview button will open the email template using the default program for the file type
that’s set up in the Windows File Explorer.
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Editing Email Templates

Email templates for payment due alerts, overdue invoice reminders and the Send Invoices program are
ANSI text or HTML files that provide the body of the emails. Use a plain text editor — like NotePad — to
edit the text and HTML email templates. Do not use an editor that might change the file format and insert
hidden formatting.

Note that reminder emails for payment due alerts list ALL due invoices and emails for overdue payment
reminders list ALL overdue invoices for each company (unless the invoices are on hold) — so each
recipient receives only one email per mailout.

Templates for payment due alerts and overdue invoice reminders can also include macros that lists all
pending or overdue invoices and invoice amounts for the company:

o S$INVOICES lists all not-yet-due invoices on payment due alerts emails.

e $OVERDUE_INVOICES lists all overdue documents — or all unpaid documents -- on overdue
payment reminder emails, depending on whether you choose the Overdue Invoices format or the
Account Summary format from the Format dropdown on the Overdue Payment Reminders Setup
screen.

o $AGING_TABLE displays overdue amounts for the standard aging periods — 30, 60, 90, and
over 90 days — and current amounts if you choose the Account Summary format for documents.

The Overdue Payment Reminders program uses the email template for the oldest overdue invoice —
unless the aging period is set to generate phone call tasks instead of send email reminders.

For example, the following HTML overdue payment reminder email — 4Delinquent.html — might be sent to
customers whose oldest invoice payment is over 90 days overdue.

Note that this example lists overdue invoices only. You can change the Format setting in the Overdue
Payment Reminders Setup screen to display all unpaid documents instead. See Overdue Payment
Reminder Setup.

File Edit Search View Encoding Language Seftings Tgols Macro Run Plugins Window 2 3

] @t B3

&

TOATaiRox C1 Payment

= 5 £

] 4Deincuent his

2s="PanelA” width="700" border="0" cellpadding="5" cellspacing=

Dear SCUSTOMER CONTACT,</td>

One or more of your invoices is sericusly overdus.</Sd>
Dear Don Ellington, =
<td>Because we have been unable to work cut payment with you, I regret
to inform you that if we do not hear from you in 3 days, e will report
this 1ssne to the credit bureau and turn your account over to a
collection agency who will coutact you in regard to payment.</td>

One or more of your invoices is seriously overdue.

Because we have been unable to work out payment with you, I regret to inform you
that if we do not hear from you in 5 days, we will report this issue to the credit
bureau and turn your account over to a collection agency who will contact you in
regard to payment.

The details of all overdne invoices are as follows:</td>

The detalils of all overdue invoices are as follows:

Invoice

Date

Amount

Due

Balance

Days Overdue

IN0003071

6/19/2020

1,680.69

7/19/2020

1,680.69

98

INO003095

7/3/2020

599.30

8/2/2020

599.30

84

Total:

2,279.99

Overdue invoice balances by days overdue:

Ta>

[1- 30 Days[31 - 60 Days [61 - 90 Days | over 90 Days [ Total |

[ 0.00] 0.00] 599.30] 1,680.69]2,279.99| \
Sincerely,
Administrator \

length: 1,696 lines Windows (CRLF)  UTF-8 NS

e The image on the left shows what you see when you click the Preview button.
e The image on the right shows the email in a text editor — in this case, NotePad++.
e The $CUSTOMER_CONTACT macro displays the contact name in the email.
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e $OVERDUE_INVOICES generates the first table shown above, with invoice information for all
overdue invoices that are not on hold — or for all outstanding documents (depending on the
Format setting on the Overdue Payment Reminder Setup screen).

e $AGING_TABLE generates the second table, showing overdue or outstanding amounts by aging

period.

e S$INVOICES is used for payment due alerts to list all due invoices instead of overdue ones.
e The $USER macro inserts information for the user generating the emails.

Template files must be saved in ANSI text format — not in a Unicode variant. You can check the format by
opening the fie in Notepad and clicking File > Save As. The Encoding appears at the botton of the form.

File name: | 2PastDue.tet

Save as type: | Text Documents (*xt)

A Hide Folders

Encoding: | ANSI

The CRM and Collections Setup programs look for email template files in the following locations. You
must put all templates that you want to use in these locations, and then select them using the Setup

programs.

<SharedData>\COMPANY\<OrgID>\TaiRox CRM\Templates\Overdue Payment Reminders
<SharedData>\COMPANY\<OrgID>\TaiRox CRM\Templates\Payment Due Alerts
<SharedData>\COMPANY\<OrgID>\TaiRox CRM\Templates\Send Invoices

Macro Variables in Email Templates

You can use the following variables in email templates. Note that templates for the Send Invoices
program can include the Customer Information and User information but not Document Information. You
can also include most variables (except ones that generate a table) in the email subject.

Customer Information
(from Sage A/R —not CRM)

$COMPANY_PHONE
$COMPANY_FAX
$COMPANY_CONTACT
$COMPANY_NAME

$CUSTOMER_NUMBER
$CUSTOMER_NAME
$CUSTOMER_CONTACT
$CUSTOMER_BALANCE

Document Information

For Payment Due Alerts
$INVOICES - for payment due alerts.
Lists all not-yet-due invoices for the
company:

- Document number

- Document date

- Document amount

- Due date

- Balance

For Overdue Payment Reminders
$OVERDUE_INVOICES - for overdue
payment reminders. Lists all overdue
invoices or all unpaid invoices for the
company (depending on the format):
- Document number
- Document date
- Document amount
- Due date
- Balance
- Days overdue
$AGING_TABLE —amount for each aging
period defined in CRM Options
(including “Current” if using the
Account Summary format)
$OVERDUE_AMOUNT - total balance of
overdue amounts in table
$OVERDUE_DAYS — most overdue inv.
$AS_OF_DATE - system date when the
overdue payment data was updated

$FORMAT - displays "Account Summary"

or "Overdue Invoices" depending on
the options setting for reminders
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User
(Sage user account information)

$USER_NAME
$USER_PHONE
$USER_EMAIL1
$USER_EMAIL2
- Inserts the user information for the
user account generating the
overdue payment reminders.

Current Date
$TODAY
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The sample email shown previously:

Includes the Contact name in the greeting. Emails can be sent to multiple contacts at each
company.

Includes $OVERDUE_INVOICES. This macro expands to include all overdue invoices — or all
unpaid documents — listing the invoice #, date, amount, due date, current balance outstanding,
and days overdue.

Example of a table if you choose Overdue Invoices as the Format in Overdue Payment
Reminders Setup.

Invoice Date Amount | Due Balance | Days Overdue
IN0003071|2020-06-19|1,680.69 | 2020-07-19|1,680.69 58
IN0O003095 | 2020-07-03 | 599.30|2020-08-02| 599.30 44
Total: 2,279.99

o On Hold invoices will not appear in the list of overdue invoices.

Example of table if you choose Account Summary as the Format in Overdue Payment Reminders
Setup.

Invoice Date Amount | Due Balance | Days Overdue
INO003071|2020-06-19 | 1,680.69 | 2020-07-19 | 1,680.69 58
INO003095 | 2020-07-03 | 599.30|2020-08-02| 599.30 44
INO004014 | 2020-09-03 | 324.79|2020-10-02| 324.79
Total: 2,604.78

The $INVOICES macro for payment due alerts is similar, but does not have a “Days Overdue”
column.

$AGING_TABLE generates the second table, showing overdue amounts by aging period. A
“Current” period will appear if you choose the Account Summary format in Overdue Payment
Reminders Setup.

The signature line of the letter shown above includes the SUSER_NAME only, because the other
$USER information is missing from the user record.

Note that the user information is for the logged-in Sage 300 user that is running the Overdue
Payment Reminders program. You may want to substitute a single company representative,
email address, and phone number for these macro variables.

Note that SDOCUMENT variables are no longer valid. Previously, these variables listed the
details of the OLDEST overdue invoice. They can no longer be used with payment due alerts or
with overdue payment reminders.

Embedded CSS and Table Formatting in HTML Email Templates

The header information in the sample email templates sets the font style, font size, and grey background
for the overdue invoices table. Do not edit this section unless you are very familiar with HTML.

o=

File Edit Search View Encoding Language Settings Tools Macro Run

5 4Dstnquert ol E3 |

R ugi
Y=y B | g & & |EE| =

o

<ntml> ~
<styls typs="text/css">

Fe/styles v

Hyper Tex length: 1,385 lines: 53 Ln:15 Col:2 Sel:0]0 Windows (CRLF)  UTF-8 INS
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The body of the email is set up as a series of tables, with each paragraph in a table cell. Do not change
the email structure unless you are familiar with HTML. We suggest that you just edit the text in each cell.

You can preview your email templates using a browser, then by using the Preview button in the Overdue
Payment Reminders Setup, Payment Due Alerts Setup, and Send Invoices Setup programs after you
copy the edited file back to the correct SharedData folder and select it in the Setup program.

File Edit Search View Encoding Language Settings Tools Macro Run Plugins Window I 3
cHHERGE s Wk Pe(hpax EEIETEFEA= ®| @ = 0BG %
5 4Delinquent himl E3 |

</style> ~
H<poay>

<table class="PanelA" width="700" border="0" cellpadding="5" cellspacing="0">
<tr>
<tdsDear $CUSTOMER CONTACT,</td>
</tr>
28 O <cr>
25 <td>One or more of your invoices is seriously overdus.</td>

</exs>

o <cr>
<td>Because we have been unable to work out payment with you, I regret to inform you that if we do
not hear from you in 5 days, we will report this issue to the credit bureau and turm your account
over to a collection agency who will contact you in regard to payment.</td>

E </ers
5 B <cr>
<td>The details of all overdue invoices are as follows:</td>
</tr>
</table>
32 [<table class="PanelA" width="700" border="0" cellpadding="5" cellspacing="0">
35 H <tr>
<td>$OVERDUE_INVOICES</td>
</tr>
8 </table>
39 E<table class="PanelA" border="0" cellpadding="35" cellspacing="0">
40 B <tr>
41 B <td>
42 =] <table cellpadding="0" cellspacing="0">
43 <trr<td>Sincerely, </t
as <tr><td>$USER_NAMES/t:
a5 <tr><td>$USER_PHONE</td><
46 <tr>ctd>§USER_EMATL1</td>
4 </table>
4 </td>
4 </rrs
5 </table>
B </body>
5 </html>
£2 v
Hyper Text Markup Language file  length: 1,386 lines: 53 Ln:15 Col:2 Sel:0|0 Windows (CRLF)  UTF-8 INS.

Adding a Logo

The sample email templates installed by CRM and Collections include an embedded logo to illustrate how
you can add your own logo to Overdue Payment Reminders, Payment Due Alerts, and Invoice emails.

Here is an email template loaded in a browser, showing the company logo at the top:

i O [ Dussoonntmi +

~

G @ (@ File | F/Sage/Sage300/XQ61A/T... o l‘_rsignin "\

TaiRe=x

Dear $CUSTOMER_CONTACT,

We are letting you know that payment for one or more of your invoices is due soon.
The details of the invoices are as follows:

And here is the HTML segment for the embedded logo:
e

File Edit Search View Encoding Language Settings Tools Macro Run Plugins Window ? + v X
cHHEEGa JaR|peing|lax@E ST EFERRe® O oM BB
[=] Duesaon.htmi EZ!l

.PanelB { ~
font-family: Verdana, Arial, Helvetica, sans-serif;
12 font-size: lépx;

color: #000000;
background-color: #eeceee;

</style>
<body>

F<table class="PanelA" width="700" border="0" cellpadding="5" cellspacing="0">
<tr>
<td><img src="tairox-logo.png" width="106" height="27"></td>

2 </tr>
</table>
J<table class=-"PanelA" width="700" bordsz=n"0" Cellpadding="5" Cellspacing="0">

<trs
<td>Dear $CUSTOMER CONTACT,</td>

</tr>

<tr>

<td>We are letting you know that payment for one or more Of YOUr invoices is due soom.</td> v

Hyper Text Marku length : 1,574  lines: 64 Ln:22 Col:8 Pos:434 ‘Windows (CRLF)  UTF-8 INS
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Setting
Note:

e The image is embedded in a table at the top of the email.

e The image files must be located in the same folder as the template.

e Don't use any special characters in the filenames.

e You can enclose the filename in quotes or apostrophes in the html template.

Sending Emails and Invoices Using the “Preferred Language”
Company Setting

TaiRox Collections provides multi-language support for sending emails from the Overdue Payment
Reminders, Payment Due Alerts, and Send Invoices programs.

o [ 3q+

Company Optional Fields Contacts Opportunities  Documents

Name |Mr Ronald Black |

Cases Motes Communications

Created On Created By Customer Number NG
Modfied On [2024-01-08 Modfied By Cumency USD

[ inactive

Short Name 2 Casels) Collections
e B R | | > Ovee st

Phone Number |{213} 555-0274 | = Promised Payment(s)

FaxNumber  [1213) 5557234 |

Wieb Ste [ | =

Email | ‘ E

Contact’s Name |Mr Black ‘ Contact’s Phone |( ) - | E
Contact’s Emai  [ronaldblack 99@hatmail.com | B ComactsFax [ - |

Prefemred Language

ENG

[4] Send Overdue Payment '
Date of the last Overdue FRA2

Minimum days overdue before creating an Overdue
Payment Reminder

ljl {Enter 0 to use the system default)

You select a company’s preferred language on the Company screen, along with other options for sending
overdue payment reminders, payment due alerts, and invoices.

TaiRox CRM and Collections provides support for English, French, and Spanish language preferences.
The program will send emails in the selected language, and will also provide translated versions of

attached invoices.

Here are the steps for sending French or Spanish emails with translated invoice attachments:

Install the Sage 300 language files for French and/or Spanish to send emails and invoices in the
target languages.

Select the Preferred Language for all customers that should receive French or Spanish emails.

Add the English versions of your email templates to the default templates folders for overdue
payment reminders, payment due alerts, and invoices.

Create FRA and ESN subfolders for the translated versions of your email templates.

Add the French and Spanish versions of your email templates to the default templates folders for
overdue payment reminders, payment due alerts, and invoices.

o The translated templates must have the same names as the English versions in the root
folders.

o You must include any image files for the emails in the language subfolders.

The following screen shows the root template directory for the Send Invoices program, with html and
text versions of the template, along with a picture file for the logo that appears in the email.
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Setting
Home Share View o
« v 4 <« TaiRox CRM » Templates » Send Invoices » v | O A Search Send Invoices
W Templates & Mame Date modified
Bulk Email Ternplates ESM 2024-01-02 2:21 PM
v Overdue Payment Reminders FRA
ESN € sendinvoice html
FRA D Sendlnvoicetxt
v Payment Due Alerts tairox-logo.png
ESN
FRA
v Send Invoices
ESN
FRA L 4 >
Sitems  1item selected E =

The screen also includes two subfolders for Spanish and French versions of the email templates.
Note the following points:

o When you select a template using Setup program for Overdue Payment Reminders, Payment
Due Alerts or Send Invoices, the program looks for html or txt files in the root folder for
Overdue Payment Reminders, Payment Due Alerts, or Send Invoices root folder. For
example:

\Sage300\SharedData\Company\<ORGID>\TaiRox CRM\Templates\Send Invoices

The dropdown that you use to select a template file will not display template files that are in
the language subfolders.

o When you run the Send Invoices program (for example), the program will check the preferred
language code for each customer, look for the appropriate language subfolder, and, if it
exists, look for a template that matches the selected email template name.

If the template does not exist in the language subfolder, the program will use the English
template file in the “...\Templates\Send Invoices” root folder.

In other words, you must create the language-specific versions of your template using the same
template names and copy them to the appropriate language subfolder where the program can

find them.
The contexts of the language subfolder will look like this — with similarly-named html, txt and
image files:
Home  Share  View (7]
« S <« Templates » Send Invoices » FRA ~ O S Search FRA
v Templates ol Mame - Date modified

Bulk Email Templates e Sendinvoicehtml

A Overdue Payment Reminders D Sendlnvoicett
ESN tairox-logo.png
FRA

v Payment Due Alerts
ESN
FRA
v Send Invoices
ESN
FRA

3 items

>
[EH=

In this case, the French-language version has all the same files as the default English folder —
including the logo file.
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Setting
Also Note:
o The subject line for the email comes from the setup programs for Overdue Payment
Reminders, Payment Due Alerts, and Send Invoices. It does not get translated.
o The Crystal Report form used for A/R and O/E invoices and CR/DR notes is set on the
Customer PDFs tab in CRM Options.
By default, the program will browse to the AR\ENG or OE\ENG folder to let you choose the
report for invoices. When you run the program, it will select the preferred customer language
from the language folders.
o Do not specify a path when you choose an invoice print form in CRM Options.
Options Emai Calendar Document Folders Customer PDFs
A/R Invoice Opti U; Mz DEINVDTRPT Browse...
[ o/Einvoice 0Bt [ pryy seriatLot pumbers
O/E Credit Note OPE [include Backordered ttems
[[] Use Custom Form
[ Print Kit Component kems
[ Print Bills Of Material Component ftems
[ Retainage
Cancel
o Column titles in tables will be translated to French and Spanish — the two other languages
supported by CRM and Collections.
o If you are inserting an image in your email — such as the logo — it must be copied to the

language folder with the email template.

Previewing Translated Email Templates

The Preview buttons for Overdue Invoice Reminders, Payment Due Alerts, and Send Invoices work as

follows:

o |f the template preview is for a specific customer — such as when you select a customer in the

Overdue Payment Reminders or Payment Due Alerts grid and click the Template column heading
— the program will display the email for the customer’s preferred language (if the email template
exists).

[B Company Name [E Flags Days Over... Stage Invoices Overdue Amourt Overdue Cumency  Action
Custom Comfort 1 8 1-Late 67.456.45 USD Send Email Cate himi
Qe Dan Penn 30 1-Late 10,090.12 USD Send Email TLate html

I 2 Pt e [ &6 lUsD_Send tmal |2FaaDuchini

43 2-Past Due 178.552.39 USD Send Email 2PastDue html

TR TR %
The Rayal Cavendish Ca. 33 2-Past Due 2221858 GBP Send Email 2PastDue html

The Yoshida Gardens 39 2-Past Due 74 JPN Send Email 2PastDue html

e |f the template preview is not for a specific customer — such as when you click the Preview button
on the Send Invoices screen or on the setup screens for Overdue Payment Reminders, Payment
Due Alerts, and Send Invoices — the program will display the email template that matches the
Sage 300 user’s language setting.

So, if you are running Sage 300 in French, the program will preview the French email template.
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Appendix D: Sending Bulk Emails and
Using Bulk Email Templates

TaiRox CRM and Collections provides several ways to send mass email messages to contacts using
mass emailing programs such as MailChimp, SendGrid, or Swiftpage.

o Upload a contact list to your bulk mail account and use it to send out emails.

o Export a selection or group of contacts — or all contacts belonging to a communication.
o Upload the contact file to MailChimp, SendGrid, or Swiftpage websites.
o Send emails to all contacts on the uploaded list.

The contact must have an email address, first and last name, must consent to receiving emails
(set on the Contact screen), and not be inactive or belong to an inactive or deleted company.

e Use CRM’s Send Bulk Email program to send personalized emails to selected contact
groups, CRM companies’ contacts, or A/R customers’ contacts.

Using a bulk email provider to send emails:

o Create email templates and unsubscribe groups using the facilities on your bulk email
provider’s website.

o Run the Send Bulk Email program to send out bulk emails from your provider, using the
program to select the email template, unsubscribe list, and set of email recipients.

Sending bulk emails directly from CRM:

o Optionally create email templates for use with the Send Bulk Email program — such as
company information letters or newsletters.

o Run the Send Bulk Email program to send bulk emails from CRM using an email template
stored on your server or directly adding the email text and specifying the email recipients.

The Send Bulk Email option is available with CRM and Collections. It is not included in the stand-
alone Collections module from TaiRox Software.

This appendix describes the process for sending emails using both methods.

Exporting Contacts and Uploading a Contact List

In order to export and upload contacts to a bulk email provider, each contact must have an email address,
a first and last name, must consent to receiving emails (this is a checkbox on the Contact screen), and
not be inactive or belong to an inactive or deleted company.

You can export a list of contacts using any of the following methods:
e Export all filtered contacts from the Contacts program using the File > Export function.

e Export all contacts belonging to a Contact Group from the Contact Groups program by clicking
the Export Contacts button at the bottom of the Contact Group record...
Change Log

Save Delete Close

...or by clicking the Actions button (=) at the top of the screen beside the Name field and
choosing Export to MailChimp or Export to Swiftpage.

Name ]ﬁacnmaas il_—
Export to MailChimp N

Contact Groups ~ Contacts
Export to Swiftpage

Search [ Copy Group Search | _Adyanced

Order By [ Mame ~]

Add Contacts To Another Group
Un Lreated by Modfied Un

Modified By Inactive Inactive On

e Export all contacts belonging to a Communication from the Communications program by
clicking the Export Contacts button.
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Choose MailChimp or Swiftpage

The Export function lists two email options — MailChimp and Swiftpage.

Select Type of Import./Export

MailChimp w

Swiftpage

The MailChimp format includes just 3 fields: Email Address, First Name and Last Name. This format can
also be imported into Swiftpage or other services.

The Swiftpage format includes many other fields that could be used for more complex communications.
These fields will need to be remapped when importing into Swiftpage. The Swiftpage remapping input will
look something like this:

Import List

Your data fields must be mapped to List Manager fields.

Field Map: (Default) hd

Save Map as:

Original Column Name | Swiftpage E-marketing Contact List Column
Email Address Email Address A
First Name First Name -
Last Name Last Name M
Phone Office Custom 1 A
Phone Mobile Custom 2 A
Phone Other Custom 3 A
Address 1 Address 1 A
Address 2 Address 2 A
Address 3 Address 3 -
Address 4 Custom 4 v
City City v
State State v
Country Country A
ZIP Code Z1IP Code A
Web Site Web Site A

Using CRM’s Send Bulk Email Program

The Send Bulk Email program lets you send emails using a bulk email provider or using the email server
specified in CRM Options.

You can also use templates from your email provider’s site, or add the email subject and body on-the-fly.

To Set Up Bulk Emailing with a bulk email provider:

1. Subscribe to MailChimp or SendGrid services (or other services supported by CRM and
Collections). You can also set up and use the email server that is specified in CRM Options.

2. Add bulk email service account information to CRM using the Bulk Email Accounts setup program
in the Marketing folder. (The Marketing folder does not appear in TaiRox Collections.)
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Create contact groups in CRM for sending bulk emails. You can also choose email recipients by
selecting ranges of CRM companies or ranges of A/R customer accounts.

Log in to your bulk email service to:

o Create email templates for bulk emails.

o Create unsubscribe groups for each kind of email that you send.

o Associate your sending domain with the bulk email provider (if feature is available).
o Create customer surveys.

Features are dependent on the email service provider.

Send test emails to a limited group of recipients.

Using the Email Server Specified in CRM Options

This is an ideal option if you do not have a bulk email provider or if you are sending an email to just a few
recipients.

To send the email, you just:

Select the “Email Server set up in Options)”.
Enter a “From” email address and name.

Select recipients by choosing the contact group, contacts for a range of companies, or contacts
for a range of A/R customers.

Enter the subject and body of an email directly on the Send Bulk Email screen, or choose an
email template stored on the Sage 300 server.

See Editing Payment Due and Overdue Reminder Templates for general information on editing
email templates. Note that substitution variables are not supported in bulk email templates.

Select attachments for the email and optional fields for the communication it creates.

Click the Send button to send.

Send Bulk Email is ideal for sending out a new price list to contacts or letting customers know that their
sales rep has changed.

Using a Bulk Email Provider

The Send Bulk Email program lets you send emails through a bulk email provider using templates and
unsubscribe lists from the email provider’s site.

To send the email:

Select the “Bulk Email Provider”.

Select the email template stored on the bulk email provider’s site.
Select the unsubscribe list that matches the email you are sending.
Enter a “From” email address and name.

Select recipients by choosing the contact group, contacts for a range of companies, or contacts
for a range of A/R customers.

If you are not using a template, enter the subject and body of an email directly on the Send Bulk
Email screen.

Select attachments for the email and optional fields for the communication it creates.

Click the Send button to send.
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Using your Provider’s Bulk Email Templates and Unsubscribe Lists
Send Bulk Email lets you select a bulk email template and an unsubscribe group set up on your provider’'s
website. Using multiple templates and unsubscribe lists, you can;

e Send on-brand HTML newsletters viewable through a browser and employ a newsletter
unsubscribe list so users can stop receiving newsletters.

e Send business announcements with a business announcements unsubscribe list — to announce
address changes, salesperson changes, etc.

e Send promotional emails using a PROMOTIONS unsubscribe list.
e Send informational emails, attach price lists, and use a different unsubscribe list.

e Take advantage of other provider features, such as surveys or landing pages.
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Appendix E:
Updating Calendars with .ics Event Files

CRM and Collections generates .ics files when employees add or change revisit dates and user
assignments for cases, opportunities, and tasks, and sends them to the “Email 1” address entered in
Sage 300 for the newly assigned and newly unassigned users.

.ics files (iCalendar files) are plain text files containing the details for a calendar event or a to-do
item. Typically, they are sent as attachments to emails that you can save to a calendar, such as the
calendar in Outlook or the Google calendar.

Note: CRM and Collections does not send calendar files when tasks are generated by the Overdue
Payment Reminders program. However, it will send calendar reminders when you change the revisit date
or user for tasks generated by overdue payment reminders.

Setting Up TaiRox CRM and Sage 300 to Email Calendar Events

Setting up TaiRox CRM and Sage 300 to send calendar event files involves the following steps:

e Add “Email 1” email addresses for all users in Sage 300 > Administrative Services > Users.

User ID
User Name

Account Type

Method | Sage 300

[ 4GERRY — |p B+

[Gemy Freyer

[ User ~|  Language

[Engish ]

| Job Role

[ Accounting Manager/Contraler - |

Windows Domain

Windows User Name | |

Contact Information

Phone (890) 556-1212

Microsch Office 365 ntegration
Exmail Accourt [ ]

[] User receives e-mail from Sage with information relevant to job role

Add Delete

['e}
g

TaiRox CRM and Collections sends calendar events to the Email 1 email address.

e Add the settings for your email server in CRM and Collections > Settings > Options.

Options  Emai Calendar Overdue Payment Reminders  Peyment Due Aets  Document Folders

E-mal Server Settings

Server Name [smtp youmnaikerver.con ]

Send Test Email

Save Close

Use the Send Test Email button to test the email server settings.
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e Select the entities that you want to update calendars. The program lets you send calendar events
whenever the revisit date and user assignment changes for cases, opportunities, and tasks.

Note that “Opportunities” will not appear if you are running the Collections module without CRM.

Options  Evmal  Calendar Overdue Payment Reminders  Payment Due Aletts  Document Folders

Select which entiies wil update user calendars
Cases

Opporturities

Teskst

How Calendar Events Update Your Calendar

Calendar events are generated and emailed to assigned users:

e When you manually create a new case, opportunity, or task with an assigned user and revisit
date. The revisit date is the date for the calendar event.

e When the revisit date and/or user assignment changes for cases, opportunities, and tasks.

The program sends a calendar event to the assigned user—and to the previous owner if the
ownership changes — when you save the case, opportunity, or task.

Examples of Calendar Events
Calendar events are sent as email attachments and are handled differently by different email clients.
Outlook email client

The following screens show a typical sequence for adding the emailed calendar event for a case to your
calendar.

e Email arrives in email client — such as Outlook:

=]} = notifications - morgan.thomas@tairox.com - Outlook

Fle  Home  Send/Receive  Folder  View Developer  Help @ Tell me what you want to do

<

3 New Email Search notifications P | cumentFoider -|  ExReply BaReply Al S Forward

notific  gba- 01 905 AM
TaiRox CRM and Collections ...

e Al Unread ByDate~ 1

D5 o |FroM SUBIECT RECEVED ¥ [SZE |¥
4 Date: Today

Inbox
- SUPPORT
Sent Mail

CASE_0000000012.ics
[J_ notifications... ' TaiRox CRM and Collections - Calendar Event Wed 2021-08-11.. 6KB_ [P 544 bytes

4 Date: Yesterday

[ notifications... TaiRox CRM and Collections - Calendar Event Tue202108-10.. 6KB |

e Double-click on the calendar event attachment, or right-click the
attachment and choose the “Open” command.

o If Outlook is set as the default program for “.ics” files, the
program prompts you to add the calendar event to Outlook.

"ﬁ Add this Internet Calendar to Outlook?

i)
You should only apen calendars from sources you know and trust.

Attachment “CASE_000DD00D12.ics™ from TaiRox CRM and

Collections - Calendar Event”

If this message does not appear, you can change Windows Settings to add Outlook as the default
program. See below, To change the default app....
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How Calendar Events Update Your Calendar

To Add this Internet Calendar to Outlook, click the Yes button in the above dialog box to open

the event, and then click the Accept button to add the calendar event.
Bargain Mart - Damaged desk in delivery - OEORD00009784 - Meeting
[LECTICH Inseit  FormatText  Review  Help Q) Tell me what you want to do
@ X [ moew T | @ [V]? X ¥E Zees O g | b
<
Save & Delete Copyto My O Forard Meeting || Decine Respond | & Rermnder:[None | Recumence Time | BT
Close Calendar Notes - : Zones | 'V LowImportance
Actions Show Meeting Notes Respond Options Tags ~
@ The organizer has not requested a response for this meeting.
Organizer  Administrator <morgan thomas@telus.com> Sent Nane
Subject Bargain Mart - Damaged desk in delivery - OEORDO0009784
Lacation |
Start time Fri 2021-08-13 D .00 AM - All day event
End time Fri 2021-08-13 = |2:00 AM -
The new calendar event will now appear in the Outlook calendar.
:
i New Appointment « > August 8 - 14, 2021 Victoria, Canada ~ ;ﬁ’?}ﬁ,r A ;‘;’”F"I':"Wr Search Calendar (This computer only) el
« ‘August 2021 »
SU MO TU WE TH FR SA SUNDAY MONDAY TUESDAY 'WEDNESDAY THURSDAY FRIDAY SATURDAY
25 26 27 28 29 30 31 8 9 10 1 12 13 14
1.2 3 4 5 6 7
15 16 17 18 19 20 21 e
22 23 24 25 26 27 28 g Bargain Mart -
‘Administrator
September 2021
SU MO TU WE TH FR SA 2
e |If a case is reassigned to another user, you might see a calendar event like this appear, allowing

you to delete a previously scheduled event from your calendar.

Bargain Mart - Damaged desk in delivery - DEORDO0ODSTEA - Mecting

—1C W hove - Pys )
= || @ = HEEERAE
% Reply & Delete [ Related -
Meeting | Calendar Mark Follow | Tanslae Read | Zoam
Colender | - Notes Unresd Up - o Brselets | giou
Respond Meeting Notes| Calendar Quick Steps & Meve Tags. 1 Editing Speech Zoam

\dministrator <m Administratar

Bargain Mart - Damaged desk in delivery - OEORDO0009784

When August 15, 2021 10:00 AM-T1:00 AW Location

Bargain Mart - Damaped desk in defivery - OEORDO0009784 deskc i delivery - DEORDOOOISTSA
Agministrator

10 Bargain Mart -
¢ Administrater

11

To change the default app to Outlook:
o Choose Settings > Apps.

Windows Settings

Ilﬂ‘ Devices U Phane @ Network & Internet
L uetoom proter - - Link A hone W kL miplane VPN

L1 System

[ Personalization

]
s
ig
E2R

p Accounts (F),  Time & Language
] sccounts, &mal AF ee 1

o Choose Default Apps.

@ Home Default apps
[ Find a setting | choose default apps Choose your default apps
| xae Email peiiirlcin
u Outlook
IE Apps & features ke
iS5 Default apps | Maps .

Scroll down and choose

o Scroll down to “.ics”, and select Outlook if it's not already selected.

- o

€ setings

@ Choose default apps by file type

dcon n GNU Image Manipulation Program

dcs Qutiook
Calendar File
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Gmail email client

The following screen shows the same new calendar event in Gmail.

Mi Gmail

g

I'd «

[

INBOX;- SUPPORT
INBOX/CRM New Featu
INBOX/CRM Videos
INBOX/Dispatch emails
INBOX/newsletter samp...
INBOX/notifications
INBDX;sales

INBOX/TaiRox product |

® 0 @

Q,  iabelinbox-notifications

B 0 @ ® D

notificatians @tairox.com
tama v

Erm Bargain Mart - Damaged desk in delive...

13 w Fri Aug 13,2021 8am - Gam (PDT)
o Y Adminestrators

W CASE_0000000012.es Download

X

TaiRox CRM and Collections - Calendar Event inskineiications «

®nctve - (D £ Googleo
7 < > B
ienB

© naM @ mnutes sl @
Agenda

8am  Bargain Mart - Damaged desk in delive. +

How Calendar Events Update Your Calendar

e Click the Add to Calendar link to add the event to the Google Calendar, where you can edit the
entry before saving.

x Bargain Mart - Damaged desk in delivery - OEORDO! m

ANg13,2021 B00am to GO0am  AUGIX20Z1  Time zome

O Alday Goesnotrepeat =

@ Addocation
O Notifcation = 10 minutes ~

Add

organ Thomas @) =

3 Busy - Defaultvisibilty -

Guests

Add quests.

Gusst permissions
O Moatyevent
it Others

See guest it

i Google ) .

The next screen shows a calendar event being cancelled in Gmail.

= M Gmail Q,  labstinbox-notifications X oaciver @ @ Google ()
- wai 7 ¢ ®m 0B B8 0 & B O > B
®  INBOX/- SUPPORT notifications@tairex.com © 932AM (W mintes age) Yy
@ INBOX/CAM New Featu ome v
@ INBOX/CRM Videos
KR Bargain Mart - Damaged desk in delive..
®  INEOX/Dispaich emails 16 - ’
@  INBOX/newsletter samp. Mon This event has been canceled o
W INBOX/notifications.
®  INEOX/sales
W INBOX/TalRox product | +
[ CASE 0000000012.ics Download
+ chat +
If viewing the Gmail message on your phone, the screen may look like this:
« ! Fido Wi-Fi & 9:56 AM 91 - « | Fido Wi-Fi & 10:00 AM & 91% .
< = Done CASE_0000000012ics (1]
BargainMart-Damaged-desk
TaiRox CRM and indelivery - OEORD00009784

Collections - Calendar w

Event iNsoxotifications

Bargain Mart - Damaged de...

Fri, Aug 13, 8:00 AM

When

® Fri, Aug 13, 8:00 AM

& Organiser
= Administrator

Bargain Mart - Damaged de...

Mon, Aug 16, 10:00 AM

A notifications 9:04 AM

v

Email message for new

calendar event
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Examples of Calendar Event Files

How Calendar Events Update Your Calendar

CRM creates two main types of calendar event files for each entity that generates .ics files:

e METHOD = PUBLISH — used to create or update an event in a user’s calendar when the case,
opportunity or task is first reassigned to a user or is updated with a new revisit/meeting date.

e METHOD = CANCEL - used to delete an event in a user’s calendar when the case, opportunity
or task has been reassigned to a different user.

For example, here is a sequence of calendar events sent to a single user regarding a revisit date /

meeting date for a case.

Note:

e The UID identifies the case.

e The sequence number shows the order of events.
e The title of the case is “Bargain Mart - Damaged desk in delivery - OEORDO00009784”.

e The administrator is the user who updated the file each time — set as event organizer.

e The event was cancelled when the assigned user was changed from Morgan to Carla.

e File dates are in UTC, not local time.

Calendar file adds an event on
August 13 for Morgan

Date and Time changed to
Monday at 10:00 am

Calendar event cancelled
(reassigned to Carla)

BEGIN:VCALENDAR
VERSION:2.0
PRODID:-//TaiRox Software
Inc.//TaiRox CRM and
Collections//EN
METHOD : PUBLISH
BEGIN:VEVENT

ORGANIZER;CN=Administrator:

MAILTO:mthomas@telus.com
UID:CASE 0000000012
SEQUENCE: 0

SUMMARY :Bargain Mart -
Damaged desk in delivery -
OEORD00009784
DTSTART:20210813T080000
DTSTAMP:20210811T1604502
CREATED:20210811T160450Z
TRANSP: TRANSPARENT
PRIORITY:5

CLASS:PUBLIC

END:VEVENT

END:VCALENDAR

BEGIN:VCALENDAR
VERSION:2.0
PRODID:-//TaiRox Software
Inc.//TaiRox CRM and
Collections//EN

METHOD: PUBLISH
BEGIN:VEVENT

ORGANIZER;CN=Administrator:

MAILTO:mthomas@telus.com
UID:CASE 0000000012
SEQUENCE: 1

SUMMARY :Bargain Mart -
Damaged desk in delivery -
OEORD00009784
DTSTART:20210816T100000
DTSTAMP:20210811T163143Z
CREATED:20210811T163143Z
TRANSP: TRANSPARENT
PRIORITY:5

CLASS:PUBLIC

END:VEVENT

END:VCALENDAR

BEGIN:VCALENDAR
VERSION:2.0
PRODID:-//TaiRox Software
Inc.//TaiRox CRM and
Collections//EN

METHOD: CANCEL
BEGIN:VEVENT
ORGANIZER;CN=Administrator:
MAILTO:mthomas@telus.com
UID:CASE 0000000012
SEQUENCE: 2
STATUS : CANCELLED

SUMMARY :Bargain Mart -
Damaged desk in delivery -
OEORD00009784
DTSTART:20210816T100000
DTSTAMP:20210811T163236Z
CREATED:20210811T163236%
TRANSP: TRANSPARENT
PRIORITY:5

CLASS:PUBLIC

END:VEVENT

END:VCALENDAR
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Appendix F: Exporting and Importing
Companies, Contacts, and Notes

CRM and Collection’s programs for exporting and importing companies, contacts, and notes provide a
flexible way to import company, contact and note data from non-Sage 300 databases and to create new
CRM systems from existing ones. Import and export files are in Excel (xIsx) format.

Export and Import programs provide full support for optional fields, letting you export and import a file with
a single line per company that includes optional fields.

Note: Import Companies does not automatically update A/R Customer records.

Run Sync Companies from the CRM and Collections Periodic Processing menu after importing records if
you updated companies that are linked to A/R customers.

[]
Home

SOX Check Approval ~
50X Second Sight TaiRox CRM and Collections
I ~_TaiRox CRM and Collections I Licensed to: Don Thomson, TAIROX SOFTWARE INC
Change Log Dealer: TAIROX SOFTWARE INC
Collections cC: TAIROX SOFTWARE INC
Collections Reports
Import / Export aau [ =
& & B S @ = = E
Marketing
] Deshboard Calendar Companies Opportunities Contacts Contact Groups Documents Communications Cases Tasks
Periodic Processing
Sales Reports
Send Documents = B — - B — — B — —
Setup
Notes Sales Reports Send Documents Collections Collections Reports Marketing Change Log Import / Export Setup Periodic Processing
v TaiRox Productivity Tools
Accounts Payable Tools v
8age For Help, press F1 Session Date: 2023-07-24 | [&

SOX Check Approval ~
SOX Second Sight Import / Export (Export Companies)
 TaiRox CRM and Collections Licensed to: Don Thomson, TAIROX SOFTWARE INC
ChangeLog Dealer:
Collections CC‘
Collections Reports
Import / Export | = = = = = = = =
Marketing L) L) L3 L3
Export Companies  Export Contacts  Export Company Export Notes Import Companies  Import Contacts  Import Company Import Notes
=R Contacts Contacts
Send Documents v
Sage | For Help, press F1 Session Date: 2023-06-30 | [B

Full Import / Export Support

The Export and Import programs for companies, contacts, company contacts, and notes let you:
e Import company, contact, company contact, and note information into CRM and Collections.

o Import Companies imports from a file with a single line per company, allowing you to import
companies from non-Sage programs. It also allows you to import a file that you previously
exported from CRM and edited.

o Import Contacts imports from a file of contact information with a single line per contact. It
allows you to import contacts from non-Sage programs.

o Import Company Contacts imports records that link contacts to CRM companies and
specify which accounting forms (statements, invoices, and overdue payment reminders)
should be emailed to the contact for the company.
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Records

Note: You must add or import companies and contacts before you can add or import the
company contacts records.

o Import Notes imports notes for companies, cases, opportunities, and tracked invoices from
Excel files with a single line per note.

e Export company, contact, company contact, and note information to a single record per line that
includes optional fields (where appropriate).

o Export Companies creates a file with a single line per company for use with other programs,
or to edit in a spreadsheet and then reimport the data.

o Export Contacts creates a file of contact information with a single line per contact for use
with other programs, or to edit in a spreadsheet and then reimport the data.

Note that the standard Sage 300 Export choice on the Companies File menu exports
optional fields to a separate tab of a workbook. TaiRox Export functions include the
optional fields as additional columns in the company and contact records.

o Export Company Contacts exports the companies that contact is linked to, along with the
accounting forms (statements, invoices, and overdue payment reminders) that each contact
is emailed.

o Export Notes creates a file with a single line per note for use with other programs, or to edit
in a spreadsheet and then reimport the data.

o Easily import additional company and contact fields that are in source programs but not in CRM.

Just add optional fields to CRM that match the additional source program’s data fields, extract
records from the source program into a spreadsheet, and then import all the data directly into
CRM by mapping the additional source fields to CRM’s optional fields.

TaiRox import programs also let you add new records to CRM and/or update existing records, allowing
bulk record updates such as the addition of a new optional field.

Exporting Company, Contact, Company Contact, or Notes
Records

e Select the Export program from the Import / Export folder.

File Help

Fie  [CA\Users\dont\Desktop\Companies export xisx 1Q

Sclect fields to export Al None [ i deleteed Gompanes:

Select  Field ~
»

Deleted
Created On
Created By
Madied On

Modified By

Short Name

!!!!!!!!!!H

Street 1 v

oK Cancel

e Use the Finder to specify the destination file name and file location.

e For notes, choose whether to export notes for companies, cases, opportunities, or tracked
invoices.

e For companies, choose whether to export deleted companies.

e Select which fields you want to export to the spreadsheet.
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Importing Company Records

Click the OK button. Optional field columns appear at the end of each company and contact
spreadsheet line (if you use optional fields).

Importing Company Records

Select the Import Companies program from the Import / Export folder.

Use the Finder to specify the source file name and file location. (If the name is already in the field,
press Tab or Enter to load the import spreadsheet and display the spreadsheet columns.)

Note that the program reads the 1st row from the 1st visible worksheet to validate the import file
and display the import fields.

il Help

Fle  [C\Users\dont \Desktop:Companies expott s

1]

Insert and Update

Field

Deleted

Inaciive

Contents

DELETED
INACTIVE

Data Type

- I

~ | Boolean

~ | Boolean
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Name NAME | Siing
Short Name ABBREV | Siing
Street 1 STREET1 | Siing
Strect 2 STREET2 | Siing
Street 3 STREET3 | Siing
Street 4 STREET4 | Siing
City oy | Siing
State/Prov. STATE | siing v

oK Cancel

Choose Insert, Update, or Insert and Update, depending on the import process.

If necessary, match the columns in the spreadsheet to the fields in the Company records.

Field Conterts Data Type ~
D D | Integer
Deleted <Defauit Value> | Boolean
Inactive <Defauit Value> | Boolean
Name NAME | String
» o >

Street 1
Street 2
Street 3
Street 4
City
State/Prov

POSTALCODE String v

In the above example, the Deleted and Inactive fields are not in the spreadsheet, and the
program provides a “default value for these fields.

The spreadsheet has a column called ABBREV, which is being matched to the Short Name field
in CRM.

Match the optional fields to the import fields at the bottom of the list.

Click the OK button to proceed.

— Import Companies
The ID number is a required field. Import will not proceed if you set ID to <Default Value>.

Leave the ID number blank for new company records; provide the ID number for updated
records. The ID is used to match the updated record to the existing record.

Currency code is a required field — but you can set it to the <Default Value>.

Records with an invalid Territory code will be skipped — but you can set it to the <Default
Value> (which will appear in the Company record as the Default Territory).

Run Sync Companies after importing company records that are linked to A/R customer
records.
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Importing Contact Records

e When updating a company:
o If you specify <Default Value>, or if the cell is empty, import will keep the current field value.
Optional fields are handled as follows:
o If you specify <Default Value> for the optional field, import will leave the existing value “as is".
o If you specify a column, import behaves as follows:
- If the optional field already exists then it is either updated with the imported value [if there
is a value] or deleted if the imported value is null.
- If the optional field does not exist and a value was specified then the optional field is
inserted.
e When inserting a new company:

o If you specify <Default Value>, the program will enter the default value if one exists.
Optional fields are handled as follows:

o If you specify <Default Value> for the optional field, it will be inserted if its auto insert property
is Yes in optional fields setup.

o If you specify a column, the optional field will be inserted if the column contains a value.

Importing Contact Records

Select the Import Contacts program from the Import / Export folder.

Use the Finder to specify the source file name and file location. (If the name is already in the field,
press Tab or Enter to load the import spreadsheet and display the spreadsheet columns.)

Note that the program reads the 1st row from the 1st visible worksheet to validate the import file
and display the import fields.

il Help

Fle  [C\Users\dont \DesktopContacts export fik xsx |Q

fnsetand Update |

Field Contents Data Type ~
» T o - T

Inactive INACTIVE ~ | Boolean

Lest Name LASTNAME
FIRSTNAME
Selutation TITLE
Job Title POSITION
Phane (Office) PHOFFICE
Phane (Mobie) PHMOBILE
Phone (Cther) PHOTHER
Email EMAIL
Notes 1 NOTES
SUBSCRIBED

~ | sting
First Name ~ | Sting
~ | sting
~ | sting
~ | sting
~ | sting
~ | sting
~ | sting
~ | sting

Contact conserts o receive e

~ | Boolean
v

aK Cancel

Choose Insert, Update, or Insert and Update, depending on the import process.
Note that Contacts are independent of companies.

You associate contacts with companies using the Company Contacts import file — or add them to
companies on the Contacts tab for each company record (or on the Companies tab for each
contact record).

If necessary, match other columns in the spreadsheet to the fields in the Company records.

Field Contents Data Type @

Phone (Mobilc)
Phone (Other)
Emai

Notes 1

Contact consents to

receive &

PHMOBILE
<Default Value>
EMAIL

<Default Value>
SUBSCRIBED
nuny

| Sing
v | Sting
~ | Sting
~ | Sting

~ | Boolean

Inactive <Default Value> ~ | Boolean
Last Name LASTNAME ~ | Sting
First Name FIRSTNAME w | Sting
Salutation <Default Value> ~ | String
Job Title <Default Value> ~ | Sting
Phone (Office) PHOFFICE ~ | Sting
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Notes

In the above example, the Deleted and Inactive fields are not in the spreadsheet, and the
program provides a “default value for these fields.

You can match contact optional fields at the bottom of the list to the import fields.

Click the OK button to proceed.

— Import Contacts

The Contact Code is a required field. Import will not proceed if you set the Contact Code to
<Default Value>.

The Contact Code is also used to match the record updates to the existing records.

o Same Contact Code — it's an update.

o New Contact Code —it’s an insert.

The “Contact consents to receive emails” field is used for mass emails. It filters out contacts who
don’t want emails when you export to MailChimp or Swiftpage.

When updating a contact:

o If you specify <Default Value>, or if the cell is empty, import will keep the current field value.
Optional fields are handled as follows:

o If you specify <Default Value> for the optional field, import will leave the existing value “as is".

o If you specify a column, import behaves as follows:
- If the optional field already exists then it is either updated with the imported value [if there
is a value] or deleted if the imported value is null.
— If the optional field does not exist and a value was specified, then the optional field is
inserted.

When inserting a new contact:
o If you specify <Default Value>, the program will enter the default value if one exists.

Optional fields are handled as follows:

o If you specify <Default Value> for the optional field, it will be inserted if its auto insert property
is Yes in optional fields setup.

o If you specify a column, the optional field will be inserted if the column contains a value.

Importing Company Contacts Records

Select the Import Company Contacts program from the Import / Export folder.

Use the Finder to specify the source file name and file location. (If the name is already in the field,
press Tab or Enter to load the import spreadsheet and display the spreadsheet columns.)

Note that the program reads the 1st row from the 1st visible worksheet to validate the import file
and display the import fields.

File  Help
Fle  [C:\Users\dont\Deskiop*Company Cortacts xisx 1Q
Find matching company using
Field | Company ID ~ Column  SDCOMP v
Field Corttents Data Type
" T o .
AR Invoices ARINVOICE ~ | Boclean

A/R Statements ARSTATEMENT ~ | Boolean
O/E Invoices OEINVOICE ~ | Boolean
X/Q Paymert Reminders XQOVERDUEPAYMENT ~ | Boolean
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e Choose the fields for matching contacts to the correct companies in CRM.

Find matching company using

Field | Compar Column  IDCOMP ~
ar

Data Type

T

C
P Customer Credit Waming
Freight Method

Note: The Company Contacts file links contacts to companies and lets you specify the
accounting documents that each contact is sent. You must add company records and contacts to
CRM before importing the Company Contacts file.

You can identify the company that contacts belong to by:

o The Company ID field — the unique number that CRM assigns to each company in CRM.
o The Company Name field in the CRM company record.

o Matching an optional field that has been added to the company to a field in the import file.

Choose the field in the customer record for identifying the customer record from the left
dropdown, and the column that matches it in the import spreadsheet.

In this case, we are matching the Company Name in CRM to a “NAMECOMP” column in the
import file.

Find matching company using

Field [Company Name v Column |NAMECOMP ~

e If necessary, match other columns in the spreadsheet to the fields in the Company records.

| Fietd

A/R Statements
AR Letters
A/R Invoices

O/E Invoices

X/Q Overdus Payment Remin

| Contents

ARSTATEMENT

ARLETTER

ARINVOICE

OEINVOICE

73 KN K1 K KN N

XQOVERDUEPAYMENT

Data Type

oo [T R -

Boolean
Boolean
Boolean
Boolean
Boolean

e Click the OK button to proceed.

Importing Notes Records

e Select the Import Notes program from the Import / Export folder.

e Use the Finder to specify the source file name and file location. (If the name is already in the field,
press Tab or Enter to load the import spreadsheet and display the spreadsheet columns.)

Note that the program reads the 1st row from the 1st visible worksheet to validate the import file
and display the import fields.

il Help

Fle  [Co\Users\dont\Desktophexport test aisx 1Q

Import Netes For | Companies ~ Insert and Update ~

Speciy the field in the company record and the matehing column in the impat fle that uniquely identfies the
company that cach note i irked to

Field | Company ID

Column | <Select Coiumn> 2

Field

Note Name
Note

Conterts

NAME
TEXT

Data Type
~ | Sting
~ | Sting

aK Cancel

o Choose the type of notes that you are importing — Companies, Cases, Opportunities, or Tracked

Invoices.

e Choose Insert, Update, or Insert and Update, depending on the import process.
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View Import Log File

Choose the fields for matching notes to the correct companies, cases, opportunities, or tracked
invoices in CRM.

You can identify the company/case/opportunity/tracked invoice that notes belong to by:

o The Company ID/Case ID/Opportunity/Tracked Invoice ID field — the unique number that
CRM assigns to each record in CRM.

OR

— If you are importing notes for companies, the Company Name field in the CRM company
record.
- If you are importing notes for tracked invoices, the Document Number.

Match other columns in the spreadsheet to the fields in the CRM records.

Note that you MUST choose the matching spreadsheet field for each record field — as in the
following example.

Import Notes For | Companies v Insert and Update v

‘Specify the field in the company record and the maiching column in the import file that uriquely identfies the
company that each note i rked to

Field | Company ID d Column | IDCOMP v

Field Cortents Data Type
Note ID IDNOTE ~ | Integer
Note Name NAMENOTE | Sting

Click the OK button to proceed.

Notes — Import Notes

When inserting a new note:
o The note IDs in the Excel file must be 0. CRM will assign IDs to all new notes.

When updating an existing note:
o The note ID in the spreadsheet file must match the ID of the note you are updating/replacing.

View Import Log File

The import programs generate a log file that lists any issues from the import procedure.

Choose File > Log Files... to display the file.

The log shows the number of records added, updated, or skipped, as well as any import errors.

Import Companies 2019-10-21 17:07:49
Performed by user: ADMIN

File: C:\Users\user\Documents\Import test.xlsx
Operation: Insert and Update

Row 3

Invalid input. Territory OR does not exist.
Row 4

Invalid input. Currency cannot be blank.

w

record(s) were read from the file.

records
records
records
records

N OO

added.

updated.

skipped.

not processed due to error(s).

TaiRox CRM and Collections for Sage 300 231

User Guide



Appendix G: CRM and Collections Security

Security Levels and User Access

Appendix G: CRM and Collections Security

CRM and Collections provides two layers of security on user access to customer account data: access by
territory and access by security authorization.

e Access by territory — users see companies, opportunities, cases, and tasks based on the
territories to which they belong. Tasks that are not associated with a company are not filtered by

territory.

o Users can be granted rights to see any number of specific territories. There is no hierarchy of

territories.

User ID

Search |
Order By

Users  Temtories

User Name

|Don Fenske

Search

| Code

ID Code

Default Temitory

A S I

3CA Califormia

Notes

Created On
20151209

Created By

ADMIN

20191209 ADMIN

o Users can be granted the right to see all territories. CRM and Collections includes a switch

that effectively turns off all territory restrictions for a user.

User

All Temitories

Notes

Gt Gt
ModfiedOn  [20210315 | Modfied By
[ Inactive

User ID [boN .+ [Don Fenske

Non Admin

Save

Change Log...

Close

e Access by security authorization — CRM and Collections provides a full set of security

authorizations to control access to CRM settings, user maintenance,

data, etc.

Setup Maintenance
Setup Inquiry

Import Processing
Export Processing
User Maintenance
Company Maintenance
Company Inquiry

Promote/Unlink
Companies

- Opportunity Maintenance -
- Opportunity Inquiry -
- Contact Maintenance -
- Contact Inquiry -
- Document Maintenance -
- Document Inquiry -
- Communication Maintenance -
- Communication Inquiry -

customer data, collections

Note Maintenance

Note Inquiry

Collections

Case Maintenance

Case Inquiry

Send Documents
Accounting Doc Maintenance
Accounting Doc Inquiry

o Disputed invoices, promised payments, and tracked invoices (collections related entities)
appear only if the user has been granted "Collections" security access.
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o Collections type cases also appear only if the user has been granted “Collections” security
access.

o Users must have been granted Opportunity Inquiry (or Opportunity Maintenance) security
access in order to see opportunities.

o Users must have been granted Case Inquiry (or Case Maintenance) in order to see cases.

o Security groups and user authorizations are all defined through Administrative Services — just
like core Sage 300 modules.
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Frequently Asked Questions (FAQ)

Read the user guide for TaiRox CRM and Collections in addition to reviewing this FAQ.
The CRM and Collections user guide provides specific guidelines for setting up TaiRox
as well as general information and notes on all CRM and Collections features.

Resources Available to Answer Sage 300 Questions?

In many cases, issues with CRM and Collections are actually Sage 300 issues — such as database
connectivity issues or issues where Sage 300 cannot create a control, and many of these issues have
been encountered by other Sage 300 users.

Q: Where can you get fast answers to Sage 300 issues?
A: Google the error message and check the results.

Sage 300 error messages are often self-explanatory or can be Googled for an explanation. These
messages may indicate fairly simple issues that users can resolve, or environmental issues that
consultants can resolve.

In many cases, you may find your answer on an existing Sage 300 support forum, posted by partners
who have already encountered your issues.

For example:

https://support.na.sage.com/selfservice/

www. pluscommunity.com/ubbthreads/
https://www.sagecity.com/support_communities/sage300_erp
https://www.acutedata.com/sage-300-kb/

CRM and Collections Installation and Upgrade Issues

Q: Where can | get CRM and Collections release notes, and what will they tell me?

A: Click the Release Notes link in the upper left-hand corner of the TaiRox CRM and
Collections product page on the TaiRox web site.

Among other things, the Release Notes will tell you about recent fixes and provide program
compatibility information. For example:

Build 2023-10-04
- Support added for Sage 300 2024.
- Contract Groups have enhanced management of copy and merge operations.

Build 2023-07-31
- Marketing menu added with Bulk Mail setup and send functions, enhanced
Contact Group functions.
Send emails to multiple users through local mail server, MailChimp and
SendGrid.
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Frequently Asked Questions (FAQ) CRM and Collections Installation and Upgrade Issues

Q: How do you install TaiRox CRM and Collections?

A: TaiRox CRM and Collections has a standard Windows installation file that follows standard
removal protocols.

As of September 2022, the installation file — Setup-2018-202n.msi — works with Sage 300
2018 to the current version.

Important:

¢ Sage 300 must already be installed on the machine before you install TaiRox CRM.

e Activate Sage’s M/T Contacts module if available in your version of Sage 300. CRM
contacts are totally compatible with Sage’s Multiple Contacts module.

¢ When upgrading, uninstall the previously installed version of TaiRox CRM using the
Windows Control Panel/Windows Settings before installing the new version.

Q: What is the upgrade procedure for TaiRox CRM and Collections?

A: When upgrading, uninstall the previously installed version of TaiRox CRM using the
Windows Control Panel/Windows Settings before installing the new version.

Q: How do I synchronize TaiRox CRM contacts with Sage 300 after activating the
Sage 300 M/T Contacts module?

A: Sage’s M/T Contacts module was added in versions of Sage 2020 Product Upgrade 1.

To use Sage contacts:

e You must first install a version of Sage 2020 PU1 or higher that has the Multiple
Contacts module.
e Upgrade TaiRox CRM to the most recent version.

Step 1: Activate Sage 300 Multiple Contacts using the Data Activation program in
Administrative Services. (And activate the most recent version of CRM, if necessary.)

Step 2: Run Sync Contacts in the TaiRox CRM Periodic Processing folder on the Sage 300
Desktop. Sync Contacts will add all CRM contacts to the Sage 300 M/C Contacts module.

Step 3: Run Sync Companies in the TaiRox CRM Periodic Processing folder on the Sage
300 Desktop. Sync Companies will update Sage A/R customer records with the contacts
maintained for CRM Companies.

After completing these steps, A/R customer contacts will match the contacts in CRM, and
updates to contacts in either CRM or A/R will be reflected in both systems.

Q: I have issues running Sage 300 and CRM after completing a Sage 300 upgrade.
What can 1 do? And how can | diagnose installation issues?

A: Always upgrade all of your TaiRox products to the most recent versions when you upgrade
Sage 300 products.
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The latest version of a TaiRox product replaces all previous versions of that product. CRM
and Collections supports all versions of Sage 300 from 2018 through to the current version.
In other words, the TaiRox CRM installation program is not Sage 300 version specific. If you
upgrade Sage 300, make sure that you also upgrade TaiRox CRM and Collections.

A: Run TaiRox Install Check (available here on the TaiRox website -- http://tairox.com/install-
check-for-sage-300-erp-accpac.html)

Install Check checks the environment on a computer running Sage 300. If the environment
is not correct, some or all functions in Sage 300 and third-party applications may not operate
correctly.

Install Check leaves no footprint — it does not install, does not change the Windows registry,
and does not require a license.

Install collects basic environmental information and checks that certain Sage 300 related
operations can be performed. The download is a zipped-up EXE file. Run the EXE, click the
Installation Check & System Information buttons, copy the results to the clipboard, save in a
Word document and analyze: paying particular attention to any red message.

If you are running a TaiRox program that provides a log file that shows a problem, review
the log file as well.

If you can re-create a problem in a known environment (all O/S, Sage 300 and third-party
software freshly installed in a recorded order), we can check what might be happening in a
matching environment using our developer tools.

Note that SDK applications publish a list of files that are part of their application. Install
Check checks this list against files that are actually installed. This helps diagnose situations,
for example, when an anti-virus program has incorrectly quarantined a legitimate file.

Q: Why did the Sage Desktop stop working?

We just upgraded a client to a new version of Sage 300. All workstations except one are
working fine. One workstation gets a “DESKTOP has stopped working” message when the
user attempts to log on to their live company database; however, it works fine when they log
in to SAMINC or SAMSYS.

A: This error is usually indicative of a Product Update mismatch.

For example -- We had this error when setting up a test environment. The live data was from
Sage 300 2018 PU6 and we restored it into the test environment where the application files
were Sage 300 2018 Rev 0. The error went away when we installed PUG6 in the test
environment.

Q: Where can | find TaiRox CRM log files?

A: CRM creates logs when it runs processes for Emailing Statements, Letters and Invoices to
customers, and it creates change logs whenever you change a company, contact, contact
group, opportunity, case, document, communication, note, disputed invoice, promised
payment, task, tracked invoice, territory, or user.
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To see a log file for Send Statements / Letters, Send A/R Invoices and Send O/E Invoices,
open the program and click the Log button.

To view change logs, open the maintenance program and click the Change Log button, or
open the Change Log folder and choose the Change Log icon to view change logs, or use
the Change Log Report to print change reports.

Q: How can | deactivate a product that is installed with Sage 300?

A: Fast DBTools has a deactivation function that correctly deactivates products by deleting all
tables with the prefix and the rows in Common Services tables that refer to the prefix. For
example, CRM uses data prefix “XQ”.

Q: Why does message “Can’t Create Control” appear when running a TaiRox
CRM or Sage 300 program? (The problem is only occurring for a specific
user.)

A user gets the following message when opening a CRM program or drilling down to Sage
300 from CRM.

Error l_J&

Can't Create Control: {39B3E016-AD72-4695-A0AC-D5ES556B71ET }

Other users logging in from the same workstation have no problems — for example as either
ADMIN or with their own ID.

This user was previously able to run this program successfully, but had an issue and hasn’t
been able to use the program since.

A: There are many possible reasons for this message to appear. For example, some Sage
300 containers have had issues.

First thing to try: Restore Defaults on the Sage screen where there were issues and on the
TaiRox Extended version of the screen.

¢ Right-click the icon on the Sage desktop, and choose Restore Defaults from the pop-up
menu.

A: You should also check that all Sage 300 and TaiRox CRM updates and have been installed.

A: Another possibility — if using a remote desktop to run Sage 300, check if the program's
screen size is too large relative to the display resolution of your remote desktop window
when you get the Can't Create Control error.

o If you log onto the server (via remote desktop) and change the resolution does the
problem go away?

The problem can arise when one user runs the program successfully and resizes the form —
which then causes problems when another user runs the program as a published
application.
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A: Google the error message for more troubleshooting leads, and look at the forums listed at
the top of this FAQ.

Q: I get this error when trying to “Send Test Email” from Setup > Options in
Tairox Collections. What is the problem?

& Error X

Emor

Description: System Emor. Send Test E4nail failed. Emor=Chilkat ActiveX.
component not installed, or not registered.

Source: 08:25:39 -

Print Help ..

A: This problem usually arises when you are running on a workstation, and did not run
Workstation Setup after installing CRM and Collections. As a result, the Chilkat dll that was
installed in the Sage 300 runtime folder has not been registered for this workstation.

You can fix the problem by running Sage's RegAcc.exe program on the workstation to
register the dlls/ocxs that were installed with TaiRox CRM and Collections. (You can find
RegAcc in the runtime folder.)

A/R and M/T Integration with Demo Data

Q: Why did | get an error message when | unchecked “Suspend A/R and M/T
Integration in CRM and Collections Options?

I unchecked the A/R and / or the M/T Integration checkboxes in Setup Options and got the
following message:

The Suspend A/R Integration option should be checked when
in Demo Mode unless you are certain 'Sample Company
Limited' is a test company.

Are you sure you want to turn off Suspend A/R Integration?

tes

A: A/R and M/T Integration are suspended for your protection to ensure that CRM does NOT
update the Sage 300 Multiple Contacts and Accounts Receivable data.

If you created Demo Data with SAMLTD or SAMINC — or with a copy of your company
database and want to see the results of A/R and M/T Integration — you can turn on
integration in Setup Options.

Do not turn integration on if you are working with a production database!
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User Management

Q: Why can’t | add a new user to CRM and Collections?

A: You must first add the user to Sage 300, and then use TaiRox CRM > Setup > Users to add
the user to CRM.
o First, add users to Sage 300 using Administrative Services > Users.

e Second, add users to TaiRox CRM using TaiRox CRM > Setup > Users.

Using SmartFinder Search

Q: Why don’t | have any search results?

A: Check the spelling for the terms you entered. If you are unsure of spelling, shorten the
search string to characters that you are sure of.

Using Contacts

Q: How do you delete a customer contact from a CRM company? Does it delete
the contact from Sage 3007?

To delete a contact from a CRM company record, go to the Contacts tab, highlight the
contact record in the grid, and use the Delete key (or the Unlink button).

e This will remove the contact from the company record, and, if you are using the M/T
Contacts module, it will also remove it from the A/R customer record unless you suspend
A/R integration (in Setup Options).

Similarly, if you remove a contact from the A/R customer record, it will also be removed
from the CRM company record unless you suspend A/R integration.

e The contact will still remain in the CRM Contacts list and in the M/T Contacts module.

e If you delete a contact from the Sage M/T Contacts module, it will also be removed from
the CRM Contacts program unless you suspend M/T integration.

Notes concerning M/T Contacts in Sage 300 A/R and A/P:

e If you delete the contacts from A/P or A/R, the contacts will be removed only from the
vendor or customer record. The contact record will still exist in the list maintained by
Sage’s M/T Contacts module.

e To delete the contact from Sage 300, use the M/T Contacts module in Common
Services. Note, however, that in the Sage 2020 versions of A/P and A/R, the code for
the contact will still appear on the vendor or customer contact tabs until you delete it.
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Emailing Company Contacts

Q: Can | send emails to CRM contacts directly from CRM?

A: Yes. The Send Documents button on the Companies screen lets you create an email for
the currently selected company, add attachments, and select company contacts. The sent
emails are added as communications for each contact.

See Sending Miscellaneous Emails and Email Attachments to Contacts for details.

Emailing Statements, Invoices, Payment Alerts, and Reminders

Q: | see the following “Important Information” message when | try to send
overdue payment reminders. What’s wrong?

# Important Information Lﬁ
Waming: One or more of the Overdue Payment Reminder templates do MOT include the macro
SOVERDUE_INVOICES and/or the email subject line contains macros beginning with SDOCUMENT.
Explanation: Overdue Payment Reminder emails now consolidate all overdue invoices irto a single email,
instead of sending a separate email for each overdue invoice. Atable of overdue invoices is inserted into the
email body at the position marked by the macro SOVERDUE_INVOICES. Macros beginning with

SDOCUMENT will be replaced by the details from the most overdue invoice.

We suggest you make changes to the templates and/or the email subject line before sending overdus

payment reminders. See Appendix C in the Uiser Guide for instruct

l Send Overdue Payment Reminders

A: This message (or one like it) tells you that Email templates have changed due to a program
update, and that you should update your old email templates.

The message was added in 2020 to warn you that templates — or the email subject line —
included a $DOCUMENT macro. The message may be different in later versions of the
program.

Some changes over the past few years are as follows:

In June 2023, we dropped the deprecated macros starting with SDOCUMENT _. They can
no longer be used with payment due alerts or with overdue payment reminders.

In September 2020, we added the $OVERDUE_INVOICES macro to insert a table with all
overdue invoices into payment reminder emails. We also changed all macros starting with
$DOCUMENT to refer to the oldest outstanding invoice.

If you want to continue and send the Payment Reminder — for example, if you are
demonstrating the feature or if you want to separately include information about the oldest
invoice — click the Process Overdue Payment Reminders button to continue.

To cancel the mailout and update your templates, click the Cancel button.

The Email Subject, From Email, Reply-To Email, Cc and Bcc fields for A/R Statements/
Letters and A/R and O/E Invoices are set in the Setup > Accounting Documents program.

Those fields for Overdue Payment Reminders and Payment Due Alerts are specified with
the Overdue Payment Reminders Setup and Payment Due Alerts Setup programs.
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Q: My invoices are not being sent properly via email. In some cases, an email is
actually sent, but the log notes a failure and the program does not create an
EML file or a communication. This a sporadic issue. What’s wrong?

I ran Send O/E Invoices, but the EML file was not created in the CRM directory, and the
program did not create a communication, even though an email was sent. However, for no
apparent reason, the program worked properly when | tried it later. This happens
sporadically.

A: Check the log file for a timeout after the program starts to send an email. It may be that your
email server is not sending a response back in the first 30 seconds, which is the default
email timeout for CRM and Collections. Your mail server may be busier at some times and
not so busy at others — when you do not experience the issue.

If your email server is timing out, you have several options:

o Check the server to see why it takes over 30 seconds to respond. IT staff may be able to
upgrade the server or set up a relay email server.

e Increase the ReadTimeout value in the XQ.INI file in recent versions of CRM and
Collections (in the Sage300\XQ61A subfolder). This setting was added in July, 2022.

The downside of this approach is that our program may appear to be “hung” as it waits
for a longer time to get a response from the mail server.

The setting is initially commented out (the line starts with “;”) and default to 30 seconds.

[SendDocuments]

SendEmails=True

;ReadTimeout is in seconds. The default value is 30.
;ReadTimeout=300

Un-comment the line and specify a larger value than 30.

Q: I have the wrong “From Email” address in my emailed documents. Where does
this address come from?

A: The default “From Email” address comes from the Email tab in the Setup > Options
program. If this field is blank, the default address will be the Email 1 address from the Sage
300 user’s account.

You can override the default email address in Options for the following emailed documents
using the Accounting Documents Setup program:

¢ A/R statements and letters
¢ A/R and O/E invoices

And you can override the default email for Overdue Payment Reminders and Payment Due
Alerts with the Overdue Payment Reminders Setup and Payment Due Alerts Setup
programs.

If you do not specify a From Email address in Accounting Documents, the above programs
will use the setting in Options.

You can also override the default From Email address when you resend documents from the
Company window by specifying a new address in the Send Documents window.
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Frequently Asked Questions (FAQ) Synchronizing Contacts and Companies

Q:

A:

The emails for Overdue Payment Reminders, Payment Due Alerts, and/or Send
Invoices are not using the customer’s preferred language. What’s wrong?

See Sending Emails and Invoices Using the “Preferred Language” Company Setting for
details on sending emails in the customer’s language.

Here are the steps for sending French or Spanish emails:

¢ Install the Sage 300 language files for French and/or Spanish to send emails and
invoices in the target languages.

e Select the Preferred Language in the Company window for all customers that should
receive French or Spanish emails.

e Create FRA and ESN subfolders for the translated versions of your email templates.

For example:
<Sage300SharedData>\Company\<companyID>\TaiRox CRM\Templates\Overdue Payment Reminders\FRA
<Sage300SharedData>\Company\<company|D>\TaiRox CRM\Templates\Payment Due Alerts\FRA
<Sage300SharedData>\Company\<companyID>\TaiRox CRM\Templates\Send Invoices\FRA

o Add the French and Spanish versions of your email templates to the default templates
folders for overdue payment reminders, payment due alerts, or invoices.
o The translated templates must have the same name as the English versions in the

root folders.

o You must include any image files for the emails in the language subfolders.

Synchronizing Contacts and Companies

Q:
A:

Why doesn’t Sync Companies add CRM companies to A/R?

Sync Companies synchronizes companies that were not synchronized by CRM’s normal A/R
Integration — and A/R integration does not automatically add new companies to A/R.

Usually, you will add prospective customers to CRM, and then promote them to Accounts
Receivable when they become customers. See Promoting Prospects to Customers in
Accounts Receivable.

Sync Companies is mainly used when you first set up CRM and want to add all customer
records to CRM as companies, and when circumstances have caused the two databases to
go out of sync (such as suspending A/R Integration on the Setup Options form).

: Why does a message appear when | choose Sync Contacts / Sync

Companies?

Message Message

Description: M/T integration has been suspended in TaiRox CRM Options. Description: A/R integration has been suspended in TaiRox CRM Options.
Sync Contacts cannct be performed. Sync Companies cannct be perfformed.

Source: 16:41:21 - Source: 16:42:14 -

Sync Contacts and Sync Companies are disabled if you suspend integration with the Sage
M/T contacts module and with A/R. To enable the programs, you must uncheck “Suspend
M/T Integration” and “Suspend A/R Integration” on the first tab of the Setup Options screen.
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Frequently Asked Questions (FAQ) Using Sage Number Changers

Using Sage Number Changers

Q: I've been using the Sage Number Changers and don’t think that all records
were updated in CRM. Does CRM or CRM and Collections work with Sage 300
number changers

CRM or CRM and Collections does handle Sage 300 number changers — but ONLY for
changing one number to another. It does not combine two numbers into one.

You should also:

¢ Make sure that you are using the most recent version of CRM or CRM and
Collections with Sage 300 to ensure that your version of CRM matches the version of
Sage 300.

¢ Update generated data after using the number changers — for example, update
Customer Aging, Overdue Invoices, Payment Due Alerts, and Send Invoices.

Note also that CRM database tables do not include vendors, I/C items or G/L Accounts, so
those Number Changers do not apply.
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